Solar Fire 5
TM

for Microsoft Windows



User Guide
ASTROLABE ESOTERIC TECHNOLOGIES

Before you open the disk package... Please read the End User
Agreement that comes with your program disks. Breaking the wrapper
signifies that you agree to the terms of this contract. This means you will
not sell or give away copies of Solar Fire or its documentation and
manuals while still using a copy on your own computer. Buying a copy of
this programs entitles its use on only one computer at a time. If you do not
agree to these terms, return the manual and unopened disk package, and
your money will be refunded. No refunds are available on opened disk
packages.
Producing this program has taken many months of development time,
testing, and documenting. To continue to supply astrologers with top-grade
astrology software, its makers need to recoup costs and keep staff on hand
to give service and technical support. Please make sure that those you
know have only licensed copies of these programs. That way, you can
ensure continued technical support and new programs in the future.

Program and User Guide copyright © 2000
by Esoteric Technologies Pty Ltd.
All rights reserved.
Reproduction of this manual in whole or in part, by any means, for any
but the registered user’s own personal use, is strictly prohibited without
written permission from the publisher.
Printed in the United States of America
Published by: Astrolabe, Inc.
350 Underpass Road • PO Box 1750 • Brewster, MA 02631 USA
Tel.: (508) 896-5081 • Fax: (508) 896-5289
www.alabe.com • email: astrolabe@alabe.com
SF5DOC 04/00

Table of Contents
Getting Started .................................................................................1
Chapter 1: Solar Fire and Its Authors............................................1
Selected Features..........................................................................................2
Esoteric Technologies Pty Ltd .....................................................................3
Finding the Information You Need ..............................................................3

Chapter 2: Installation ....................................................................4
Computer System Requirements ..................................................................4
Installation....................................................................................................4
Troubleshooting the Installation...................................................................6

Chapter 3: Finding Your Way Around Solar Fire.........................10
Starting Solar Fire ......................................................................................10
Using Solar Fire .........................................................................................11
Solar Fire’s Main Screen............................................................................11
Exiting from Solar Fire ..............................................................................15
Using On-line Help ....................................................................................15
Using the Keyboard....................................................................................16
Chart Calculation and Storage....................................................................19

Chapter 4: A Guided Tour of Solar Fire........................................22
Casting a Natal Chart .................................................................................22
Casting a Solar Return Chart......................................................................23
Displaying or Printing a BiWheel ..............................................................23
Displaying or Printing a Synastry Grid ......................................................24
Changing Aspects.......................................................................................24

WORKING WITH CHART DATA

26

Chapter 5: Casting a New Chart ...................................................26
Pre-Setting Calculation Options.................................................................26
The “New Chart Data Entry” Dialog Box..................................................27
Casting an Instant Chart for Here and Now ...............................................27
Entering the Chart Name............................................................................28
Entering a Date...........................................................................................28
Entering a Time..........................................................................................31
Entering Location Details...........................................................................32
Entering a Time Zone.................................................................................33
Entering Longitudes and Latitudes.............................................................35
Contents iii

Selecting an Event Type.............................................................................36
Selecting a House System ..........................................................................37
Selecting a Zodiac ......................................................................................37
Selecting a Coordinate System...................................................................37
Entering a Source Rating............................................................................38
Entering Chart Comments..........................................................................39
Calculating the New Chart .........................................................................39

Chapter 6: Using Place Databases ...............................................40
Using the Solar Fire Place Database ..........................................................40
Using Solar Fire Timezone Tables.............................................................44
Using the ACS Atlas ..................................................................................48

Chapter 7: Retrieving Charts From a File ....................................54
Selecting the Required Chart File ..............................................................55
Searching All Chart Files ...........................................................................55
Finding a Chart in the Current Chart File...................................................55
Selecting Charts Manually .........................................................................59
Opening Charts...........................................................................................60

Chapter 8: Manipulating Charts in Files.......................................61
Editing Chart Details..................................................................................61
Copying Charts ..........................................................................................62
Deleting Charts...........................................................................................62
Moving Charts............................................................................................63
Adding or Editing Chart Comments...........................................................63
Changing the Chart File Description..........................................................64
Printing a Summary of Charts in a File......................................................64
Chart File Limitations ................................................................................65

Chapter 9: Casting Subsidiary Charts..........................................66
Selecting a Base Chart ...............................................................................66
Entering Subsidiary Date, Time and Place Data ........................................67
Casting a Progressed or Directed Chart .....................................................67
Casting a Return, Ingress or Transit Chart .................................................70
Casting an Harmonic, Arc Transform or Antiscia Chart............................75
Casting a Combined Chart .........................................................................77
Casting a Prenatal Chart.............................................................................78
Casting a Rising/Setting Chart ...................................................................80
Casting a Lunar Phase Chart ......................................................................82
Casting a Locality or Relocated Chart .......................................................84

Chapter 10: Saving Charts to a File..............................................86
iv Solar Fire 5

Chapter 11: Manipulating Calculated Charts...............................88
Editing a Calculated Chart .........................................................................88
Deleting Charts from the List of Calculated Charts ...................................89
Retaining Charts.........................................................................................89

Chapter 12: Converting Chart Files..............................................90
Chart Files You Can Import From .............................................................91
Chart Files You Can Export To .................................................................92
Starting the Solar Fire Chart Conversion Utility........................................92
Converting Charts ......................................................................................95

Chapter 13: Emailing Charts .........................................................97
About MAPI...............................................................................................97
Choosing How to Send Chart Data ............................................................97
Sending Chart Files ....................................................................................98
Sending Chart Details as Text....................................................................99

Chapter 14: Exporting Data to Text Files ...................................101
Using the Export Chart Data Dialog ........................................................102
Editing ASCII Definitions........................................................................103
Specifying Record Format .......................................................................105
Specifying the Fields in a Record ............................................................105
Available Fields .......................................................................................106
Choosing the Appropriate Fields..............................................................108
Limitations ...............................................................................................110

DOING ASTROLOGY WITH SOLAR FIRE

111

Chapter 15: Viewing Charts, Grids and Pages ..........................111
Viewing a Single Chart or Grid................................................................111
Viewing MultiWheels and Synastry Grids...............................................111
Viewing Pages..........................................................................................113
Using the Page Topic Index .....................................................................114
Shortcuts for Viewing Multiple Wheels or Charts ...................................116

Chapter 16: Using the View Screen Features ............................118
Using View Screen Buttons .....................................................................119
Adjusting a Chart to a new Time or Date.................................................120
Using Dials and Pointers ..........................................................................122

Chapter 17: Copying, Publishing and Sending Graphics.........126
Chapter 18: Viewing Interpretations...........................................129
Contents v

Opening the Interpretations Window .......................................................130
Browsing the Interpretations ....................................................................132
Switching Modes......................................................................................133
Selecting Information Types ....................................................................134
Changing Rulerships ................................................................................136
Changing the Display Options .................................................................137
Sending an Interpretations Report to a Word Processor ..........................137
Exporting Text to a File ...........................................................................140
Changing the Interpretations File .............................................................141
Exiting from the Interpretations Window.................................................142

Chapter 19: Viewing Astro-Locality Maps..................................143
The Main Solar Maps Window ................................................................144
Charts .......................................................................................................145
Maps.........................................................................................................145
Lines.........................................................................................................147
Eclipses ....................................................................................................147
Display Options........................................................................................148

Chapter 20: Viewing the Planetarium.........................................150
Choosing the Coordinate System .............................................................151
Choosing the View Direction...................................................................152
Choosing the View Heading ....................................................................152
Choosing a Star ........................................................................................152
Viewing a Constellation ...........................................................................153
Viewing Information About a Star...........................................................153
Animating the Planetarium.......................................................................154
Printing the Planetarium...........................................................................154

Chapter 21: Generating Chart Reports.......................................155
Report Options .........................................................................................155
Descriptions of the Reports ......................................................................156
Reports for a Single Chart........................................................................162
Synastry Reports ......................................................................................164

Chapter 22: Using Dynamic Reports and Time Maps ...............165
Dynamic Report Options..........................................................................165
Generating a Dynamic Report..................................................................166
Viewing the Report ..................................................................................173
Time Map.................................................................................................180

Chapter 23: Using the Graphic Ephemeris ...............................184
Choosing Ephemeris Options...................................................................184
Viewing and Printing the Graphic Ephemeris..........................................188
vi Solar Fire 5

Chapter 24: Searching for Eclipses............................................190
Chapter 25: Real Time Clock and Animation.............................194
How to Set Up Animations ......................................................................195
Selecting Alternative Chart Types ...........................................................197
How to Control the Animation.................................................................199

Chapter 26: Generating an Ephemeris Listing ..........................201
Starting the Ephemeris Generator ............................................................201
Setting Ephemeris Options.......................................................................202
Viewing the Ephemeris ............................................................................203

Chapter 27: Printing from Solar Fire ..........................................205
Printing from a View screen.....................................................................205
Printing without Viewing .........................................................................205
Using the Print Dialog Box ......................................................................206
Setting Page Margins ...............................................................................207
Altering Printer Settings...........................................................................208
Using the Batch Print Queue....................................................................209

CUSTOMIZING SOLAR FIRE

211

Chapter 28: Using the File Manager ...........................................211
Selecting a File.........................................................................................213
Selecting a Directory or Folder ................................................................214
Creating a File ..........................................................................................214
Deleting a File ..........................................................................................215
Copying or Renaming a File ....................................................................215
Editing a File............................................................................................216

Chapter 29: Editing a Chart Points File......................................217
Chapter 30: Editing an Extra Dynamic Points File ....................220
Selecting Midpoints .................................................................................222
Selecting Stars, Arabic Parts, Asteroids & Extra Bodies .........................223
Selecting Fixed Positions .........................................................................224
Saving Your Selected Extra Points ..........................................................224

Chapter 31: Editing an Asteroid File ..........................................225
Using More Asteroids ..............................................................................227

Chapter 32: Editing an Extra Ring Points File ...........................230

Contents vii

Chapter 33: Editing Interpretations ............................................234
Editing Text..............................................................................................235
Changing Scoring of Balances .................................................................237
Changing Aspects Used ...........................................................................238
Viewing a Summary of Contents .............................................................241
Decompiling and Compiling ....................................................................244
Compacting the File .................................................................................245

Chapter 34: Editing an Aspect Set .............................................246
Selecting Advanced Options ....................................................................248

Chapter 35: Editing a Color File..................................................252
Chapter 36: Editing an Arabic Parts File....................................255
Chapter 37: Editing a Fixed Stars File........................................259
Creating a New File .................................................................................260
Opening an Existing File..........................................................................260
Saving a File.............................................................................................260
Merging a File ..........................................................................................260
Importing a Star File from Nova ..............................................................261
Printing.....................................................................................................261
Editing Star Information...........................................................................261
Changing the Date....................................................................................265
Sorting the File.........................................................................................265
Viewing Stars in the Planetarium.............................................................266

Chapter 38: Editing a Wheel Design File....................................267
Creating a New File .................................................................................268
Opening an Existing File..........................................................................268
Saving a File.............................................................................................268
Editing the Design Properties...................................................................269
Adding a New Circle................................................................................278
Deleting a Circle ......................................................................................278
Adding a New Chart.................................................................................278
Deleting a Chart .......................................................................................278
Editing the Wheel Description .................................................................279

Chapter 39: Editing a Dignity/Almuten File................................280
Manipulating Files ...................................................................................281
Editing a Single Definition.......................................................................282
Selecting Further Options.........................................................................289
Adding a New Definition to the List ........................................................292
Deleting a Definition................................................................................293
viii Solar Fire 5

Chapter 40: Editing a Page Design File......................................294
Opening the Editing Screen......................................................................294
Selecting Files to Edit ..............................................................................295
The Editing Process..................................................................................296
General Description of the Properties ......................................................298
General Description of The Objects.........................................................301
Selecting and Inserting Page Sizes...........................................................327
Editing the Page Description....................................................................330
Saving Files and Exiting ..........................................................................331

Chapter 41: Changing Chart Options.........................................332
Displayed Points.......................................................................................332
Current Chart’s Displayed Points.............................................................333
Extra Ring Points .....................................................................................333
Aspect Set ................................................................................................334
Aspected Points........................................................................................334
Files..........................................................................................................335
Wheel Styles and Dial Styles ...................................................................335
Proportional Houses .................................................................................336
House Expansion......................................................................................337
Aspect Lines.............................................................................................337
Aspect Glyphs ..........................................................................................338
Multiwheel Superimposition ....................................................................338
Color Schemes .........................................................................................340
Fonts.........................................................................................................345

Chapter 42: Changing Preferences ............................................348
Saving and Restoring Settings..................................................................348
Save Settings on Exit ...............................................................................349
Editing Settings ........................................................................................349
Editing the Toolbar Buttons .....................................................................371
Viewing Panels on the Main Screen.........................................................372

Chapter 43: Using the Astrologer’s Assistant...........................373
Browsing or Editing a Task List ..............................................................375
Examples of Recording Task Lists...........................................................377

Chapter 44: Backing Up Chart Files ...........................................380
Chapter 45: Using the Utilities Menu..........................................381
Editing Menu Items..................................................................................381
Deleting Menu Items................................................................................382
Reordering the Menu................................................................................383
Saving Changes to the Menu....................................................................383
Contents ix

Suggestions for the Utilities Menu...........................................................383

Chapter 46: Entering Angles.......................................................384
Chapter 47: Changing Rulerships and Weightings...................385
Rulerships.................................................................................................385
Weightings ...............................................................................................385
Starting the Rulerships & Weightings Editor...........................................386
Adding a Set of Rulerships.......................................................................387
Deleting a Set of Rulerships.....................................................................388
Editing Rulerships....................................................................................388
Editing Weightings...................................................................................388
Exiting from the Editor ............................................................................389

Chapter 48: Compiling Interpretations.......................................390
Requirements ...........................................................................................390
Procedure .................................................................................................390
Editing Interpretations Text .....................................................................391
Running the Compiler ..............................................................................392
File Locations...........................................................................................394
Input File Layout......................................................................................394

Appendix A: Symbols & Abbreviations......................................401
Appendix B: Rulerships & Associations....................................405
Appendix C: Calculation Methods..............................................406
Appendix D: Format of the Orbital Elements File......................429
Appendix E: Text and Data Supplied with Solar Fire ................432
Appendix F: Bibliography ...........................................................438
Appendix G: Changes from Version to Version of Solar Fire ..441
Appendix H: Technical Details....................................................452
Appendix I: Technical Support ...................................................455
Index .............................................................................................456

x Solar Fire 5

Getting Started

Chapter 1: Solar Fire and Its Authors
Solar Fire is a state-of-the-art astrology software package for 32 bit
Windows on a PC. Solar Fire is intuitive, easy-to-use calculation software,
designed for both novice and expert astrologers alike, and it provides easy
access to high-quality chart production using the Windows visual interface.
Solar Fire includes natal, progressed, directed, solar, lunar and any planet
or asteroid return, composite, harmonic, lunar phase, rise/set and prenatal
charts, with a flexible selection of aspect sets, chart point sets, and database
files for chart and place detail storage. It also includes flexible and
powerful dynamic transit and progression reporting over any specified time
period, plus novel options for sorting and viewing output graphically for
maximized readability.
It is possible to view interpretations of any natal chart or of any dynamic
report event interactively on the screen, by simply clicking on items in the
chart or report. Synastry interpretations are also included for any pair of
charts. Both interpretations of individual charts plus general definitions of
a large variety of astrological categories are included. It is possible to edit
or append your own text to that supplied with the program.
Chart viewing includes an aspectarian inside the chart wheel (or as a
separate tabulation, if preferred), plus dual wheels, biwheels, triwheels or
even quadriwheels for displaying combinations of two or more charts, and
synastry grids. Chart points can be viewed in color, as can the zodiac sign
glyphs.
Reports include sorted listings of standard chart analysis details, lunar
phasing, modalities and elements, plus additional listings of aspects,
rulerships and dispositorships, both traditional and esoteric, and midpoints
listings, midpoint trees and axes, fixed star and Arabic Parts positions and
aspects.
Chart points include all conventional planets, Moon's nodes (true or mean),
the TransNeptunians, TransPluto, the Black Moon Lilith (mean position),
seven asteroids, including Chiron, Vesta, Pallas, Ceres, Juno, Astraea and
Hygeia, the Ascendant, Midheaven, Vertex, Equatorial Ascendant and Part
of Fortune. The esoterically important planet Vulcan is also included.
Solar Fire has aspect sets selectable from the 1st to the 12th harmonic, with
glyphs and colors for each, plus the ability to accept user defined aspect of
any type.
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Selected Features
•

Holds up to 15 chart pages in "video memory" for instantaneous
viewing.

•

Allows on-screen viewing of a large variety of astrological definitions
and interpretations, including interpretations of each planet and
asteroid in each sign and house, plus interpretations of each planet in
aspect to every other planet (using six different aspect types). There is
also information relating to decanates and individual degrees of the
chart, amongst many other categories.

•

Displays high-clarity, high-resolution charts on the screen using the
maximum resolution of any screen device.

•

Chart point and aspect colors are user selectable.

•

Includes all commonly used chart-type calculation methods.

•

Computes composite charts for a pair of individuals or for an entire
family or group of up to 15 individuals.

•

Includes 30 different house systems.

•

Creates any number of named aspect sets with user-definable orbs.
Any one of these can be selected to be used in computing charts by
simple mouse operation.

•

Prints charts to the maximum resolution of any printer, including
high-resolution laser printers and inkjet printers.

•

Contains a user-updateable place database with more than 30,000
location names, positions and time zones accessible by simple mouse
operation, plus time zone change tables for many countries.

•

Allows creation of any number of chart database files from which
records can be retrieved, copied or deleted.

•

Supports color printers. Aspect lines, planets and signs can be printed
in color.

•

Copies charts to the Windows clipboard for use in word-processing or
drawing programs.

•

Charts, chart data and page displays and may be emailed in one step,
when used with a MAPI compliant email program.
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Esoteric Technologies Pty Ltd
Esoteric Technologies is an Australian company specializing in technology
for the harnessing and beneficial use of esoteric knowledge. In addition to
the development of astrological software, it offers various astrological
services, including chart printing and consultations.
Esoteric Technologies’ directors are Graham Dawson and Stephanie
Johnson.
Graham holds a B.Sc. in Physics and Meteorology and a Ph.D. in Coastal
Oceanography. He has been employed as a technical software consultant to
a variety of large companies in the UK and Australia. He has a strong
interest in Ageless Wisdom teachings, including esoteric psychology and
astrology. Graham is the Technical Manager of Esoteric Technologies.
Stephanie holds a B.A. in journalism and has been a freelance journalist
reporting on current affairs, women's issues, the environment, politics and
the arts. She is also a consulting astrologer. Stephanie is the Marketing
Manager of Esoteric Technologies.
Graham and Stephanie both hold Practitioner Certificates from the
Federation of Australian Astrologers and MSE degrees in Esoteric
Psychology from the University of the Seven Rays in New Jersey, USA.

Finding the Information You Need
If you are new to the Solar Fire program, then you should first read the
chapters in the "Getting Started" section of this manual. These chapters
present some basic information about the manner in which the program
operates.
If you are familiar with the basic concepts and method of operation, but
you wish to find out how to achieve a specific task, then you may like to
refer to relevant chapters in the body of the manual as the need arises.
If you are upgrading your version of Solar Fire from earlier versions, then
you may wish to refer to the section that contains a summary of differences
between this version and older versions.
If you wish to find out by which methods charts have been calculated, or
how certain information in a report has been produced, then you may refer
to information in the later chapters. These also contain information to help
you interpret any symbols or abbreviations used in the program's output.
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Chapter 2: Installation
Computer System Requirements
Before opening and installing the program, be sure that you have all the
hardware and software you need to run Solar Fire:
•

An IBM-compatible PC with a Pentium or higher processor

•

A minimum of 16Mbytes of RAM (32Mbtyes or more is
recommended)

•

A VGA (640x480) monitor and adapter with 16 colors or gray scales
(SVGA 800x600 or higher resolution modes with High Color is
recommended)

•

A hard disk drive with at least 65Mb of free disk space (or about
40Mb for a compact installation).

•

Windows 95, 98, NT4, 2000 or later.

Installation
W

To Install Solar Fire

1.

Insert the Solar Fire installation CD into your CD ROM drive

2.

After a short delay, the installation will start. (If it does not start
automatically then use Start/Run/Browse to find SETUP.EXE on the
CD, and then click on the OK button to run it.)

3.

The installation program will guide you through the subsequent steps.
You will be shown licensing information and any other important last
minute information before the installation goes ahead.

4.

You will then be prompted to enter your name, serial number and
password as supplied to you by your vendor. Note that you must enter
these three items exactly as they as given to you, including the same
spelling, capitalization and spacing.

5.

You must then choose the location for your installation. Unless you
are familiar with folders and directories, and have a reason for altering
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the suggested location, then it is recommended that you proceed
without altering the suggested location.
6.

You can then choose one of the following setup types
•

Typical – This installs the entire program with all options
included. This is the recommended option for most users.

•

Compact – This installs the program with a reduced ephemeris
range and no additional asteroid ephemerides. This option is
recommended for those users who wish to conserve space on their
computers, and have no interest in charts prior to 1200BC or after
3000AD, or in the additional asteroids.

•

Custom – This allows you to choose exactly which items to
install. This option is only recommended for expert users who are
re-installing parts of the program.

If You are Re-installing Solar Fire v5
The installation program will find your existing installation location and
suggest that you re-install it there.

If You are Upgrading from an Earlier Version
The installation program will find your earlier installation location and
suggest that you install v5 to the same location, thus ensuring that you
retain any customised files that you may have created in earlier versions,
and facilitating access to any old chart files you may have.

If You Own Solar Maps v1
This version of Solar Fire includes an update to Solar Maps v2.
If your current Solar Maps v1 is already installed into your current Solar
Fire’s directory, then you will get the benefit of a full update to Solar Maps
v2.
However, if you install Solar Fire v5 to a different location from your
existing Solar Maps v1, then you will only be able to use limited features
of Solar Maps Lite from within Solar Fire v5. In this case it is
recommended that you re-install Solar Maps into Solar Fire’s current
location before installing Solar Fire v5.
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Troubleshooting the Installation
Insufficient Disk Space
If the free disk space on your hard disk is insufficient, then the installation
will notify you. Your options are to free up extra disk space, or to choose a
compact installation requiring less disk space. If you are re-installing, then
performing an uninstall of Solar Fire v5 first will free up some space (but
note that you may lose any custom chart files if you do this).

Connecting to the ACS Atlas
Besides having its own place database, Solar Fire interfaces seamlessly
with the ACS atlases if you have one of them installed on your computer.
Solar Fire works with the
•

ACS PC Atlas, version 2.x

•

ACS PC Atlas for Windows

•

ACS PC Mini Atlas

Solar Fire does not work with the ACS PC Atlas version 1.x for DOS. If
you try to use an ACS Atlas while running Solar Fire and get the error
message “Invalid TIMZON.BIN file”, it means that you have the ACS PC
Atlas version 1. In this case, contact your dealer to have it upgraded to one
of the versions listed above.
W

To connect to an ACS Atlas

If you have an ACS Atlas already on your hard disk, then Solar Fire will
connect with it automatically when it is installed. Alternatively, you can
select it manually in Solar Fire by clicking on the Places tab of the
Preferences dialog. See page 366 for more details.

Setting Your Computer’s Internal Clock
On its Main Screen, Solar Fire has a constantly updated display of current
planetary positions. In several of its data-input screens it has a “Now”
button that automatically inserts the current date and time. For these
features to work correctly, you should ensure that your computer’s internal
clock is correctly set. Some computers do not keep accurate time, or you
may want to change from Standard to Daylight or Summer time or viceversa, if Windows has not done this for you automatically.
W

To set the computer’s internal clock
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Click on the current date or time panel of the status bar across the top of
the main screen of Solar Fire. This will open up the Control Panel dialog
that allows you to reset the date and time as required.

Selecting a Time Format
To choose between AM/PM and 24-hour time format, you also need to use
the control panel. Solar Fire lets you enter time in virtually any format - the
time format you select here determines how times are written in Solar Fire
displays and printouts. Your computer will probably already be preset to
whatever time format is usually used in your country.
W

To reset the time format

From the Windows Control Panel, select the “Regional Settings” icon. In
the “Time” tab or area of the screen, you can select various time format
options, including whether a 12hr or 24hr clock is used, and how AM/PM
is displayed.

Selecting a Date Format
In most cases the computer will already be preset to show dates using the
normal convention for your country. Solar Fire displays dates in its own
format, but decides on whether to show the International order (Day,
Month, Year) or the American order (Month, Day, Year) according to the
format that you select with in the Control Panel.
W

To reset the date format

From the Windows Control Panel, select the “Regional Settings” icon. In
the “Date” tab or area of the screen, you can select various date format
options, including the order in which the day and month appear.

Setting the Default Place
On its Main Screen, Solar Fire has a constantly updated display of the
current Ascendant and Midheaven for whatever location is currently
selected as the default place. When you first install Solar Fire, this default
place will probably not be set to the place where you currently live. It is
recommended that you set the default place to the location where you are
currently living, so that the displayed Ascendant and Midheaven will be
correct for you own location. Solar Fire also uses the default place that you
set as a “first guess” whenever you choose to relocate a chart to a new
location. If this is set to your current location, then this guess will probably
often be correct, and this will save you from having to enter new location
Chapter 2: Installation 7

details needlessly.
W

To set the default place

1.

Click on the Place panel of the Date and Place status bar.

2.

If your current location is one that is already listed in the list of
Favorite Places, then select it with the mouse.

3.

Otherwise click on the Add… button to open the Atlas and either find
your location or enter it a new location. See page 40 for full
instructions on choosing a place from the Atlas.

4.

Once your location appears on the list of favorite places, then select it
with the mouse and select the Set as Default button.

5.

You can then click on the Save button to return to the Main Screen.

The location shown in the status bar at the top of the Main Screen will now
show the newly saved location, and the Ascendant and Midheaven will be
correct for this location.
You will need to update the default place details in the same way whenever
you move with your computer to a new place.

Pre-Setting Calculation Options
Solar Fire is shipped to you with the most commonly used chart options
already selected for you. Choices like house system, coordinate system and
zodiac are easy to find, as they appear on the “New Chart Data Entry”
screen itself. However, there are some less frequently used options that can
be set in the “Preferences” dialog of Solar Fire, and you may like to set
them before you start calculating charts.
•

Geocentric Latitude Correction

•

Lunar Parallax Correction

•

Lunar Node Type

•

Zodiac

•

Angle Progressions

•

Progression Day Type

•

User Progression Rate

•

Primary Direction Rate

•

Vulcan Calculation
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•

Part of Fortune

These options are described in detail on page 348.

Customizing the Compliments Text
Most chart and grid pages printed from Solar Fire contain some text placed
on a corner of the page that gives the name and address of your software
supplier. You can alter this text to display your own name and address (or
any customized message) if you wish.
W

To change the compliments text

1.

Select the Edit Settings… item from the Preferences menu on the
Main Screen.

2.

Select the Compliments tab.

3.

This will display six lines of text which you can freely edit.

4.

When you click on the Save button, any charts subsequently printed
will display the newly edited compliments text, and this text will also
be permanently retained by Solar Fire for future sessions.
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Chapter 3: Finding Your Way Around
Solar Fire
We have designed the Solar Fire program to be flexible and easy to use.
There are often several different ways of achieving the same objective, and
it is up to each individual user to find the manner in which they prefer to
proceed.
Most operations, such as casting a new chart, will be very easy to learn for
those who are experienced astrologers, and the intuitive manner of
operation of the program should enable inexperienced astrologers to
proceed almost as quickly.
To facilitate data entry and selection, most dialog boxes have default
values, so that it is not necessary to enter new data every time the screen is
used. Generally, whenever a dialog box is called up, it will initially contain
all the values that were entered into that box the last time it was used. For
example, when a new chart is cast, the chart's name, date, time, location,
house type etc. are all retained. The next time that a new chart is cast, it
will only be necessary to update the items that need to be changed. This
makes it very quick and easy to generate the same chart with a different
house system, or with a slightly different birth time, for example.

Starting Solar Fire
W

To start Solar Fire

Activate the Solar Fire icon on your desktop, or
From the Start button menu select Programs / Solar Fire v5 / Solar Fire, or
Find and open the Solar Fire v5 folder, and then double-click the Solar Fire
program icon.
When the program loads, an initial screen will be displayed showing the
program name, version number, and end-user license message. The first
time the program is run after installation, you must click on the OK button
to acknowledge the license agreement. On subsequent occasions, this
screen will disappear automatically after a few seconds.

10 Solar Fire 5: Getting Started

Using Solar Fire
When you start Solar Fire, the main screen appears, ready for you to create
charts. To use the program, you will need to be able to select menu items
and command buttons, enter information into dialog boxes, and use scroll
bars and list boxes. If you are unfamiliar with using menus, dialog boxes,
list boxes and scroll bars, then it is desirable that you read your Windows
documentation to familiarize yourself with these concepts.

Solar Fire’s Main Screen

Solar Fire’s main screen consists of the following components.
•

Menu

•

Toolbar

•

Date and Place

•

Current Settings

•

Current Chart

•

Calculated Charts

•

Planet Bar

•

Background
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Each of these is described in more detail in the following sections. Note
that you can switch off some of these components by using options under
the Preferences menu.

Menu
The menu provides access to all the available functions and actions that
Solar Fire can perform. Some menu items can be activated by shortcuts –
either particular key combinations, or via toolbar buttons or the current
settings panel, for example.

Toolbar
The toolbar contains a range of graphical buttons that provide shortcuts to
various items within Solar Fire. It may be customized by changing the
selection or ordering of the buttons it contains, and can also be switched
off altogether if you prefer. See page 371 for instructions on customizing
the toolbar.

Date and Place
The Date and Place bar contains the current system date and time, the
current Ascendant and Midheaven positions, and the current place name
and timezone details. If the details shown are incorrect then you can
change them as follows.
W

To change the date

Click on the date box in this panel. This will display the control panel
utility that allows you to adjust the date on your computer system.
W

To change the time

Click on the time box in this panel. This will display the control panel
utility that allows you to adjust the date on your computer system.
W

To change the place

Click on the place box in this panel. This will display the Preferences
dialog for editing and selecting your current location from an atlas. See
page 367 for more details. Changing the place will usually result in the
correct timezone being displayed as well.
W

To change the timezone

Click on the timezone box in this panel. This will display a timezone
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selection panel from which you can select the correct timezone.
Note: The Ascendant and Midheaven positions are calculated according to
the date, time and place details as displayed in the other boxes on this
panel. However, other options which affect these positions are
•

The Geocentric Latitude Correction – See page 350 for further
information.

•

The Default Zodiac type – See page 358 for further information.

Current Settings
The current setting panel displays a range of items that reflect how various
options have been set. For example, the name of the currently selected
displayed points file, aspect set, default zodiac and screen colors are all
shown here.
As well as allowing you to see what options are in effect, this panel
provides a shortcut to altering these options, simply by clicking on the
option you wish to change. For example, clicking on the Displayed Points
area will cause the File Manager to appear with a list of displayed point
selections, allowing you to select an alternative file or perform various
other functions.

Current Chart
The current chart panel displays the chart details of whichever calculated
chart is currently selected. As well as the full chart details (such as name,
date and place), it also displays the following information.
•

Image Status – This is an icon and text that indicates whether an image
(i.e. displayed wheel or page) for this chart has already been created.
The text can be either “No Image” or “Image Exists”.

•

Save Status – This is an icon and text that indicates whether or not this
chart is already saved in a chart file. The text can be “Not Saved”,
“Saved” or “Retained”.

•

Comments – This is text that indicates whether or not any comments
have been added to this chart, and if so how many characters of text.
Clicking on this item will open up the comments editing dialog in
which you can see the comments and edit them if you wish.

Calculated Charts
The calculated charts panel contains a list of all the charts that are currently
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available in Solar Fire.
You can add to this list by casting new charts, opening saved charts, or
generating subsidiary charts using various options in the Chart menu.
You can select any number of charts in this list by using the mouse and
Ctrl or Shift keys. (The Current Chart panel will always display the details
of the most recently selected chart.) Some function in Solar Fire will allow
all your selected charts to be processed, whilst others can work only with
the single current chart. For example, when you choose View / Current
Chart or Chart / Save to File, all the selected charts will be processed.
However, when you choose Interps / View, only the current chart is used.
You can also delete charts from this list if you wish.

Planet Bar
The planet bar panel contains the current positions of the ten main chart
bodies. Planets that are currently in retrograde motion are shown in red,
and those that are direct are shown in black. These positions are
automatically updated on a regular basis.
You can get further information about each planet by moving the mouse
over its box. This will cause a “hint” type message to appear, giving the
following information.
•

The Moon and the Sun – Sign, date and time of last sign ingress, and
of next sign ingress, plus the timezone for which these times are valid.

•

Other Planets – Date and time of last and next planetary station, plus
the timezone for which these times are valid.

Background
The background of the main screen may be customized to show either a
uniform color or a user-selected graphic.
W

To set the main screen background options

Click the right-hand mouse button anywhere over the background area of
the main screen.
This will bring up a pop-up menu with the following options.
•

Background Graphic… - This will display a file selection dialog
allowing you to browse for a graphic file that you wish to display. This
must be a file of type *.bmp, *.rle, *.gif, *.jpg, *.jpeg, *.wmf, *.emf,
*.ico. Once selected the graphic will be either tiled or stretched
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according to the option selected below.
•

Background Color… - This will display a color selection dialog
allowing you to select any desired color. Note that you must clear any
existing graphic file before this change will take effect.

•

Clear Graphic – This will clear any graphic file that has been
previously selected, in which case the current background color will
be applied.

•

Tile – If a graphic file is being displayed, this will tile the graphic to
fill the entire background area.

•

Stretch - If a graphic file is being displayed, this will stretch the
graphic to fill the entire background area.

Exiting from Solar Fire
W

To exit from the program

Select the Exit option from the Chart menu. If you have cast any new
charts during your session that have not been saved, then the program will
prompt you to save them as part of the exit procedure.

Using On-line Help
Solar Fire has comprehensive on-line help, which can be invoked from
anywhere within the program.
W

To invoke help from any screen

Press the F1 key. This will call up a Windows help screen containing
information about whichever screen or control currently has the focus. This
is known as context sensitive help.
W

To invoke help from the menu

Select the Contents option from the Help Menu -This will display the
contents page of the on-line help file.
Select the Search for Help on... option from the Help Menu - This will
display the keyword search screen from which it is possible to locate
topics based on keywords that they contain (much like an index of a
manual).
Select the How to Use Help... option from the Help Menu - This will
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display help information on how to use Windows help files.
Once the help screen is displayed, it is possible to navigate through the text
and topics as desired, and to select any of the options that are available in
Windows help files. Some of these options are:
•

Contents Button - Takes you to the contents page

•

Search Button - Displays the keyword search screen

•

Back Button - Goes back to the last topic you looked at

•

History Button - Displays a list of all the topics you have previously
looked at

•

<< and >> Buttons - Goes to the previous or next topic

•

Group Button - Goes to the start of the current group of topics

For more information on these, and other standard features in Windows
help files, see the How to Use Help option of the Help menu.

Using the Keyboard
Although Windows is most easily used with a mouse, use of the keyboard
is compulsory for certain data entry items, and it is possible to perform
almost all operations from the keyboard instead of the mouse if this is
desired.
Additionally, there are various "short-cut" keys that enable some tasks to
be invoked more quickly from the keyboard then by using a mouse.

Dialog Boxes
Movement and editing within a dialog box may be carried out according to
the key definitions as described in your Windows manual. A brief reminder
of some of these keys follows.
TAB

Move from option to option

SHIFT+TAB

Move from option to option in reverse order

ALT+character

Move to option whose letter matches character

Arrow key

Move cursor within a data box

HOME

Move cursor to start of data within a data box
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END

Move cursor to end of data within a data box

INSERT

Toggle between typeover and insert modes

DELETE

Delete the next character or the selected text

BACKSPACE

Delete the previous character

ENTER

Activate the dialog box's default command button

SHIFT+cursor

Select text across which cursor moves

When the text in a dialog box is selected (highlighted), then typing any text
will cause the existing text to be deleted. To avoid this, use the END or
cursor keys to switch off the selection of text before typing any characters.

Short-Cut Keys
A variety of short-cut keys have been defined within Solar Fire to facilitate
the activation of certain frequently used menu options without having to
use the mouse. Each short-cut key combination activates an item from the
menu. A list of these keys follows.
F1

Context sensitive help

F2

New chart

F3

Open chart

F4

Progressed chart

F5

Return chart

F6

Harmonic chart

F7

Combined chart

F8

Prenatal chart

F9

Rising/Setting chart

F11

Lunar Phase chart

F12

Save chart to file

CTRL+F1

Dual Wheels

CTRL+F2

BiWheel
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CTRL+F3

TriWheel

CTRL+F4

QuadriWheel

CTRL+F5

Synastry grid

CTRL+F6

User defined page

CTRL+F7

Planetarium

CTRL+F8

Solar Maps

CTRL+A

Aspect set

CTRL+C

View current chart

CTRL+D

Displayed points

CTRL+E

Edit current chart

CTRL+G

View current chart+grid

CTRL+H

View current grid

CTRL+I

View Interpretations

CTRL+P

Print chart/s

CTRL+R

Restore settings

CTRL+S

Save settings

CTRL+T

Aspected Points

CTRL+V

View last image

SHIFT+F1

Reports for current chart

SHIFT+F2

Synastry reports

SHIFT+F3

Dynamic report

SHIFT+F4

Graphic Ephemeris

SHIFT+F12

Locality chart

SHIFT+INS

Edit chart comments

DEL

Delete current chart

CTRL+INS

Copy & edit current chart

When you are viewing interpretations in the interpretations window, the
following short-cut keys apply
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F2

Previous information type

F3

Next information type

CTRL+C

Current Chart Mode

CTRL+G

General Mode

Chart Calculation and Storage
When the Solar Fire program saves and reads charts to and from chart
databases, only the chart details are stored eg. name, date, time, location,
etc.. Planetary positions and house cusp positions are not stored in a chart
database file.
However, once a new chart is cast in the program or opened from a chart
database, all planetary positions and house cusps are calculated and stored
until the user exits from the program. These are known as "Calculated
Charts", and the main screen displays a list of all such charts in a list box.
It is only possible to display a chart, aspect grid, report, or to generate any
subsidiary charts, after that chart has been calculated and is listed in the
"Calculated Charts" list box on the main screen.
Calculated charts can be of any type - natal, progressed, return, composite,
harmonic, etc.
The following table summarizes which chart types may be used in each
type of operation. The 5 symbol denotes that it is possible to perform the
operation in the left hand column on the chart type at the top of that
column.
The chart operations are as follows.
Open

To retrieve chart details from a chart file and calculate
the chart

Save

To store the details of a chart to a chart database file

Edit

To copy and edit an existing calculated chart

Delete

To delete a chart from the list of calculated charts
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Retain

To retain calculated charts for use in future sessions

Progress

To calculate a progressed or directed chart from a
base chart

Return

To calculate a planet or asteroid return chart from a
base chart

Combine

To calculate a combined chart from two or more base
charts

Harmonic

To calculate an harmonic or arc transform chart from
a base chart

Antiscia

To calculate an antiscia or contra-antiscia chart from a
base chart

Locality

To calculate a relocated or locality chart from a base
chart

View

To view a calculated chart or aspect grid on the screen
or to print it

Report

To generate a report from a base chart

Dynamic

To generate a transits/progressions report or graphic
ephemeris from a base chart

Charts which are equivalent to Natal are - Return, Ingress, Transit,
Davison, Lunar Phase, Lunar Phase Return, Rise/Set, Prenatal, Relocated.
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Calculated

Chart

Natal or

Progressed

Composite

Equivalent

Directed

Coalescent

Harmonic

Contraantiscia

Open

5

5

5

5

5

Save

5

5

5

5

5

Edit

5

-

-

-

-

Delete

5

5

5

5

5

Retain

5

5

5

5

5

Progress

5

-

-

-

-

Return

5

-

-

-

-

Combine

5

5

-

5

5

Harmonic

5

5

5

-

5

Antiscia

5

5

5

5

-

Locality

5

5

5

5

5

View

5

5

5

5

5

Report

5

5

5

5

5

Dynamic

5

5

5

5

5

Operation

Type
Antiscia

Chapter 3: Finding Your Way Around Solar Fire 21

Getting Started

Chapter 4: A Guided Tour of Solar Fire
Once you’ve carried out a few simple tasks in Solar Fire, you’ll probably
be able to run most of the program without reference to the manual. This
section takes you through the basic tasks and gives you an idea of the many
things that Solar Fire can do.
If you have never used any version of Solar Fire before, then the easiest
way to learn the program is to go through this chapter and try out each
operation that is described. If you are eager to plunge in on your own, we
recommend that you start with the tasks labeled with an asterisk (*), below.
If you have already used earlier versions of Solar Fire, then you can skip
most of this section, simply noting the parts that are new.
Starting Solar Fire (*)
Casting a natal chart (*)
Casting a solar return chart (*)
Viewing and printing a biwheel
Viewing and printing a synastry grid
Changing the aspect set and redrawing a chart

Casting a Natal Chart
The steps involved in calculating and displaying or printing a new natal
chart are as follows.
1.

Select the New... option from the Chart menu on the main screen.

2.

Enter all the natal details, including name, date, time, place and
timezone. (It is possible to use the Place... or Zone... buttons to choose
an existing location or timezone.)

3.

Select a house system, coordinate system and zodiac type from the
available choices on the screen. (Normally, western astrologers use
Placidus or Koch houses, geocentric coordinates and the tropical
zodiac.)

4.

Optionally select a chart type, chart ratings and source comment.

5.

Click on the OK button. The program will then calculate all the
planetary positions and house cusps, and add the chart to the list of

22 Solar Fire 5: Getting Started

Calculated Charts on the main screen.
6.

Select the Current Chart option from the View menu on the main
screen.

7.

To print the chart on your printer, select the Print... button from the
"View Chart" screen, or select the Print Chart... option from the
View menu on the main screen.

Casting a Solar Return Chart
The steps involved in calculating and displaying or printing a solar return
chart are as follows.
1.

Either cast a new chart or open the existing chart for which you wish
to generate a solar return chart.

2.

Select the Return & Ingress... option from the Chart menu on the
main screen.

3.

Select the chart which you wish to use by clicking on the charts list,
and ensure that the selected calculation method is "Solar Return".

4.

Optionally enter a date and select which solar return you require, and
the details of the place for which you wish the solar return to be
calculated. (It is possible to use the "Location" option buttons or the
Place... or Zone... buttons to choose an existing location or timezone.)

5.

Click on the OK button - The program will then calculate all the
planetary positions and house cusps, and add the chart to the list of
Calculated Charts on the main screen.

6.

Select the Current Chart option from the View menu on the main
screen.

7.

To print the chart on your printer, select the Print... button from the
"View Chart" screen, or select the Print Chart... option from the
View menu on the main screen.

Displaying or Printing a BiWheel
The steps involved in displaying or printing a biwheel chart are as follows.
1.

Either cast new charts or open the existing charts that you wish to use
in the biwheel.

2.

Select the BiWheel... option from the View menu on the main screen.
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3.

Select the charts that you wish to place on the inner and outer wheels
by clicking on the charts list and the positions list.

4.

Click on the View button - The biwheel will then be drawn on the
"View Chart" screen.

5.

To print the biwheel on your printer, select the Print... button from the
"View Chart" screen, or repeat the first 3 steps above and then select
Print... button from the "BiWheel Selection" dialog box.

Displaying or Printing a Synastry Grid
The steps involved in displaying or printing a synastry grid are as follows.
1.

Either cast new charts or open the existing charts that you wish to use
in the grid.

2.

Select the Synastry Grid... option from the View menu on the main
screen.

3.

Select the charts that you wish to place across and down the grid by
clicking on the charts list and the positions list.

4.

Click on the View button - The grid will then be drawn on the "View
Chart" screen.

5.

To print the grid on your printer, select the Print... button from the
"View Chart" screen, or repeat the first 3 steps above and then select
Print... button from the "Synastry Grid Selection" dialog box.

Changing Aspects
The usual steps involved in changing the aspect set and viewing a chart
with the new aspect set are as follows.
1.

Select the Aspect Set... option from the Chart Options menu on the
main screen.

2.

Select the name of an alternative aspect set from the list, and click on
the Select button. (It is possible to first create or edit the contents of an
existing aspect set by clicking on the Create... or Edit... buttons.)

3.

Select the Last Image option from the View menu on the main screen
- The last image that you created will then appear on the "View
Chart" screen.
In order to redraw any of the existing chart
images with new aspect set:

4.

Click on the required entry in the list of images.
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5.

Select the ReDraw button from the "View Chart" screen.
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Working With Chart Data

Chapter 5: Casting a New Chart
This chapter describes how to enter data to cast a new natal or event chart.
The same conventions apply to entering data for subsidiary charts,
dynamic report and all other places where you would enter dates, times or
places.

Pre-Setting Calculation Options
There are several options in Solar Fire that affect the calculation of the
chart. If you wish to alter them, then you must do so before the chart is
cast, as you cannot set them on the “New Chart Data Entry” screen. These
options are
•

Geocentric Latitudes - Whether or not the entered latitude is
converted to a geocentric latitude. Most astrologers do not use
geocentric latitude.

•

Lunar Parallax - Whether or not a correction is made to the moon’s
position due to location. Most astrologers do not correct the moon for
parallax.

•

Lunar Node Type - Whether the true node or mean node is
calculated. Astrologers today are fairly evenly divided on this issue.

•

Vulcan Calculation - Which method of calculating Vulcan’s position
is used. This option is only relevant if you intend to display Vulcan in
your chart. Most astrologers do not display Vulcan.

•

Part of Fortune - Which formula is used to calculate the position of
the Part of Fortune in the chart, i.e. whether to use Asc+Moon-Sun for
both day and night births, or to change it to Asc+Sun-Moon for night
births.

•

MC in Polar Regions – Which formula is used to calculate the
position of the MC for charts cast in locations when the Sun does not
rise across the horizon during the day.

W

To alter any of the above options
1.

Select the Edit Settings… item from the Preferences menu on
the Main Screen.

2.

Select the Calculations tab.

3.

Alter any settings as required
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See page 348 for more information on these options.

The “New Chart Data Entry” Dialog Box
W

To begin casting a new chart

Choose New... from the Charts menu. This will display the "New Chart
Data Entry" dialog box into which natal details and chart options may be
entered.
New Chart Data Entry Dialog Box

When this dialog box is displayed it will already contain data. If you have
not yet cast or opened a chart since the program was started, then the data
displayed is whatever has last been saved as default values. (See page 348
for details of how to alter default values.) Otherwise it will contain the data
from the last chart that was cast or opened.

Casting an Instant Chart for Here and Now
To cast a quick chart for the current time and place, you can use the default
time and place values that you have already set. This is handy for casting a
quick horary or event chart.
W

To calculate a chart for the current moment

Select the Now button. The Chart Name box will appear as “Transits of
[date]”, and the Date and Time fields will be updated to correspond to the
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computer’s internal clock.
W

To calculate a chart for the default place

Select the Restore button. The boxes Place through to Longitude will fill
with whatever values were selected for the default place. (You will
probably have set the default place to be your current location.)

Entering the Chart Name
Up to 30 characters of text may be entered to describe the chart. Typically
this will be the name of the person for whom a birth chart is being cast (eg.
"John Smith", but could also be a description of an event eg. "President's
Inauguration"). It should be noted that, for chart storage indexing and when
combined charts are being produced, the last item on the line is assumed to
be a "last name". Therefore we recommend that names always be entered
with the first name first, and the last name last. You must enter at least 1
character in the Chart Name box.

Entering a Date
You can enter the date in almost any format you like, and when you leave
the date box, the date will be converted into Solar Fire’s standard format. If
you enter an impossible date such as February 30 or a month number
greater than 12, or use a format that the program does not understand, then
you will get an error message and be given a chance to try again.
Following are some examples of valid dates, and the manner in which they
are displayed by the program.

User Entered Date

Int'l. Display Format

US Display Format

1 Dec 1992

1 Dec 1992

Dec 1 1992

1 Dec 92

1 Dec 1992

Dec 1 1992

1 Dec 02

1 Dec 2002

Dec 1 2002

Dec 1 1992

1 Dec 1992

Dec 1 1992

1 December 1992

1 Dec 1992

Dec 1 1992

1st December 1992

1 Dec 1992

Dec 1 1992

1 Dec 1992 AD

1 Dec 1992

Dec 1 1992
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1 Dec 1992 BC

1 Dec 1992 BC

Dec 1 1992 BC

1 Dec 0092

1 Dec 0092

Dec 1 0092

1/12/92

1 Dec 1992

Jan 12 1992

12.1.92

12 Jan 1992

Dec 1 1992

The display format that Solar Fire uses is based on the date order settings
within Windows, which may be set by using the Regional Settings icon on
the Windows Control Panel.
Description of Format
You must enter a day, month and year, separated by any of the following
characters: blank( ); slash(/); period(.); colon(:); semi-colon(;) or comma(,).
If you use a month name or abbreviation instead of a month number, then
you do not need to use any separators.
A day number (eg. 1, 2, 3, ..., 31). You may also use any of the following
suffixes: "st", "nd", "rd" or "th".
A month name, abbreviation or number (eg. Jan, Feb, Mar, ..., Dec, or 1, 2,
3, ..., 12). These must be English month names, but may be in upper,
lower or mixed case. Abbreviations must contain at least the first three
letters of the month name. If you use a month name or abbreviation,
then it does not matter whether you put the day or the month first.
However, if you use a month number, then you must ensure that you
enter the date in whatever order has been set in Windows. See page 7
for instructions on settings the Windows date order.
A year number (eg. 57, 1957, 2005, -6). You may also use any of the
following epoch indicators: “AD”, “A.D.”, “BC”, “B.C.”, “CE”,
“C.E.”, “BCE”, “B.C.E”. If you only enter two digits, then the year is
assumed to be within the time window specified in the Preference
settings. To enter dates in the 1st century, you must use a 00 prefix (eg.
0059 for year 59).
Optionally there may also be any of the following items:
A calendar style indicator (i.e. OS, O.S., NS, N.S.)
The epoch is assumed to be AD unless BC or BCE has been entered, or if
the year is negative. If the year is negative, then Solar Fire will
automatically convert the year into a BC year, and remove the minus sign.
(Note that there is a difference of 1 year between BC years and negative
(astronomical) years eg. the year -6 is converted into 7 BC. This is due to
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the absence of a year 0 in the BC format.)
Modern and Old Calendars
Unless you specify otherwise (by entering an OS or NS suffix), Solar Fire
assumes that the dates that you enter
on or before 14th October 1582 are in the old style (Julian) calendar.
on or after 15th October 1582 are in the new style (Gregorian) calendar.
The Gregorian calendar was not adopted everywhere at the same time.
Sometimes dates after 15th October 1582 are given in terms of the old
style calendar (often followed by the initials O.S.). Also, some sources
convert pre 1582 dates to new style dates (often followed by the initials
N.S.).
If you wish to enter a date on or after the 15th October 1582 which is
expressed as an old style date, then add the suffix “OS” or “O.S.” to the
entered date (eg. 17 Dec 1723 OS).
If you wish to enter a date before the 15th October 1582 which is
expressed as a new style date, then add the suffix “NS” or “N.S.” to the
entered date (eg. 7 Jan 1503 NS).
The way in which these dates are displayed in Solar Fire depends on usermodifiable preferences. You can determine whether or not Solar Fire will
automatically convert any entered dates into the default calendar for that
date, or alternatively whether any dates that you enter with an OS or NS
suffix will always be displayed exactly as they were entered. Additionally,
you can specify a range of years between which the OS or NS indicator is
displayed with all dates. See page 348 for more details.
The following table shows the adjustment that Solar Fire makes in order to
convert from old style to new style dates:
15 Oct 1582 to 28 Feb 1700

Add 10 days

29 Feb 1700 to 28 Feb 1800

Add 11 days

29 Feb 1800 to 28 Feb 1900

Add 12 days

29 Feb 1900 to 28 Feb 2100

Add 13 days
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Entering a Time
The time that you enter should be ordinary clock time of the locality, or
“Universal Time”. If you enter a Universal Time or Greenwich Mean
Time, be sure to change the initials in the Zone... box to “UT” or “GMT”.
If necessary you can also enter a Local Mean Time or a Local Apparent
Time which were the prevalent time standards prior to the late 19th
century. If you enter time as Local Mean Time or Local Apparent Time
then you should enter “LMT” or “LAT” in the Zone... box.
There is no need to convert a time to Ephemeris Time (ET), as Solar Fire
does this internally whenever it is necessary.
You may enter a time in any of the most commonly used formats. Any
characters within the time may be in upper, lower or mixed case. Entered
times are always immediately transformed into a standard display format if
they are recognised. If they are not recognised as valid times then an error
dialog box appears, after which a further attempt may be made.
The display format that Solar Fire uses is based on the time format settings
within Windows, which may be set by using the Regional Settings icon on
the Windows Control Panel. See page 7 for further details.
Following are some examples of valid times, and the manner in which they
are displayed by the program:

User Entry

AM/PM Format

24Hr Format

Noon

12:00 PM

12:00

12

12:00 PM

12:00

12 PM

12:00 PM

12:00

12 AM

0:00 AM

0:00

12:00

12:00 PM

12:00

12:00:00

12:00 PM

12:00

6

6:00 AM

6:00

13:00

1:00 PM

13:00

13:25

1:25 PM

13:25

13:25:49

1:25:49 PM

13:25:49
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1:25:49 AM

1:25:49 AM

1:25:49

1:25:49 PM

1:25:49 PM

13:25:49

Description of Format
You must enter at least an hour; minutes and seconds are optional. You can
separate hours, minutes and seconds with a blank( ), slash(/), period(.),
colon(:),semi-colon(;) or comma(,).
You can enter time in the 24 hour format (with an hour from 0 to 23), or
you can use an AM/PM format by typing either AM or PM after the time.
If the hour number is less than 12, then there is no need to type AM.
You can also enter any of the following words: "Noon", "Midday" or
"Midnight".

Entering Location Details
The location details are: the place name, the country or state, the timezone,
the latitude and the longitude. It is possible to enter each of these items
manually onto the “New Chart Data Entry” screen, but there are also
shortcuts to finding and entering the location details that you need.
W

To restore the default location details

You would normally already have set the default location to be where you
live. To retrieve all the details and insert them automatically into the
required text boxes, simply select the Restore button.
W

To recall a place that you have used recently, or is on your list of
favourite places

Click on the down arrow on the Place… drop-down box and select the
required place from the list
W

To perform an automatic atlas lookup

1. Ensure that the Auto Lookup check box is checked
2. Enter the name of the required place into the Place... box. You
can
enter up to 20 characters to describe the location name. Typically this
would be city name or city name and state (eg. "London" or "New York
NY").
3. Enter the country or state into the Country/State box. You can enter up
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to 20 characters to describe the country or state (eg. Canada, USA,
Australia, NY, MA, NSW, VIC).
4. As soon as you move the cursor out of the Country/State box (or press
the Enter key whilst the cursor is still in the Country/State box), an
atlas lookup will be performed invisibly to you, and if the place is
found, then the remaining zone latitude and longitude boxes will be
updated with the details stored in the atlas for this place.
5. If the place is not found in the atlas, then you will see a dialog box
informing you of this, and you will be taken into the database dialogs in
order to try to find the required place.
W

To perform a manual atlas lookup

Select the Place... button. This will display a dialog box which allows the
selection or entry of a place from a database of locations. This is described
in detail on page 40. Using this button will cause data to be automatically
entered into all the boxes relating to location, including time zone,
longitude and latitude. Note that if you are using Solar Fire's own place
database, then it may still be necessary to alter the time zone if the current
time zone in use is non-standard. (Eg. the place database may enter "GMT
+0:00" into the time zone box when London is selected. However, if
summer time is in effect then this should be altered to "BST -1:00" by
using the Zone... button or by entering "BST" into the Zone box.). If you
are using the ACS Atlas, then the time zone will be adjusted automatically,
if necessary.
If you have already obtained all the location details from the atlas, then you
can skip the following sections that describe how to enter timezones,
latitudes and longitudes.

Entering a Time Zone
Time zones may be selected either by using the Zone... button to display
the "Time Zone Selection" screen, or by entering a time zone mnemonic or
a time directly into the Zone... box.
You can enter standard time zones, Local Mean Time or Local Apparent
Time.
•

Standard Time Zones – These are standards that were adopted by
various authorities in order to ensure that all people living in the same
region used the same time standard.

•

Local Mean Time (LMT) – This is the standard time of the longitude
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of a location. This was used in most places prior to the adoption of
standard time zones. Using this standard, the mean position of the Sun
is on the meridian at noon, but note that the true Sun varies from this
position by up to about 15 minutes either way.
•

Local Apparent Time (LAT) – This is the time according to the true
position of the Sun in its diurnal arc, which is equivalent to sundial
time. By this standard, noon occurs on each day when the Sun is
exactly on the meridian. This is the standard that was generally used
prior to LMT.

W

To enter a time zone using its mnemonic abbreviation

Enter one of the standard 3 or 4 letter time zone abbreviations (eg. “EST”,
“AEST”, “BST”, “CWT”, etc.). For the program to recognize the
abbreviation, it must be in Solar Fire’s internal time zone database. If the
abbreviation is not recognised, you will see an error dialog box, and you
can try again. If it is recognised, then the corresponding zone time will be
automatically appended after the abbreviation in the Zone... box.
W

To enter a time zone using its time offset

Enter the number of hours (and optionally minutes and seconds) from
Universal Time or Greenwich Mean Time eg. +8 or 8 for Pacific Standard
Time, or -10:30 for Australian Central Daylight Time. For zones west of
Greenwich, use a plus (+) sign or no sign. For zones east of Greenwich,
use a minus (-) sign. You must use a colon(:) to separate hours minutes and
seconds.
W

To enter Local Mean Time

Type “LMT” into the Zone... box. The correct zone time for the current
longitude will be appended after the abbreviation in the Zone... box, and if
you subsequently alter the longitude, this zone time will be amended
automatically.
W

To enter Local Apparent Time (Sundial Time)

Type “LAT” into the Zone... box. The correct zone time for the current
date and location will be appended after the abbreviation in the Zone...
box, and if you subsequently alter the longitude or date, this zone time will
be amended automatically.
W

To choose a time zone from the database of time zones

Select the Zone... button. This will display the "Time Zone Selection"
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dialog box from which a time zone may be selected.

You can alter the order in which entries are shown by selecting the Sort
Order as follows
•

Full Name - the records will be sorted into ascending alphabetical
order of their full descriptive name.

•

Zone Time - the records will be sorted into numerical order by their
hours from GMT. (Note that the ordering is from 0 to 12 positive
numbers followed by 0 to 12 negative numbers).

•

Mnemonic - the records will be sorted into ascending alphabetical
order of their mnemonic abbreviation.

W

To retrieve time zone details to the screen from which the Zone... button
was selected

1. Select the desired time zone entry from the list box
2. Click on the Select button.

Entering Longitudes and Latitudes
Longitudes and latitudes must be entered in degrees and minutes with an
indicator of which hemisphere they are in.
Longitudes and latitude must have at least a degree number (i.e. 0 to 180
for longitude, 0 to 90 for latitude) and a hemisphere code (i.e. E or W for
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longitude, N or S for latitude). They may also have a minutes number (i.e.
0, 1, 2, 3, ..., 59) and a seconds number. Separators between the numbers
may be any of the following: blank( ); slash(/); period(.); colon(:); semicolon(;) or comma(,).
Some examples of valid longitudes are as follows.
0W

0W0

149e38

78W23

E 167 52

Some examples of valid latitudes are as follows.
0S

0N0

17S58

62n17

S 45 23

Enter ordinary geographic latitudes, even if you want to use the geocentric
latitude. (Atlases always give geographic latitudes). If you wish to use
geocentric latitudes in chart calculations then you should switch the
Geocentric Lats option on. See page 350 for instructions on how to do
this.

Selecting an Event Type
By default, any new chart is labeled as an “Event” chart, which is a
catchall name to cover any kind of astrological chart. However, you are
also able to select some alternative labels that describe more exactly what
type of event the chart describes. Some of these labels are used in other
parts of Solar Fire to help display chart information in its most appropriate
format.
If the event type that you wish to select is not already highlighted in the
Event Type list box, then simply find the required event type from the
drop-down list and highlight it.
The event types available in Solar Fire are as follows:
•

Unspecified – This is used for charts which were created in older
versions of Solar Fire, or alternative astrology programs when
imported into Solar Fire.

•

Male – use this label for the birth chart of a male. This label is used in
synastry reports to apply the correct gender language to the
interpretations.

•

Female – use this label for the birth chart of a female. This label is
used in synastry reports to apply the correct gender language to the
interpretations.

•

Event – use this label for any non-natal chart, such as a transit chart or
mundane event.
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•

Horary – use this label for any chart which is cast for the purpose of
asking an horary question. In this case, the Chart Name can contain the
text of the question.

Selecting a House System
If the house system that you wish to use is not already highlighted in the
House System drop-down list box, then simply find the required house
system from the list and highlight it.
You can reset the default house system that is selected whenever you start
Solar Fire by altering a preferences setting. See page 359 for instructions
on selecting the default house system, and a description of what they mean.

Selecting a Zodiac
You can select any of the available zodiac types by highlighting the desired
option on the drop-down list of zodiac types.
Most Western astrologers normally use the Tropical zodiac, whereas
Sidereal astrologers normally use one of the other (sidereal) zodiacs. Most
Western astrologers who practice sidereal astrology use the Fagan-Allen
zodiac.
The initial default value of the zodiac selection is set according to your
choice of zodiac in the Preferences menu. See page 358 for instructions on
changing the default zodiac.

Selecting a Coordinate System
You can select either geocentric or heliocentric coordinates from the
drop-down list of coordinate types.
Most astrologers use the geocentric coordinate system. If you select the
heliocentric coordinate system, then the chart will be calculated with
heliocentric planetary positions on geocentric houses.
If you do not want to display geocentric houses on a heliocentric chart,
then you could select "0 Deg Aries" as your house system, as this is a
"neutral" house system which is independent of the chart’s location on
earth.
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Entering a Source Rating
The source rating is an optional code that indicates how accurate or reliable
the chart’s date and time are. This is very useful when charts are
exchanged with other astrologers, because it can help avoid
misunderstandings about how accurately a chart’s time is known. For
example, a chart’s time may be given as “10:43 am”, implying that it was
timed to the nearest minute, but if the source rating is given as “D –
Conflicting/Unverified”, then an astrologer would be very cautious about
drawing firm conclusions from the chart.
W

To enter a source rating

Either
•

Select a pre-defined rating category from the drop-down list box, or

•

Enter any rating code up to 2 characters long

The predefined rating codes are known as “Rodden Rating” codes as
devised and promoted by Lois Rodden. These codes are:
•

AA - From birth record, eg. directly from a birth certificate or hospital
record, or quoted from such a record

•

A - From memory or from a news report

•

B - From a biography or auto-biography

•

C – Original source unknown or rectified from an approximate time

•

DD – Conflicting with other sources or otherwise unverified

•

X - Time unknown eg. only the date is known or has been rectified
without an approximate starting time

•

XX – Date in question or otherwise undetermined

•

Entering a Source Description

•

In addition to entering a source rating code, you can optionally also
enter a brief source description to elucidate the rating code. The
purpose of this field is to provide more information about the chart
rating than can be conveyed by the two-character source rating code.

•

Some examples of possible source descriptions are

•

AA - “Birth certificate” or “Quoted from hospital record”

•

A – “The Times 3 Nov 1992” or “Mother’s memory”
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•

B – “from ‘A Good Life’ by C. Cook”

•

C – “Rectified from10am by John Smith”

•

DD – “Alternative time 11:15pm” or “Several alternatives known”

•

X – “Time unknown”

XX – “Calendar type uncertain”

Entering Chart Comments
It is possible to enter up to about 30,000 characters (many pages) of free
text which is stored and saved along with the chart details. This can be
used to store, for example, biographical information, a description of the
chart event, records of what astrological analysis has been done on the
chart, notes on the chart’s rectification etc.
W

To enter or edit chart comments

Click on the Comments button
This will open up the comments editing window, which allows you to
browse, enter or edit any comments text. Any text that you enter will
remain associated with the chart when you use it in Solar Fire, so that
when you save the chart to a file, the comments that you enter here will
also be saved with it.
Note that you can also easily edit any comments that you enter here after
you have calculated the chart, and also after you have saved the chart, if
you wish to, from other places in the program.
However, if you do not save this chart to a file or retain it before exiting
from Solar Fire, then any comments that you enter here will be discarded
along with the chart that you create here.

Calculating the New Chart
When all the required data items have been entered and preferred options
chosen, select the OK button. The chart is then calculated and added to the
list of Calculated Charts on the Main Screen.
It is possible to view, print, report on, or cast subsidiary charts from any
such chart on the list of calculated charts by selecting the appropriate
options from the menu.
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Chapter 6: Using Place Databases
This chapter describes how to select a place for use in chart casting, and if
you are using Solar Fire's own place database, how to add, edit or delete
entries from a place database file, or copy entries between two different
place database files. If you have the ACS Atlas for PC installed on your
computer, then you can choose whether you wish to use this Atlas in
preference to Solar Fire's own place database. See page 368 for instructions
on how to select which Atlas you wish to use.
It is possible to invoke the ACS Atlas or Solar Fire place database from
any screen on which a location must be entered, for example in the New
Chart Data Entry screen, the Subsidiary Chart Data Entry Screens and the
Dynamic Reports screen.

Using the Solar Fire Place Database
W

To open the Place Database dialog box

Select the Place... button.
Place Database Dialog Box

The list box on the left of the screen contains a list of all the place and
country or state names that are stored in the currently selected place
database file. The name of the currently selected place database file is
displayed in the box titled “File Name”. The number of place records
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stored in this file is shown in the box titled "Records". If there are no
records in this file then the number of records will be zero, and no place
names will appear in the list box. The number of places that have been
selected for deletion or copying is shown in the box titled "Selected".

Finding a Place
W

To find a place in the list box

Do any of the following
•

Select the File... button - This will display the "File Manager" dialog
box with a list of place database files, from which it is possible to
select an existing place database file or create a new one. Refer to page
211 for instructions on using the File Manager.

•

Select a Name Order - The City First option will list the places in
ascending alphabetical order according to the place name. The
Country First option will list the places in ascending alphabetical
order according to the country or state name, and by place name
within each country or state.

•

Click on any place on the list and type any alphabetic key on the
keyboard - This will move the list pointer to the first place name
starting with that alphabetic character. Repeated use of the same key
will cause the pointer to jump to subsequent entries starting with the
same character.

•

Select the Find... button - This will display a dialog box allowing a
character or series of characters to be entered. Subsequently selecting
the OK button from this box will move the list pointer to the first place
name beginning with the entered character or series of characters.

•

Browse the list by using the scroll bars on the right hand side of the
list box.

Selecting a Place
W

To retrieve a place from the list for use within the program

Do either of the following
•

Select the required place and use the Select button.

•

Double click on the required place.

The place database screen will disappear and you will be returned to
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whichever screen was previously displayed, and the selected place details
will be copied automatically onto that screen.

Adding a New Place
W

To add a new place record

Select the New button - This will clear all the data from the individual
place data entry boxes, and it is possible to enter data for a new place
record. It is possible to cancel the entry of this new record by selecting the
Cancel button at any time. See the next section for details on how to enter
data.

Editing Place Details
W

To edit the details of an existing place record

Select the required place from the list box
Edit Place Name - Up to 20 characters may be entered to describe the
location name. Typically this would be city name (eg. "Adelaide" or
"New York".).
Edit Country - Up to 20 characters may be entered to describe the country
or State (eg. "Australia" or “NY”).
Select either the Zone... button or the Table... button - Selecting the
Zone... button will display a dialog box which allows the selection of a
fixed time zone from a database. This is described in detail on page 33.
Using this button will cause data to be entered automatically into the
time zone box. Selecting the Table... button will display the “Timezone
Table” dialog that allows a time zone table to be selected or edited for
the current location. See page 44 for instructions on using the timezone
tables. If a table is selected, then Solar Fire will use that table to find
the correct timezone applicable to any location that you look up in the
database.
Enter a Time Zone - Time zone may be entered as a standard mnemonic or
as a time. If the format is not acceptable then an error dialog box will
be displayed. See page 33 for details on acceptable formats.
Enter a Latitude - Enter the location latitude in an acceptable format. If the
format is not acceptable then an error dialog box will be displayed.
Acceptable formats are described in detail on page 35.
Enter a Longitude - Enter the location longitude in an acceptable format. If
the format is not acceptable then an error dialog box will be displayed.
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Acceptable formats are described in detail on page 35.
Finally, select the Enter button - This will display a dialog box asking if
you wish to save the changes that you have just made to this record.
You are still able to cancel any changes that you have made to this
record by selecting the Cancel button from this dialog box. If you
select the OK button then the changes will become permanent, and the
record will be moved to its appropriate place in the database file
according to the currently selected sort order.

Selecting Places to Copy or Delete
You can select any number of places to copy or delete in a single
operation, by holding down the Ctrl key whilst clicking on subsequent
places in the list. The number of places selected is displayed in the
"Selected" box.
W

To select all the places in the current database

Select the All button.
W

To unselect any selected places

Select the Clear button.

Copying Places
W

To copy one or more places from the current place database into
another existing place database file

Select the required places and use the Copy... button - This will display a
dialog box with a list of target place databases, from which you must select
one. If the Select button is chosen then a "Copy Places" dialog box will be
displayed, giving the options of copying all of the selected places without
confirmation, of being asked for confirmation of the copying of each
individual place, or of canceling the deletion process. If the Yes button is
selected then, for each selected place in sequence, a dialog box will be
displayed asking whether or not that individual place should be copied. If
the No button is selected then all of the selected places will be copied
immediately. If the Cancel button is selected then no further places are
copied.
If you wish to copy places into a new place database, it is necessary to
create the new database file before using this copying procedure. See page
211 for instructions on how to create a new database file.
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Deleting Places
W

To permanently delete places from the current place file

Select all the required places and use the Delete... button - This will
display a "Delete Places" dialog box, giving the options of deleting all of
the selected place records without confirmation, of being asked for
confirmation of the deletion of each individual place record, or of
canceling the deletion process. If the Yes button is selected then, for each
selected place in sequence, a dialog box will be displayed asking whether
or not that individual place should be permanently removed. If the No
button is selected then all of the selected places will be removed
immediately. If the Cancel button is selected then no further places are
deleted.

Using Solar Fire Timezone Tables
Any place that is stored in a Solar Fire place database file may be linked to
a lookup table of time zone changes, so that Solar Fire can automatically
find the appropriate time zone for any date.
The timezone table is fully editable, so that you have the option of entering
your own data, or if necessary making corrections to any timezone data
which is out-of-date.
W

To access the timezone table selections

1. Enter Solar Fire’s place database screen by clicking on the Place...
button in any screen.
2. Select a place for which you wish to view, edit or select timezone
tables.
3. Click on the Table... button. This will display the “Timezone Table“
dialog box.
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From this screen, you can create new zone tables, edit existing tables,
delete them, or select a table for use with the currently selected location.
W

To create a new zone table

1. Click on the Add New... button. This will display the “Edit Time Zone
Table” dialog for a new table with no entries.
2. Follow the instructions below for editing a zone table.
W

To delete a zone table

1. Select the required entry on the list of available zone tables
2. Click on the Delete... button.
W

To select a zone table for the currently selected location

1. Select the required entry on the list of available zone tables
2. Click on the Select button.
W

To select a zone table for many locations at once

1. From the Place Database screen, select all the required locations by
clicking on them individually with the Ctrl key held down, or by
clicking on the All button.
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2. Select the Table... button.
3. Select a table from the list of available time zone tables.
4. Click on the Select button.
W

To unselect a zone table for one or more locations

1. From the Place Database screen, select all the required locations by
clicking on them individually with the Ctrl key held down, or by
clicking on the All button.
2. Select the Table... button.
3. Select the !No Table! entry from the list.
4. Click on the Select button - All the selected locations will revert to
using a fixed time zone instead of a zone table.

Editing a Time Zone Table
W

To edit a zone table or view zone table data

1. Select the required entry on the list of available zone tables
2. Click on the Edit... button. This will display the “Edit Time Zone
Table” dialog displaying the data for the current zone table.

46 Solar Fire 5: Working With Chart Data

W

To set the title and other options

1. Enter a Table Name - preferably a name that is descriptive of the
locations to which this table applies.
2. Optionally select the Next Table - From the Next Table drop-down
list, select any other existing table that should be used for dates
following the last date in the current table. In most cases you will want
to leave this set to “None”.
3. Set the verification message option - If the time zones in this table are
likely to continue changing regularly after the last entry in the table,
then you may choose to have Solar Fire issue a warning message for
charts with dates beyond the last entry in this table. If you want to see
such messages, ensure that this option is checked.
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W

To add an entry to the table

1. Click on the Add Entry button.
2. Edit the Start Date - the date on which the new time zone takes effect
3. Edit the Start Time - the time at which the new time zone takes effect
4. Edit the Time Zone abbreviation or longitude standard - You can enter
any of Solar Fire’s standard time zone abbreviations, or click on the ...
button next to the Time Zone box to choose a zone from the list of
available zones. You can also enter any longitude in Solar Fire’s usual
longitude format (eg. 135E00) to apply a fixed zone standard. Each 15
degrees of longitude corresponds to 1 hour of time, so 135E00
corresponds to -9 hours from GMT.
Note that when you add a new entry, the date of the new entry is
automatically set to be the same day of week in the same week of the
month as the second most recent entry in the table, but one year later. For
example, if the second to last entry was the last Sunday in March of 2000
(26 March 2000), then the new entry will be set to the last Sunday in
March 2001 (25 March 2001). This feature will save you much effort if all
you want to do is to extend the date range of the table based on the
continuation of the current pattern of daylight savings. All you need to do
is to click on the Add Entry button repeatedly until the table reaches the
required year.
W

To delete an entry

1. Select the required entry in the table
2. Click on the Delete Entry button.
W

To sort all entries into correct order of date

Click on the Sort Table button. This will put the earliest entry at the top of
the list down to the latest entry at the bottom.
W

To save any changes you have made

Click on the Save button. This will sort the list, and return you to the
previous screen.

Using the ACS Atlas
W

To activate the ACS Atlas dialog box:
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Select the Place... button.
ACS Atlas Dialog Box

When this screen appears, the place, date and time boxes will contain the
information that was held on the previous screen. You have the option of
changing any of these if you wish to, and then clicking on any of the four
main command buttons, which are described below. When you have found
the place that you require, then clicking on the OK button will return you
to the previous screen, and the displayed place details will be copied
automatically onto that screen.

Atlas Lookup
If the ACS Atlas does not recognize the name of the country or state to
which the given place name belongs, then you will be presented with a list
of names and abbreviations of countries and states from which to choose:-
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W

To select the required country or state

Click on the required entry and then the Select button, or double-click on
the required entry - If the place name that you entered is found, then the
city, country or province, state or country, latitude, longitude and time
zone will all be filled on the ACS Atlas dialog box. If the place name that
you entered is not found, then you will be presented with a list of similar
names from which to choose. See the next section for instructions on how
to proceed.

Similar Names
If you click on the Similar Names button, or if the place you are looking
for was not found, then you will be presented with the City dialog box.
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W

To select the required city

Click on the required entry and select the OK button, or double-click on
the required entry - If you select the Cancel button, then you will return to
the ACS Atlas screen after seeing a message indicating that the lookup was
not successful.

Radius Search
If you click on the Radius Search Button, then the following box appears.
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The initial settings of the longitude and latitude will be the same as the
most recent entry that was found in the atlas. You have the option of
altering these if you wish, and of specifying the radius of the search in
minutes of arc by editing the Distance box. By default it is set to 1 minute
of arc.
W

To start the search

Select the Start Search button - You will be prompted for the country or
state in which you wish to search, and the results will be presented in the
City dialog box, from which you may select any entry. If no entries are
found within the given radius, then you will be returned to the ACS Atlas
screen without any result.

Zone Changes
W

To see a list of dates and times at which the time zone changes occur

Select the Zone Changes button - You may be prompted for the country
or state, and for the city for which you wish to see the zone changes and
the results will be presented in a dialog box as shown below.
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Selecting the OK button will simply return you to the ACS Atlas screen.
Note: It is not possible to edit or add information to the ACS PC Atlas
directly from Solar Fire. For further information refer to the documentation
supplied with the ACS PC Atlas.
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Chapter 7: Retrieving Charts From a
File
This chapter describes how to find and select charts from your Solar Fire
chart files, so that you can view, work with, edit and print them.
Whenever you retrieve a chart from a file, you do so from the “Chart
Database” dialog box. This dialog box is also a gateway to editing and
manipulating chart files.
W

To display the Chart Database dialog box

Select Open... from the Chart menu.
Chart Database Dialog Box

Whenever this screen is displayed, the list box on the left of the screen
contains a list of all the chart names that are stored in the currently selected
chart database file. The name of the currently selected chart database file is
displayed in the box to the right of the File... button, and its descriptive
title (if it has one) is displayed below this. The number of charts stored in
this file is shown in the Charts box. If there are no charts in this file then
the number of records will be zero, and no chart names will appear in the
list box. The number of charts that have been selected for copying, deleting
or opening is shown in the box titled Selected.
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Selecting the Required Chart File
If the chart that you want is not in the current chart file, then you can select
another file to look in.
W

To select a different chart file

Select the File... button. This will display the “File Manager” dialog box
with a list of chart database files from which it is possible to select an
existing chart database file or create a new one. See page 211 for
instruction on using the File Manager.

Searching All Chart Files
Solar Fire can also search through all your chart files at once for any chart
or charts with the same string of characters in the chart name.
W

To search through all chart files in a directory or folder

1. Select the Search All Files... button.
2. In the displayed dialog box, type in the series of characters that you
wish to find (eg. type in “kennedy” to find all charts with Kennedy in
their name), and select the OK button.
3. All of the valid chart files in Solar Fire’s current chart directory (i.e. the
directory or folder in which the currently selected chart file resides)
will be searched, and you will see a list of all charts containing the
entered string in any part of their name. Each entry displays the name
of the chart file on the left, followed by the full chart name and type.
4. Double-click on any chart in the list to select it. The file in which the
selected chart resides will be automatically selected, and the selected
chart will be highlighted in the list of charts, ready for you to open,
edit, copy, delete etc.
If you do not wish to select any chart, or if no matching charts were found,
then double click on the control box of the search results window, in order
to close it.
Note: If you wish to search all chart files in a different directory or folder,
then you must first select a chart file that resides in that directory or folder.

Finding a Chart in the Current Chart File
The Stored Charts list box displays a list of all the chart names that are in
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the current chart file. You can use any of the following ways to help find
the required chart or charts.
•

Scroll the list by using the scroll bar on the right hand side of the list
box.

•

Jump to the beginning entry for any letter of the alphabet by selecting
any chart on the list and then pressing the key for the letter you want.
Hit the same key to move through each successive entry beginning
with the same letter.

•

Use the Find... button to find charts with any character string in their
name or in their chart comments, or to find charts with certain
planetary placements or aspects.

•

Sort the list in various ways to make finding charts easier, by clicking
on the Name or Date column headers and using the Reverse Chart
Names and Descending Sort Order check boxes.

The sort options have the following effects:
•

Name will list charts in either alphabetical order of their listed names,
or in the order in which the charts are stored in the file. Subsequent
selection of this option will toggle between these two sort modes.

•

Date will list charts in order of their date and time.

•

Reverse Chart Names will display the listed chart names starting
with the last distinct character string (i.e. preceded by at least one
blank) in each chart name as it was entered. eg. an entered name of
“Bill Clinton” is displayed as “Clinton, Bill”. If this option is not
checked, then the chart names are shown exactly as they were entered.
(Note that the titles of charts that are marked as Horary or Event charts
are not affected by this option – they are always displayed exactly as
they were entered.)

•

Descending Sort Order will list the charts starting from the highest
value to the lowest value i.e. from Z to A, from last date to earliest
date, from last chart entered to first chart entered. If this option is not
checked, then the charts will be listed in ascending order of the current
sort option, instead.

Searching for Character Strings
W

To find charts containing certain character strings in their names or
comments
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1.

Select the Find... button.

2.

From the drop-down menu, select one of the following options
•

Next Chart Name with... - to select the next chart on the list
(after the currently highlighted chart) which contains a specified
character string in its name

•

All Chart Names with... - to select all the charts on the list which
contain a specified character string in their name

•

Next Chart Comment with... - to select the next chart on the list
(after the currently highlighted chart) which contains a specified
character string in its comments

•

All Chart Comments with... - to select all the charts on the list
which contain a specified character string in their comments

3.

In the displayed dialog box, type in the series of characters that you
wish to find (eg. type in “kennedy” to find all charts with Kennedy in
their name, or “athlete” to find all charts with the word athlete in their
comments), and select the OK button.

4.

If any chart or charts are found with the specified string, then they will
be selected (highlighted) on the list. It is then possible to open, copy or
delete all of these charts using the appropriate buttons.

Searching for Planetary Placements or Aspects
You can search for charts in the current chart file using a variety of
astrological criteria, such as which house or sign a planet is in, and what
aspect is formed between two planets or from a planet to a fixed zodiacal
point. For example, you could find all charts which have the Moon in
Taurus.
As well as simple searches, you can combine criteria to perform complex
searches involving several different factors. For example, you could find
all charts which have the Moon in either Taurus or Gemini, and the Sun in
the 7th house square Uranus.
W

To enter the “Planetary Search Selection” dialog box

1 Select the Find... button.
2 From the drop-down menu, select one of the Planet Search... option
When this dialog box is first displayed, the Current Search Criteria box
will be empty, and you will need to make selections from the Criteria
Selection box and add them to the current search criteria.
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If you intend to use criteria that involve aspects, then you can specify
which set of aspects you wish to use. This will determine which aspects are
available for selection, and what orbs each aspect has.
W

To select which aspects and orbs to use

Click on the > button to the right of the Aspect Set.
This will display the “File Management” dialog box from which an aspect
set may be selected, edited or created.
W

To add a search criterion

1.

Select which type of criterion you want to use
•

Planet in Sign - Any planet or chart point in any of the 12 signs.
You must select which planet from the Planet drop-down box,
and which sign from the In drop-down box.

•

Planet in House - Any planet or chart point in any of the 12
houses. You must select which planet from the Planet drop-down
box, and which house from the In drop-down box.

•

Planet in Aspect - Any planet or chart point making any aspect to
any other planet or chart point. You must select which planet from
the Planet drop-down box, which aspect from the In drop-down
box, and the second planet from the To drop-down list box.

•

Planet in Position - Any planet or chart point making any aspect
to a fixed zodiacal position. You must select which planet from
the Planet drop-down box, which aspect from the In drop-down
box, and specify a zodiacal position in To text box. You can enter
a position using a degree, sign abbreviation and minute number
(eg. 17Ar15 for 17Degs and 15Mins or Aries). For more
information on entering zodiacal positions, see page 384.

2.

Select the Add button. This will copy the selected criterion into the
Current Search Criteria list box.

3.

(Optional) If this is not the first criterion in the list, then you can select
the And/Or button to toggle the condition between logical “And” and
logical “Or”.

Note that all the conditions will be evaluated in exactly the sequence that
they appear in the list, and conditions cannot be grouped together (or
bracketed). For example:
FIND

Condition1
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AND

Condition2

OR
AND

Condition3
Condition4

will be evaluated in the following order
Condition1 AND Condition2 = Result1
Result1 OR Condition3 = Result2
Result2 AND Condition4 = Result3
The final result of the above combined criteria is Result3.
W

To delete a search criterion

Highlight the criterion that you wish to delete.
Click on the Delete button.
W

To clear all the search criteria

Click on the Clear button.
W

To start the search

Click on the Search button. A status bar will appear to show progress.
When the search has finished, if any charts were found, then you will be
returned to the “Chart Database” screen from which you can copy, open or
delete the selected charts. If no charts were found, then you will be
notified, and will be given the option of trying another search.

Selecting Charts Manually
A chart is selected by clicking the mouse onto its name in the Stored
Charts list box. A selected chart is shown in the list box with a reverse
video, highlighted entry. It is possible to select any number of charts to
open, copy, delete or print a summary, by holding down the Ctrl key
whilst clicking on subsequent charts in the list. Any selected chart may
also be deselected by clicking on it again whilst holding down the Ctrl
key.
W

To select all the charts in the current file

Click on the Select All button.
W

To deselect all selected charts
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Click on the Clear button.
Note: The chart edit button is only enabled if a single chart has been
selected, because it is not possible to edit multiple charts simultaneously.

Opening Charts
Any number of selected charts from the current chart file may be opened
and added to the list of calculated charts in the Main Screen.
W

To open a single chart from the list of Stored Charts

Select the required chart and then click on the Open button, or doubleclick on the required chart.
W

To open multiple charts at once

Select all the required charts and then click on the Open button.
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Chapter 8: Manipulating Charts in
Files
This section gives you the tools to keep your chart files up-to-date and
organized. It shows how to correct a chart that has been incorrectly cast;
how to add comments to a stored chart, such as notes on the source of the
data, biographical notes or other client notes; how to copy, delete and
move charts from one file to another; how to add a descriptive title to a
chart file, making it easier to tell what the file contains; how to print a
summary of charts contained in a file.
The instructions in this section assume a basic knowledge of how to find,
select and open charts as described in the previous section. See page 54 for
further information.

Editing Chart Details
Instead of opening a chart exactly as it is stored in the chart file, you may
wish to change some of the chart’s details, for example to correct an
incorrect birth time, or to specify a different location, house system, zodiac
or event type for the chart.
W

To edit a chart

Select a single chart, and then click on the Edit button. This will display
the “New Chart Data Entry” dialog box with the data from the selected
chart. Type any new data over the existing data. Before selecting the OK
button:
W

To replace the stored chart with the newly edited chart

Select the Replace Chart in File option by ensuring that it is checked. The
original chart will be overwritten with the newly edited details, and you
will be returned to the “Chart Database” screen.
W

To create a separate copy of the edited chart

Do not select the Replace Chart in File option (ensure that it is
unchecked). The original chart will remain in the chart file, and a new chart
will be opened with the newly edited details. To keep a permanent copy of
this new chart you will need to save it to a file yourself. See page 86 for
further instructions on saving files.
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Copying Charts
You can copy any number of charts from the current chart file into any
other chart file, either existing or new.
W

To copy charts into another file

1. Select the required charts
2. Click on the Copy... button. This will display the File Manager with a
list of target chart files.
3. Either select one of the files on the list, or select the Create button to
create a new empty chart file to copy the charts into.
4. A "Copy Charts" dialog box will be displayed, giving the options of
copying all of the selected charts without confirmation, of being asked
for confirmation of the copying of each individual chart, or of canceling
the copying process. If the Yes button is selected then, for each selected
chart in sequence, a dialog box will be displayed asking whether or not
that individual chart should be copied. If the No button is selected then
all of the selected charts will be copied immediately. If the Cancel
button is selected then no charts are copied.
Note that when charts are copied to another chart file, any chart comments
that are associated with the charts are copied as well.

Deleting Charts
W

To delete charts from the current chart file

1. Select the required charts
2. Click on the Delete... button, and choose the Selected Charts... item
from the drop-down menu
3. This will display a "Delete Charts" dialog box, giving the options of
deleting all of the selected charts without confirmation, of being asked
for confirmation of the deletion of each individual chart, or of canceling
the deletion process. If the Yes button is selected then, for each selected
chart in sequence, a dialog box will be displayed asking whether or not
that individual chart should be deleted. If the No button is selected then
all of the selected charts will be deleted immediately. If the Cancel
button is selected then no further charts are deleted.
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In certain situations you may find that you have stored more than one copy
of a chart in a chart file. This might occur if you are copying various charts
from one file to another, for example, and accidentally copy the charts
more than once. Fortunately there is an easy way to get rid of any duplicate
charts without having to find them all manually.
W

To remove duplicate copies of charts from the current chart file

The process is the same as above, except instead of choosing the Selected
Charts... item, choose the Duplicate Charts... item from the drop-down
menu.
Note that charts are considered to be duplicates if they have the same basic
chart details (Name, date, time, location, house system, zodiac etc.).
However, special conditions apply if the comments associated with each of
the duplicate charts are different: If comments are present on only one of
the charts, then those comments are retained. However, if comments are
present on both charts, but are different, then only the comments from the
chart that is stored later in the file will be kept.

Moving Charts
W

To move charts from the current chart file to another chart file

First copy the charts to the new file, and then delete them.

Adding or Editing Chart Comments
You can add permanently saved comments to any chart. These comments
are displayed in the Chart Comments box whenever the chart is
highlighted in the list of Stored Charts.
W

To add or enter comments for a chart

1. Select the required chart from the list of Stored Charts
Click inside the Charts Comments box, or select the Comments… button
This will display the comments editing dialog where you can type in
whatever text you wish
Any changes that you make are permanently saved as soon when you
select the Save button. You can enter up to about 30,000 characters of text
(which is equivalent to about 10 pages of typewritten text).
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Changing the Chart File Description
To aid in identifying and selecting chart files, you can give any Solar Fire
chart file a description of up to 80 characters. This description is displayed
in the File Manager, as well as on the “Chart Database” screen. However,
note that you cannot enter a description for Solar Fire chart files which are
v2 (Standard Edition) format or earlier.
W

To add or edit a chart file description

Click inside the chart description box above the list of chart names, and
type in whatever you want. Any changes that you make are permanently
saved as soon as the cursor leaves the description box.

Printing a Summary of Charts in a File
You can print out a summary listing of any or all charts contained within a
single chart file. The summary may be printed at three different levels of
detail:
•

Brief Listing - Each chart occupies a single line of output, and
contains only the essential details that would be required to recast the
chart: Name, date, time, timezone, latitude and longitude.

•

Full Listing - Each chart occupies two lines of output, and contains
the same information as the brief listing plus the coordinate system
(geocentric/heliocentric), zodiac type, house system, place name and
country/state.

•

Full with Comments - The details of each chart occupy two lines of
output, containing the same information as the full listing, and any
chart comments that are associated with the chart occupy additional
text lines below the chart details.

W

To print a summary of all charts in the current chart file

1. Select the Print Details... button and from the drop-down menu select
the All Charts option.
2. Select the Print Details... button and from the drop-down menu select
one of the listing options Brief Listing..., Full Listing... or Full with
Comments....
3. The “Print” dialog box will appear, from which you can alter printer
settings, add this job to the print queue, or print it immediately. See
page 205 for further information on printing.
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W

To print a summary of only the selected charts in the current chart file

1. Select the Print Details... button and from the drop-down menu select
the Selected Charts Only option.
2. Proceed as in steps 2 to 3 above.

Chart File Limitations
The number of charts which can be stored in a single chart file is about
64,000.
As a general recommendation, it is suggested that you save no more than
several thousand charts in any one chart file. This will ensure that Solar
Fire’s performance remains good, and avoids the likelihood of the chart
file limitations ever being reached.
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Chapter 9: Casting Subsidiary Charts
This chapter describes how to select, enter data for and cast Solar Fire's
subsidiary chart types. These types include
•

Progressed charts - secondary, tertiary, minor, user-defined rate

•

Directed charts - solar arc, ascendant arc, vertex arc, user-defined arc

•

Return charts - any planet or asteroid, any harmonic, plus Wynn-Key
and progressed solar returns

•

Ingress charts - any planet or asteroid

•

Harmonic charts - any harmonic

•

Arc Transform charts - any pair of chart points

•

Antiscia or Contra-Antiscia charts

•

Relationship charts - from 2 charts

•

Composite charts - from up to 15 charts

•

Coalescent charts - from 2 charts

•

Prenatal charts - 19 types

•

Rising/Setting charts - rising, setting, culminating or anti-culminating
of any planet or asteroid

•

Lunar phase charts - any of the main transiting phases or progressed
phases plus lunar phase return charts

•

Locality charts - relocated, Johndro or Geodetic

Selecting a Base Chart
Nearly all of the above chart types require a base chart, which is usually a
natal chart. If you have not already cast the natal chart see page 22 for
instructions on creating a new chart, or page 54 for instructions on opening
an existing chart.
You can cast most subsidiary chart types for any natal chart. Whether or
not you can use other types of charts as base charts depends on the type of
subsidiary chart you are casting. If the base chart that you select is
inappropriate, then the data in the Base Chart Details box will become
grayed, and the OK button will become grayed and disabled. In this case
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you cannot proceed until you choose another base chart which is of an
appropriate type.

Entering Subsidiary Date, Time and Place Data
The Date, Time, Place, Country, Zone, Latitude and Longitude fields in
the subsidiary charts data entry screens follow the same data-entry
conventions as those in the New Chart Data Entry screen, and you can
use the Solar Fire place database and ACS Atlases in the same way. Most
forms of data entry will work, and Solar Fire will give you a message if the
data that you enter is not acceptable. See page 26 for further information.

Casting a Progressed or Directed Chart
You can create a progressed or directed chart from any natal type chart.
You can progress geocentric, heliocentric, Tropical and Sidereal charts.
The resulting coordinate system and zodiac type of the progressed chart are
always of the same as those of the natal type chart that you are progressing.
The progression rate may be:
•

Secondary - a day for a year

•

Mean tertiary - a day for a mean lunar month

•

True tertiary - a day for each true lunar month

•

Minor - a mean lunar month for a year

•

User-defined - a rate that can be set in the Preferences dialog

The direction arc may be:
•

Solar Arc - the longitudinal distance moved by the secondary
progressed sun

•

Ascendant Arc - the longitudinal distance moved by the secondary
progressed ascendant

•

Vertex Arc - the longitudinal distance moved by the secondary
progressed vertex

•

User Rate - a rate that can be set in the Preferences dialog

•

User Arc – a fixed angle that can be set each time this option is used

•

Profection Annual – an annual rate of 30 degrees, corresponding to a
direction of one sign (or house) per year.
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Progressed charts are calculated according to certain options that are set in
the Preferences dialog.
W

To pre-set basic progression options

From the Preferences menu of the main screen, select Edit Settings…,
and click on the Progs/Dirns tab.
•

Chart Angle Progressions Type - to determine how to progress the
Midheaven (which also determines the Ascendant, house cusps and
other chart angles). See page 354.

•

Progression Day Type - to determine the type of daily cycle on which
the progression rate is based. See page 356.

•

User Progression Rate... - to determine what progression rate is used
when the User-Defined progression rate option is chosen. See page
355.

•

User Direction Rate... - to determine what annual direction rate is
used when the User-Defined direction arc option is chosen. See page
357.
Progressed/Directed Chart Data Entry Dialog Box
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W

To cast the progressed or directed chart

1. Ensure that the required natal type chart that you want to progress or
direct is already calculated.
2. Choose the Progressed... menu item from the Chart menu
3. Select a chart type from the Chart Type to Generate list box.
4. Select a chart from the Base Chart list box.
5. Enter the Date to which you wish to progress or direct the base chart.
6. (Optional) Enter the Time to which you wish to progress or direct the
base chart. The time is not important for secondary progressed chart
(and most directed charts), unless the Mean Quotidian rate is being
used for angle progressions.
7. Select the Location type. Normally the location of a progressed or
directed chart would be the same as the natal chart location. However,
if the natal chart is that of a person who moved during the first few
months of their life, it may be appropriate to relocate the secondary
progressed chart. If the Natal option is selected then all the boxes
relating to location, including time zone, longitude and latitude will
contain the location details from the selected base chart. Note that
although it may be technically correct to alter the time zone if the
current time zone is different from the natal one, in practice this is not
necessary, as the difference in the resultant progressed chart would be
negligible. If the Relocated option is selected then all the boxes
relating to location, including time zone, longitude and latitude will
contain the current default values. (See page 348 for details on default
values.) Any of these values may be altered in the same manner as
when creating a new chart. See page 26 for instructions on how to alter
location values.
8. (Optional) Select Special Options. It is possible to apply two types of
special options to the calculation of the progressed or directed chart. If
the Precessed option is checked, then the calculation of the chart will
be done according to how far the planets have moved on the Sidereal
zodiac, rather than the Tropical zodiac. However, the resulting chart
will be still be calculated for the Tropical Zodiac. Note that if the base
chart which you are progressing or directing already has a Sidereal
zodiac, then this option will have no effect, and the resulting chart will
have a Sidereal zodiac. Note that for most progressed or directed charts,
the effect of precession is negligibly small, and this option is included
for completeness. If the Converse option is checked, then the
calculation of the progressed or directed chart will be done backwards
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in time from the time of the base chart instead of forwards.
9. Select the OK button. The subsidiary chart will be calculated and added
to the list of calculated charts in the list box on the main screen of the
program. You can now view, print, report on, and otherwise manipulate
this newly created chart.

Casting a Return, Ingress or Transit Chart
You can cast solar, lunar, planetary or asteroid returns, ingresses into any
zodiac sign, or transits to any planet in a base chart or to any user-defined
zodiac point. You can also produce multiple returns from one starting date,
including demi, quarti and other partial or harmonic returns. You can also
calculate two types of progressed solar returns.
You can cast returns for geocentric, heliocentric, Tropical and Sidereal
charts. The resulting coordinate system and zodiac type of the progressed
chart are always of the same as those of the natal type chart that you are
progressing.
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Subsidiary Return Chart Data Entry Dialog Box

W

To cast a single Solar or Lunar return or Wynn-Key or Progressed Solar
Return

1. Ensure that the natal type chart that you want the return for is already
calculated.
2. Choose the Return... menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list
box.
4. Select a chart from the Base Chart list box.
5. Enter the Date from which you wish to search, or for Wynn-Key or
Progressed Solar Returns enter the exact date for which you wish to
calculate the return chart.
6. The Time is not needed for ordinary solar or lunar returns, as the
program will find the exact time of the return. However you should
enter a time for Wynn-Key or Progressed Solar Returns, as this is used
as the time for which the return is calculated.
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7. Select the Location type. Normally the return chart is relocated to
wherever the person is living at the time of the return. If the Natal
option is selected then all the boxes relating to location, including time
zone, longitude and latitude will contain the location details from the
selected base chart. Note that although it may be technically correct to
alter the time zone if the current time zone is different from the natal
one, in practice this is not necessary, as the difference in the resultant
progressed chart would be negligible. If the Relocated option is
selected then all the boxes relating to location, including time zone,
longitude and latitude will contain the current default values. (See page
348 for details on default values.) Any of these values may be altered in
the same manner as when creating a new chart. See page 26 for
instructions on how to alter location values.
8. Select a Which Return option. If the Current option is selected, then
Solar Fire will search backwards from the entered date to find the
return that occurred most recently. If the Next option is selected, then
Solar Fire will search forwards from the entered date to find the return
that will occur next. If the Nearest option is selected, the Solar Fire
will find either the current or the next return, depending on which is
closer to the entered date.
9. (Optional) Select Special Options. It is possible to apply two types of
special options to the calculation of the progressed or directed chart. If
the Precessed option is checked, then the calculation of the chart will
be done according to how far the planets have moved on the Sidereal
zodiac, rather than the Tropical zodiac. However, the resulting chart
will be still be calculated for the Tropical Zodiac. Note that if the base
chart which you are using already has a Sidereal zodiac, then this
option will have no effect, and the resulting chart will have a Sidereal
zodiac. For each year of life, about 50 seconds of arc will be added to
the return planet’s longitude, thus allowing for the precession of the
equinoxes. If the Converse option is checked, then the calculation of
the progressed or directed chart will be done backwards in time from
the time of the base chart instead of forwards.
10. Select the OK button. The subsidiary chart will be calculated and added
to the list of calculated charts in the list box on the main screen of the
program. You can now view, print, report on, and otherwise manipulate
this newly created chart.
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Advanced Return Options Dialog Box

W

To cast multiple solar, lunar or other returns

1. Follow the steps 1 to 7 above, under “To cast a single solar or lunar
return”.
2. In the Chart Type to Generate box, select Advanced & Ingress, and
then click on the Options... button. This will display the “Advanced
Return Selections” dialog box.
3. From the list of chart points on the left of the screen, select the body for
which you wish to find a return.
4. Select the options in the Which Return/s and Special Options as in
steps 8 and 9 above.
5. Next to Number of Returns, type in the number of successive returns
that you want, or click on the spin button to increase or decrease the
number of returns.
6. Select the OK button. Solar Fire will calculate the first return just as it
would for a single return chart, and then each successive return after
that up to the number that you specified. When you return to the Main
Screen, you will find that all these returns have been added to the
Calculated Charts listbox.
W

To cast demi, quarti or other harmonic returns

1. Follow the steps 1 to 5 above, under “To cast multiple solar, lunar or
other returns”.
2. In the Return...To area, select Natal Position, and next to Harmonic,
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type in a number or use the spin button to change the number. You
would enter 2 for demi returns, 4 for a quarti returns, etc.
3. Select the OK button.
W

To cast planetary or asteroid returns

Proceed as you would for casting multiple returns, choosing a planet or
asteroid instead of the Sun or Moon, and then select the OK button.
If you are casting geocentric planet/asteroid returns, then it is possible that
there may be three or even five possible dates for that return. If so, then a
Return Selection dialog box will appear containing a list of all the dates,
showing whether each return is direct or retrograde.
Return Selection Dialog Box

If only one return date is found, then the chart for that date is calculated
automatically, and the temporary dialog box will disappear. If more than
one return is found then you may choose one or more of the return charts
to be calculated. Use the Ctrl key whilst clicking on each required chart in
order to make multiple selections. (Note that if you have specified a
number of returns greater than 1, then selecting the Cancel button will
prevent any further returns from being calculated.)
Note: Even with the most accurate astronomical calculations, the slower a
planet is moving, the harder it is to pinpoint the exact time of its return. For
outer planets in general, and for inner planets when they are near a station
point, it is best to treat the chart angles and house positions as approximate.
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In the chart details of the return chart, an estimated accuracy of the return
time is given, so that you can judge how accurate the chart angles and
house cusps really are, in each case.
W

To cast a chart for a sign ingress or for a transit to any planet or userdefined point

1. Follow the steps 1 to 5 under “To cast multiple solar, lunar or other
returns”.
2. In the Return...To area, select Position or Ingress, and in the dropdown box below this, either select one of the existing longitudes for
sign ingresses, or type in you own value. If you are finding a return to a
planet’s position, then you can automatically insert that planet’s
position into this box by double-clicking on that planet in the listbox on
the left of the screen. (However, don’t forget to subsequently reselect
the required return planet by highlighting it with a single click.)
3. Select the OK button.

Casting an Harmonic, Arc Transform or Antiscia
Chart
You can create an harmonic, arc transform, antiscia or contra-antiscia chart
from any other type of chart.
These chart types are calculated as follows:
•

Harmonic - The longitude of each point in the chart is multiplied by
the harmonic value.

•

Arc Transform - The longitude of each point in the chart is multiplied
by an harmonic value calculated from the longitudinal separation
between a pair of points in the chart. This has the effect of bringing
that planetary pair into exact conjunction in the Arc Transform chart.

•

Antiscia - The longitude of each point is reflected in the 0 Cancer/0
Capricorn axis.

•

Contra-antiscia - The longitude of each point is reflected in the 0
Aries/ 0 Libra axis.
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Subsidiary Harmonic Chart Data Entry Screen

W

To cast an harmonic chart

1. Ensure that the natal type chart that you want the return for is already
calculated.
2. Choose the Harmonic... menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list
box.
4. Select a chart from the Base Chart list box.
5. Type a numerical value into the Harmonic box, or use the spin button
to set an integer value. The harmonic value may be any positive
number, either integer or real (i.e. it may contain decimal places).
6. Select the OK button. The subsidiary chart will be calculated and added
to the list of calculated charts in the list box on the main screen of the
program. You can now view, print, report on, and otherwise manipulate
this newly created chart.
W

To cast an antiscia or contra-antiscia chart

1. Repeat steps 1 to 4 above.
2. Select the OK button.
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W

To cast an arc transform chart

1. Repeat steps 1 to 4 above.
2. Select a planetary pair from the Arc Transform Pairs list.
3. Select the OK button.

Casting a Combined Chart
This section describes how to create a composite, relationship or coalescent
chart by combining two charts, or a group composite chart composed of up
to 15 base charts.
Subsidiary Combined Chart Data Entry Dialog Box

W

To cast a composite, Davison relationship or coalescent chart

1. Ensure that the natal type charts that you wish to combine are already
calculated.
2. Choose the Combined... menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list
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box.
4. Select two or more charts from the Base Chart list box. Holding down
the Ctrl key allows multiple charts to be selected at once. You should
only select two charts, unless you have selected the “Composite Group”
chart type, in which case you may select up to 15 chart.
5. (Optional) Edit the Title1 and Title2 boxes. As charts are selected,
these title boxes are automatically updated. When either one or two
charts are selected, the title list boxes contain the chart name of each
chart suffixed with its chart type. When more than two charts are
selected then the Title1 box contains the last names of each selected
chart, separated by slashes (/), and the Title2 box contains the chart
type of the first selected chart on the list of base charts. These titles will
appear whenever the chart is displayed or printed. These may be edited
if you wish.
6. Select the Location type. If have selected the “Composite - Midpoints”
or “Relationship - Davison” then this option will be disabled, and you
can pass to the next step. Normally the combined chart is relocated to
wherever the relationship exists. If the Natal option is selected then all
the boxes relating to location, including time zone, longitude and
latitude will contain the location details from the selected base chart,
although only the latitude is used in the chart calculation. If the
Relocated option is selected then all the boxes relating to location,
including time zone, longitude and latitude will contain the current
default values. (See page 348 for details on default values.) Any of
these values may be altered in the same manner as when creating a new
chart. See page 26 for instructions on how to alter location values.
7. Select the OK button. The subsidiary chart will be calculated and added
to the list of calculated charts in the list box on the main screen of the
program. You can now view, print, report on, and otherwise manipulate
this newly created chart.
Note - You cannot calculate a composite chart based on other composite
charts. The mathematical basis on which composite charts are calculated
does not work if composite charts are combined. The only way of
combining more than two natal charts is to use the “Group Composite”
method.

Casting a Prenatal Chart
This section describes how to create a prenatal chart for an individual
whose natal chart has already been cast. The most commonly used type of
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prenatal chart is the conception chart, for which two different methods of
calculation are available. However, there are many other types of prenatal
chart type available, plus the ability to derive a natal chart from the date of
conception or quickening, if they are known. See page 413 for a full
discussion of the different types of prenatal charts that can be calculated.
Subsidiary Prenatal Chart Data Entry Dialog Box

W

To cast a prenatal chart

1. Ensure that the base chart that you wish to use is already calculated.
2. Choose the Prenatal... menu item from the Chart menu
3. Select the required chart type from the Chart Type to Generate list
box.
4. Select a chart from the Base Chart list box.
5. Select the Location type. Normally, a prenatal chart should be located
where the individual was at the time of the prenatal chart. For example,
a conception chart should be located to where the conception took
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place. However, for some of the other prenatal chart types you cannot
know a definite location. In these cases it is recommended that the natal
location is used. If the Natal option is selected then all the boxes
relating to location will contain the details from the selected base chart.
If the Relocated option is selected then all the boxes relating to
location, will contain the current default values, and any of these values
may be altered in the same manner as when creating a new chart. See
page 26 for instructions on how to alter location values.
6. If the prenatal chart type is one for which the calculation is based on a
number of lunar cycles, then you can specify the number of cycles in
the Lunar Cycles box. The number of lunar cycles is automatically
preset to a suggested value eg. for the conception charts it is set to 10
lunar cycles (about 273 days) which is the normal term of pregnancy. If
you know that the pregnancy was especially short or long term, then
this number may be changed.
7. If you have selected a “Bailey Conception” or “Bailey Birth (C)”
charts, you should indicate the sex of the individual using the Sex of
Subject option buttons. If the sex is not known, then the best alternative
is to use the Jayne Uranus (C) or Jayne Birth (C) chart types instead, as
these are equivalent to the Bailey Conception and Birth charts but
ignore the sex of the subject.
8. Select the OK button
9. A dialog box may appear listing details of the possible prenatal charts.
You can select one or more entries from the list and then select the OK
button in order to calculate the selected charts. These calculated charts
will be added to the list of Calculated Charts on the Main Screen.

Casting a Rising/Setting Chart
This section describes how to create a chart for the moment of rising,
setting, culmination or anti-culmination of any planet or asteroid on any
given day. For rising and setting charts it is possible to choose whether to
calculate the chart for the time at which the planet or asteroid would appear
to cross the horizon visually, or alternatively to calculate the chart for the
time at which its center crosses the true astronomical horizon.
You can create these types of charts without a base chart. However, if you
wish to base them on the date of an existing chart, you should have already
cast or opened the chart which you wish to use.
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Subsidiary Rising & Setting Chart Data Entry Dialog Box

1.

Choose Rising/Setting... from the Chart menu.

2.

Select the chart type you want from the Chart Type to Generate list
box.

3.

•

To base the rising/setting chart on the date and location of an
existing chart: Select a chart from the Base Chart list box.

•

To do a rising/setting chart for some other date or place: Fill in the
required Date, or click on the Now button for today’s date. Select
the Relocated option button and fill in the required location
details.

If you are doing a rising or setting chart (as opposed to a culmination
or anti-culmination chart), select one of the following Rise/Set Type
options
•

True Altitude - the rising or setting time is that for which the
center of the body crosses the astronomical horizon. This ignores
atmospheric refraction, the size of the body and parallax effects.

•

Visual - the rising or setting time is that for which the leading
edge of the body rises or the trailing edge would set visually on an
idealized flat horizon. This takes account of atmospheric
refraction and the size of the body. In the case of the moon, the
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lunar parallax is also taken into account.
4.

Select the OK button.

5.

A dialog box will appear listing the times of rise, set, culmination and
anti-culmination were found. Select one or more entries on the list and
then select the OK button in order to generate the charts. These charts
will be added to the list of Calculated Charts on the Main Screen.

Casting a Lunar Phase Chart
This section describes how to create a chart for
•

Any of the 4 main transiting lunar phases (new moon, first quarter, full
moon, last quarter)

•

Any of 8 main progressed lunar phases (new moon, crescent, first
quarter, gibbous, full moon, disseminating, third quarter, balsamic)

•

Any lunar phase return (a chart in which the phase angle between the
sun and the moon returns to its natal phase angle)

•

Any lunar phase which is part of a “phase family”, either new or
current. A phase family is a series of lunar phases, separated by about
9.25 months, which occupy similar positions in the zodiac. The “New”
phase family finds the series that begins at the current (or nearest or
next) new moon. The “Current” phase family finds the series of which
the current (or nearest or next) lunar phase forms a part – this can be
any of the four major phases.

You can create a transiting lunar phase chart without a base chart.
However, before creating a progressed lunar phase or lunar phase return
chart, it is necessary to have either cast or opened the base chart which you
wish to use.
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Subsidiary Lunar Phase Chart Data Entry Dialog Box

W

To cast a transiting, progressed or lunar phase return or family chart

1.

Choose Lunar Phase... from the Chart menu.

2.

Select the chart type you want from the Chart Type to Generate.

3.

If you want to base the lunar phase chart on an existing chart, then
select a chart from the Base Chart list box. This is optional for
transiting lunar phase or family charts, but obligatory for progressed
phases.

4.

Optionally enter a new Date and Time around which to search for the
phase charts. As the program will find the exact time of the lunar
phases around the entered date, there is normally no need to enter or
alter the time.
•

If you have selected “Transiting Lunar Phases”, or “Phase
Family” then selecting a base chart will automatically set the date
and time from the base chart. This makes it quick and easy to find
the lunar phases around the time of birth.

•

If you have selected “Progressed Lunar Phases” or “Lunar Phase
Returns”, then you will probably want to select a current date.
You can do this by either manually entering a new date, or by
selecting the Now button.
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5.

Select Location type. If you select the Natal option, then all the boxes
relating to location will contain the location details from the base
chart. If you select the Relocated option, then all the boxes relating to
location will contain the current default values, and you can enter new
location data if you wish to.

6.

Select the OK button.

7.

A dialog box will appear listing the lunar phases that were found and
their dates and times. You can select one or more entries on the list
and then select the OK button in order to generate the charts for the
chosen lunar phases. Any charts calculated from this procedure are
automatically added to the list of Calculated Charts on the Main
Screen.

Casting a Locality or Relocated Chart
This section describes how to relocate a chart or to cast a chart for a
locality.
•

The types of locality charts that may be calculated are

•

Relocated - calculated for the exact same time as the base chart, but
for a different latitude and longitude.

•

Geodetic - using either right ascension or longitude, and optionally
allowing a user-defined geographic longitude base point. This
technique involves adjusting the MC of the base chart according to a
projection of the zodiac onto the earth’s surface.

•

Johndro - using either right ascension or longitude. This technique is
similar to the geodetic technique, but incorporates a zodiacal
precession adjustment in fixing the base point longitude.

You can create a locality chart based on any geocentric natal type chart.
The house system and zodiac type of the resulting chart are always the
same as that of the base chart that you have selected.
W

To relocate a chart

1.

Choose Locality... from the Chart menu.

2.

Select the “Relocated” chart type from the Chart Type to Generate.

3.

Enter the details of the location to which you wish to relocate the
chart.

4.

Select the OK button.

84 Solar Fire 5: Working With Chart Data

5.

The relocated chart will be added to the list of Calculated Charts on
the Main Screen.

W

To cast a Geodetic or Johndro type chart

1.

Choose Locality... from the Chart menu.

2.

Select the required chart type from the Chart Type to Generate.

3.

Enter the details of the location for which you wish the chart to be
calculated.

4.

Select the OK button.

5.

If you have selected a User Geodetic chart type, then you will be
prompted to enter the terrestrial longitude at which you wish the
zodiac to start. In standard Geodetic charts, this longitude is 000W00
(i.e. the Greenwich meridian).

6.

The Geodetic or Johndro chart will be added to the list of Calculated
Charts on the Main Screen.
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Chapter 10: Saving Charts to a File
This chapter describes how to save a calculated chart to a chart database
file, so that it may be opened again in subsequent sessions with the Solar
Fire program.
You save charts of all types created in Solar Fire apart from multiple
composite charts. Although these types of charts cannot be saved to a chart
database file, you may still retain them for use in subsequent sessions of
Solar Fire. See page 89 for details on how to retain charts.
The Chart Details display box on the Main Screen indicates whether or
not the chart can be saved, and if it can be saved, whether it has already
been saved or retained.
It is possible to save as many copies of a chart as you wish, either to the
same chart file or to a different one. (See page 211 for information about
how to create new chart files.)
Note that if the Auto Chart Save option is switched on, then all new or
edited charts will be saved automatically to the currently selected chart file
as soon as they are cast. See page 369 for more information about this
option.
W

To save one or more charts from the Main Screen

1. Select the required chart or charts from the list of Calculated Charts
2. Select the Save to File... item from the Chart menu
3. If you are saving a single selected chart, and that chart is already saved,
then a dialog box will appear asking you to confirm whether you wish
to save another copy of the chart. If you are have selected more than
one chart to save, then you will not be asked to confirm whether to
reserve any saved charts - all selected charts will be saved to the
selected chart file regardless of whether or not they have been
previously saved.
4. The File Manager will appear, listing all of the available chart database
files. Select the required chart file from this list, or click on the Create
button to create a new empty chart file, and then click on the OK
button.
W

To save the currently displayed chart in the “View Chart” screen

Select the Save button and then follow step 4 above.
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W

To save a chart before exiting from Solar Fire

When you exit from Solar Fire you will be asked whether you want to save
any charts that have not yet been saved. To save the chart(s), select the Yes
button. You will be shown the details for each unsaved chart and given the
chance to save it. Selecting Yes will save it, No will not save it, and
Cancel will return you to Solar Fire without exiting.
Note: All charts saved by this method are saved to the currently selected
chart file. If you want to save the chart to a different file, you must select
the Cancel option to return to the Main Screen, and then follow the above
instructions for saving a chart from the Main Screen.
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Chapter 11: Manipulating Calculated
Charts
As soon as you calculate a chart or retrieve a chart from a chart file, the
name of the chart is added to the “Calculated Charts” list on the Main
Screen. A calculated chart is open and ready to view, see reports on, cast
subsidiary charts from, and print. Calculated charts may or may not have
been saved to a file.
This section describes certain file-type manipulations that you can do with
calculated charts, even though they may not yet have been saved to a file.
If a calculated chart has not already been saved, it can be saved after being
edited or retained. Once an unsaved chart is removed from the list of
“Calculated Charts”, it cannot be saved or retrieved.

Editing a Calculated Chart
This section describes how to copy and edit, or edit and replace, a natal or
event chart that appears on the list of "Calculated Charts" on the main
screen. It is not possible to edit any type of chart other than a natal or event
chart or its equivalent. If you wish to alter any other type of chart you will
have to use one of the subsidiary chart options such as Progressed, Return,
Harmonic, etc.
It is also possible to copy and edit, or to edit and replace a chart that is
already stored in a chart file. For instructions on how to do this, see page
54.
W

To copy and edit a natal type calculated chart
1.

From the main screen, select the required chart in the list of
“Calculated Charts”.

2.

Select the Copy and Edit... item from the Chart menu. (If the
selected chart is not editable, then this option is disabled).

3.

The “New Chart Data Entry” dialog box will appear, displaying
the details of the selected chart.

4.

Type over whatever details you wish to change.

5.

Select the OK button. An edited copy of the original chart will be
created and added to the list of calculated charts. The original
chart will remain in the list.
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W

To edit and replace a natal type calculated chart
1.

From the main screen, select the required chart in the list of
“Calculated Charts”.

2.

Select the Edit... item from the Chart menu. (If the selected chart
is not editable, then this option is disabled).

3.

The “New Chart Data Entry” dialog box will appear, displaying
the details of the selected chart.

4.

Type over whatever details you wish to change.

5.

Select the OK button. An edited copy of the original chart will
replace the original chart on the list of calculated charts.

Deleting Charts from the List of Calculated
Charts
This section describes how to remove one or more charts from the list of
"Calculated Charts". You might wish to do this if you already have a large
number of charts calculated, and wish to reduce the list of charts to a more
manageable size. Any type of chart may be deleted.
W

To remove one or more charts from the list of “Calculated Charts”

1. Select the required chart(s) from the list of "Calculated Charts"
2. Select the Delete... item from the Chart menu
3. A dialog box will appear, asking you to confirm whether or not you
wish to delete the selected charts. If you select the OK button, then the
charts will be removed.

Retaining Charts
This section describes how to retain or remove a selection of calculated
charts to appear automatically in the list of Calculated Charts in subsequent
Solar Fire sessions.
Retained charts are different from saved charts in that any types of
calculated charts may be retained, whereas multiple composite charts may
not be saved to file. Also, retained charts are stored with all the planetary
positions pre-calculated, whereas charts saved to file must have their
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planetary positions re-calculated each time that the chart is opened.
Retained charts use much more disk storage than saved charts - about 3000
bytes for each chart, whereas saved charts use only about 300 bytes.
Typically it is useful to retain only a small number of charts that you like
to work with frequently. Retaining a large number of charts uses a lot of
space and clutters up the list of calculated charts. For example, if you
frequently work with your own and your partner’s charts, then you might
like to retain both of your natal charts plus your composite chart, and
perhaps also your current solar return charts.
W

To retain charts for subsequent sessions of Solar Fire

1. Select the required charts from the list of "Calculated Charts"
2. Select the Retain Charts... option from the Chart menu
3. This will display a dialog box asking you to confirm whether or not you
wish to retain the selected charts. If you select the OK button, then the
selected charts will be retained for subsequent sessions. If you already
had retained charts prior to making this new selection, then the old
selection will be overridden.
W

To clear the retained charts

1. Select the Clear Retained... option from the Chart menu
2. This will display a dialog box asking you to confirm whether or not you
wish to clear the selection of currently retained charts. If you select the
OK button, then no charts will be retained for subsequent sessions.
Note that these options have no effect on the list of calculated charts during
the current session. They only take effect when Solar Fire is next started
up.
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Chapter 12: Converting Chart Files
This chapter describes how you can use Solar Fire's Chart Conversion
Utility to import and/or export natal type charts to or from chart files
created by Solar Fire or various other astrological software, as well as
sending chart details to text files.
Note that you can also export planetary type data such as longitudes and
latitudes – please refer to page 101 for further details.
Most charts produced by Astrolabe and Matrix Blue*Star or QuickCharts
compatible software may be imported into Solar Fire format. The
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capability to import other types of chart files may also be added at a later
date. If you have Nova, Chartwheels, Professional Natal Report, Blue*Star,
or QuickCharts, and you have calculated and saved important natal charts
using these programs, Solar Fire can import them into its own chart file
format.
This utility searches for and processes only the natal chart records in your
chart files. It does not import or export derived-type charts such as
progressed charts, solar and lunar returns, and composite charts, for
example.
Note: The ASCII text data that can be imported or exported using this
utility can consist only of chart details such as name, date, place, timezone
etc., and cannot include planetary or house data such as planetary and
house cusp longitudes, declinations etc. If you wish to export planetary
type data from Solar Fire, then you must use the Export Charts as Text…
item from the Chart menu, instead. See page 101 for further details.
Note: Solar Fire is able to open, read and save charts in Nova type chart
files directly, without the need to import or export chart files. Hence, if you
are using Nova type chart files, then you do not need to import or export
using this utility them unless you want to do so.

Chart Files You Can Import From
You can import natal type charts from any of the following types of chart
files.
•

Solar chart files - This feature is useful for importing charts
created in current or earlier versions of Solar Fire (v1/2/3/4/5),
Solar Maps, Solar Spark or Solar Writer.

•

JigSaw project files – JigSaw v1 or v2 project files have the
extension .DAT.

•

Nova chart files - Nova and Nova-series software has charts in
files with the extension .NOV. Example: FRIENDS.NOV.

•

Blue*Star chart files - Blue*Star saves charts in files with the
extension .RND.

•

QuickCharts chart files - QuickCharts saves charts in files with
the extension .QCK.

•

ASCII files – These can be text files that contain chart data in
fixed length or comma quote delimited format, with a file
extension of .ASC, .TXT or .DAT.
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•

Other file formats - Any additional file formats which are added
after publication of this manual

Note: This utility cannot import Win*Star charts directly. However, if you
convert your Win*Star charts into QuickCharts format first (or
alternatively into an ASCII text file), then these charts may be imported
with this utility.

Chart Files You Can Export To
You can export natal type charts to any of the following types of chart
files.
•

Solar Fire v5 chart files

•

Solar Fire v3/v4 chart files

•

JigSaw v2 project files

•

ASCII files – These can be flexibly defined to contain selected
chart details in fixed length or comma quote delimited format.

Starting the Solar Fire Chart Conversion Utility
W

To start the utility

From the Start / Programs / Solar Fire v5 menu, select the Chart
Conversion item.
After the utility loads, Solar Fire displays a chart conversion dialog
containing three tabbed dialogs.
•

Import From - To select the file from which data will be read

•

Save To - To select the file to which data will be exported or
written

•

Options – To select various conversion options
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Import From
W

To select the file to import from
1.

Select the required File Type from the Chart Type to Import
From drop-down list box. This selection determines which file
types will be visible in the file list below.

2.

Select the required Drive from the drop-down list of drive names.

3.

Select the required Directory or Folder by navigating through the
directories/folders. Each time you change the directory or folder,
the list of files available to import from will be updated, to reflect
the newly selected location. When you have selected the required
directory or folder, all the files of the selected chart type that are in
that folder will be listed in the file list.

4.

Select the required file from the file list. When you do so, the
“Import From” box at the bottom of the dialog will be updated to
give the full path and file name of your selected file.

Save To
You have the option of saving or exporting charts either into a new file, or
to be appended to an existing file.
W

To select the file to save or export to
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1.

Select the required File Type from the Chart Type to Save Into
drop-down list box. This selection determines which file types
will be visible in the file list below.

2.

Select the required Drive from the drop-down list of drive names.

3.

Select the required Directory or Folder by navigating through the
directories/folders. Each time you change the directory or folder,
the list of existing files of the selected type will be updated, to
reflect the newly selected location. When you have selected the
required directory or folder, all the files of the selected chart type
that are already in that folder will be listed in the file list. If you
are importing chart for use in Solar Fire, then you should select
Solar Fire’s USERDATA directory (or whichever other directory
you are using to store its chart files).

4.

If you wish to save your charts into a file that already exists, then
select the required file from the file list.

5.

If you wish to save your charts into a new file, then enter a new
file name into the File Name to Save Into box. When you do so,
the “Save To” box at the bottom of the dialog will be updated to
give the full path and file name of your selected file. If you omit
the file extension, then the correct extension type will be
appended to the file name automatically when the file is created.

Options
New Solar Fire Chart Files
This option is used only when you are saving charts into a new Solar type
chart file. It determines the internal format of any Solar type chart file
which is created by this utility.
•

Create v3/4 format chart files – Newly created chart files will be
compatible with Solar Fire v3, v4 and v5, but when used with
Solar Fire v5, cannot be used to store non-natal type charts, chart
ratings or source comments. Choose this option if you wish to
create chart files that can be used by owners of Solar Fire v3 and
v4.

•

Create v5 format chart files - Newly created chart files will be
fully compatible with Solar Fire v5, but cannot be used with any
older version of Solar Fire.

Default House System
This option is used only when you are saving charts into a Solar type chart
file.
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The default house system that is selected in this drop-down list is applied
whenever the chart data that is being imported does not have a house
system stored with it, or has a house system that is not recognised in Solar
Fire.
If the Force all converted charts to use this house system option is
checked, then all imported charts are given the default house system,
regardless of what house system may be stored in the imported chart.
Default Zodiac
This option is used only when you are saving charts into a Solar type chart
file.
The default zodiac that is selected in this drop-down list is applied
whenever the chart data that is being imported does not have a zodiac
stored with it, or has a zodiac that is not recognised in Solar Fire.
If the Force all converted charts to use this zodiac option is checked,
then all imported charts are given the default zodiac, regardless of what
zodiac may be stored in the imported chart.
Default Coordinates
This option is used only when you are saving charts into a Solar type chart
file.
The default coordinate system that is selected in this drop-down list is
applied whenever the chart data that is being imported does not have a
coordinate system stored with it, or has a coordinate system that is not
recognised in Solar Fire.
If the Force all converted charts to use these coordinates option is
checked, then all imported charts are given the default coordinate system,
regardless of what coordinate system may be stored in the imported chart.
ASCII Format to Use
This option is used only when you are importing from or exporting to an
ASCII text type chart file.
You can either select a pre-defined ASCII format from the drop-down list,
or click on the Edit ASCII Formats… button to create new ASCII format
definitions, or edit or browse existing ASCII format definitions.
See page 103 for instructions on editing ASCII format definitions.

Converting Charts
Once you have selected all the required options, you can start the
Chapter 14: Exporting Data to Text Files 95

conversion by clicking on the Convert button.
If the Save To file already exists, then you will be prompted whether or
not you wish to append new charts after any existing charts in that file.
When the process has finished, you will be notified how many charts were
successfully converted.
Note: If you import a Solar Fire chart file, then any comments associated
with the charts in that file will also be imported.
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Chapter 13: Emailing Charts
This chapter explains how to send chart files and chart data by email, either
from Solar Fire’s main screen, or from the “Chart Open” dialog.
You can send data directly from within Solar Fire provided that you have a
MAPI compliant email program.
If you do not have a MAPI compliant email program, then Solar Fire will
generate files that you can attach to your emails manually, instead.

About MAPI
MAPI is a mail automation protocol that allows third party programs to
automate the generation of email.
In order to use these automated email options, you must have a MAPI
compliant email program. All Microsoft email programs (eg. Outlook and
Outlook Express) and Eudora are MAPI compliant, for example.
You may also need to ensure that the MAPI options are activated in some
email programs, for example in Eudora Pro v3, you may need to go into
the Tools / Options menu item, find the MAPI category, and ensure that
“Use Eudora MAPI server” is switched to either “When Eudora is
Running” or “Always”. If you are unsure about any of these options, you
should consult the documentation of your email program (eg. search for
“MAPI”), or contact the manufacturer of your email program.

Choosing How to Send Chart Data
You have several options regarding the format in which the chart data will
be sent. For example, you can send it as an attached chart file, or
alternatively with the chart details appearing as written text within the
body of your message.
The decision regarding how to send chart data depends mainly on whether
or not the intended recipient (or recipients) own Solar Fire v5:
•

All recipients own Solar Fire v5 - The best option is to send
your chart data as an attached chart file, because they will be
able to open the chart file automatically from their email
program. You might also consider including text chart details,
although it is not necessary.
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•

Some recipients might own Solar Fire v5 – The best option is
to send your chart data as an attached chart file, and also to
include the text chart details either in the body of the message
(best if there are not many charts), or as an attached chart file
(best if there are many charts). This will allow those who own
Solar Fire v5 to view the chart data easily using the chart file,
but will also allow those who don’t own Solar Fire v5 to view
the text details.

•

No recipients own Solar Fire v5 – The best option is to send
your chart data as text, either in the body of the message (best if
there are not many charts), or as an attached chart file (best if
there are many charts).

Sending Chart Files
When you send chart files as an attachment, you have the following
choices to make.
•

Whether to also include the chart details as text, and if so

•

Whether to include the text in the body of the message or as an
attached text file

•

Whether to include any chart comments along with the chart’s details

See page 369 for further information on how to select these options from
the Preferences dialog.
W

To send a chart file from the main screen

1.

Select the required chart/s from the list of calculated charts

2.

Select the Email Charts / As Solar Fire Chart File… item from the
Chart menu.

This will create a chart file containing the selected charts (and optionally
also a chart comments file containing any comments associated with these
charts), and start up your email program with these files already attached to
an outgoing email.
You will need to address the email, and optionally edit or append text to
the body of the message as required before sending it.
W

To send a chart file from the Chart Open dialog

1.

Optionally, select the required chart/s from the list of charts in the
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current chart file
2.

Optionally, click on the Email button to choose between the Selected
Chart Only or All Charts items.

3.

Click on the Email button and select the Send Solar Fire Chart File
item.

This will create a chart file containing the selected charts (and optionally
also a chart comments file containing any comments associated with these
charts), and start up your email program with these files already attached to
an outgoing email.
You will need to address the email, and optionally edit or append text to
the body of the message as required before sending it.

Sending Chart Details as Text
When you send chart details as text, you have the following choices to
make.
•

Whether to include the text in the body of the message or as an
attached text file

•

Whether to include any chart comments along with the chart’s details

See page 369 for further information on how to select these options from
the Preferences dialog.
W

To send chart details text from the main screen

1.

Select the required chart/s from the list of calculated charts

2.

Select the Email Charts / As Chart Details Text… item from the
Chart menu.

This will either create a chart file containing the selected charts details as
text (which may optionally also include any chart comments), and start up
your email program with these files already attached to an outgoing email,
or it will start up the email program with the chart details already included
in the body of the message.
You will need to address the email, and optionally edit or append text to
the body of the message as required before sending it.
W

To send chart details from the Chart Open dialog

1.

Optionally, select the required chart/s from the list of charts in the
current chart file
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2.

Optionally, click on the Email button to choose between the Selected
Chart Only or All Charts items.

3.

Click on the Email button and select the Send Chart Details as Text
item.

This will create a chart file containing the selected charts (and optionally
also a chart comments file containing any comments associated with these
charts), and start up your email program with these files already attached to
an outgoing email.
You will need to address the email, and optionally edit or append text to
the body of the message as required before sending it.
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Chapter 14: Exporting Data to Text
Files
This chapter describes how to export chart details and astronomical data
into text files or to the clipboard for pasting elsewhere. You have some
control over the format of the exported data, as well as a selection of what
types of data to include.
You are able to export data either for a selection of calculated charts from
Solar Fire’s main screen, or directly from an existing chart file.
W

To export data from a selection of calculated charts

Highlight the required charts in the list of charts on Solar Fire’s main
screen.
1.

Select the Export Charts as Text… item from the Chart menu.

This will invoke the Export Chart Data dialog.
W

To export data from an existing chart file

1.

Select the Open… item from the Chart menu

2.

If you only wish to export data for selected charts, then you must
highlight the required charts first.

3.

Click on the Export… button, and selected the required option from
the popup menu.

This will invoke the Export Chart Data dialog.
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Using the Export Chart Data Dialog
This dialog allows you to select various options relating to the process.
•

Types of Points – You can select any combination of the available
point types. Note that most point type names are followed by the
name of the current file selection for that point type. If you wish to
change the file selection for any point type, then you must return to
Solar Fire’s main screen to do so. If you select no types of points,
then only header lines with chart details will be exported.

•

Types of Data – You can select any combination of the available
types of data. If you are exporting data for more than one chart, and
you are not including header lines for each chart, then you will
probably wish to include “Chart Name”, so that you can identify
which data belongs to which chart.

•

Header Lines to Include – If you select the Column Titles option,
then the first line in the exported data will simply be a label for each
column included in the output, allowing you to identify which
column is which. If you select the Chart Details option, then there
will be an additional line at the beginning of each chart’s data, giving
showing certain chart details. The exact format of this line is dictated
by the selection in the drop-down list box below the Edit ASCII
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button. The Edit ASCII button can be used to edit or create new
formats defining how the chart details are written. See page 103 for
further details on this option.
•

Field Delimiters – Comma Quote (CQD) format can be read by
most other programs that allow data to be imported. It places any text
fields inside double quote marks, and separates the fields with
commas. Tab format is also quite common, and does not use quote
marks, but separates the fields with tab characters.

•

Destination – If you export to clipboard, then you can paste it into
another program. If you export to file, then you can specify a file
name and location first, by clicking on the Browse button.

When you have finished your selections, click on the Export button to
start the process. You will be notified with a message box as soon as it is
complete.
Hints
1.

If you wish to export the chart details only, without any astronomical
data, then ensure that no types of points are selected. This will result
in only the chart details lines being included.

2.

If you are exporting data for multiple charts, and wish to import it
into a spreadsheet, then it is best to include “Chart Name” as one of
the types of data, and not to include the “Chart Details” header line.
This is because the Chart Details header line has a different layout
from the other data lines, and will cause problems if you want to do
things like sorting the data in your spreadsheet.

3.

If you are exporting data for natal charts and subsidiary charts for the
same people, then include the “Chart Type” data type, so that you
can differentiate between the natal data and subsidiary data.

4.

If you intend to do a large export job to a file, then try it first with a
small number of charts and export it to the clipboard, so that you can
easily preview that data to check that it is formatted as you expect.

Editing ASCII Definitions
If your exported data contains chart details in addition to planetary type
data, then you must select an existing (or create a new) ASCII Data
Definition, which controls what types of chart data are exported, the order
in which items appear on a line, and the format in which they are written.
You can select an existing definition whenever needed by highlighting its
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name in the drop-down list of definition names. This drop-down box
appears on the Export Chart Data dialog as well as the Chart Conversion
Utility.
The ASCII Data Definition editor allows you to browse through the
existing definitions, as well as creating new ones or deleting old ones.
Note that ASCII Data Definitions are used for both exporting data from
Solar Fire, and also whilst using the chart conversion utility to import or
export chart files.
W

To enter the ASCII Data Definition editor

Click on the Edit ASCII… button.
This will display the ASCII Format Definitions dialog.

W

To Select a Definition To Browse, Edit or Delete

Click on the drop-down list labeled Definitions and select the required
item on the list by clicking on it.
W

To Delete a Definition
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1.

Ensure that the required definition is selected

2.

Click on the Delete Definition button

This will remove that definition from the list.

Specifying Record Format
Record formats may be either comma-quote delimited (CQD) or fixed
length.
CQD - All fields in each record must be separated by commas, and
character fields must be enclosed in double quote marks. If a line break
occurs before all the fields are read in, then it is assumed that the remaining
fields can be found on the following line/s. This format is commonly used
for data exchange with spreadsheets, where each field corresponds to one
cell in a row of the spreadsheet. eg.
“John Smith”,”1 Jan 1972”,”12:13 pm”,85.6312,42.9832
Fixed Length - Each field in the record is a fixed user-specified length, so
that the length of the full record is exactly equal to the sum of the length of
each field in the record. Each record must be terminated by a line break.
eg.
”John Smith

01011972 1213P 85E38 42N59

If you choose this option then you must specify the length of each field
individually so that the total record length is matched exactly. You can use
“Filler” fields if there are items in the record that are not relevant to the
data exchange.

Specifying the Fields in a Record
W

To add a new field to the record definition

Highlight the required field from the list of available fields and click on the
< button.
W

To delete a field from the record definition

Highlight the required field from the list of fields in the record and click on
the > button.

W

To change the position of a field in the record
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Highlight the required field from the list of fields in the record and click on
the Up or Dn button.
This will move the highlighted field up or down the list.

Available Fields
The available fields are:
•

Name/Description - A character string which contains a name for the
chart e.g. “John Smith”

•

Date (String) - A character string which contains a date for the chart.
This may be in any format that is understood by Esoteric
Technologies’ programs such as the Solar range and JigSaw eg. “1
Apr 1999”

•

Year - The year number, which can also be negative for BC years
(where 1BC = Year 0, 2BC = Year -1 etc.)

•

Month - The month number (1-12)

•

Day - The day number (1-31)

•

Time (String) - A character string which contains a time for the chart.
This may be in any format that is understood by Esoteric
Technologies’ programs such as the Solar range and JigSaw eg.
“12:59:17 pm”

•

Hour - The hour number (0-23)

•

Minute - The minute number (0-59)

•

Second - The second number (0-59)

•

AM/PM Indicator - A character string which flags whether the time is
AM or PM if its hour number is 12 or less. (The value of this flag for
recognizing PM times may be specified as an additional option.)

•

Zone Abbreviation - A character string which is a label for the time
zone (eg. “EST”, “ACDT” etc.)

•

Zone Time (String) - A character string which contains a timezone for
the chart. This may be in any format that is understood by Esoteric
Technologies’ programs such as the Solar range and JigSaw eg. “9:30”

•

Zone Time (Numeric) - The numeric value of the timezone in decimal
hours from GMT. The standard used in Esoteric Technologies’
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programs is to use a -ve number for times east of the Greenwich
Meridian eg. -9.5. (If you need to use the opposite convention, then
you can choose to reverse its sign automatically as an additional
option.)
•

Zone Time Hour - The hour number of the timezone (-13 to +13)

•

Zone Time Minute - The minute number of the timezone (0-59)

•

Zone Time Second - The second number of the timezone (0-59)

•

Place Name - A character string which contains a name for the place
of the chart e.g. “Adelaide”

•

Country/State Name - A character string which contains an additional
name for the place of the chart e.g. “Australia”

•

Longitude (String) - A character string which contains a longitude for
the chart. This may be in any format that is understood by Esoteric
Technologies’ programs such as the Solar range and JigSaw eg.
“84E59 59”

•

Longitude (Numeric) - The numeric value of the longitude in decimal
degrees. The standard used in Esoteric Technologies’ programs is to
use a -ve number for longitudes east of the Greenwich Meridian eg. 123.7891. (If you need to use the opposite convention, then you can
choose to reverse its sign automatically as an additional option.)

•

Longitude Degree - The degrees number (0-180)

•

Longitude Minute - The minutes number (0-59)

•

Longitude Second - The seconds number (0-59)

•

Longitude Hemisphere - A character string which flags whether the
longitude is East or West. (The value of this flag for recognizing
Western longitudes may be specified as an additional option.)

•

Latitude (String) - A character string which contains a latitude for the
chart. This may be in any format that is understood by Esoteric
Technologies’ programs such as the Solar range and JigSaw eg.
“35S55”

•

Latitude (Numeric) - The numeric value of the longitude in decimal
degrees.

•

Latitude Degree - The degrees number (0-90)

•

Latitude Minute - The minutes number (0-59)
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•

Latitude Second - The seconds number (0-59)

•

Latitude Hemisphere - A character string which flags whether the
latitude is North or South. (The value of this flag for recognizing
Northern latitudes may be specified as an additional option.)

•

Filler - Any character string or number. The value for the filler must
be specified as an option of the current field when it is selected.

Choosing the Appropriate Fields
You can select any combination of fields in any order, but there are certain
combinations of fields which are often used together, and some that are
incompatible with one another.
Dates
If the dates in the ASCII records are expressed in everyday date format (eg.
“31 Dec 1957” or “Dec 31 1957” etc.), then it will usually be possible to
use the Date (String) field, and there is no need to use any of the other date
related fields. However, if the dates in the ASCII records are split up into
year, month and day parts, then the Year, Month and Day fields should be
used instead.
Times
If the times in the ASCII records are expressed in everyday time format
(eg. “12:17pm” or “18:23:59” etc.), then it will usually be possible to use
the Time (String) field, and there is no need to use any of the other time
related fields. However, if the times in the ASCII records are split up into
hour, minute and second parts, then the Hour, Minute, Second and AM/PM
Indicator fields should be used instead.
Note: If no time field is present in the record definition, then the time
defaults to 12:00 (Midday) when data is imported.
Zone Times
If the zone times in the ASCII records are expressed in everyday time
format (eg. “-9:30” or “+5:00” etc.), then it will usually be possible to use
the Zone Time (String) field, and there is no need to use any of the other
zone time related fields. However, if the zone times in the ASCII records
are split up into hour, minute and second parts, then the Zone Hour, Zone
Minute, Zone Second fields should be used instead. If the zone times are
expressed in decimal hours, then only the Zone Time (Numeric) should be
used.
Note: If no zone time field is present in the record definition, then the zone
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time defaults to 0:00 (GMT or UT) when data is imported.
Longitudes and Latitudes
If the longitudes and latitudes in the ASCII records are expressed in
everyday time format (eg. “84W59 59”, “34S55 21” etc.), then it will
usually be possible to use the Longitude (String) and Latitude (String)
fields, and there is no need to use any of the other longitude and latitude
related fields. However, if the longitudes or latitudes in the ASCII records
are split up into degree, minute and second parts, then the Longitude and
Latitude Degree, Minute, Second and Hemisphere fields should be used
instead. If they are expressed in decimal hours, then only the Longitude
(Numeric) and Latitude (Numeric) should be used.
Note: If no longitude or latitude field is present in the record definition,
then they default to 0W00 and 0N00 when data is imported.
Fillers
Filler fields must be used in the following circumstances
•

Importing Data - when the input records contain an item which is not
relevant to the data required for import

•

Exporting Data - when the output record needs to contain an item
which is fixed in every record

Filler fields may have a default value specified for them. This default value
is ignored when the record definition is being used for imported data, but if
the same definition is ever used to export data, then that default value is
inserted into the output record in the position where the Filler field appears
in the definition.
Example:
Import
data
record:
“John
Smith”,”1
1972”,17.834,”12:13 pm”,85.6312,42.9832

Jan

The 3rd field in the record (17.834) is not relevant to the chart data, so the
third field in the definition of the CQD definition should be a Filler.
Suitable record definition for above record format:
•

Name/Description

•

Date (String)

•

Filler “0.0”

•

Time (String)
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•

Longitude (Numeric)

•

Latitude (Numeric)

If the same definition was used for exporting data, then this would produce
the following output record:
“John
Smith”,”1
PM”,85.6312,42.9832

Jan

1972”,0.0,”12:13

Limitations
It is not possible to create a definition for a file which contains records of
differing layouts. All records in the file must be of the same format.
Only those field types listed in the editor may be selected eg. if you have a
file which contains the time of day in decimal hours, this cannot be used,
because only files which contain integer hour/minute/second (eg. 12,13,00)
or time character strings (e.g. “12:13 pm”) can be selected as fields in the
record.
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Doing Astrology With Solar Fire

Chapter 15: Viewing Charts, Grids and
Pages
This chapter describes how to view charts, aspect grids or other page
displays for charts that appears on the list of "Calculated Charts" on the
main screen.
Before viewing a chart or its grid, it is necessary to have either cast or
opened the charts that you wish to use. If you have not yet done so, see
page 22 for instructions on casting a new chart, or page 54 for instructions
on opening an existing chart.

Viewing a Single Chart or Grid
Any type of chart that Solar Fire calculates can be viewed in wheel form or
in an aspect grid as follows.
W

To view a chart from the main screen

Select a chart on the list of "Calculated Charts".
Choose Current Chart... from the View menu, or Double click the mouse
on a chart on the list of "Calculated Charts".
W

To view an aspect grid from the main screen

Select a chart on the list of "Calculated Charts".
Choose Current Grid... from the View menu.
W

To view a chart and aspect grid on the same page, from the main screen

Select a chart on the list of "Calculated Charts".
Choose Current Chart+Grid... from the View menu.
W

To view a chart or grid whose image was the last one to be displayed

Choose Last Image... from the View menu.

Viewing MultiWheels and Synastry Grids
There are a variety of wheel and grid displays that show more than one
chart eg. biwheels, synastry grids, dual wheels etc.
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W

To view any displays which require more than one chart

Select the required option from the View menu. These options are
Dual Wheels - Two separate charts
BiWheel - Two concentric charts
TriWheel

- Three concentric charts

QuadriWheel - Four concentric charts
Synastry Grid - An aspect grid showing inter-chart aspects
Selecting any of these options will display the "Chart Selection" screen,
which allows two or more charts to be selected for viewing, printing or
reporting.
Chart Selection Dialog Box

W

To select the positions of charts on the multiwheels (or on the synastry
grid)

1. Select a wheel (or grid) position on the Selected Charts list box
2. Select a chart for this position from the Charts list box
3. Repeat above steps for each chart position
When a chart is selected, its name and type is written into the Selected
Charts list box. If there are further selections to be made, then the
highlight bar will move to the next wheel (or grid) position on the Selected
Charts list, ready for the next chart to be selected from the Charts list
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box. It is possible to change the selection of any chart by repeating the
above procedure as often as required. Whilst all the chart selections have
not yet been made, the View, Report and Print... buttons are disabled, and
cannot be used.
W

To clear all the selections that have been made so far

Select the Clear button. This will return the state of the screen to how it
appeared before any selections were made.
When all required charts have been selected, then the following options are
available.
W

To view the chart, grid or page

Select the View button. If this image has not already been created, then it
will create the image. Otherwise it will locate the old image, and in both
cases it will then display the desired image on the "View Chart" screen.
W

To print the chart, grid or page

Select the Print... button. This displays the "Print Chart" dialog box,
allowing the user to cancel printing, add the print job to the batch print
queue, to alter printer settings, or to print immediately. See page 22 for
more details on these options.
For dual wheels, biwheels, synastry grids and page displays which contain
2 charts only, a further option is available.
W

To view a report using the two selected charts

Select the Reports... button. This will display the "Report View" screen,
which allows a variety of synastry reports for the selected charts to be
browsed, edited or printed. See page 164 for further details about synastry
reports. The same set of synastry reports is generated regardless of whether
the user has selected the biwheel, synastry grid or other user defined page
option.
Reports are not available for triwheels or quadriwheels or other pages that
contain more than two charts. (It is possible, however, to generate reports
on the individual charts in a multiwheel by selecting the appropriate
options from the main screen menu.)

Viewing Pages
There are a variety of supplied and customizable pages that may show one
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or more charts and other astrological data in ways that are not possible
from any of the other display options in Solar Fire. For example, a page
may display a single wheel in a non-standard scaling and positioning, or
may display multiple wheels, grids or tabulations on a single page.
W

To view any page

From the main screen
Select the Page Topic Index... option from the View menu. This will
display the Page Selection by Topic dialog box, listing all available page
layout files categorized by topic. If you select a page layout file that
displays the same number of charts as are already selected in the list of
calculated charts, then it will display that page immediately, using the
currently selected charts. Otherwise the "Chart Selection" screen will be
displayed, which allows the charts to be selected prior to viewing the page.
•

From the View Chart screen

Select the Pages… button (or make a right hand mouse button click over
the list of images at the top right of the screen). This will display the “Page
Selection by Topic” dialog box, listing all page layout files that use the
same number of charts as the currently displayed page type. When you
have chosen a page, you have the option of selecting the View button to
preview the new page without creating a new image, or selecting the OK
button to create a new image and close the Page Selection dialog.
W

To view any of the four most recently viewed page types

From the main screen, select the name of the required page from the list in
the View menu underneath the User Defined Page... option. This list is
empty the first time you run Solar Fire, but is updated each time you view
a user-defined page, and is retained from one session on Solar Fire to the
next.
The user may change the appearance of any existing pages, and new pages
may be created from scratch. See page 294 for more information.

Using the Page Topic Index
The Page Topic Index is a dialog that contains a list of displayable wheels
and pages, categorized into various topics, in a collapsible/expandable list.
You have the ability to select pages from this list to view or preview, and
to re-organize the arrangement and names of topic categories as you wish.
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W

To add a new topic category

Click on any topic category name and use the right hand mouse button to
display a pop-up menu, and select the Add Topic item.
This will display a dialog allowing you to enter the new category name
W

To rename a topic category

Click on the topic category name and use the right hand mouse button to
display a pop-up menu, and select the Rename Topic item.
This will put a focus box around the topic category name and allow you to
edit it.
W

To move a page from one category into another

Simply drag the page description onto another topic category name.
If the topic category you wish to move to is off the top or bottom of the
page, then drag the page off the top or bottom of the list. This will cause
the list of pages to collapse, and scroll up or down respectively, thus
making the required target topic category visible.
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W

To refresh the list of pages after creating a new page or editing a page
title

Use the F5 key.
This is the standard Windows key for refreshing lists of files.

Shortcuts for Viewing Multiple Wheels or Charts
It is possible to expedite the process of viewing wheels, grids and pages by
selecting multiple charts from the list of Calculate Charts before selecting
the required viewing option.
W

To create chart wheel images for several charts at once

1. Select all of the required charts from the list of Calculated Charts on the
Main Screen.
2. Select the Current Chart menu option from the View menu.
An image will be created for each of the selected charts without any further
action n your part.
W

To view a biwheel without using the Multiwheel selection screen

1. Select all of the required charts from the list of Calculated Charts on the
Main Screen.
2. Select the BiWheel menu option from the View menu.
An image of the biwheel will be displayed immediately. The first chart on
the list of calculated charts will be on the inner wheel. If you want to
reverse the order of charts, then you can select the Swap button.
W

To create images for several biwheels at once

1. Select all of the required charts from the list of Calculated Charts on the
Main Screen.
2. Select the BiWheel menu option from the View menu.
An image will be created for each pair of selected charts. The first chart of
each pair will be on the inner wheel. If you want to reverse the order of
charts, then you can select the Swap button.
The same principle applies for any selectable page as well. For example, if
you have an eight-wheel page, then you can select the eight charts from the
list of Calculated Charts in order to avoid having to select them later in the
Multiwheel selection screen. The main limitation of this shortcut is that the
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charts are always taken in the order in which they appear in the list of
Calculated Charts.
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Chapter 16: Using the View Screen
Features
The View Chart Window

If you are viewing a chart or page for the first time, then its image will be
drawn according to the currently selected chart options, and the chart's
reference number will be added to the list box on the top right hand side of
the screen.
If you are viewing a chart or grid whose image has already been created
previously, then its existing image will simply be redisplayed.
W

To change any of the display options

Place the mouse over any part of the displayed chart or page image and
click on the right-hand mouse button. This will display a pop-up menu
containing the same items as the main screen's Chart Options (such as
displayed points, aspect set, color schemes etc.) from which you may select
any items to change with the left-hand mouse button, as usual. See page
332 for instructions on altering chart options. After you have changed any
display options, select the ReDraw button in order to regenerate the image
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using the current set of chart options.
W

To view any other previously created image

Select the desired chart or page item from the list box. The image of the
selected chart, grid or page will be displayed in place of the last image.
It is possible, during computation of a chart or grid image, that the
computer may run out of video memory. In this case an error dialog box
will appear, notifying the user of the problem. If this happens, you can take
several different corrective steps. The first time that this happens, it might
still be possible to generate the image despite the error. To try to generate
the image despite the problem, select the ReDraw button. If the error
recurs, then use the following procedure. Firstly, print all the chart images
that you wish to keep (or add them to the batch print queue), and then from
the main screen. Then select the Clear Images... option from the View
menu. This will delete all the chart, grid and page images that have been
created so far, and free up all associated memory. You can then proceed
normally again.
Whilst viewing a chart, there are a number of buttons and controls that may
be used for various purposes. Some of these, such as the Rectify button or
the Save button may be used when a single chart is being viewed, and
others, such as the Swap button, when multiple charts are being viewed.

Using View Screen Buttons
ReDraw - This option causes the displayed page to be redrawn according
to the current settings and display options.
Swap - This option is only available for page displays involving two or
more charts. It causes the displayed charts to be swapped or cycled. For
example, if you are displaying a biwheel, then the inner and outer charts
are swapped. If you are viewing a quadriwheel, then each time you use this
option, the innermost chart moves to the outermost position, and the others
charts are moved inwards correspondingly.
Rectify - This allows you to easily and interactively edit the date, time,
Ascendant, Midheaven, latitude or longitude of the chart (or of the first or
innermost chart on the page if there are multiple charts). It is described
fully on page 120.
Save - This allows the displayed chart to be saved to a file. It is fully
described on page 86.
Reports - This invokes the Reports screen, which is fully described on
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page 150.
Transits - This invokes the Dynamic Report Selection screen, which is
fully described on page 165.
Copy - This invokes a “Copy Image To” dialog that allows you to select
whether to send the currently displayed image to the clipboard, to a file, or
to an email attachment, with various selectable options. See page 126.
Print - This allows the displayed image to be sent to your printer, or to the
print queue for printing later. You can also alter printer settings before
printing, if desired.
Pages – This displays the “Page Selection by Topic” dialog, allowing you
to select other page types to preview or display.
Charts – This displays the chart selection dialog, allowing you to select
alternative charts to be displayed with the currently displayed page type.
Wheel Style – If the currently displayed page has only one wheel type
displayed, then this will display the File Manager with a list of wheel style
files that you can select for this wheel type. If there is more than one wheel
type displayed on the current page (eg. a uniwheel and a biwheel), then this
will display the Chart Options menu, from which you can choose one of
the wheel style types.

Adjusting a Chart to a new Time or Date
This section describes how to use a rectification assisting tool to adjust the
date, time or angles of a natal or event chart. (If the chart that you are
displaying is not a natal or event type chart, then the Rectify... button will
be disabled.)
W

To adjust a chart

1.

Display the chart that you wish to rectify in the "View Chart" window.
(If you are viewing a multiwheel, then make sure that the chart you
wish to rectify is the first charts listed, which is usually the innermost
chart.)

2.

Click on the Rectify... button

3.

This will display the "Rectify Assist" dialog box.
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Rectify Assist Dialog Box

W

To adjust the chart’s date

Click on the spin button next to the Date box to change the date by 1 day
at a time, or type a new date directly into the box.
W

To adjust the chart’s time

Click on the spin button next to the Time box to change the time by
whatever interval is selected in the Time Step Interval box, or type a new
time directly into the box. (You can make the Time Step Interval box
visible by clicking on the More button.)
W

To adjust the chart’s MC or Asc

Click on the spin button next to the MC or Asc box to change the angle by
whatever interval is selected in the Angle Step Interval box, or type a new
time directly into the box. (You can make the Angle Step Interval box
visible by clicking on the More button.)
W

To adjust the chart’s latitude or longitude

1.

Click on the More button to make the Lat and Long boxes visible.

2.

Click on the spin button next to the Lat or Long box to change the
angle by whatever interval is selected in the Angle Step Interval box,
or type a new latitude or longitude into the box.

Whenever you adjust any of the values, then the data displayed in each of
the other boxes is updated automatically to ensure inter-consistency
between them. For example, adjusting the MC by 1 degree will cause the
time to shift by 15 seconds.
Note that if spin buttons are used to pass the time forward through
midnight, then the date is automatically incremented by one day. If the
time passes backwards through midnight, then the date is automatically
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decremented by one day.
Angles can be entered in degrees, minutes and seconds (eg. "133 24 20") or
in zodiacal annotation (eg. "13 Cn 24 20"). For more information on
entering angles see page 384.
Time can be entered in hours, minutes and seconds and include an am/pm
indicator (eg. "7:30" or "2:23pm"). See page 31 for more details.
W

To preview the effect of the changes on the chart image

Click on the View button. This will create a new calculated chart, and
replace the chart image with an image using the new chart, but leave the
“Rectify Assist” dialog box where it is for further adjustments to be made.
W

To apply the changes and return to the Chart View screen

Click on the OK button. This will create a new calculated chart, and
replace the chart image with an image using the new chart, and The
“Rectify Assist” dialog box will disappear.
You may repeat these procedures as many times as you wish with the same
chart image, but note that each time you display an adjusted image, a new
calculated chart is created. Any new chart calculated this way will be
unsaved (unless you have switched on the Autosave option), so you may
wish to save it before proceeding by clicking on the Save button.

Using Dials and Pointers
It is usually possible to alternate between displaying a chart wheel and a
dial display of the same chart or charts by simply selecting the desired
option with the mouse from the Wheel/Dial drop-down list. The style of
wheel or dial that is displayed depends on whatever is selected as the
default style under the Wheel Styles... and Dial Styles... of the Chart
Options menu.
This option has no effect if the displayed page is one that uses a
specifically named wheel or dial style. However, if you are using any of
Solar Fire’s pre-defined displays from the View menu, such as the Biwheel
or Wheel+Grid options, or if you are using an ordinary page layout which
uses default display styles, then this option will work as expected.
Whenever a dial is displayed, a pointer is displayed in the middle of the
innermost chart in the dial. Initially this pointer will be pointing to the zero
point on the dial scale. You can move the pointer in a variety of ways, set
an orb for the display of midpoints, and select which chart the pointer is
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associated with. Before any of these things can be done, you must first
switch on the pointer options box.

W

To switch on the pointer options box

Click anywhere inside the innermost chart of the dial that you want to use.
If the page you are viewing has more than one dial on it, then the pointer
options box will only appear inside one dial at a time. Clicking on another
dial will switch it off in the previous dial, and switch it on in the newly
selected dial.
W

To step the pointer around the dial

1 Click on the Options button in the pointer options box to see the dropdown menu
2 Select one of the following Step options
• Step by Degree - Step by one degree on the dial scale at a time
• Step by Minute - Step by one minute of a degree on the dial scale
at a time
• Step by Planet - Step to the next planet position on the dial
3 Click on the left or right arrows on the spin button above the options
button. Each click will step the pointer to the next degree, minute or
planet position on the dial, depending on which step option was chosen.
If the dial is a multiwheel, then the pointer will always initially be
associated with the innermost chart in the dial. However, you can select
another chart to use the pointer with, as follows.
W

To select which chart to use the pointer with
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1 Click on the Options button in the pointer options box to see the dropdown menu.
2 Select one of the charts listed at the bottom of the menu.

When the pointer reaches a position where it is at the midpoint of two
planets, then a solid red line is drawn between those two planets. If those
two planets also happen to form an aspect in the chart, then a dashed line is
drawn from each planet to the center of the dial. The dashed line takes on
the same color as the color of the aspect is formed, according to the current
selected aspect colors.
In addition to the lines which appear, a midpoint tree is displayed
underneath the options box indicating which planets are forming the
midpoint to the pointer position, and if an aspect is formed, then the aspect
symbol is also displayed.
In the example shown, the pointer is pointing to 78°32’, and this is the
midpoint of the Ascendant and Venus, and also of Neptune and the Moon.
Additionally, Neptune and the Moon are in quincunx (150°) aspect.
Initially the orb for midpoints and aspects is set to 1°00’. However, you
can change this orb. The orb is measured in terms of a 360 degree circle,
regardless of the modulus of the dial, so a 1 degree orb corresponds to 1/4
degree on the dial scale of a 90 degree dial, and to 1/8 degree on the dial
scale of a 45 degree dial, for example.
W

To change the orb of the midpoint tree in the dial

1 Click on the Options button in the pointer options box to see the drop124 Solar Fire 5: Doing Astrology With Solar Fire

down menu.
2 Select the Change Orb... option.
3 This will display a dialog box which allows you to enter the orb that
you require, in decimal degrees or degrees and minutes, separated by a
space.
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Chapter 17: Copying, Publishing and
Sending Graphics
You can copy any of Solar Fire’s chart displays and graphic ephemerides
to the Windows clipboard (to be pasted into another program), to a file
anywhere on your computer or network, or to a file which is automatically
attached to an email ready to be addressed and sent. Various graphic file
formats may be used, as well as some other options governing the
appearance of the output.
W

To copy, publish or send a graphic

•

From the Chart View screen, select the Copy button

•

From the Graphic Ephemeris screen, select the Copy menu item after
using the right hand mouse button over the ephemeris area

This will display the “Copy Image To…” dialog, allowing various
selections to be made.

Destination
•

Clipboard – This will send the graphic to the Windows clipboard,
from where it can be pasted into any other program which recognizes
the graphic type. For example, you can paste it into a word processor
or desktop publishing program.

•

File – This will send the graphic to a file of your choice. You will be
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prompted to specify a file name and location.
•

Email attachment – This will generate a graphic file that is
automatically attached to an outgoing email, ready to send, provided
that you have a MAPI compliant email program. See page 97 for
further details.

Graphic Type
•

Bitmap – This will create a bitmap file, which is a fixed resolution
graphics file used in many Windows applications. This type of
graphic may be placed and scaled in some other application, but as it
has a fixed resolution, doing so may cause some loss of image
quality. Typically this type of file is rather large (often over 1Mbyte),
and is therefore not usually suitable for sending over the internet,
unless it is first zipped or compressed in some way.

•

Metafile - This will create a Windows metafile, which is a scaleable
graphics file used in many Windows applications. It is possible to
place and scale the graphic to your requirements without loss of
image quality, using the commands of the application that you are
using. Hence this format is good for high quality desktop publishing.
This type of file is usually very small in size, but it has the
disadvantage that if you send it over the internet, the recipient must
have the required Solar Fire fonts installed on their machine, or else
they will see incorrect symbols in place of any astrological glyphs.

•

JPEG – This will create a JPEG file, which is a somewhat like a
compressed bitmap file. This type of graphic may be placed and
scaled in some other application, but as it has a fixed resolution,
doing so may cause some loss of image quality. Typically this type
of file is fairly small, and is well suited to sending over the internet.

Special Options
• Include Captions - When copying to a Metafile format, it is possible
to select whether or not the chart details and compliments text are
included in the output. Sometimes, for desk-top-publishing
requirements, it is preferable to have the chart on its own without any
text, and for any captions to be added separately to the document.
•

Monochrome - When copying to a Metafile format, it is possible to
select whether or not the generated graphic should be in the currently
displayed color scheme, or in monochrome (black lines and text only).
As many publications are only in monochrome, this option makes it
easy to ensure that the graphic is in an appropriate format.

•

Quality – When copying to a JPEG format, it is possible to choose the
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level of trade-off between quality and size of the graphic. The range is
1 (lowest quality, smallest storage size) to 100 (highest quality, largest
storage size). Typically, a value of 50 provides an adequate level of
quality without using too much storage. If you are sending graphics
which have a lot of detail and small text, you may wish to increase the
quality, whereas if the graphic does not have much fine detail, and
only has large glyphs, then you might be able to economize by
decreasing the quality.
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Chapter 18: Viewing Interpretations
Solar Fire contains text on a large variety of astrological topics, including
the meanings of certain astrological archetypes, plus interpretations of
planets in signs, houses, in aspect to one another etc. You may view any of
the text by opening the interpretations window. This can be done either
from the main screen of Solar Fire, or from the "View Chart" screen.
Solar Fire is supplied with three separate sets of interpretations – for natal
charts, for synastry between two charts, and for transits to a natal chart.
Solar Fire allows you to create or use sets of interpretations of the
following types:
•

Natal - Supplied with Solar Fire

•

Progressed

•

Return

•

Combined

•

Prenatal

•

Synastry (Natal to Natal) - Supplied with Solar Fire

•

Transits to Natal - Supplied with Solar Fire

•

Progressions to Natal

•

Directions to Natal

When you open the interpretations window, Solar Fire automatically
detects which category of interpretations is required in the current
circumstances, and opens that interpretations file. For example, if you are
viewing a Solar Return chart when you open the interpretations window,
then Solar Fire will open the interpretations file that has been selected to
apply to Return charts.
When Solar Fire is first installed, most of the categories are set to use the
standard natal interpretation set. Only the Synastry and Transits to Natal
category use a different set. In order to change which set of interpretations
Solar Fire will use for each of the above categories, you must change the
appropriate settings on the Interpretations Files option of the Interps
menu. See page 141 for instructions on how to do this.
You can use any set of interpretations with any type of chart if you wish to,
for example using the natal interpretations for a progressed chart, return
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chart or composite chart. However, if you do so, then you will need to bear
in mind that some of the interpretations will not apply in the same way as
they would to a natal chart. It is also possible, in the future, that you will be
able to purchase alternative sets of interpretations which are written in
different styles, or which apply to different chart types.
You can edit the existing text or create you own new set of interpretations
by using a separate utility program which is supplied with Solar Fire. For
instructions on how to use this, see page 390.
The interpretations window has two modes of operation:
General Mode - In this mode, you can browse through every possible
combination of interpretation and definition text.
Current Chart Mode - In this mode, you are limited to browsing through
interpretation relating solely to the current chart. (The current chart is
whichever chart was last selected from Solar Fire's main screen, or the
chart which you were displaying in the "View Chart" screen
immediately before opening the interpretations window.

Opening the Interpretations Window
W

To open the interpretations window from the main screen

Choose the View... item from the Interps menu
If there are any calculated charts in the main screen's list of calculated
charts, then the interpretations window will open in Current Chart Mode
and initially contain text relating to the current chart. If there are no charts
calculated yet, then the interpretations window will open in General Mode
and initially contain general definitions text.
You can open the interpretations window from the "View Chart" screen
provided that you are displaying at least one single wheel or multiwheel
chart. However, it is not possible to open the interpretations window from
this screen if you are only displaying a grid.
W

To open the interpretations window from the “View Chart” screen

You must be displaying at least one chart in a single or multi-wheel - you
cannot open the interpretations window if you displaying only a grid or
other tabulations. The interpretations window will appear when you click
on parts of the wheel as follows:
1. Double-click on any displayed chart point (i.e. planet, asteroid or
angle glyph). This displays an interpretation of that chart point in its
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house and sign eg. Jupiter in the 11th House in Cancer. If this is a
multi-wheel, then the house placement is based on the houses of the
anchor chart, which is usually the innermost chart.
2. Double-click on the degrees, sign glyph or minutes of any chart
point. This displays information about the degree occupied by that
chart point eg. 17th degree of Pisces.
3. Double-click on a sign glyph on any house cusp. This displays an
interpretation of the selected house when ruled by its sign eg. Leo on
the 3rd house cusp.
4. Double click on the degrees or minutes of any house cusp. This
displays information about the chart degree of that house cusp eg. 3rd
degree of Aries.
5. Double-click on any unoccupied space inside a house. This displays
information about the meaning of that house eg. the 7th House.
6. Double-click inside the aspect ring, or outside the chart. This displays
explanatory text about the set of interpretations, such as who wrote it
and to what type of charts it applies.
7. Click once on any chart point followed by a single click on any other
chart point within 3 seconds. This displays an interpretation of the
aspect between those two points, if there is an aspect made between
them eg. Jupiter Trine The Sun. If the chart points that you click on are
in different wheels, then Solar Fire will automatically select the
Synastry, Transits to Natal, Progressions to Natal or Directions to Natal
set of interpretations, depending on what chart types are involved.
8. Click once on any chart point followed by a single click on either the
sign glyph on the 1st house cusp, or the sign glyph on the 10th house
cusp. This displays an interpretation of the aspect between the first
point and the Ascendant or Midheaven respectively, if there is an aspect
made between them eg. Venus Conjunct Ascendant.
The following diagram shows an example of the "sensitive" areas of a
chart, which are numbered according to the list above.
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Browsing the Interpretations
Interpretations Window

Once the interpretations window is open, it is possible to browse through
all the categories of interpretations for a chart as well as all the general
definitions, without leaving the window again.
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In order to browse through all the available definitions or interpretations
relating to the currently selected mode and information type, select any
item from any of the drop-down list boxes.
You can also browse through the definitions or interpretations simply by
using the cursor keys (UP, DOWN, LEFT and RIGHT). The UP and
DOWN keys will move you up and down the items in the currently
highlighted drop-down list box. The LEFT and RIGHT keys will move you
between the drop-down list boxes eg. if there are two drop down-list boxes
using the left key will shift the highlight to the left box, and using the right
key will shift the highlight to the right box.
Note that some information types do not have any drop-down list boxes, as
there is only one type of information available for them. For example, if
you are in Current Chart Mode, then the Element information type shows
a single set of information about the balance of elements in the current
chart. However, if you are in General Mode, then there will be drop-down
list boxes allowing you to browse the different elements (fire, earth, air,
water) and emphasis types (definition, weak, strong).

Switching Modes
W

To switch between General Mode and Current Chart Mode

Select the desired option from the Mode menu.
A tick appears to the left of whichever menu option is selected. Also, when
you are in General Mode, the title of the interpretations windows is
"General Interpretations", whereas when you are in Current Chart Mode,
the title consists of the chart's name and its type eg. "Marilyn Monroe Natal".
It is not possible to select Current Chart Mode if you have not yet cast or
opened any charts. Otherwise you can freely switch between modes as you
wish.
In most cases the information type that you are browsing will be retained
when you change mode eg. if you are looking at information about the
degree of Mercury in a chart (in Current Chart Mode), then when you
switch to General Mode you will still see the same text about that degree,
but you will be able to browse through the text relating to all the adjoining
degrees.
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Selecting Information Types
There is a large variety of information types available. These can be
accessed from the Info menu.
W

To switch between information types

Select the desired option from the Info menu
A tick appears to the left of whichever menu option is selected.
Most information types show different text depending on whether the
mode is set to "General Mode" or to "Current Chart Mode". The
information types, and a description of the text which they show in each
mode are:
Introduction
General Mode - Title, copyright and explanatory text
Current Chart Mode - Same as General Mode
Degree
General Mode - Information about any degree of the zodiac
Current Chart Mode - Information about the degree of any chart point
Decanate
General Mode - Information about any decanate (10 degree
subdivision) of the zodiac and its ruler
Current Chart Mode - Information about the decanate of any chart
point, and its ruler
Sign
General Mode - General definition plus weak and strong definition of
any sign
Current Chart Mode - Balance of the signs using a scoring system
Element
General Mode - General definition plus weak and strong definition of
any element
Current Chart Mode - Balance of the elements using a scoring system
Mode
General Mode - General definition plus weak and strong definition of
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any mode
Current Chart Mode - Balance of the modes using a scoring system
House
General Mode - General definition plus weak and strong definition of
any house
Current Chart Mode - Balance of the houses using a scoring system
Quadrant
General Mode - General definition plus weak and strong definition of
any quadrant
Current Chart Mode - Balance of the quadrants using a scoring system
Hemisphere
General Mode - General definition plus weak and strong definition of
any hemisphere
Current Chart Mode - Balance of the hemispheres using a scoring
system
Aspect
General Mode - General definition of any aspect
Current Chart Mode - Interpretation of the aspect between any two
chart points in the current chart
Ray
General Mode - General definition plus weak and strong definition of
any ray
Current Chart Mode - Balance of the rays using a scoring system
Lunar Phase
General Mode - Interpretation of any of 8 lunar phases
Current Chart Mode - Interpretation of the lunar phase of the current
chart
Sign on House
General Mode - Interpretation of any sign on any house cusp
Current Chart Mode - Interpretation of any house cusp's sign in the
current chart
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Chart Point
General Mode - Definition of any chart point
Current Chart Mode - Basic technical information and aspect list for
any chart point in the current chart
Point in House/Sign
General Mode - Interpretation of any chart point in any sign and any
house
Current Chart Mode - Same as above two information categories
combined
Point Ruling House
General Mode - No information available (disabled)
Current Chart Mode - Definition of each of the houses ruled by any
chart point in the current chart
Dispositor's House/Sign
General Mode - No information available (disabled)
Current Chart Mode - Definition of the house and sign of the dispositor
of any point in the current chart
Point's Aspects
General Mode - Any chart point in any aspect to any other chart point
Current Chart Mode - Interpretations of all of the aspects formed to any
chart point in the current chart
Point's Rays
General Mode - Definition of each ray relating to any chart point
Current Chart Mode - Same as General Mode

Changing Rulerships
Some information types, such as decanates, house rulerships, dispositors
and rays, contain information relating to planetary rulerships of signs and
decanates. It is possible to select any available set of rulerships (such as
Modern, Old and Esoteric) to be used in the text for these items as follows.
W

To change rulerships

Select the desired rulership set from the Rulerships menu. It is possible to
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browse or edit these rulerships, and add or delete rulership sets with a
separate utility, which is described in detail on page 384.

Changing the Display Options
You can select a variety of display options as follows:
W

To ensure that the interpretations window remains visible on top of any
other window

Select the Always On Top item from the Options menu. This may be
switched off simply by re-selecting it.
W

To display the interpretations window at full screen size

Click on the maximize button at the top right of the window. You can
restore the window to its original size simply by clicking on the restore
button at the top right of the window.
W

To alter the font style, size or color

Select the Font... item from the Options menu. This will display a
standard font selection window, from which you can select any available
screen font, plus its style, size and color.
W

To alter the size of the interpretations window

Drag the window's borders with the mouse button held down

Sending an Interpretations Report to a Word
Processor
Solar Fire’s interpretations are designed for personal and professional use
rather than for mass-production of printouts for sale.
For beginners they provide a fun-to-use learning tool, and a way to print
out chart readings for themselves, friends and family.
For professionals they can be the basis for personalized written
interpretations. The text database itself can be revised and expanded to
reflect one’s own astrological ideas, and the interpretations for any chart
can be sent to a word processor and modified for a particular individual.
Today’s word processors offer many sorts of font and formatting
possibilities. Combining creatively formatted text with the special chart
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wheels and page designs that you can create in Solar Fire, you can produce
distinctive and attractive printouts for gifts and special occasions.

Selecting a Word Processor
You can select which word processor you wish to use when viewing and
printing interpretation reports. If you do not select one yourself, then Solar
Fire will use the default word processor on your computer system. See
page 366 for more details on selecting a word processor.

Viewing a Full Interpretations Report
W

To generate a chart interpretations report

Select the Full Report... item from the Interps menu, or View Full
Report... option from the File menu of the interpretations window. This
will display a selection dialog box from which you can choose which
categories of interpretations will be included in the report.

138 Solar Fire 5: Doing Astrology With Solar Fire

Text Categories Dialog box

You can select any of the available text categories by ensuring that the
check box for that category contains an "X". Click on any of these to select
or unselect them. If you switch off the "Chart Points" category then it is not
possible to include categories relating to rulerships and aspects between
points, so these option become disabled (grayed). When you are happy
with the selection, click on the View... button. Your word processor will be
opened up displaying this report. You are then free to browse the report, to
print it, or to save it under another name if you wish. Note that, to keep a
permanent copy of the report, you must save it under a different name,
because Solar Fire always uses the same report name. When you have
finished with the report, exit from your word processor.
Note: If you do not exit from your word processor, then the next time that
you generate an interpretations report you will see the old report instead
of the newly generated one. If this happens, then exit from your wordprocessor, and generate the report again.
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W

To generate a synastry interpretations report

Select the Synastry Report... item from the Interps menu, or View Full
Report... option from the File menu of the interpretations window when
you are already viewing synastry interpretations. This will display a
selection dialog box from which you can choose which categories of
interpretations will be included in the report, and also the gender of each of
the charts.
The interpretation categories may be selected in the same manner as for
natal interpretations. However, bear in mind that the some categories do
not apply to the synastry report, so that selecting them will make no
difference to the final report. In particular, the following items are not
included in the default synastry report.
•

Balances

•

House Cusps

•

Rulerships & Dispositor

•

Rays

Exporting Text to a File
You can send a selection of the available interpretations for the current
chart to an external DOS file to be used in a separate text editor, printing
utility or word-processor. The resulting text file will have an ANSI format
without any carriage return/line feeds within the body of each paragraph.
This makes it easy to use if it is imported into a word-processor as it will
not be necessary to remove "hard" carriage returns from each paragraph of
text.
W

To send interpretations to a text file

Select the Export Text... option from the File menu of the interpretations
window. This will display a selection dialog box from which you can
choose which categories of interpretations will be exported.
You can select any of the available text categories by ensuring that the
check box for that category contains an "X". Click on any of these to select
or unselect them. If you switch off the "Chart Points" category then it is not
possible to include categories relating to rulerships and aspects between
points, so these option become disabled (grayed). When you are happy
with the selection, click on the Export... button.
You will then be able to select a directory and filename to which the
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interpretations text will be sent from a standard Windows "Save File"
dialog screen. Initially the filename is set to INTERPS.TXT, but you may
change this if you wish, to any valid DOS filename. You might also prefer
to select the directory in which your word processor resides in order to
make it easier to find the exported file from you word processor.
Once you click on the Export... button, the interpretations will be sent to
the file that you specified, a series of beeps will be sounded to let you
know that it has finished, and you will be returned to the interpretations
window.
Note that you cannot export text if you are in General Mode. This export
utility can only be used with the interpretations relating to the current
chart.

Changing the Interpretations File
When you first install Solar Fire, there are only two interpretations files
available, for natal charts and transits to natal charts. However, if you have
created additional interpretation files with the interpretations compiler, it is
possible to select another file. The possible categories of interpretations
are:
•

Natal

•

Progressed

•

Return

•

Combined

•

Prenatal

•

Synastry (Natal to Natal)

•

Transits to Natal

•

Progressions to Natal

•

Directions to Natal

Each of these categories can have a different interpretations file associated
with it, which is used whenever a chart of that type is selected. It is
possible for all of them to use the same interpretations file, although
ideally each category would have its own separate interpretations file, with
text that has been written specifically for that chart type.
When Solar Fire is first installed, you will find that all the categories use
the same interpretations file (standard.int) apart from Synastry
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(synastry.int) and Transits to Natal (transits.int).
W

To change the selected interpretations file

Do either of the following.
From the Interpretations window, select the Open... item from the File
Menu.
From the Main Screen, select the required file type from the
Interpretations Files menu item under the Interps menu.
You will then see the File Manager Dialog Box, from which you can
choose any other available interpretations file. If you click on the Select
button, then the chosen interpretations file will become the default for
interpretations of the chosen category (if selected from the Interps menu),
or for the category that is currently being viewed (if chosen from the
Interpretations window).

Exiting from the Interpretations Window
You can exit from the interpretation window in two different ways. One
way will close and unload the interpretations file, which means that next
time you open up the interpretations window a few extra seconds will be
taken to load the file again. The other way simply minimizes the
interpretations window without unloading the interpretations, so that it can
be accessed again almost instantaneously.
W

To exit from the interpretations and unload the interpretations file

Choose the Exit option from the File menu of the Interpretations window.
W

To minimise the Interpretations window

Click on the minimize button on the top right of the Interpretations
window. Once it is minimized, you can retrieve it by double-clicking on its
icon, or by using any of the methods previously described to open the
Interpretations window.
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Chapter 19: Viewing Astro-Locality
Maps
Solar Fire contains an astro-locality mapping module called Solar Maps
Lite. If you have already purchased the full version of Solar Maps v2, then
you will be able to access its full features instead of the limited features of
Solar Maps Lite.
If you own the full Solar Maps program, then you should refer to its
manual or on-line help file for instruction on using all of its features. What
follows is a brief description of the features of Solar Maps Lite.
Solar Maps Lite allows you to
•

Display world maps in rectangular or spherical formats

•

Display planetary positions on maps for any natal type chart that has
already been calculated in Solar Fire

•

Display lines of culmination, anti-culmination, rise or set for the
chart’s planets and bodies

•

Display planetary direction lines in local space

•

Display day/night shading for any chart on a rectangular world map

•

View solar eclipse paths for any solar eclipse in the period 1951 to
2200

•

Measure angular and linear distances between maps locations or
planetary lines

•

Add, edit or remove cities which are displayed on maps

•

Apply alternative pre-defined map and line color selections

W

To start Solar Maps and display the currently select chart

1.

Select the required chart from the list of calculated charts

2.

Select the Solar Maps item from the View menu.

This will start up Solar Maps, displaying the selected chart over the last
selected map.
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The Main Solar Maps Window
When Solar Maps starts up for the first time, it needs to prepare the map
database. This may take several minutes, and the progress of this operation
is shown with a progress bar in the middle of the screen. This is only
necessary the first time that Solar Maps is run, and it will normally not
occur again.
Like other windows, the Solar Maps main window may be minimized,
resized and moved around the screen. Whenever you resize the window,
the map will be redrawn automatically to fit the new window size.
The title bar - the bar across the top of the window - normally displays
information about whatever chart and/or eclipse is currently being
displayed, and what kind of astrological lines are being displayed. Some
examples are
Transits 25 Jan1997 - Natal - Lines: MC/IC/Rise/Set
John Smith - Natal - Lines: Local Space
John Smith - Natal & Eclipse of 26 Feb 1998 - Lines: MC/IC/Rise/Set
Eclipse of 26 Feb 1998
The menu is the means of accessing all the options within the program.
The main headings in the menu are
Chart - Options for selecting and displaying charts and astrological
lines on the current map
Map - Options for selecting maps
Eclipse - Options for selecting solar eclipse lines to display on the
current map
Options - Special display options
Help - On-line help
The location information box displays the current position of the cursor
over the map in terms of latitude and longitude. It also displays angular and
linear distance between two points when the mouse is anchored and
dragged anywhere across the map.
The line symbols which appear around the edge of the map (and on some
lines within the map itself) indicate the line type of whatever line it is
attached to. For example, the As/Venus symbols indicate that the attached
line is one along which Venus is rising.
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Charts
When you first enter Solar Maps Lite, the chart which is displayed is that
which was the current chart in Solar Fire. However, you can select any of
Solar Fire’s calculated charts without leaving Solar Maps.
W

To select an alternative chart to display

1.

Select the Select Chart… item from the Chart menu, or click on the
Chart button

2.

Highlight the required chart and click on the OK button

To display or remove day/night shading for a chart on a map
Select the Day/Night Shading item from the Chart menu
This will toggle it on or off. When it is on, the region where the sun is
below the horizon is shaded with a cross-hatching pattern. This region is
bordered by the lines of rising and setting for the Sun. (Note: This option
works only on rectangular world maps. It has no effect on spherical format
maps.)

Maps
When you first enter Solar Maps Lite, the map which is displayed is that
which was displayed when you last exited Solar Maps.
W

To select an alternative map to display
1.

Select the Select Map… item from the Map menu, or click on the
Map button, or select a recently used map from the bottom of the
Map menu

2.

Highlight the required map file name and click on the OK button

This will cause the newly selected map to be displayed with whatever chart
has already been selected.
W

To add, edit or remove city names from a map

Select the Edit Cities… item from the Map menu
This will display the Edit Cities dialog.
The information that is stored for each entry in the city file is
Name - This name is what appears on the map.
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Latitude - The latitude at which the name is to be plotted.
Longitude - The longitude at which the name is to be plotted.
Zone - The normal timezone observed in that city.
Plot If <= - This controls how wide the map must be in order for the
name to be plotted. This option is only useful in the full Solar Maps
program. It should normally always be set to 360 for Solar Maps
Lite.
Alignment - This controls where the symbol is plotted in relation to the
city name. If the Left option is chosen, then the name is aligned so
that the symbol is on the left of the name (i.e. +Name). If the Right
option is chosen, then it is aligned with the symbol on the right (i.e.
Name+). If the Center option is chosen then the name is centered
over the symbol (i.e. Na+me).
À To edit an existing entry in the city file
1. Click on the required entry in the listbox.
2. Edit the information fields.
See the description of fields above.
À To add a new entry to the list
1. Click on the “Add City“ button.
2. Enter data into the information fields.
If you have the ACS PC Atlas, then you will see the “ACS PC Atlas”
dialog box which allows you to enter the city name and look up its details
in the Atlas. These details will be inserted automatically into the
information fields on this screen.
À To delete one or more entries from the list
1. Click on the desired entry or Whilst holding down the “Ctrl“ key, click
on each of the required entries.
2. Click on the “Delete“ button.
You will be asked to confirm deletion before the selected entries are
removed.
À In order to exit from this screen
Click on the “OK“ button.
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You will be asked whether or not you wish to save the changes that you
have made. If you choose to save them, then the entries will be saved and
sorted into alphabetical order for next time you use this screen again. If
you choose not save them, then any changes that you made using this
screen will be lost.

Lines
When you first run Solar Maps Lite, lines of culmination, anti-culmination
rise and set are displayed.
W

To select which line types to display

Select the Displayed Lines… item from the Chart menu, or click on the
Lines button.
This will display the “Select Lines” dialog, where there are two categories
of line types that may be selected. These are
Planet/Angle Lines - These are the lines which describe where on the
Earth individual planets are culminating or anti-culminating or are
rising or setting. These lines are also sometimes called
Astro*Carto*Graphy® lines in other books and programs. The
culminating and anti-culminating lines are always lines of
longitude, whereas the rising and setting lines are great circles
around the globe and appear to curve on a map viewed in Cartesian
or Mercator projection.
Local Space Lines - These are the lines indicating the direction in
which planets or stars are found when looking from the chart’s
location. These lines are great circles around the globe, starting
from the chart’s location. The common convention is to continue
the line right around the world, back to the starting location. When
viewed in Cartesian or Mercator projection, these lines generally
appear to curve.
You can select any combination of the above lines to displays
simultaneously.

Eclipses
W

To display a solar eclipse path

Select the Select Eclipse… item from the Eclipse menu, or click on the
Eclipse button.
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This will display the “Select Eclipse” dialog, from which you can select
any partial or total solar eclipse from 1950 to 2200.
When you click on an eclipse in the listbox on the left, the details of that
eclipse will be displayed in the box at the right.
Additionally, you may select which of the following items to display by
clicking on their check boxes.
Total Eclipse Line - If selected, this will display the central line of
total eclipse
Partial Eclipse Lines - If selected, this will display lines of equal
magnitude of eclipse in intervals of 25%.
Current Chart - If selected, the currently displayed chart will be
retained and plotted at the same time as the eclipse lines.
Note that the Total Eclipse Line option is not available for partial eclipses,
and the Current Chart option is only available if you have previously
selected a chart.
À To remove any currently selected eclipse, and leave the map without any
eclipse lines displayed
Select the Clear Eclipse item from the Eclipse menu.

Display Options
Fonts
It is possible to alter the font in which country and city names are written
onto the maps, including italicizing or emboldening the typeface or
changing its point size.
À To select font attributes
Select the Text Font... item from the Options menu
This will display a standard Windows font selection dialog, from which
you can select
Font Name
Font Style
Font Size
When you have made your selections, click on the “OK“ button. The map
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will be redrawn using the newly selected font for any country or city
names that are plotted on the map.

Extra Line Annotation
The number of symbols which are displayed around the outside of the map
may be altered. Typically, each astrological line is identified with two
symbols - one showing which planet or star it belongs to, and the other
showing which line type it is eg. a Venus on the Midheaven line will have
a symbol for Venus and a symbol for the MC. It is possible to limit this to
displaying a single symbol for the planet, and omitting the line type
symbol. This allows the margin around the edge of the map to be reduced,
and therefore creates a bigger plotting area for the map. If you have
selected settings which give different line types different colors (or line
styles or thicknesses), then you may not need the extra symbol to be
displayed.
À To switch the extra line symbols on or off
Select the Extra Line Annotation item from the Options menu.
This switches the extra line type symbols off if they are on, or switches
them on if they are off. A tick appears to the left of this item when it is
switched on. The map is automatically redrawn whenever this option is
changed.
Note: This option does not affect printed maps. Printed maps always
contain the extra line annotation, regardless of how this option is set.

Map Settings
The colors of land and sea areas on the maps and the line types and styles
used for planetary lines can be altered according to some pre-defined
settings.
W

To choose an alternative set of map and line settings

1.

Select the Select Settings… item from the Options menu

2.

Highlight the name of a settings file, and click on the OK button

This will apply the new color selections and redisplay the current map and
chart using these new settings.
Whichever settings you choose will be remembered and re-used in any
subsequent sessions with Solar Maps Lite.
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Chapter 20: Viewing the Planetarium
Any calculated chart in Solar Fire may be viewed in a planetarium style
display showing planets and asteroids against the fixed stars and
constellations, from a variety of perspectives. It is possible to get textual
and technical information on the fixed stars in so far as it has been entered
with Solar Fire’s Fixed Star Editor.
W

To display the planetarium for any calculated chart

Select the required chart from the list of Calculated Charts on the main
screen
Select the Planetarium option from the View menu
This will cause the planetarium screen to be displayed, displaying the
currently selected set of Displayed Points, and the currently selected set of
Fixed Stars.
It is also possible to start up the planetarium directly, without running
Solar Fire, by double-clicking on its icon in the Solar Fire Group window.
However, in this case no planets or asteroids are displayed, and the star file
that is used is whatever was last saved as the default Fixed Star file in
Solar Fire. See page 213 for instructions on selecting another star file.
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Planetarium Screen

Whilst you are in the planetarium screen, it is possible to explore the
celestial sphere in various ways which are explained below.

Choosing the Coordinate System
The possible coordinate systems are:
•

Equatorial - Coordinate lines on the sphere are lines of right
ascension and declination.

•

Ecliptical - Coordinate lines on the sphere are lines of longitude and
latitude.

•

Local - Coordinate lines on the sphere are lines of azimuth and
altitude. When viewing a chart, the local horizon is that for the
location of the chart at the time of the chart. If no chart is being
displayed, then the local horizon is that of the default location of Solar
Fire, as displayed on Solar Fire’s main screen, and the time is current
time according to your computer’s system clock.

When you select the required system from the drop-down list box, the
display will be updated automatically to reflect the new coordinate system.
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Choosing the View Direction
The possible view directions for equatorial or ecliptical coordinates are:
•

Equator - The line of the equator or ecliptic is shown horizontally
across the screen, with the north pole upwards and the south pole
downwards.

•

North Pole - The view is towards the north pole, with the pole in the
center of the screen.

•

South Pole - The view is towards the south pole, with the pole in the
center of the screen.

For local coordinates
•

Horizontal - the line of the horizon is shown horizontally across the
screen.

•

Above Horizon - The view is upwards, with the horizon around the
edge of the screen.

•

Below Horizon - The view is downwards, with the horizon around the
edge of the screen.

When you select the required view direction from the drop-down list box,
the display will be updated automatically to reflect the new coordinate
system.

Choosing the View Heading
The view heading may be moved through a full 360 degrees by using the
horizontal scroll bar at the bottom of the frame. Its precise value is written
at the top right of the frame. When using an equator or horizontal view, the
heading is the angle towards which you are looking. When using a polar or
above/below horizon view, then the heading is the angle at the top of the
display.

Choosing a Star
W

To select an individual star

Do either of the following
Select a star from the Star List - If it is not visible on the currently
displayed hemisphere, then you will hear a beep. If the selected star is
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visible on the current display, then it will be highlighted.
Click somewhere on the displayed sphere - The nearest star to where you
clicked will then be highlighted in the list of stars. This is especially
useful if you wish to find the nearest star to a planet in the chart - to do
this, all you need do is click on the planet symbol.
When the star is highlighted, it becomes brighter than the other stars, and
expanding and contracting rings will be shown around it for a few seconds
to help you locate it. Also, the constellation in which that star resides will
appear in the Constellation list box.

Viewing a Constellation
W

To see a particular constellation

Select it from the Constellation drop-down list box. If the selected
constellation is not visible in the displayed hemisphere, then you will hear
a beep. If it is visible, then the stars in that constellation will be highlighted
in red, to differentiate them from the other stars.

Viewing Information About a Star
W

To see a pop-up information box which lists information about a star

Do either of the following.
Select the required star from the Star List and then Select the Info button
Double-click somewhere on the displayed sphere - This will show
information on the nearest star to where you clicked.
The information shown on the star is everything that may be entered into
the Fixed Star editor, including name, nomenclature, NGC number,
magnitude, spectral class and any text available for that star. Also, the
longitude, latitude, right ascension, declination, azimuth, altitude and rising
and settings times are shown. These times are on the 24hr clock, and are
listed as “Always Above” or “Always Below” if the selected star does not
cross the horizon during this day.
Note: The rise and set times shown in the planetarium are “apparent” times
i.e. they take account of the average refraction of the atmosphere. These
may differ by several minutes from “true astronomical” rise or set times.
The apparent rise and set are calculated to occur when the star is
astronomically 34 minutes of arc below the horizon (i.e. about half of a
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degree).

Animating the Planetarium
The planetarium can be stepped around continuously by clicking on either
the play forward or play backward buttons. You can click on the stop
button to halt this at any time.
Note: This option simply rotates the planetarium continuously, and does
not change the date or time for the displayed data.

Printing the Planetarium
W

To obtain a full page printout of the currently displayed view

Select the Print button - This will print on the default printer using the
currently selected page orientation and resolution. If you wish to change
these settings, then you must do so before printing.
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Chapter 21: Generating Chart Reports
This chapter describes how to view and print any of Solar Fire’s report
types relating to a single chart or synastry report types relating to two
charts. It is not possible to generate a report relating to more than two
charts at a time.
If you wish to generate dynamic transits and progressions reports, rather
than a chart report, then refer to page 165.
Before generating a report, it is necessary to have either cast or opened the
chart or charts which you wish to report on. If you have not yet done so,
see page 22 for instructions on casting a new chart, or page 54 for
instructions on opening an existing chart.
Also it is necessary to have selected the required set of displayed chart
points and aspects to be used in generating the report. See page 332 for
instructions on selecting the set of displayed points and the aspect set.

Report Options
There are two report options that affect the way in which some of the
reports are generated. These relate to the vernal point in midpoint reports,
and which parans are used in fixed star paran reports.

Vernal Point
The vernal point is the point at the beginning of the zodiac, i.e. zero
degrees of Aries. This point may be included as a chart point (with the
symbol Vp) in any of the reports which list midpoints, if desired. If this
option is switched off, then only the currently selected displayed points are
used in the report.
W

To switch the vernal point option on or off

Choose Vernal Point from the Reports menu

Parans
The fixed star paran report lists stars that are in paran to points in the chart.
Parans may be of four types - rising, setting, culminating or anticulminating. It is possible to select which parans to include or exclude
from the report. For example, if only rising and settings parans are
selected, then the report will list any stars which are rising or settings as
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the chart points rise or set, but not as the stars or chart points culminate or
anti-culminate.
W

To select which parans to use in the fixed star parans report

Click on any of the Parans to Use options from the Reports menu Parans which are selected will have a check mark on their left of their entry
in the menu. Clicking on an unselected paran will switch it on, and clicking
on a selected paran will switch it off. Note that the fixed star paran report
lists which parans are currently in use when the report is generated.

Descriptions of the Reports
These are the different types of reports you can choose from:
Chart Analysis
Chart details: name, birth date, birth time, latitude, longitude, etc.
Astronomical information: DeltaT, Ephemeris Time, Julian Day,
Sidereal Time at Greenwich, Local Sidereal Time, Obliquity of the
ecliptic, Adjusted Calculation Date for midnight and midday
ephemerides.
Chart angles: the longitudes of the Ascendant and Midheaven computed to
the second of arc.
House cusps: the longitudes of the intermediate house cusps and angles
computed to the second of arc.
Chart points: longitudes, daily travel, latitudes, declinations, azimuths
and altitudes of all planets and points selected.
Lunar phase: the Sun/Moon angle and it phase out of 8 and 28 phases.
Elements and Modalities analysis: weighted points showing the
concentration of planets and points in Fire, Earth, Air and Water;
Cardinal, Fixed and Mutable.
Rulerships Report
This report is available using any available level of rulerships. (It is
possible to add your own rulerships to Solar Fire. Refer to page 384 for
instructions on how to do this.) It shows you the following:
Planets: accidentally dignified, in mutual reception, in rulership,
detriment, exaltation and fall, and the final dispositor.
Chart points: in signs, house, house ruled, dispositor and dispositor's
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house.
Horary Report
Planetary day, planetary hour, hour of day or night
House Cusps: Almutens (calculated according to the options in the
houses.alm almuten definition file)
Chart Points: Ruler, Exalted, Triplicity, Term, Face, Detriment, Fall,
Score, Peregrine (calculated according to the options in the essdig.alm
dignity definition file)
Chart Hyleg: according to Bonatti’s method and Ptolemy’s method.
Aspects List
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
Aspects list: listing of aspects in order from the Moon to the Lunar
South Node, showing orb and whether applying or separating.
When this report is produced as a synastry report, aspects shown are
between the two charts instead of between planets within the single
chart.
Sorted Aspects
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
Orb used: maximum orb angle
Aspects list: listing of aspects in order of increasing orb and whether
applying or separating.
When this report is produced as a synastry report, aspects shown are
between the two charts instead of between planets within the single
chart.
Aspects Analysis
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
Major aspect patterns: Unaspected planets, Stelliums or clusters, TSquares, Grand Crosses, Grand Trines, Kites, Mystic Rectangles, Hard
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Rectangles, Yods, Focused Yods
Aspect distribution grid: the number of aspects found among the inner
planets, outer planets, and angles.
Aspect frequency analysis: aspect type, actual aspect hits, likely aspect
hits, and the percentage of difference from expected frequency of
aspect hits.
When this report is produced as a synastry report, aspect patterns do not
appear on the report, and the aspect distribution relates to aspects
between the two charts.
Chart Point Sort
Modulus used: modulus angle
List of chart points: In order of modulus angle, including zodiacal
positions
When this report is produced as a synastry report, the points from both
charts are listed together, and are flagged to show which chart they
belong to.
Sensitive Points
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
List of sensitive points: zodiacal position, aspect made, chart point
aspecting this position
This report is especially useful for quickly finding what is being
triggered in a chart by a transiting planet, for example. It is also useful
simply as a list of what points in the zodiac are sensitive in chart.
MidPoint Listing
Modulus used: modulus angle
List of midpoints: In planetary order, modulus angle
List of midpoints: In midpoint order, modulus angle
When this chart is produced as a synastry report, the midpoints from
the first chart are mixed with the primary positions (i.e. the positions of
the chart points themselves) of the second chart, and these are flagged
to show which chart they belong to. In this manner it is possible to see
the positions of the transiting planets relative to a chart's midpoints, for
example.
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MidPoint Axes
Modulus used: modulus angle
Orb used: orb angle
List of Axes: In planetary order down the screen. Midpoints within orb
are listed across the page (and onto next line if line is full).
Example:

*Ura*
Mar/Jup 0 09

Vp/Sat 0 02d

*Asc* 0 05

This shows that Uranus is within 2 minutes of arc of the midpoint of
the Vernal Point (0 Aries) and Saturn; within 5 minutes of arc of the
Ascendant; and within 9 minutes of arc of the midpoint Mars and
Jupiter, within the modulus specified. Also note that the "d" indicates
that the midpoint is a conjunction or opposition, regardless of the
modulus chosen.
MidPoint Trees
Modulus used: modulus angle
Orb used: orb angle
List of Trees: In planetary order across the screen. Midpoints within
orb are listed down the page under each point.
Example, showing the same midpoints as in the previous example:
*Ura*
Vp/Sat

0 02d

*Asc*

0 05

Mar/Jup 0 09
Midpoint Modes
Cardinal Points: Zodiacal position of chart points and midpoints which
are in cardinal signs, plus modulus angle of points which are in
semisquare or sesquisquare to chart points and midpoints.
Fixed Points: As for cardinal points
Mutable Points: As for cardinal points
This report is especially useful for quickly finding any 8th harmonic
aspects to midpoints in a chart. For example, in the cardinal section of
the report, if two of the entries are:Mar/Nep

14Li59 Mer/Nod

15 25
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then a transiting point at 15Cp00
is square the Mar/Nep
midpoint in the chart with an orb of 1 minute, and is either semisquare
or sesquisquare the Mer/Nod midpoint with an orb of 25 minutes.
Arabic Parts
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
List of Parts: Name and zodiacal position
List of Aspects: Aspects to chart points, orbs
Star Aspects
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
Chart Points: Zodiacal position and declination
List of aspects: Aspects to fixed stars in current fixed star file, orb and
star keywords
Star Parans
Parans Used: List of which parans are included (rise, set, upper
culmination, lower culmination)
Paran Orb: maximum paran orb
Chart Points: Zodiacal position and declination
List of parans: Parans to fixed stars in current fixed star file, star
keywords
Planetary Nodes
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
Chart Points: North node position and daily travel, South node position
and daily travel
List of aspects: Aspects to other chart points, in order of increasing orb
Asteroids
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
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or chart point applying and separating orb, aspect name.
List of Asteroids in current asteroid file: Longitude, daily travel,
latitude, R.A. and Declination, list of aspects from asteroid to other
chart points, orbs
Other Bodies
Aspects used: aspect abbreviation or glyph, aspect angle, luminary
applying and separating orb (Sun/Moon to other planets), other planet
or chart point applying and separating orb, aspect name.
List of Bodies: Name, longitude, daily travel, latitude, R.A. and
Declination
List of Aspects: Aspects to chart points, orbs
The bodies which appear in this report are those whose orbital elements
are defined in a file called “extras.dat”, which resides in Solar Fire’s
\USERDATA directory. If you have adequate knowledge of orbital
elements, it is possible to add or remove bodies from this file, and these
changes will be reflected in this report. See page 429 for an explanation
of the format of this file.
MWA (Munkasey Midpoint Weighting Analysis)
Total Hits, Midpoints in weighted order, Hits in weighted order,
Planets in weighted order, sign weights, house weights, harmonic
weights.
Unlike the original MWA that includes all of Munkasey’s PSPs
(personal sensitive points), this version of the report uses only the
currently selected chart points.
The weightings are specified in the file MWA.INI in Solar Fire’s main
directory, and adventurous users can edit this file if they wish to alter
the weightings.
Difference Listing
Modulus used: modulus angle
List of differences: In planetary order, modulus angle
List of differences: In difference order, modulus angle
The difference between a pair shown in the report as “A/B” is
computed as (Position B – Position A), i.e. it indicates the zodiacal
distance from point A forward through the zodiac to point B.
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Reports for a Single Chart
W

To view a report for a single chart

Do either of the following
From the main screen, select a chart from the list of "Calculated Charts",
and then choose Current Chart from the Reports menu.
From the "View Chart" screen, select an image of the required single chart,
aspect grid or user-defined page from the list box, and select the
Reports button.
This will display the "Chart Report" screen, which allows reports to be
selected, browsed, edited and printed.
Chart Report Display Screen

The list box on the top left of the screen contains a list of all the report
types which may be displayed.
W

To display any report

Select the required report name from the list box on the top right of the
window.
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If you select a chart point sort report, or any midpoint type of report, then
you can select a modulus angle for the report.
W

To select a Modulus angle

Do either of the following
Click on the Modulus drop-down list box and select a pre-defined value It is possible to select a modulus for any harmonic from the 1st to the
12th
Enter an angle into the Modulus box - It is possible to type in any angle
from 1 minute of arc to 360 degrees in degrees, minutes and seconds
(eg. "67 23" for 67° 23').
If you select a report which requires an orb to be entered, such as a
midpoint axes or trees report, or a star paran report then you can enter a
limiting orb.
W

To enter an orb

Type the required orb into the Orb box - Any orb may be entered from 0 to
10 degrees, in degrees, minutes and seconds (eg. "0 10" for 10 seconds of
arc).
You can browse through the report by clicking on the scroll bars to the
right and bottom of the report display box. You can alter the appearance of
the report by switching on or off any of the following options:
Use Glyphs - This will substitute astrological glyphs into the report
wherever appropriate, replacing abbreviations for planets, asteroids,
zodiac signs and aspects.
Use Colors - This allows you to switch on or off the selected colors of
each planet, asteroid, zodiac sign and aspects wherever they appear in
the report. When this option is switched off, all items appear in black. It
is possible to alter which colors are used for each item by selecting
Point Colors..., Sign Colors... and Aspect Colors... from the Chart
Options menu of the main screen. See page 252 for instructions on how
to do this.
Bold Text - This allows you to switch between regular (light) text and bold
text.
Full Headers - This allows you to switch on or off the full chart details
and full listing of aspects used (in reports which use aspects). This
option is useful if you do not need to see the full details, or if you wish
to use less paper when printing a report.
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W

To send a copy of the report to the Windows Clipboard

Select the Copy... button - Note that glyphs and colors cannot be copied to
the clipboard. Abbreviations are used instead of glyphs when the report is
copied into the Clipboard. Also, report columns may not align correctly in
the Clipboard. If you paste the Clipboard contents into your wordprocessor, you may have to edit the document to ensure that the columns
align correctly, (from where it may be pasted into a word-processor
document, for example):
W

To print the report which is currently displayed

Select the Print... button. - This will display the "Print" dialog box,
allowing you to cancel, alter printer settings, add the report to the batch
print queue, or to print it immediately. See page 205 for instructions on
printing. The printed report will contain glyphs (if you have the Use
Glyphs option selected), and colors (if you have a color printer and you
have the Use Colors option selected). However, the printed report always
uses regular (light) text. It is not possible to print the report using bold text.

Synastry Reports
W

To view a synastry report

Do either of the following
From the main screen, choose Synastry... from the Reports menu - you
must then select charts as described on page 111, and then select the
Report button.
From the "View Chart" screen, select the image of the required biwheel or
synastry grid from the list box, and then select the Reports button.
This will display the "Reports" screen, which allows reports to be selected,
browsed, edited and printed. Refer to the previous section for instructions
on how to use this screen.
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Doing Astrology With Solar Fire

Chapter 22: Using Dynamic Reports
and Time Maps
This chapter describes how to generate, view and print a report of transits
or progressions to any chart (hereafter referred to as the "radix" chart). It
also describes how to view the output in the form of a “Time Map”.
Before generating a dynamic report, it is necessary to have either cast or
opened the chart for which you wish to generate the report. If you have not
yet done so, see page 22 for instructions on creating a new chart, or page
54 for instructions on opening an existing chart.

Dynamic Report Options
There are some dynamic report options that must be selected before
entering the “Dynamic Report selection” screen, which affect the way the
report is generated. These relate to the amount of detail displayed in the
report header and whether times are displayed in the report in addition to
dates.

Full Transit Header
The full header of the dynamic report usually takes up about half a page. It
is possible to prevent this information from being printed in order to save
this space. The full header contains full chart details and lists all selected
report options. If this option is switched off, then only the base chart name
and the name of the saved selection are printed.
W

To switch the full transit header option on or off

Choose Full Transit Header from the Dynamic menu - This will switch it
on if it was off, or off if it was on.

Transit Times
The dynamic report usually shows the date on which events occur, but not
their times (unless the moon or chart angles are selected as transiting
points). The reason for this is that the calculation is normally done at
weekly time intervals, as a result of which the accuracy is not sufficient to
show exact times. If this option is switched on, then the calculation is
performed at daily intervals, and the times are shown in the report.
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W

To switch the transit times option on or off

Choose Transit Times from the Dynamic menu - This will switch it on if
it was off, or of if it was on.
Note that this option has no effect if the moon or chart angles are selected
as transiting points, as in this case the times of the events are always
shown, regardless of this option.

Generating a Dynamic Report
Dynamic Report Selection Dialog Box

W

To generate a dynamic report

1. Choose Transits & Progressions... from the Dynamic menu - This
will display the "Dynamic Report Selection" dialog box that allows the
selection of a radix chart and options to be used in generating the
report.
2. Select a chart from the Dynamic Radix Chart list box.
3. Optionally select a different chart from the Alternate Radix Positions
Chart drop-down listbox. Usually this should be the same chart, but if
you choose a different chart, then the generated dynamic report will
show dynamic events of the Dynamic Radix Chart in relation to the
chart points of the alternate chart. For example, if you choose “Sarah
Jones” as your dynamic radix chart, and “David Smith” as your
alternate radix chart, then when you generate a progressions report, it
166 Solar Fire 5: Doing Astrology With Solar Fire

will show Sarah’s progressed planets making aspects to David’s natal
planets.
4. Optionally, choose an item from the drop-down list of Saved
Selections - Doing so will cause all the options on this screen to be
updated according to what was last saved in this Saved Selection.
Having done this, you may still alter any of the options on the screen
without causing any changes to the Saved Selection. For example, if
your Saved Selection has a report period of 1 year, you might wish to
alter this to 2 years for this particular report, or you may wish to add
Eclipses to the report. These new options will remain in effect until you
either choose another item from the drop down list of Saved Selections,
or alter any of the other options yourself. (If you select the same Saved
Selection again, then the options will be reset to what they were when
you last selected it.)
5. Enter the Start Date for the report. There are some shortcuts to setting
the date quickly and easily as follows: Select the Now button to get
today’s date; double-click on the Days option button to set the date
back by one day; double-click on the Months option button to set the
date back to the first day of the month (or to the previous month if the
day is already the 1st of the month); double-click on the Years option
button to set the date back to the first day of the year (or to the previous
year if the day is already the 1st of January).
6. Set the length of the reports by selecting any one of the Days, Months
or Years option buttons, and enter the number of days, months or years
in the Period box. This must be a positive integer. The period for
which the report will run will be this number of years, days or months,
depending on which of these periods has been selected with the option
buttons.
7. Select Location type to be either Natal or Relocated. If a dynamic
report is being generated for an individual, then it should normally be
relocated to wherever they are living during the period of the report.
However, if the chart's subject is someone who is living in the same
location as they were born during the time of the report, then the natal
option is appropriate. If only progressions are being generated for an
individual, then the location should normally be the same as the natal
chart location. However, if the radix chart is that of a person who
moved during the first few months of their life, it may be appropriate to
relocate it. If the Natal option is selected then all the boxes relating to
location, including time zone, longitude and latitude will contain the
location details from the selected base chart. Note that although it is
technically correct to alter the time zone if the current time zone is
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different from the natal one, in practice this is only necessary if you are
examining lunar or chart angle transits, as the difference in the resultant
times is otherwise not significant. If the Relocated option is selected
then all the boxes relating to location, including time zone, longitude
and latitude will contain the current default values. (See page 348 for
details on default values.) Any of these values may be altered in the
same manner as when creating a new chart. See page 22 for instructions
on how to alter location values.
8. In the Event Selection area, click on the options which you wish to
include. These options are:
Transits to Radix - transits of planets/asteroids/angles to points in the
selected radix chart
Transits to Transits - transits of planets/asteroids/angles to one
another
Transits to Progressions - transits of planets/asteroids/angles to their
progressed positions
Transits to Directions - transits of planets/asteroids/angles to their arc
directed positions
Progressions to Radix - progressions of planets/asteroids/angles to
points in the selected radix chart
Progressions
to
Progressions
planets/asteroids/angles to one another

-

progressions

of

Directions to Radix - arc directed positions of planets/asteroids/angles
to points in the selected radix chart
Note that at least one of the above options MUST be selected in order
to produce a report. Also note that, unless the radix chart is a natal or
event type chart, then it will only be possible to select the Transits to
Radix or Transits to Transits options. In this case, the other options will
be disabled (grayed).
House Ingress - If selected, then the report will contain an entry for
each chart point that crosses a house cusp in the radix chart, either
direct or retrograde.
Sign Ingress - If selected, then the report will contain an entry for each
chart point that crosses a zodiac sign cusp in the radix chart, either
direct or retrograde.
Parallels of Declination - If selected, then the report will contain
entries for parallels and contra-parallels of declination, as well as
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for aspects of longitude.
Parallels of Latitude - If selected, then the report will contain entries
for parallels and contra-parallels of latitude, as well as for aspects of
longitude.
Stationary Points - If selected, then the report will contain entries
showing the dates when planets or asteroids are geocentrically
stationary. (This has no effect if the radix chart is heliocentric.)
Solar & Lunar Eclipses - If selected, then the report will contain
entries showing the date and time and zodiacal position of
maximum eclipse of any solar or lunar eclipses.
Entering/Leaving - If selected, then the report will contain an entry for
each chart point as it enters transiting orb and leaves transiting orb,
as well as when the transit, progression or solar arc direction is
exact. If it is not selected, then the report contains entries only for
exact hits. The angle of the transiting orb used for the report is taken
from the current aspect set file. This orb may be altered by editing
the aspect set file. See page 334 for instructions on how to edit the
aspect set file.
Note that only one of the parallels options can be selected at one time.
It is not possible to produce a report containing both parallels of
declination and of latitude.
8. If you have selected any events involving Progressions or Directions,
then in the Dynamic Type box, select which type of progressions or
directions you wish to use by selecting one of the available types from
the drop-down list boxes. The progression types are:
Secondary - This is the most commonly used type of progression,
based on a day for a year i.e. one day per solar cycle.
Tertiary - This method of progression is based on the mean rate of a
day for a lunar month.
Minor - This method of progression is based on a mean lunar cycle for
a year.
User Rate - This method allows you to define whatever rate of
progression you choose. The rate used here must be set in the User
Progression Rate option of the Preferences dialog.
The direction types are:
Solar Arc - This is the most commonly used method. Chart points are
directed by the secondary progressed solar arc.
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Ascendant Arc - Chart points are directed by the ascendant arc (which
is itself derived from the secondary progressed solar arc.)
Vertex Arc - Chart points are directed by the vertex arc (which is itself
derived from the secondary progressed solar arc.)
User Arc - Chart points are directed by a user-defined annual arc rate.
The rate used here must be set in the User Direction Rate... option
of the Preferences menu.
Primary Mundane - This method directs chart points along their
respective diurnal arcs according to the rotation of the earth about
its axis. This option is different from all the others in that aspects
formed using this method are mundane aspects rather than aspects
of zodiacal longitude. The rate of direction can be selected from the
Primary Direction Rate option of the Preferences menu. See page
356.
Profections (Annual) – This directs the chart by 30 degrees per year.
Conventionally, you would use this direction method to find when
the directed Ascendant makes conjunctions to points in the radix
chart.
9. Optionally, select the Precessed or Converse options. If the Precessed
option is checked, then the calculations will be done according to the
position of the planets in the Sidereal zodiac, rather than the Tropical
zodiac. However, the resulting report will still be calculated in Tropical
Zodiac. Note that if the radix chart which you are using already uses a
Sidereal zodiac, then this option will have no effect, and the resulting
report will be in the Sidereal zodiac. If the Converse option is checked,
then the calculation of the transits and progressions will be done by
searching backwards from the converse entered time in relation to the
time of the dynamic radix chart.
10. You may wish to alter the Point Selection. The items that you can
select are:
Transits - Transiting points. You may, for example want to include just
transits from the outer planets only. On the other hand, for a very
short-term report, you may want to include transits by the Moon.
Extras - Extra transiting points. This can include any combination of
midpoints between planets or other chart points, as well as fixed
stars, asteroids and extra bodies.
Progs - Progressing and Directed points. You can specify a different
set of points from the transiting points.
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Extras - Extra Progressing and Directed points. This can include the
same types of points as for the extra transiting points.
Radix - Points in the radix chart that you want to include in the report.
You could exclude the MC and Ascendant if the birth time was
uncertain; add asteroids, use inner planets only, etc.
Extras - Extra radix points. This can include any combination of
midpoints between planets or other chart points, and fixed stars,
arabic parts, asteroids, extra bodies, fixed zodiacal positions and
house cusps.
The names of the currently selected sets are displayed, and it is possible
to select different sets, browse or edit them etc. by clicking on the name
of the desired set. Doing so will cause the File Manager screen to be
displayed See page 211 for instructions on using the File Manager to
alter any settings.
You may also wish to alter the Aspect Selection. The items that you
can select are:
Transits - Aspects formed from transiting points to radix points.
Progs - Aspects formed from progressed or directed points to radix
points. This can be a different set of aspects from the transiting
aspects.
11. Optionally select the Merge checkbox – If you do so, then the new
report that you generate will be merged with the previously generated
dynamic report, and all events for both reports will be displayed
together. This option is useful for generating reports that require
combinations of settings that are not possible in a single report. For
example, you could produce a report using Solar Arc directions, and
then merge this with another report using Ascendant Arc directions.
The final result is a report containing both types of directions.
12. Finally select the View button - The "Dynamic Events Report" screen
is displayed, and the report is generated as you watch.
Instead of viewing the report immediately, you have the option of adding
the report to the print queue, to be printed later.
W

To add the report to the print queue

Select the Queue... button - This will display a dialog box asking you to
confirm whether or not you wish to add this dynamic print job to the Solar
Fire print batch queue. If you select the OK button, then it will be added to
the queue, and it will not be calculated or printed at this time. It is possible,
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at any later time, to start printing all the jobs that are on the batch print
queue by selecting the Start Print Queue... option from the View menu of
the main screen. Note that any dynamic report that is calculated on the
batch queue will be sorted into date order. If you wish to see the report in
any of the other available sort orders, you must generate the report using
the View button.

Saving and Deleting Selections
Solar Fire is supplied with a list of predefined dynamic report selections. It
is possible to select any of these, edit them, delete them, or to create your
own selections. Each named selection in the list is simply a record of all
the selections that can be made on this screen, including start date, period,
location details, event types etc. In this manner, it is possible to customize
your own set of dynamic report options and to save them for easy access in
future sessions.
W

To save or re-save the currently selected dynamic options

Select the Save Selection... button. You will be asked to enter a description
under which to save this selection. If you then select the OK button, it will
then be saved to the list.
W

To delete a saved selection

Highlight the desired selection in the Saved Selections list and use the Del
key.
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Viewing the Report
Dynamic Events Report Screen

During report generation, you can stop further report calculation by
selecting the Cancel button. When the report is finished, it is possible to
exit from this screen by selecting the Quit button.
The status of report generation is shown in the three boxes at the top right
hand side of the screen. The top box shows the type of calculations being
performed, the second box shows the date for which calculations are
currently being performed, and the lower box shows an approximate
percentage completed so far, both by percentage number, and with a
graphical "flood-fill" bar, for the current calculation type.
There is a limit of 10,000 dynamic events in any one report. If this limit is
reached, or if your computer runs out of memory before this limit is
reached, then you see a dialog box indicating the problem, and the report
will be truncated at that point.
When the report calculation is complete, the report is sorted into whichever
sort order was last chosen. It is possible to sort the report into a variety of
different orders as follows.
W

To change the sort order

Select the required sort order option from the drop-down list. Possible
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orders are
Date - Entries in the report will be sorted according to date and time, in
ascending order of time.
E/X/L Event - Entries in the report will be sorted into group of entering,
exact leaving events for the same transit or progression, and then the
groups are sorted into date order of the first item in the group. If the
Entering/Leaving option was not selected for this report, then this order
is the same as Date order.
Point 1 - Entries in the report will be sorted into groups of entries for each
point in the first column of the report. These are the dynamic chart
points. The entries are sorted by date within each dynamic point group.
Point 2 - Entries in the report will be sorted into groups of entries for each
point in the third column of the report. These are normally the radix
points, but may also be dynamic points if the event is a transit to transit,
transit to progression, transit to solar arc or progression to progression.
The entries are sorted by date within each point group.
Weighting - Entries in the report will be sorted into an order calculated
according to weightings ascribed to each transiting point, aspect and
radix point. The weightings relate to the speed of movement of each
chart point, so that transits involving (slow moving) Pluto are at the top
of the report, and within the transits of each planet, transits involving
the (fast moving) ascendant are at the top. In many instances this order
will approximate to the level of significance of the transit. However,
due to the subjective nature of determining the importance of particular
transits, this report should only be used as a potential aid - not as a
definitive statement of the relative importance of each transit!
Event Type - Entries in the report will be sorted into groups of the same
event types, for example all the transits to radix (Tr-Na) will appear
first, the transits to transits (Tr-Tr) next etc. The entries are sorted by
date within each group.
Aspect - Entries in the report will be sorted into groups of aspect. For
example, all conjunctions appear at the top, oppositions next etc. The
order in which of the aspects appear is determined by Solar Fire’s
internal aspect ordering, which is the same order in which aspects
appear in the aspect editor, for example.
You can alter the appearance of the report by switching on or off the Use
Glyphs, Use Colors, and Bold Text option. These work in the same way
as for the Chart Reports, as described on page 150.
If you wish to keep the report to view again later, then you can click on the
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screen's minimize button (at the top right of the screen). This will turn the
screen into an icon at the bottom of your Windows desktop area, and you
may view it again at any time by double-clicking on its icon. Note,
however, that if you generate another dynamic report, then it will overwrite
your existing report. If you wish to save it then you must print it or copy it
to the clipboard before producing another dynamic report.

Description of Report Layout
The report appears on the screen in two parts - at the top is a small window
giving a report header. This contains details of the radix chart, the points
and aspects selected and the types of events selected, and the period of the
report. Below this is the large window, containing the body of the report.
You can browse through the report by clicking on the scroll bars to the
right of the report display boxes.
A typical report line has the following items:
Point1

Asp

Point2

Hit

Type

Date/Time

Position1

Position 2

Ura(10)

Sqr

Ven(7)

(X)

(Tr-Na)

Jun 12 1993

19Cp23 R

19Li23 D

In this sample report line, transiting Uranus (retrograde) at 19°23' of
Capricorn in the 10th house is making an exact square to natal Venus
(direct) at 19°23' of Libra in the 7th house on 12th June 1993.
The possible items in each line are defined in the following table.
Point1

The dynamic point and the house it is occupying on the
radix chart

Aspect

The aspect formed between Point1 and Point2

Point2

The radix point (or second dynamic point) and its house
in the radix chart

Hit

(X) for exact hit, (E) for entering orb, (L) for leaving
orb, (S) for sign ingress, (H) for house ingress.

Type

A combination of abbreviations from the list below,
indicating the type of dynamic event and radix chart for
Point1 and Point2.

Date/Time

To the nearest day, expect for transits of the moon or
angles or eclipses, in which case the time is also given.

Position1

Zodiacal position of Point1 - R indicates retrograde, D
direct. If the aspect is a parallel or contra-parallel, then
this shows the declination or latitude. If this relates to a
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primary mundane direction, then this shows the position
of Point1 in its diurnal arc in pseudo degrees
(0°=Eastern horizon,90°=Upper culmination).
Position2

Zodiacal position of Point2 - R indicates retrograde, D
direct. If the aspect is a parallel or contra-parallel, then
this shows the declination or latitude.

Chart 1

Indicates the chart number and name of the dynamic
radix chart. This column only appears if an alternate
radix positions chart has been selected, or if the report is
merged with other reports which use a different
dynamic radix chart.

Chart 2

Indicates the chart number and name of the alternate
radix positions chart. This column only appears if an
alternate radix positions chart has been selected.

Possible Type abbreviations are as follows.
•

Tr - Transits

•

Sp – Secondary Progressed

•

Tp – Tertiary Progressed

•

Mp – Minor Progressed

•

Up – User Rate Progressed

•

Sa – Solar Arc Directed

•

Aa – Ascendant Arc Directed

•

Va – Vertex Arc Directed

•

Ua – User Arc Directed

•

Pm – Primary Mundane Directed

•

Pf - Profected

•

Na – Natal Radix

•

Pn – Progressed Radix

•

Di – Directed Radix

•

Re – Return Radix
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•

Co – Composite Radix

•

Ha – Harmonic Radix

•

Prefix “c” – Converse

•

Prefix “p” – Precessed

Some examples of these types are as follows.
•

Tr-Na - Transits to Natal

•

Sp-Na - Secondary Progressed to Natal

•

cpVa-Na - Converse Precessed Vertex Arc Directions to Natal

•

Tr-Pn – Transits to a Progressed Radix chart

•

Tr-Pr – Transits to progressions (same radix chart)

Point1 and Point2 may be any of the following types.
•

Any chart point (planet, asteroid, Transneptunian, angle) - Shown by
either it’s glyph or by it’s abbreviation (e.g.  or “Ura”)

•

A midpoint between any two points - Shown by either their glyph or
by their abbreviations (eg.  or “Ura/Mon”)

•

A fixed star - Shown by either s* where * is a number or by its first
six letters (eg. “s12” or “Mirach”)

•

An Arabic Part - Shown by either p* where * is a number or by its
first six letters (eg. “p7” or “Brothe”)

•

An asteroid - Shown by either a* where * is a number or by its first
six letters (eg. “a3” or “Apollo”)

•

A fixed position - Shown by either f* where * is a number or by its
position (eg. “f1” or “00Ar00”)

•

A house cusp – shown by a number from 1 to 12.

Note: If you have a listing with a large number of fixed stars, Arabic Parts,
asteroids or fixed positions, then you may wish to switch between the
alternate display styles to help you identify which item is which on the list.
W

To switch between the alternate display styles for Point1 and Point 2

Click on the Use Glyphs option in the Report Style frame
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Editing the Report
It is possible to delete lines from the report, on a line by line basis. In order
to delete a line, you must first select the line by clicking on it. The line is
shown to be selected by a dashed rectangle enclosing it. Then simply use
the Del key. The line will be deleted, and the other report lines adjusted as
necessary to fill the gap. Note that deleted lines cannot be undeleted. You
will need to regenerate the entire report in order to get any deleted lines
back.
You can also change the widths of the columns of the report by dragging
the column borders on the report header bar with the mouse, and the width
of the entire report by resizing the entire report window.

Item Info
It is possible to view further information on items in the dynamic report,
such as interpretations or a list of aspects to eclipses. This option also
makes it possible to see the full name of any fixed star, Arabic Part or
asteroid that appears in abbreviated form in a line of the dynamic report
W

To view further information on an item

Select a report line by clicking on it and then select the Item Info button,
or double-click on a line in the report
The Item Info dialog box will be displayed.
Item Info Dialog Box

The top box in this screen will show in words, what dynamic event this
line contains, followed by an interpretation of that event, if interpretation
text exists for that type of event.
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The bottom box will list any similar events that are found in the report, eg.
if the selected line is transiting Saturn square natal Moon, then any other
exact, entering or leaving hits of this transit will also be listed. Also, if the
selected event is a transit to a radix chart, then the total number of exact
hits that will occur during this transit is listed, plus the number of hits that
occurred before the report period, and/or the number that will occur after
the report period.
If the event is an eclipse or a stationary point of a planet (i.e. going direct
or retrograde), then a list of aspects of points in the radix chart to the
eclipse or stationery position is shown. The aspects used in this list are
those in Solar Fire’s currently selected aspect set.
When you have finished looking at the information in this dialog box,
clicking on the OK button will cause it to disappear.

View Chart
It is possible to calculate and display a full chart for date and time of any
event in the report. The type of chart depends on what type of dynamic
event is selected, for example for transits to a natal chart, you see a biwheel
showing a transit chart on the outside and the natal chart on the inside; for
a stationary point you see a single wheel showing transits; for transits to
progressions you see a biwheel with transits on the outside and
progressions on the inside, etc.
W

To display a chart for any event in the dynamic report

1. Select a report line by clicking on it
2. Select the View Chart button
This will cause any required chart or charts to be calculated and added to
the list of Calculated Charts, and the “View Chart” screen to be displayed.
When you have finished looking at the chart and Quit from this screen,
you are returned to the dynamic report screen.

Viewing a Dynamic Interpretations Report
You can send all the available interpretations for a dynamic report to be
viewed in a separate word-processor. You may also wish to select which
word processor to use (see page 138), and whether or not the report will be
formatted using Rich Text Format (see page 366).
W

To view an interpretations report

Select the Interps Report... button. Your word processor will be opened
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up displaying this report. You are then free to browse the report, to print it,
or to save it under another name if you wish. Note that, to keep a
permanent copy of the report, you must save it under a different name,
because Solar Fire always uses the same report name. When you have
finished with the report, exit from your word processor.

Copying to the Clipboard
W

To copy the report to the Windows clipboard

Select the Copy button.
From the clipboard, the report may be pasted into a word-processor or page
layout program, for example. Note that glyphs and colors cannot be copied
to the clipboard. Abbreviations are used instead of glyphs when the report
is copied into the Clipboard. Also, report columns may not align correctly
in the Clipboard. If you paste the Clipboard contents into your wordprocessor, you may have to edit the document to ensure that the columns
align correctly.

Printing the Report
W

To print the report in the displayed sort order then

Select the Print... button.
The printed report will contain glyphs (if you have the Use Glyphs option
selected), and colors (if you have a color printer and you have the Use
Colors option selected). However, the printed report always uses regular
(light) text. It is not possible to print the report using bold text.
Note that it is not possible to add a report to the print batch queue from this
screen. To do so you must use the Queue... button on the "Dynamic
Selections" dialog box.

Time Map
W

To view a graphical display of the dynamic events in your report

Select the Time Map button.
After a brief calculating period, the TimeMap screen will appear.
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Time Map Screen

The time scale for the time map corresponds to the period of the dynamic
report upon which it is based. The list of dynamic events is the same as
those in the dynamic report, expect that all the Entering, Exact and Leaving
events of a particular transit or progression are grouped together into single
entries. Also, to optimize space, the events are listed using astrological
glyphs, using subscripts to indicate what kind of dynamic event they relate
to. These subscripts are
t - transiting
p - progressing
d - directed
n - natal
r - radix
It is possible to alter the display to show either transiting hit numbers or
dates/times on which certain events occurred, on the map. The Hit Nos
option shows which hit in a series of direct/retrograde transits to a point is
occurring. For example, if the transit has three hits (1st hit direct, 2nd hit
retrograde, and 3rd hit direct), then these events will be labeled 1:3, 2:3,
and 3:3 respectively. If the transit has only one hit, then it will be labeled
1:1. This enables you to see at a glance whether there are associated hits
which occur before or after the duration of the time map. Note, however,
that progressions and directions and special dynamic events do not have hit
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numbers shown, as these will generally always be single events. The Date
option shows the day and month of each major event on the map. For
example an event which occurs on the 23rd March will be labeled either
23/3 or 3/23 depending on the date order in your Windows setup.
However, if the duration of the time map is less than 7 days, then this
option shows the time in 24 hour format, instead of the date. For example
an event which occurs at 3:46pm is labeled 15:46. It is possible to scroll
through this list by using the scroll bars on the right of the screen. It is also
possible to reorder and delete lines in the map.
W

To delete one or more lines from the map

Select the required lines by clicking on them
Select the Delete... button
You will be asked to confirm whether or not you wish to delete them. Note
that clicking on any line selects it on the first click, and unselects it on a
subsequent click.
W

To move a line on the map

Drag and drop the required line as follows
1. Position the mouse over the line you wish to move and hold down the
left hand button
2. Drag the mouse to the required position in the map
3. Release the mouse button
W

To print a copy of the time map

Optionally use the Printer... button to alter printer settings such as paper
orientation
Select the Print button
This will print the entire list, in the displayed order, using as many pages as
are required. Each page will have a time scale printed at the top.
W

To view further information on an item

Double click on a line
The Item Info dialog box will be displayed, showing interpretations and
event information. This may be used in the same manner as in the dynamic
report screen.
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W

To return to the dynamic report screen

Select the Quit button.
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Chapter 23: Using the Graphic
Ephemeris
This chapter describes how to generate, view and print a graphic ephemeris
of longitudes of transits, progressions or directions, and of declinations or
latitudes of transits and progressions, for any chart.
It is also possible to generate a graphic ephemeris of transits without
reference to any chart, which can be printed out as a pro-forma ephemeris
for use with any chart. A graphic ephemeris may also be added to the print
batch queue, to be printed later.
Before generating a graphic ephemeris, you should cast, open or generate
the subsidiary chart that you wish to base the ephemeris on, so that it is
showing in the “Calculated Charts” list box on the Main Screen.
W

To generate a graphic ephemeris

Choose the Graphic Ephemeris menu item from the Dynamic menu. This
will display the “Graphic Ephemeris Selection” screen that allows the
selection of a base chart and various other options.

Choosing Ephemeris Options
W

To select a base chart

Click on the required base chart in the list of Dynamic Radix Charts.
You may also optionally select a different chart from the Alternate Radix
Positions Chart drop-down listbox. Usually this should be the same chart,
but if you choose a different chart, then the generated ephemeris will show
dynamic events of the Dynamic Radix Chart in relation to the radix chart
points of the alternate chart. For example, if you choose “Sarah Jones” as
your dynamic radix chart, and “David Smith” as your alternate radix chart,
then when you generate an ephemeris, it will show Sarah’s progressed
planets making aspects to David’s natal planets.
W

To select previously saved options

Choose an item from the Saved Selections drop-down list on the left hand
side of the screen. This will immediately update all the selections on the
screen with whatever was stored under that saved selection description.
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W

To set the date from which the ephemeris will start

Select the Now button - If the Now button is selected, then the Date will be
updated to correspond to the computer's internal clock. This button is
useful if you wish to produce an ephemeris covering a period from
today onwards.
Enter a Date - Enter a date in any acceptable format. Most commonly used
formats are acceptable. If the format is not acceptable then an error
dialog box will be displayed. Acceptable formats are described in detail
on page 28.
Alternatively, to facilitate the setting of the date, there is a special feature
to help you quickly set the date back by a day, to the beginning of a
month, or to the beginning of a year. To set the date back by one day,
double-click on the Days option button. To set the date back to the first
day of the month (or to the previous month if the day is already the 1st
of the month), double-click on the Months option button. To set the
date back to the first day of the year (or to the previous year if the day
is already the 1st of January), double-click on the Years option button.
Once you have the desired start date then you can set the duration of the
ephemeris to be any number of days, months or years.
W

To select the duration of the ephemeris

1. Select any one of the Days, Months or Years option buttons
2. Enter the number of days, months or years in the Period box. This must
be a positive integer. The period that the ephemeris will cover will be
this number of years, days or months, depending on which of these
periods has been selected with the option buttons.
W

To select the location for which you wish the ephemeris to apply

Select either the Natal or Relocated option button - If a dynamic report is
being generated for an individual, then it should normally be relocated to
wherever they are living during the period of the report. However, if the
chart's subject is someone who is living in the same location as they were
born during the time of the report, then the natal option is appropriate.
If only progressions are being generated for an individual, then the location
should normally be the same as the natal chart location. However, if the
base chart is that of a person who moved during the first few months of
their life, it may be appropriate to relocate it.
If the Natal option is selected then all the boxes relating to location,
including time zone, longitude and latitude will contain the location details
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from the selected base chart. Note that although it is technically correct to
alter the time zone if the current time zone is different from the natal one,
in practice this is only necessary if you are examining lunar or chart angle
transits, as the difference in the resultant times is otherwise not significant.
If the Relocated option is selected then all the boxes relating to location,
including time zone, longitude and latitude will contain the current default
values. (See page 348 for details on default values.) Any of these values
may be altered in the same manner as when creating a new chart. See page
22 for instructions on how to alter location values.
W

To select the ephemeris dynamic type

Select one of the following options from the Ephemeris Selection list:
Transits - to display transiting planetary positions
Progressions - to display any type of progressed planetary positions
Directions - to display any type of directed planetary positions
If you select progressions, then the Progressions drop-down listbox in the
Dynamic Type box will become enabled, and you can select any of the
available progression types from that list. The progressions may be
secondary, tertiary, minor or user-defined rate.
If you select directions, then the Directions drop-down listbox in the
Dynamic Type box will become enabled, and you can select any of the
available direction types from that list. The directions may be solar arc,
ascendant arc or vertex arc.
Also note that, unless the base chart is a natal or event type chart, then it
will only be possible to select the Transits option. In this case, the other
options will be disabled (grayed).
If you wish to view Precessed or Converse planetary position, then you
can optionally also click on their check boxes in the Dynamic Type box.
W

To select the graph coordinate type

Select Longitude, Declination or Latitude from the drop-down list box
below the dynamic type selection. (Only longitude is available if you have
chosen to use directions.)
If you select longitude, then you have the option of selecting an ephemeris
modulus angle. If you select declination or latitude, then you can select an
angle extent.
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W

To select the ephemeris modulus angle

Select a pre-defined modulus angle from the Modulus Angle drop-down
list
Alternatively, you can type any desired angle from 10 minutes of arc to
360 degrees directly into the Modulus Angle box. You can type in
degrees and minutes and seconds, separating each with a space (eg. 22
30 for 22°30’), and you can also use decimal format (eg. 22.5 for
22°30’).
The graph will display the zero line at the top, and extends downwards by
the amount of the specified modulus angle.
W

To select the angle extent

Select a pre-defined angle from the Angle Extent drop-down list
Alternatively, you can type any desired angle from 10 minutes of arc to 90
degrees directly into the Angle Extent box. You can type in degrees
and minutes and seconds, separating each with a space (eg. 22 30 for
22°30’), and you can also use decimal format (eg. 22.5 for 22°30’).
The angle extent determines how many degrees are displayed on either side
of the zero line. For example, selecting 30 degrees for a declination graph
will create a graph from 30 degrees south to 30 degrees north.
Note: The graph always shows an equal angle extent above and below the
zero line. You cannot produce a graph that shows only one hemisphere.
W

To select other display options

Click on the Radix Positions check box in order to have the radix chart’s
planetary positions displayed on the ephemeris.
Click on the Radix Aspects check box in order to have an aspect glyph
displayed wherever a dynamic planetary position crosses a radix
position.
Click on the Deg Gridlines check box in order to have dashed lines drawn
across the ephemeris at each degree division. Having this option
switched on helps locate positions within the ephemeris more easily,
but may be distracting when viewing the ephemeris on a small screen.
Click on the Date Gridlines check box in order to have dashed lines drawn
down the ephemeris at each date division.
Click on the Back Shading check box to have the entire ephemeris data
area shaded with a light gray. This option affects the aesthetic
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appearance of the ephemeris only.
W

To select which chart points to use in the ephemeris

Click on the required point type (Transits, Progs or Radix) inside the
Points Selection box. This will display the File Manager which lists all the
available point files. To select a file, highlight it and click the Select
button. To see what is in a file and optionally make changes, click the Edit
button. For more details on selecting and editing point files, see page 217.
Note that only those point types which are applicable to the current
selections will be enabled.
W

To save these selections for future use

Click on the Save Selection... button. You will be asked to enter a
description under which to save this selection. Type in a brief description,
and then click on the OK button. The description will appear in the Saved
Selections list on the left of the screen, ready to reselect in future.
W

To delete a saved selection

Highlight the desired selection in the Saved Selections list, and press the
Del key.

Viewing and Printing the Graphic Ephemeris
Once all the options have been set in the Graphic Ephemeris Selection
screen, it is possible to view the ephemeris, to print it now or later, and to
copy it to the clipboard for pasting into other programs.
W

To add the ephemeris to the print batch queue

Click on the Queue... button. This will display a dialog box asking you to
confirm whether or not you wish to add this job to the Solar Fire print
batch queue. If you select the OK button, then it will be added to the
queue, and it will not be calculated or printed at this time. It is possible, at
any later time, to start printing all the jobs which are on the batch print
queue by selecting the Start Print Queue... option from the View menu of
the main screen.
W

To view the graphic ephemeris

Click on the OK button. The "Graphic Ephemeris" screen is displayed, and
the ephemeris is generated as you watch. Once the ephemeris is finished,
you have the option of resizing the screen. If the screen is smaller than the
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available screen size, then clicking on the screen’s maximize button will
generate a larger display, which may be easier to read.
W

To print the graphic ephemeris

Click on the Print... button. The usual print dialog box will appear
enabling you to select Setup... or Print. However, the Queue button will
be disabled. In order to queue the ephemeris, you must return to the
Graphic Ephemeris Selection screen.
W

To copy the ephemeris as a graphic

Position the mouse anywhere over the graphic ephemeris and click once on
the right-hand mouse button. This will display the copy dialog with the
options to copy the graph to various locations in various formats. See page
126 for a full description of these options.
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Chapter 24: Searching for Eclipses
This chapter describes how to use Solar Fire’s eclipse database to list
eclipses and eclipse data, cast eclipse charts, and search for eclipses that
make aspects to any specified position or any points in a specific chart.
W

To enter the eclipse module

Select the Eclipses… item from the Dynamic menu
You will then see the Find Eclipses dialog from which you can make
various selections.

•

Dates - You must always specify a date range in the From and To
fields. These accept dates in the same way as all other date entry
fields in Solar Fire. See page 28 for details on entering dates.

•

Eclipse Types – You can select any combination of eclipse types
and/or Saros Numbers by using the check boxes for each option, and
optionally entering a specific (van den Bergh) Saros Number. See a
description of eclipse types below.

•

Eclipse Aspects – If you wish to find only those eclipses which
make an aspect to a fixed position, then check the first box, and enter
the required zodiacal position. If you wish to find all eclipses which
make an aspect to a planet or point in a chart, then check the second
box and select a chart from the drop-down list of calculated charts.
You can select which set of aspects are used by clicking on the
Aspects box, and which set of chart points are used by clicking on
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the Chart Points box.
Solar Eclipse Types
•

Partial – There is no region of complete obscuration of the Sun. This
occurs when the axis of the Moon’s shadow passes outside of the
disk of the Earth. Maximum partial eclipse therefore occurs in polar
regions.

•

Annular – This occurs when the size of the Moon’s disk is less than
the size of the Sun’s disk, so that when the Moon is directly in front
of the Sun, a ring of sunlight (annulus) is still visible around the
Moon.

•

Total – This occurs when the Moon’s disk is larger than the Sun’s
disk, and completely obscures the Sun for a period of time.

•

Hybrid - Hybrid eclipses are also known as annular/total eclipses.
They occur when the vertex of the Moon's umbral shadow pierces
Earth's surface along the central path of an annular eclipse. The
eclipse's character then changes to total along the section of the path
where the umbral vertex extends beneath Earth's surface. The central
paths of hybrid eclipses usually (but not always) begin and end as
annular eclipses, but become total along some middle portion of the
path.

Lunar Eclipse Types
•

Appulse – This occurs when the Moon passes across the penumbra
of the Earth’ shadow, and this darkens part of the Moon’s surface,
but obscures none of it completely.

•

Partial – This occurs when the Moon passes partly across the umbra
of the Earth’s shadow. Part of the Moon’s surface becomes
completely obscured.

•

Total – This occurs when the Moon passes completely into the
shadow of the Earth, and the whole disk of the Moon becomes
completely obscured.

When you have made all your selections, click on the Start Search button.
Solar Fire will list all of the eclipses that match your selection in the list
box on the bottom right of the dialog.
When you highlight any eclipse on this list, the full details of that eclipse
will appear in the box at the top, right of the dialog, and any aspects which
are made between the eclipse point and the (optionally) selected chart will
be displayed below that. The items displayed are as follows.
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•

Eclipse Type – Solar / Lunar and whether Partial / Annular / Total /
Hybrid / Appulse.

•

Date and Time – The date and time (Universal Time, timezone
+0:00) of maximum eclipse, given to the nearest whole minute.
Maximum eclipse is defined as the instant when the Moon passes
closest to the axis of Earth's shadow, or when the Moon’ shadow
passes closest to the Earth’s center.

•

Position – The zodiacal position of the Sun (in Solar Eclipses) or
Moon (in Lunar Eclipses).

•

Saros Number – The number of the Saros cycle to which this
eclipse belongs. The Saros is a period of approximately 18 years and
11 days, after which eclipses are repeated with only slightly altered
characteristics. The standard astronomical numbering system is that
first described by Prof. G. van den Bergh in “Periodicity and
Variation of Solar (And Lunar) Eclipses” publ. Haarlem,
Netherlands, 1955. An alternative numbering system was described
by Robert Carl Jansky in “Interpreting the Eclipses” publ. Astro
Computing Services 1979, and extended by Bernadette Brady in
“The Eagle and the Lark” publ. Samuel Weiser Inc, 1992.

•

Gamma – In a lunar eclipse, this is the distance of the Moon from
the axis of the Earth’s shadow, at the time of greatest eclipse. In a
solar eclipse, this is distance of the shadow cone axis from the center
of Earth at the instant of greatest eclipse. Units are of equatorial
radii.

•

Magnitude – The fraction of the Sun’s diameter obscured by the
Moon.

•

Umbral Magnitude – The fraction of the Moon’s diameter obscured
by the umbra.

•

Penumbral Magnitude – The fraction of the Moon’s diameter
obscured by the penumbra.

•

Duration Total – The duration of total or annular eclipse phase at
the point of greatest eclipse.

•

Semi-Duration Total – The half-time of totality (complete
obscuration of moon) of eclipse. Adding this time to the time of
maximum eclipse would give the time of ending of totality.

•

Semi-Duration Partial – The half time of partial (partial obscuration
of moon) phase of eclipse. Adding this time to the end of totality
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would give the time of ending of the partial phase of the eclipse.
W

To calculate a chart for a listed eclipse

1.

Highlight the required eclipse in the list box.

2.

Click on the Chart button.

This will calculate a chart for the time of maximum global eclipse for the
current default location in Solar Fire. If you wish to se the chart for another
location, then use the Chart / Locality menu items to relocate the chart to
the required location.
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Chapter 25: Real Time Clock and
Animation
This chapter describes how to use Solar Fire’s real time astrological clock,
and how to animate charts and page displays by running or stepping them
forward and backward through time. This module also allows the one-step
construction of biwheels, triwheels and quadriwheels showing transits
progressions and directions around natal chart.
Some things that can be done in this module are as follows.
•

Display a real time astrological clock for the current location

•

Display a real time astrological clock for any other location and
timezone

•

Display a natal chart ready to step forward or backward in time

•

Display a progressed or directed chart ready to step forward or
backward in time

•

Display a biwheel with a natal chart (or radix chart) on the inner
ring, and current transits on the outer ring, ready to step forward or
backward in time

•

Display a triwheel with a natal chart (or radix chart), current
secondary progressions and transits, ready to step forward or
backward in time

•

Display a quadriwheel with a natal chart (or radix chart), current
secondary progressions, solar arc directions and transits, ready to
step forward or backward in time

•

Display other combinations of fixed and dynamic charts in uni, bi,
tri and quadriwheels

•

Display any astrological page ready to step forward and backward
in time

•

Run, step or jump the charts or pages through time

Each of these options is described more fully below.
Note that the wheel styles and other color options used in this module are
always the same as those which are in effect on the View Chart screen, and
can be altered by using a right hand mouse click somewhere over the
display to bring up the Chart Options menu.
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How to Set Up Animations
W

To display a real time astrological clock for the current location

Select the Real Time Clock item from the Dynamic menu
This will display a chart for the current default location, updated at regular
intervals.
W

To display a real time astrological clock for any other location and
timezone

1.

Cast a new natal chart for the required location for any date and time

2.

Select that chart as the current chart

3.

Select the Animate Chart… item from the Dynamic menu

4.

Click on the Clock option button at the top right of the screen

This will display a chart for the required location, showing the correct
current local time for the timezone of the chart, updated at regular
intervals. For example, if your default location is Sydney, Australia (AEST
–10:00), and it is currently 3pm in Sydney, and you cast a chart for
London, UK (GMT +0:00), then display that chart in the real time clock,
then the clock time will be displayed as 5am GMT, which is the correct
current time for London.
W

To display a natal chart ready to step forward or backward in time

1.

Select the required natal chart as the current chart

2.

Select the Animate Chart… item from the Dynamic menu

This will initially display the chart exactly as it has been cast. If you use
the time controls to alter or step the time, then the chart’s date and time are
used as the starting point, and then adjusted according to the options you
choose.
W

To display a progressed or directed chart ready to step forward or
backward in time

3.

Select the required progressed or directed chart as the current chart

4.

Select the Animate Chart… item from the Dynamic menu

This will initially display the chart exactly as it has been cast. If you use
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the time controls to alter or step the time, then the chart’s date and time are
used as the starting point, and then adjusted according to the options you
choose.
To display a biwheel with a natal chart (or radix chart) on the inner ring,
and current transits on the outer ring, ready to step forward or backward in
time
1.

Select the required natal chart as the current chart

2.

Select the Animate BiWheel… item from the Dynamic menu

This will display the natal chart as a fixed chart on the inner ring, and the
current transits on the outer ring. If you use the time controls to alter or
step the time, then the current date and time are used as the starting point,
and the transits chart is then adjusted according to the options you choose.
W

To display a triwheel with a natal chart (or radix chart), current
secondary progressions and transits, ready to step forward or backward
in time

1.

Select the required natal chart as the current chart

2.

Select the Animate TriWheel… item from the Dynamic menu

This will display the natal chart as a fixed chart on the inner ring, and the
current secondary progressions on the middle ring, and transits on the outer
ring. If you use the time controls to alter or step the time, then the current
date and time are used as the starting point, and the progressions and
transits charts are then adjusted according to the options you choose.
W

To display a quadriwheel with a natal chart (or radix chart), current
secondary progressions, solar arc directions and transits, ready to step
forward or backward in time

1.

Select the required natal chart as the current chart

2.

Select the Animate QuadriWheel… item from the Dynamic menu

This will display the natal chart as a fixed chart on the inner ring, and the
current secondary progressions on the middle inner ring, solar arc
directions on the middle outer ring and transits on the outermost ring. If
you use the time controls to alter or step the time, then the current date and
time are used as the starting point, and the progressions, directions and
transits charts are then adjusted according to the options you choose.
W

To display other combinations of fixed and dynamic charts in uni, bi, tri
and quadriwheels
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If you are already displaying a dynamic wheel with the required number of
charts, then click on the Charts… button to display a dialog which allows
you to select alternative charts.
Alternatively, you can select the Animate Page… item from the Dynamic
menu. You will be prompted to select the required page type from the list
of available pages, and then the required chart types. (See below)
W

To display any astrological page ready to step forward and backward in
time

If you are already displaying a dynamic wheel or page with the required
number of charts, then click on the Page… button to display a dialog that
allows you to select alternative pages. Note that you will only be able to
select another page which requires the same number of charts as the wheel
or page you are currently viewing.
Alternatively, you can select the Animate Page… item from the Dynamic
menu. You will be prompted to select the required page type from the list
of available pages, and then the required chart types. (See below)

Selecting Alternative Chart Types
The dynamic chart selection dialog is similar to the multiwheel selection
dialog, except for the additional option of selecting a dynamic method to
apply to some or all of the charts in the wheel or on the page.
You can select the following chart types or methods:•

Transits – This will display a chart of transiting positions, varying
with the animation date and time. When this option is selected, there
is no need to select a base chart.

•

Fixed Base Chart – This will display the selected base chart as
fixed, so that it does not vary with the animation date and time. This
option should be selected, for example, with a natal chart that you
wish to place in the center of a multiwheel, with transits or
progressions around it.

•

Secondary Progressions – This will display a chart of the
progressed positions calculated from the selected base chart.

•

Mean Tertiary Progressions – As above

•

True Tertiary Progressions – As above

•

Minor Progressions – As above
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•

User Progressions – As above. The user progression rate is one of
the settings that may be specified in the Preferences dialog of Solar
Fire.

•

Solar Arc Directions – This will display a chart of the directed
positions calculated from the selected base chart.

•

Ascendant Arc Directions – As above

•

Vertex Arc Directions – As above

•

User Rate Directions – As above. The user direction rate is one of
the settings that may be specified in the Preferences dialog of Solar
Fire.

•

Annual Profections – As above. The profection rate is equivalent to
a direction arc of 30 degrees per year.

When you select a progression or direction method, you may also choose
whether to apply converse or precession options, by checking the
appropriate boxes as required. These options have the same effect as the
same named options when casting subsidiary charts under the Chart menu.
See page 66 for further information on these options.
The Selected Chart list at the bottom of the dialog contains a list of which
chart types have already been selected. If you have selected a uniwheel or
page which requires only one chart, then this list will only have a single
item in it. If there are multiple items in the list, then you must click on the
one you wish to select or edit before changing your selection of base chart
and/or dynamic chart method.
W

To select a transits chart to animate

In the Selected Charts list, click on the item that you wish to change to
transits.
In the Dynamic Methods list, click on the Transits item.
It is not necessary to select a base chart in this case, because transits
depend only on the animation date and time, and are calculated
independently of any base chart.
W

To select a fixed base chart

In the Selected Charts list, click on the item that you wish to change to a
fixed base chart.
In the Base Charts list, click on the required base chart.
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In the Dynamic Methods list, click on the Fixed Base Chart item.
Any chart that you select this way will remain fixed, even though you may
be running an animation. This option is only to be used when you have
other dynamic charts in the same wheel page, such as transits or
progressions to the base chart, and you want the base chart to remain fixed
as a radix chart whilst the other dynamic charts are animated as the date
and time change.
Note: If you use the fixed base chart option when you are only viewing a
single chart on a wheel or page, then the animation features will have no
effect.
W

To select a dynamic chart to animate

In the Selected Charts list, click on the item that you wish to change to an
animated chart.
In the Base Charts list, click on the required base chart.
In the Dynamic Methods list, click on the required dynamic method (such
as Secondary Progressions, Solar Arc Directions etc.,), and optionally also
select the Precessed and Converse options.
Any chart calculated by this method will be derived as a subsidiary chart of
the selected base chart, and updated according to the animation date and
time.

How to Control the Animation
When the real time clock is running, you cannot perform any of the
animation functions. Before using the animation features, you must ensure
that the Animation option is chosen at the top right of the screen.
W

To set the time and date to a particular value

Enter new values directly into the date and time boxes. (See page 28 and
31 for details on acceptable formats for dates and times).
W

To set the time step interval

1.

In the Step By drop-down box, select one of the pre-defined time
intervals.

2.

Optionally enter a numeric multiple into the box immediately to the
left.

For example, to specify a 5 minute interval, select the “Minutes” item from
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the list, and then enter the value 5.
W

To run the chart through time

The left and right arrows will start the animation running backward or
forward in time respectively, with the display being recalculated at the
specified intervals. Click on the red square Stop button to halt the
animation.
W

To step the chart forward or backward

The left and right arrows with the adjacent vertical bars will step the
animation backward or forward in time respectively, one step for each
mouse click.
Alternatively, after ensuring that the displayed wheel or page has the focus
(by clicking on it), you can use the left or right arrow keys to step back or
forward with one step per keypress.
W

To change the rate of animation

Use the mouse to slide the Animation Speed control left or right.
When at its leftmost position, this will attempt to update the display as
often as the power of your computer will allow. When moved further right,
the display is only updated after a fixed interval of time has elapsed. If
your computer is not a very recent, powerful model, you may wish to leave
this control at or near its fastest setting. If your computer is especially
powerful, you may prefer to choose a slower setting so that the animation
does not run overly fast.
W

To reset the date and time to now

1.

Click on the Clock option button – this will reset the date and time to
match your computer’s system clock, and the timezone of the first
displayed chart. Note that this means that the displayed time and date
will be correct for the location of the chart according to its timezone,
and may therefore be different from your current local time, but the
planetary zodiacal positions will still be the correct ones for the
current instant.

2.

If you wish to animate again from this date and time, then click on the
Animation option button.
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Chapter 26: Generating an Ephemeris
Listing
This chapter describes how to use Solar Fire's Ephemeris Generator Utility
to view or print an ephemeris for selected planets and asteroids over a
selected time period. Ephemeris positions generated in this utility have the
same accuracy as they do in any other Solar Fire chart.

Starting the Ephemeris Generator
W

To start the utility

Select the Ephemeris Generator item from the Dynamic menu.
Solar Fire then displays a screen allowing you to select what kind of
ephemeris you want.
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Setting Ephemeris Options
The selections that you may make are as follows.
Period of Ephemeris - Enter the date and time from which you wish the
ephemeris to start and the date and time at which you wish the
ephemeris to finish. Dates and times may be entered in the same way as
they entered for Solar Fire charts. The starting date and time are used
for the first ephemeris entry, and entries are then calculated at the
specified frequency until the end date and time are reached. (You may
stop the ephemeris generator at any point during calculations if you
wish).
Frequency of Entries - Specify the required interval between ephemeris
entries by choosing a unit from the dropdown list box, and optionally a
number of units. It is possible to specify an interval from 1 minute up to
thousands of years if required. Typically, you may wish to generate
entries every 1 day, 10 days, 1 month or 1 year.
Ephemeris Time Zone - Published ephemerides are usually calculated for
the GMT timezone (+0:00). However, you may enter any timezone that
you wish, either manually by typing in a zone abbreviation and/or time,
or by using the Zone button and selecting a zone from the list.
Zodiac - Select the zodiac in which you wish the ephemeris to be
generated from the drop-down list of zodiacs. The available zodiacs are
the same as those that can be used in other Solar Fire charts. The
topical zodiac is that most commonly used in western astrology.
Coordinates - Select the desired coordinate system from the option
buttons. Published ephemerides are usually in geocentric coordinates.
Lunar Node - If you are including the moon’s node as a selected point to
list, then select the desired lunar node type from the option buttons.
This option is ignored if the moon’s node is not selected as a point to
list.
Items to List - You may select one or more items to list by clicking on
their check boxes. The generated ephemeris will have one column for
each item to list for each selected point to list.
Points To List - You may either select any set of Transiting Points and/or
Extra Points (as in the dynamic report). Click on the name of the file to
see the File Manager with a list of selectable files. You can also create
new selections by using the Create button in the File Manager. Note
that some of the points you can select will give different results
depending on the location. For example, chart angles like the
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Ascendant and Midheaven, and the parallax corrected Moon will vary
according to location. The location adopted for these calculations is
always that of the currently selected chart in the list of Calculated
Charts. Hence, if you wish to list chart angles for another location, you
must first cast a chart for that location, and then select it as the current
chart, before entering the ephemeris generator.
Precision - You can select whether to display the calculated positions to
the nearest minute of arc or second of arc. Bear in mind that most of
Solar Fire’s planets are accurate to within several seconds of arc, but
the asteroids are only accurate to about a minute of arc. Therefore,
displaying the asteroid positions to the nearest second of arc is not
useful.
Notation - The generator can display its output in normal Zodiacal
notation, or in Decimal Degrees. If you choose the Decimal Degrees
option, then when you view the ephemeris, you will have the option of
dumping the output to an ASCII text file. This is useful if you want to
import the data generated into a spreadsheet or database program.

Viewing the Ephemeris
W

To start the generation of the ephemeris according to your selections

Click on the Start button. You will then see the View Ephemeris screen
which displays the ephemeris in a grid as it is generated. The percentage of
the ephemeris completed is updated continuously in a display at the top
right of the screen. This disappears when the generator has finished.
W

To stop the generator at any point, before it is finished.

Click on the Stop button.
You can browse through the ephemeris by clicking on the horizontal or
vertical scroll bars.
W

To print the output

1. Optionally click on the Printer... button. This allows you to select the
printer you require and/or alter printer settings.
2. Click on the Print button. This will send the ephemeris to the printer.
Note that if your ephemeris will take more than one page to print, then
you will be given an estimate of how many pages are required, and
given the option of canceling without printing. This is to avoid paper
wastage should you accidentally choose to print an ephemeris which is
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longer than you intended.
The ephemeris is automatically formatted to fit as many columns as
possible onto each page. However, if the ephemeris is wider than a page,
then extra pages will be generated to print the additional columns.
If you have selected the Decimal Degrees notation option, then you have
the option of dumping the data into an ASCII text file.
W

To dump the output to an ASCII file

1. Click on the Dump... button. This will display a standard File Save
dialog.
2. Select a file name and location to dump the output to.
3. Click on the OK button.
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Chapter 27: Printing from Solar Fire
This section describes how to send a chart page, report or time map to the
printer which is attached to your computer system, how to add a print job
to the batch print queue, to be printed at a later time instead of
immediately, and how to alter printer settings such as the number of copies
of each page to be printed, the page orientation and the print resolution.
If you wish to set page margins, then you must do this before printing. See
page 207 for information on how to do this.
Before printing a chart, grid or report relating to a chart or grid, it is
necessary to have either cast, opened or generated the charts which you
wish to print, or to have generated the report which you wish to print.
You can print from any screen with a Print... button, or with a Print menu
option.

Printing from a View screen
You can print any wheel, grid, user-defined page, dynamic report, Time
Map, ephemeris page or Planetarium view by clicking on the Print button
on the screen. In most cases a print dialog box will appear, which you can
use as described in following sections.
W

To print any chart or grid or page layout for which an image has already
been created

From the "Chart View" screen, select the required image from the list of
images
Select the Print... button
W

To print any report, from the "Chart Report" screen

Select the desired report from the list of reports
Select the Print... button

Printing without Viewing
If you just want printouts, you can print single and multiple wheels and
grids without first viewing them on the screen. These printouts will use
whatever displayed points, aspects set, wheel style, display options, colors,
fonts and other options that are currently selected in the Chart Options and
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Preferences menus.
W

To print one or more charts or aspect grids from the main screen

Select the chart(s) from the list of "Calculated Charts".
Select the Print Chart... or Print Grid... options from the Chart menu.
W

To print a multiwheel chart or synastry grid from the main screen

Follow the instructions on page 111 to select the required charts.
Select the Print... button.

Using the Print Dialog Box
Most Print options in Solar Fire will display the "Print" dialog box, which
allows the user to add the print job to the batch print queue, to alter printer
settings, or to print immediately.
Print Dialog Box

If you wish to exit from this dialog box without taking any action, then the
Cancel button may be used.
W

To send output to the printer immediately

Select the Print button - This will start the print job, and messages will
appear on the screen to indicate the status of printing. Generally the printer
will not actually start printing until the "Print" dialog box disappears. It is
not possible to cancel printing once it has started, although it is possible to
delete an item from the Windows print queue if it has not already been sent
to the printer in its entirety. See your Windows manual for information on
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the Windows print queue.
If the printer is switched off, not connected to the computer, or has other
problems, then Windows will issue a message asking whether you wish to
cancel or retry. You may then attempt to remedy the problem and select the
Retry button, or select the Cancel button if you wish to continue working
without fixing the problem now. If the Cancel button is selected then the
output will not be sent to the printer, but it will remain on the Windows
print queue (not to be confused with the Solar Fire batch print queue).
Please refer to your Windows manual for instructions on using the
Windows Printer object to deal with the Windows print queue.
W

To add this output to the print batch queue

Select the Queue... button - This will display a dialog box asking you to
confirm whether or not you wish to add this print job to the Solar Fire print
batch queue. If you select the OK button, then it will be added to the
queue, and it will not be printed at this time. It is possible, at any later time,
to start printing all the jobs which are on the batch print queue by selecting
the Start Print Queue... option from the View menu of the main screen.
W

To alter printer setup options

Select the Setup... button
See page 208 for information on altering printer settings.
Color Printers
If your printer is a color printer and the current printer driver allows color
or grayscale printing, then you will see two option buttons at the bottom of
this dialog box. These give you the option of selecting whether to send
output to the printer using the colors (or grayscale equivalents) which are
shown on your screen, or whether to convert all color output to black. If
you choose the color/grayscale option, then the output will be in color if
you have installed color ink cartridges, or in grayscale if you have installed
black ink only.

Setting Page Margins
It is possible to set page margins which apply to all types of Solar Fire’s
printed output, including charts, reports and time maps.
W

To set page margins

Select the Page Margins... option from the Charts menu - This will
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display a “Page Margins” dialog box in which it is possible to view the
current page margins or to set new ones.
There are four margins (left, right, top and bottom), each of which may be
different, if desired. These margins are expressed in terms of a ratio of
page dimensions (based on the printable page area, not the full page size),
so a setting of 0.1 indicates a margin of 1/10th of the printable page size,
for example.
Each margin must be between 0 and 0.4 inclusive. A page margin of 0
indicates that printed output will extend right to the edge of the printable
area of the page.
For example, if you wish to set a 10% left hand binding margin, but to
otherwise use the full printable area, then enter
0.1

0.0

0.0

0.0

When you select the OK button you will be asked to confirm your settings
before they are saved. Note that the page margin settings are saved for
subsequent sessions only if you choose to Save Settings or if Save
Settings on Exit is on.

Altering Printer Settings
W

To alter printer settings

Do either of the following
From Solar Fire’s Print Dialog box, select the Setup... button
Select the Printer Setup... option from the Options menu of Windows
Print Manager in the Control Panel
This will display a "Print" dialog box which allows the selection of an
alternative printer, and the number of copies of each page to print and
whether to collate the pages in order.
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If you wish to exit from this dialog box without altering any settings, then
the Cancel button may be used. If you wish any changes that you make to
take effect, then the OK button should be used.
There is also a Properties... button which allows page orientation and size
and other options to be selected. Use this option if you wish to alter the
page orientation from portrait (normal orientation) to landscape (page
sideways) or vice-versa. However, note that if you use landscape format to
print charts, then any reports subsequently printed will also be in this
orientation unless you switch this option back first.
Please refer to your Windows manual for further information on how to
specify printer settings.
Any alterations made with this option result in changes to the printer setup
being stored in Windows, and these changes will therefore affect any other
Windows applications that use the printer.

Using the Batch Print Queue
The batch print queue is a means of storing instructions for the printing of
a series or charts and/or reports and then allowing them to be printed all
together at a convenient time. The purpose of the option is to allow the
user to generate a large number of charts and reports in a short space of
time, without having to wait for each one to print before generating the
next one. Then at a convenient time, the user may take a break whilst the
whole batch of charts and reports in printed out without requiring any
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further user interaction. The print queue keeps a record of all the chart
display options which were in effect at the time when each item was added
to the queue, and uses the appropriate options for each chart individually as
it is printed, when the queue is released. After the batch queue has finished
printing, the chart display options are automatically restored to the settings
which were in effect immediately before the queue was released.

Adding Items to the Print Queue
For instruction on how to add items to the batch print queue, see page 205.
It is possible to put any type of chart or grid image and most types of
reports onto the batch print queue.

Starting the Print Queue
This section describes how to start the batch print queue, which will print
all the items that have been added to the print queue during this session, or
since the batch print queue was last printed or cleared.
W

To start the print queue

From the main screen, select the Start Print Queue... option from the
Chart menu - This will display a dialog box asking for confirmation of
whether to start printing items on the batch print queue. Select the Cancel
button to quit without starting the queue, or the OK button to start printing.

Clearing the Print Queue
This section describes how to clear all the items from the print batch queue
which have been added since it was last printed or cleared. If the print
batch queue is cleared, then all the items on the print queue will be lost.
W

To clear the print queue

From the main screen, select the Close Print Queue... option from the
Chart menu - This will display a dialog box asking for confirmation of
whether to clear all the items from the batch print queue. Select the Cancel
button to quit without clearing the queue, or the OK button to clear it.

210 Solar Fire 5: Doing Astrology With Solar Fire

Customizing Solar Fire

Chapter 28: Using the File Manager
This chapter describes how to use the file manager. The file manager is a
common access point to various file management functions for all the file
types which exist within the program. It is possible to create new files,
delete existing files, copy files, rename files or select files to be the current
file, from within the file manager. For certain file types it is also possible
to edit the file.
The file manager is accessed from a variety of different menu options and
screens within the program.
Choosing any of the following types of options from the main screen
menu, or from other locations in Solar Fire, will invoke the file manager.
Chart File…
Displayed Points...
Extra Ring Points…
Aspect Set...
Aspected Points...
Fixed Star File...
Arabic Parts File...
Asteroid File...
Extra Bodies File…
Wheel Styles...
Dial Styles...
Point Colors...
Aspect Colors...
Sign Colors...
Interpretations File...
In the dynamic report selection and graphic ephemeris selection screens,
clicking on any of the following boxes will also invoke the file manger.
Transiting Points
Extra Transiting Points
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Progressing Points
Extra Progressing Points
Radix Points
Extra Radix Points
Transiting Aspects
Progressing Aspects
The file manager will also be invoked if the File... button is selected from
any screen.
When the file manager screen appears its title line will display the name of
the file type that has been chosen, and the list box will contain an entry for
each file name of this file type. The file name that is highlighted is always
initially the "current" file (i.e. the last selected file). If there are no files of
this type then the list box will be empty, and it will only be possible to
create files.
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File Manager Dialog Box

The File Manager dialog can be resized horizontally or vertically as
required by dragging its borders with the mouse. It is possible to leave the
file manager at any time by selecting the Cancel button.

Selecting a File
Selecting a file causes the contents of that file to be read into the program
to be used wherever appropriate. For example selecting a "Displayed
Points" file called "plan&ast.pts" updates the list of points that will be
displayed on any subsequently drawn chart.
Also that file becomes the "current" file, and the display box on the main
screen is updated to show the name of this file as the currently selected file.
W

To select a file

Select a file from the list of file names and click on the Select button, or
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double-click on a file on the list of file names. If you are selecting a chart
file, then you also have the option of choosing a directory of folder to look
in first.
After file selection, the file manager screen is hidden.
Note: If you need more space to see long file or directory names, then
resize the dialog box by dragging its border with the mouse.

Selecting a Directory or Folder
When selecting Chart Files, it is possible to access directories other than
Solar Fire’s standard USERDATA directory. This can be useful if you
wish to read from or save charts to a diskette, networked computer, or any
other location on your own computer, for example.
W

To select a directory or folder

If the directory selection box is not already visible, then click on the
Directory… button to make it visible.
You can select an alternative drive by finding it on the drop-down list box
of drives, and any directory on that drive by navigating through the
directories or folders on that drive.

Creating a File
W

To create a new file

Select the Create... button.
This will display the "Create File" dialog box, which allows the entry of
the file name to create. Note that the file name must be a valid file name,
without a file extension (the file manager automatically adds the
appropriate file extension for this file type). A valid file name can consist
of up to 80 characters. If the name is not valid then an error dialog box will
be displayed.
When the file has been created its name is added to the list of file names on
the file manager screen, and it may be edited if it is of an edible file type.
The initial contents of a newly created file depend on the file type:
For a "Charts" or "Places" file, the file will be empty after it is created, and
it will be possible to add entries by saving charts or entering places into the
place database screen, respectively.
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For "Displayed Points", "Aspected Points", "Radix Points", "Transiting
Points" and "Progressing Points" files, the file will contain a selection of
points containing all the planets, Chiron, the North Node, the Ascendant
and the Midheaven.
For "Point Colors", "Aspect Colors" and "Sign Colors" files, the file will
contain colors all set to black.
For "Aspect Set" files, the file will contain a list of standard 12th harmonic
aspects.
It is not possible to create an "Interpretations” file. If you wish to do so,
you must use the Interpretation Editor, which is a separate utility program.
If you wish to create a new file which is to be only slightly different from
an existing file, it may be easier to copy the existing entry to the new file
name instead of creating the new file name. This will result in less editing
being required.

Deleting a File
W

To delete a file

1. Select the file from the list of file names.
2. Select the Delete... button.
This will display a dialog box asking for confirmation of deletion. When
the file has been deleted its name is removed from the list of names on the
file manager screen.

Copying or Renaming a File
Copying a file results in a new file being created with a copy of the
contents of the selected file, whereas renaming a file results in the name of
an existing file being changed.
It is possible to use these options to copy or rename files to or from floppy
disks or other directories or folders on the computer's hard disk.

W

To create a copy of an existing file under a new file name

1. Select a file from the list of file names
2. Select the Copy... button
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This will display a standard file save dialog box allowing you to enter a
new name and/or location
W

To rename a file

1. Select a file from the list of file names
2. Select the Rename... button
Then follow the same procedure as for copying a file.
Note: If any files other than chart files are copied or renamed to other
directories or floppy disks then the file manager will not be able to display
them in its list of selectable files. The file manager only displays the names
of files that are in the Solar Fire’s default USERDATA directory.

Editing a File
You can edit the contents of any file for which the Edit button in the File
Management dialog box is enabled. It is not possible to edit "Charts" or
"Places" files from the file manager. Charts files can only be manipulated
in the Chart Database screen, and Places files in the Place Database screen.
The manner in which each of the various file types can be edited is
described in the following sections.
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Chapter 29: Editing a Chart Points File
This section describes how to edit files that contain definitions of primary
chart points to be included or excluded from a chart, grid or report.
There are five different types of chart point files.
•

Displayed Points - These are the points that are to be displayed in any
chart or page image or chart report.

•

Aspected Points - These are the points to which aspects are drawn in
any chart image.

•

Radix Points - These are the points that are used as radix points in a
dynamic report.

•

Transiting Points - These are the points that are calculated as transits
to the radix points in a dynamic report.

•

Progressing Points - These are the points that are calculated as
progressions or directions to the radix points in a dynamic report.

W

To edit a points file

1. Choose the required point type from the Chart Options menu, or click
on the desired points box the Dynamic Reports Selection screen
2. Select the file from the list of file names
3. Select the Edit... button
This will display the "Chart Point Selection" dialog box.
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All the points in the "Selected Points" list box are considered to be
switched on, whereas those in the "Unselected Points" list box are
considered to be switched off and will not be used when this file is
selected.
W

To switch on a single chart point which is in the unselected list

Click on a point on the Unselected Points list, or use the arrow keys to
highlight a point on the Unselected Points list, and then use the Enter key
W

To switch off a single chart point which is in the selected list

Click on a point on the Selected Points list, or use the arrow keys to
highlight a point on the Selected Points list, and then use the Enter key
W

To switch off or on all planets, asteroids, TransNeptunians or other
points which are in the unselected list

1. Select the Planets, Asteroids, TransNeps or Others option from the
Quick Select Frame
2. Select the Off or On button.
W

To save the current set of selections, and return to the file manager
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screen
Select the OK button.
W

To make the file which has just been edited the current file

Select the Select button.
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Chapter 30: Editing an Extra Dynamic
Points File
This section describes how to edit files that contain definitions of extra
chart points to be included or excluded from a dynamic report or time map.
Extra points are points which are in addition to the normal set of individual
chart points which may be selected as Transiting, Progressing or Radix,
which includes the planets, major asteroids, TransNeptunians and chart
angles.
There are three different types of extra point files.
•

Extra Transiting Points - These are the extra points that are
calculated as transits to the radix points in a dynamic report.

•

Extra Progressing Points - These are the extra points that are
calculated as progressions or directions to the radix points in a
dynamic report.

•

Extra Radix Points - These are the extra points that are used as radix
points in a dynamic report.

The type points that are available for selection as extra transiting or
progressing points are
•

Midpoints - Any group of midpoints between any two normal chart
points.

•

Fixed Stars - Any set of fixed stars which is contained in a fixed star
file

•

Asteroids - Any set of asteroids which is contained in an asteroids file

•

Extra Bodies – Any set of extra bodies which is contained in an extra
body elements file

Additionally, extra radix points may include the following
•

Arabic Parts - Any set of Arabic Parts which is contained in an
Arabic Parts file

•

Fixed Positions - Any number of fixed zodiacal longitudes

•

House Cusps – All 12 house cusps of the radix chart

W

To edit an extra points file
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1. Click on the desired points box the Dynamic Reports Selection screen
2. Select the file from the list of file names
3. Select the Edit... button
This will display the "Select Extra Points" dialog box.

If you are editing extra transiting or progressed points, then only the
available point type options will be enabled. You can determine what items
are currently selected as follows.
Midpoints - All currently selected midpoints are listed in the list box on the
right of the “Midpoints” frame. The box is grayed if there are no
midpoints selected.
Fixed Stars, Arabic Parts, Asteroids, Extra Bodies - The name of any
selected file appears inside the text box in each frame. If no file is
selected, then the word “none” is shown, and the text box is grayed.
Fixed Positions - All currently selected fixed positions are listed in the list
box on the right of the “Fixed Positions” frame. The box is grayed if
there are no fixed positions selected.
House Cusps – If the check box is checked, then the house cusps are
selected.
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Selecting Midpoints
W

To switch on a single midpoint

1. Select the first point of the midpoint in the left hand list of points.
2. Select the second point in the right hand list of points.
3. Click on the On button. If the midpoint is not already selected, then this
will add the midpoint between those two points to the list of selected
midpoints.
W

To switch off a single midpoint

Click on the midpoint in the list of selected midpoints. This will remove it
from the list.
W

To switch on or off a group of midpoints

1. Select any number of points from the left hand list of points. Selecting
zero points has the same effect as selecting all the points. Multiple
selections may be made by holding down the Ctrl key whilst clicking
on points on the list.
2. Similarly select any number of points from the right hand list of points.
3. Click on the On button (or the Off button). This will add (or remove)
all of the midpoints formed by combining the two selections. See the
example below.
Examples
W

To switch on all the midpoints of the Moon to every other chart point

Select the Moon in the left hand list
Select no points in the right hand list
W

To switch on all the midpoint of the moon to the outer planets

Select the Moon in the left hand list
Select each of the outer planets in the right hand list
W

To switch on all the midpoint between outer planets

Select each of the outer planets in the left hand list
Select each of the outer planets in the right hand list
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Note: It is possible for you to select up to 595 different midpoints.
However, unless you are running a dynamic report covering a very short
time span only, it is recommended that you save and use selections of no
more than about 50 midpoints at a time, in order to avoid generating a
dynamic report which is far too long to be useful.
W

To clear all selected of midpoints

Select the Clear button.

Selecting Stars, Arabic Parts, Asteroids & Extra
Bodies
You can select any set of fixed stars, Arabic Parts, asteroids or extra bodies
that are supplied with Solar Fire, or which you have created or edited
yourself. If you wish to use a set of stars, parts, asteroids or extra bodies
that is not already saved in a Solar Fire file, then you must first create or
edit the required file.
W

To select an existing set of Fixed Stars, Arabic Parts, Asteroids or Extra
Bodies

1. Click on the > button on the right of the appropriate box.
2. This will display the File Management dialog box, from which a file
may selected.
After selection, the name of the selected file will be displayed in the
appropriate box.
W

To clear a selection of Fixed Stars, Arabic Parts, Asteroids or Extra
Bodies

1. Click on the name of the file in the appropriate box. This will highlight
the file name.
2. Click on the Del key. This will put the word “none” into the box, and
gray it out to show that there is nothing selected.
Note: It is possible to select large numbers of extra points if your fixed star,
Arabic Part, asteroid, or extra bodies files contain many entries. However,
unless you are running a dynamic report covering a very short time span
only, it is recommended that you save and use selections of no more than
about 50 extra points at a time, in order to avoid generating a dynamic
report which is far too long to be useful.
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Selecting Fixed Positions
W

To select a fixed zodiacal position

1. Click on the Position to Add text box, and type in the required
zodiacal position. Angles may be entered in degrees, minutes and
seconds in 360-degree notation (for example “334 27 32”) or using
zodiacal signs (for example “4 Pi27 32”). See page 384 for a more
detailed explanation.
2. Click on the Add button. This will add the position to the list of
selected fixed positions.
W

To remove a selected fixed zodiacal position

1. Select the required entry on the list of selected zodiacal positions
2. Click on the Delete button.

Saving Your Selected Extra Points
When you have selected all the required midpoints, fixed stars, Arabic
Parts, asteroids and fixed zodiacal positions, you can save your work by
clicking on the Save button. This will save your selections and return you
to the File Management dialog box, from which you can select the newly
edited file, or choose another file to edit.
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Chapter 31: Editing an Asteroid File
This section describes how to edit files that contain selections of asteroids
to be used in those reports and page objects that pertain to asteroids.
Solar Fire’s asteroids belong to two different categories:
Asteroids as Chart Points - The asteroids Ceres, Pallas, Juno, Vesta,
Astraea, Hygeia and Chiron are available for display in charts and
reports of all kinds in Solar Fire. They can be selected as Displayed
Points, Aspected Points, Transiting, Progressing and Radix Points in
their own right, without the need to select them in a asteroid file. They
are available for use in all charts and reports.
Additional Asteroids - A collection of 38 further asteroids are also
included with Solar Fire. These asteroids can only be used in specific
reports and page objects, and when they are selected in an asteroid file.
When you first install Solar Fire, all 38 of these asteroids will already
be selected for you. Therefore, you only need to edit the selection of
asteroids if you wish to remove some from the list, or if you have
obtained another collection of asteroids from another source and wish
to include these in Solar Fire. These additional asteroids that come with
Solar Fire are available for use over the period year 1900 to year 2100.
It is possible to extend this range by acquiring additional asteroid
ephemeris files.
W

To edit an asteroid file

1. Select the Asteroids File... item from the Files... option on the Chart
Options menu of the Main Screen
2. Select the file from the list of file names
3. Select the Edit... button
This will display the "Asteroid Selection" dialog box.
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The list box on the left of the window displays the number and name of
each currently selected asteroid, and the list box on the right displays the
number and name of all the asteroids which are currently available for
selection.
W

To edit the name of the selection

Click inside the Description text box, and type in a description for the
current selection. This name is displayed in the File Manager whenever
you are selecting asteroid files, so it is helpful to enter a meaningful
description of what this selection contains.
W

To select a single asteroid

1. Find the desired asteroid in the list of available asteroids
2. Click on its entry in the list
W

To unselect a single asteroid

1. Find the asteroid in the list of selected asteroids
2. Click on its entry in the list
As well as selecting individual asteroids, one at a time, you can select a
range of asteroids based on their names or numbers.
W

To select or unselect a range asteroids by name
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1. Ensure that the By Name display order is selected
2. In the Quick Select Frame, type the starting letter into the From box
3. In the Quick Select Frame, type the finishing letter into the To box
4. Click on the On button to switch them on, or the Off button to switch
them off. All the asteroids whose names are within the specified
alphabetic range will be affected.
W

To select or unselect a range asteroid by number

1. Ensure that the By Number display order is selected
2. In the Quick Select Frame, type the starting number into the From box
3. In the Quick Select Frame, type the finishing number into the To box
4. Click on the On button to switch them on, or the Off button to switch
them off. All the asteroids whose numbers are within the specified
range will be affected.
W

To alter the order in which asteroids are listed in Solar Fire reports

Select the desired order from the Display Order option buttons. Whichever
order you choose here will be adopted in Solar Fire’s asteroid reports.

Using More Asteroids
When you first install Solar Fire, the asteroids that are available for
selection are those that were installed into Solar Fire’s \ASTEROID
subdirectory. If you have installed additional asteroid ephemeris files, then
you can access those asteroids instead of the ones in Solar Fire’s
subdirectory.
Solar Fire reads data for asteroids whose ephemerides conform to the
format created by Mark Pottenger (for use with his CCRS program) or the
Swiss Ephemeris format. If you have additional asteroid ephemerides of
either of these types, then you will be able to use these with Solar Fire.
Solar Fire allows you to select many thousands of asteroids in a single
selection file. However, to maintain a reasonable level of performance, it is
recommended that you do not select more than about a thousand asteroids
per file.
You can use Pottenger and Swiss Ephemeris asteroid selections
interchangeably i.e. you can create asteroid selection files for asteroids
from either source, and switch between them as you wish.
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W

To find Pottenger asteroids on your computer

Click on the Pottenger... option button.
This will display a message asking if you wish to search for a location in
which other asteroid ephemerides are present. If you click on the Yes
button, then the program will search through all the directories (or folders)
on your hard drives, looking for a directory containing a file called
“ASTPATH”. If this file is found, then you will be asked to confirm the
name of the directory which is inside the file ASTPATH. (You also have
the option of manually typing in a different directory name). The program
will then search through that directory looking for asteroid ephemeris files,
and these will appear in the list of available asteroids, ready to be selected.
Note: You can install Pottenger asteroid ephemerides to any location on
your computer. However, they must be installed according to Pottenger’s
recommended method in order for Solar Fire to be able to access them.
W

To find Swiss Ephemeris asteroids on your computer

Click on the Swiss Ephemeris option button.
This will locate and list any available Swiss Ephemeris asteroids, and these
will appear in the list of available asteroids, ready to be selected.
Note: The Swiss Ephemeris makes freely available a full set of more than
8000 asteroid ephemeris files. These may be downloaded (in reasonable
numbers) for free from their website, or otherwise purchased in full on a
CD-ROM for a modest fee. The standard date range for these Swiss
Ephemeris asteroids is 1500 to 2100. This range can be extended to
3000BC to 3000AD (in most cases) by installing alternative larger
ephemeris files. See http://www.astro.ch/swisseph/ for further information
on the Swiss Ephemeris asteroids.
Note: You must install any Swiss Ephemeris asteroids into subdirectories
of the main Swiss Ephemeris directory, according to the recommendations
of its creators. The default location of the main Swiss Ephemeris directory
is the “SwissEph” subdirectory of Solar Fire, and the required subdirectory
names for the asteroids are “Ast0”, “Ast1”, “Ast2”, …, “Ast10”, “Ast20”.
Asteroids numbered 1 to 999 must be placed in ”Ast0”, 1000 to 1999 in
“Ast1” etc. “Ast20” is used for unnumbered ephemeris files whose names
begin with “se20…”. See also page 371.
W

To update the list of available asteroids after you have added or
removed asteroid ephemeris files

Click on the Refresh List button.
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This will search the specified directory for asteroid ephemeris files, and
then update the list of available asteroids.
Note: If you have removed any asteroid ephemeris files from your
computer, then you must also remove them one by one from your list of
selected asteroids. If you have made major changes, then it may be easier
to delete the entire asteroid selection file and create a new one from
scratch.
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Chapter 32: Editing an Extra Ring
Points File
This section describes how to edit files that contain definitions of points to
be included in an extra ring within a wheel. These points are in addition to
the normal set of individual chart points, and include fixed positions,
midpoints, asteroids, stars, Arabic parts, extra bodies and prior lunar
phases and eclipses.
These points can only be displayed inside a chart wheel that has been
specially designed to include an extra points ring. There is also a page
object called “Ring Points List – Flexible”, which will list various types of
data about the points in the extra ring points file. You can view a presupplied page which includes these items. It is called “Wheel with extra
points [uniextra.pag]”, and contains a wheel with an extra points ring
(uniextra.wh1) and ring points list.
W

To edit an extra ring points file

1.

Select the Extra Ring Points… item from the Chart Options menu

2.

Select the required file from the list of file names (or create a new one)

3.

Select the Edit... button

This will display the "Extra Point selection" dialog box.
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In the Selected Points box you will see a list of any points which are
already included in the selection.
You can remove points from this list, add various new types of points, and
edit the abbreviations, glyphs, color and font used when each point is
displayed in a wheel or in a page object.
The types of points that may be added are as follows.
1.

Point – Any of the standard 36 chart points. Normally you would not
need to use these, because they can be displayed in any ordinary
chart wheel by including them as displayed points. However, you do
have the option of adding them to the extra ring if you prefer.

2.

Midpoint – This is a list of all possible midpoint combinations
between the standard 36 chart points.

3.

Fixed Position – This allows any fixed zodiacal position to be
entered into the box to the right of the Add button.

4.

Fixed Star – This allows the selection of any star or celestial object
from the currently selected star file. Alternative star files may be
accessed using the Select File button.

5.

Arabic Part - This allows the selection of any part from the
currently selected part file. Alternative part files may be accessed
using the Select File button.
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6.

Asteroid - This allows the selection of any asteroid from the
currently selected asteroid file. Alternative asteroid files may be
accessed using the Select File button.

7.

Extra Body - This allows the selection of any extra body (defined
with orbital elements) from the currently selected extra body file.
Alternative extra body files may be accessed using the Select File
button.

8.

Prior Lunar Phase – This allows the selection of various points
related to the lunar phases which occurred most recently prior to the
chart’s date. The Syzygy points are either a new or full moon –
whichever occurred most recently. The “Most Elevated” point is the
point which is closest to the Midheaven of the current chart.

9.

Prior Eclipse - This allows the selection of the position of various
eclipse types which occurred most recently before the chart’s date.

W

To add a point or multiple points at once

Select the Point Type from the list of options
Optionally use the Select File button to choose another file
Optionally enter a fixed position into the edit box
Highlight the required point or points in the list of Available Points
Click on the Add button
W

To delete a point

Highlight the required point in the list of Selected Points
Click on the Delete button
W

To alter the display attributes of a point

Highlight the required point in the list of Selected Points
Edit the Abbr field to change the point’s abbreviated name. The
Abbreviation is displayed in the wheel instead of the glyph if you switch
on the “Glyph as Text” option in the wheel designer. However, if you do
so, then you may find that the text overlaps other items in the chart if there
are many extra points.
Edit the Glyph/s field to change the point’s displayed glyph (you may
choose a special font by clicking on the Font button, and invoke the
character map by clicking on the > button). This allows you to choose
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symbols of various types, such as a star shaped symbol for star, if you
wish.
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Chapter 33: Editing Interpretations
This section describes how to edit any of the interpretations text that is
supplied with Solar Fire, and how to create new sets of interpretations. An
interpretations editing program is supplied with Solar Fire, and this may be
accessed either on its own, or directly from within Solar Fire.
W

To start the Interpretations Editor

From the Interpretations window - Select the Edit Interpretations...
item from the File menu. This will start the editor with the current
interpretations file.
From the Main Screen - Select one of the interpretation types from the
Interpretation Files... item under the Interps menu, and when the File
Manager appears, select a file and then click on the Edit button. This
will start the editor with the selected interpretations file.
From the Solar Fire Group Folder - Double-click on the Interpretations
Editor icon. This will start the editor without opening an
interpretations file, and you will need to select one from the file open
dialog that appears upon startup.
When you enter the interpretations compiler, you will see text from
whatever interpretations file has been opened. If you wish to edit text
within this file, you may start to do so immediately. However, in many
cases you may prefer to keep the original interpretations unchanged, and to
work on a copy of the original file. In this case you must save a copy of the
current file under a new name before proceeding.
W

To save a copy of the current interpretations file under a new name

1. Select the Save As... option from the File menu.
2. This will display a standard “File Save” dialog, in which you can select
a new name for the interpretations file, and optionally a different
directory or folder. It is recommended that you keep your new
interpretation files in Solar Fire’s \INTERPS directory, because that is
the only directory that Solar Fire can access interpretations from. Also,
the new file name must be an acceptable file name and end with a “.int”
extension.
3. Click on the OK button. You will then be returned to the interpretations
editor and the newly saved copy will be open instead of the original
file.
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W

To switch to another interpretations file

1. Select the Open... option from the File menu
2. This will display a standard “File Open” dialog in which can select a
new file to open.
3. Click on the OK button. You will then be returned to the interpretations
editor and the newly selected file will be open for editing.
W

To close the current interpretations file

1. Select the Close option from the File menu.
2. This will close the current file, and you will not be able to carry out any
editing functions until you open another file.

Editing Text
Following is a list of interpretation text types showing what combinations
are available for each, and how they may be used.
Title - A descriptive title for this set of interpretations. This title appears in
the File Manager to assist in selecting the required set of
interpretations, and as a title to interpretations reports.
Copyright - A copyright notice. This appears in reports, but can be left
blank if you do not wish copyright to apply to your text.
Introduction - General introductory text. This appears as an introductory
section to interpretation reports. It can contain any preliminary
comments that you wish, for example explaining how the following
interpretations should be applied in practice, and providing disclaimers.
Degree - Information about each degree of the zodiac. This can include
Sabian symbols, medical degree interpretations, medieval degree
meanings etc.
Decanate - Information about each decanate (10 degree subdivision) of the
zodiac.
Quadrant - General definition plus weak and strong definition of each
quadrant.
Hemisphere - General definition plus weak and strong definition of each
hemisphere.
Element - General definition plus weak and strong definition of each
element.
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Mode - General definition plus weak and strong definition of each mode.
Ray - General definition plus weak and strong definition of each ray.
Aspect - General definition of each aspect.
Lunar Phase - Interpretation of each of 8 lunar phases.
Sign - General definition plus weak and strong definition of each sign.
House - General definition plus weak and strong definition of each house.
Point - Definition of each chart point.
Point in House - Interpretation of each chart point in each house.
Point In Sign - Interpretation of each chart point in each sign.
Sign on House Cusp - Interpretation of each sign on each house cusp.
Point in Aspect to Point - Interpretation of each point in each aspect to
each other point. The aspects that may be used here must be selected
before you begin editing. See page 238.
If you are creating a new set of interpretations, you will probably want to
edit the title and introduction text first. Otherwise you may wish to jump
into any category of text that you wish to work on currently.
W

To find the text category that you wish to edit

1. Select the required type from the Interpretation Type drop-down list
box.
2. Select the required combinations from the adjacent drop-down list
boxes.
Any existing text for that category will be displayed immediately in the
main editing window, and you may type over it, add to it, or otherwise edit
it as you wish. Any changes that you make are automatically saved as soon
as the focus leaves the editing window, or when you click on any other
control on the screen or access the menu. You do not need to take any
special action to save changes that you make.
On some occasions you may find that you have made an error, and wish to
undo any changes that you have made to the text. You are able to undo any
changes made since you edited the last category of text, but not any
changes made prior to that.
W

To undo text changes made since the current topic was displayed

Select the Undo Text Editing option from the Edit menu. If you change
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your mind again, selecting the same option again will restore your edited
changes.

Changing Scoring of Balances
When viewing interpretations of a chart, you will notice that there are a
number of interpretation types which relate to the overall distribution of
planets around the chart. These type are as follows.
Balance of Quadrants - Asc to IC, IC to Dsc, Dsc to MC, MC to Asc
Balance of Hemispheres - Eastern, Southern, Western, Northern
Balance of Elements - Fire, Earth, Air, Water
Balance of Modes - Cardinal, Fixed, Mutable
Balance of Rays - 1st to 7th
Balance of Signs - Aries to Pisces
Balance of Houses - 1st to 12th
In each case, an algorithm is used to determine which divisions are “weak”
(i.e. occupied by fewer than average planets) and which are “strong” (i.e.
occupied by more than average planets) in the chart being interpreted. You
have some control over how this calculation is performed, so that you can
fine-tune the circumstances in which divisions are considered to be weak
or strong. The calculation to determine which divisions are weak or strong
is as follows.
1.

For each division (such as a quadrant or an element or a sign):
•

The total number of displayed chart points (planets/ asteroids/
TransNeptunians/ others) occupying that division is totaled.

•

Optionally each displayed point occupying the division is
multiplied by its weighting score.

2.

The average score is found by summing the scores for each division,
and dividing by the number of divisions (i.e. by 3 for modes, 4 for
quadrants, hemispheres etc.).

3.

If the score for any division is less than the average multiplied by a
“weakratio”, then it is considered to be “weak”.

4.

If the score for any division is greater than or equal the average
multiplied by a “strongratio”, then it is considered to be “strong”.

The items which you can adjust in the interpretations editor are
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Whether or not the weighting of each chart point is applied.
What value the “weakratio” has.
What value the “strongratio” has.
The weighting values for each point, if you choose to use them, are the
same weighting values that are used in other parts of Solar Fire. See page
388 for further information on editing the weightings.
You can prevent weak interpretations from appearing at all by specifying a
“weakratio” of 0 (zero). If you do so, then you need not enter any text
relating to weak divisions of that type. Similarly, by entering a large
number (like 99.9), for “strongratio” you can prevent strong interpretations
from appearing, and you do not need to enter any text for strong division of
that type. For example, it might be desirable to set a “weakratio” of zero
for Balance of Signs, because it is likely that a number of signs will be
completely unoccupied in any chart, and it may not be very meaningful to
give any interpretation to those signs being unoccupied.
W

To alter the scoring of balances

1. The Scoring of Balances... from the Edit menu.
2. Select any category from the Balance Type drop-down list.
3. Optionally click on the Use Weighted Scoring check box to toggle it
on or off.
4. Enter a ratio into the Ratio for Weak box
5. Enter a ratio into the Ratio for Strong box
6. Repeat steps 2 to 5 for any other category you wish to alter
7. Click on the OK button.

Changing Aspects Used
Before you enter any interpretations text relating to chart points in aspect
to one another, it is important to ensure that you have selected which
aspects you wish to write interpretations for. This is necessary for two
main reasons:
If you alter the list of aspects that you wish to use after having written
some interpretations text for existing aspects, then it is possible that
some or all of this text will be permanently lost or mislocated in the
file.
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The size of the interpretations file varies in proportion to the number of
different aspects that you wish to include. To use space efficiently, you
should plan ahead to decide which aspects you intend to use, and
exclude those that you will not use, and would take up unnecessary
space.
You can select any combination of Solar Fire’s standard 26 aspects to use
in an interpretations file. However, in most circumstances, you will
probably want to write text for a small subset of the available aspects. For
example, Solar Fire’s “standard” interpretations set contains text for
conjunction, opposition, trine, square, sextile, quincunx, and the “transits”
interpretation set also contains text for semisquare and sesquisquare.
Mapped Aspect Names
Solar Fire’s interpretations files use a concept of mapped aspect names.
You can define a list of mapped aspect names for which you will write
interpretations, and specify which of Solar Fire’s standard aspects map
onto each of those mapped names. In most cases you will simply want to
map each standard aspect to the same mapped name, so that the each
interpretation that you are writing applies only to that one aspect.
However, if you map each of the conjunction, trine and sextile aspects onto
the same mapped name “soft”, then you will only need to write one
interpretation to appear whenever any of those three aspects occur.
Similarly you could map the opposition, square, semisquare and
sesquisquare onto the mapped name “hard”.
W

To display the “Aspects to Include” dialog box

Select Aspects to Include... from the Edit menu
On the left of the screen you will see a list of Solar Fire’s 26 standard
aspects, called “Available Aspects”, some of which will be marked as
“Used”. On the right of the screen you will see a list of “Mapped Aspect
Names”.
W

To determine which aspect is mapped to which name

Click on each entry in the “Available Aspects” list - when you do so, the
mapped entry in the “Mapped Aspect Name” will be highlighted
automatically.
W

To add a new mapped aspect name

1. Optionally select the required aspect name from the list of “Available
Aspects”.
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2. Click on the Add button - This will add the name of the currently
highlighted “Available Aspect” to the list of “Mapped Aspect Names”.
3. Optionally edit the new mapped name by typing into the edit box above
the Add button.
W

To delete an existing mapped aspect name

1. Select the required mapped aspect name in the list of “Mapped Aspect
names”
2. Click on the Delete button - This will remove the entry from the list,
and will alter the current entry in the “Available Aspects” list to show it
as unmapped.
Note: After deleting mapped aspect names, you will need to check and
reselect all the other mapping relationships to ensure that they are still
correct.
W

To set or alter the mapped name of available aspect

1. Select the required aspect from the list of “Available Aspects”.
2. Select the required mapped name from the list of “Mapped Aspect
Names”.
Note: Selecting the “Not Used” item from the top of the list will unmap
that aspect, so that it can no longer be used.
W

To save all your changes

1. Firstly, re-check that each aspect is correctly mapped.
2. Select the OK button. If you have made any major changes which are
likely to result in interpretations text being lost, then you will be
prompted to confirm your changes before you are returned tot he main
editing screen.
Dynamic Aspects
When you are creating a set of interpretations applying to a single natal
chart, or to synastry between two charts, then you normally want the
interpretations for point1 in aspect to point2 to be the same as for point2 in
aspect to point1, eg. Pluto square Moon and Moon square Pluto would
have the same interpretation.
However, if you are creating a set of interpretations for transits,
progressions or directions to a radix chart, then you would want to supply
different interpretations in each case eg. Pluto square Moon and Moon
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square Pluto would have different interpretations. This case is referred to
as Dynamic Aspects.
You can set the interpretation file to work in either way, with the Dynamic
Aspects on or off. When the Dynamic Aspects option is off, Pluto Square
Moon and Moon Square Pluto will both display the same text in the editor,
so editing one of them will also affect the other. When the Dynamic Aspect
option is on, they will display separate paragraphs of text, and editing one
will have no effect on the other.
W

To switch Dynamic Aspects On or Off

Select Dynamic Aspects from the Edit menu. This will switch he option
on if it was off, or off if it was on.
Note: When the Dynamic Aspects option is on, there are more than twice
as many items to write interpretations text for.

Viewing a Summary of Contents
During the process of editing text, you may from time to time want to see a
summary of which categories in the file have already had text inserted, and
those categories that still have no text yet.
W

To see a summary of which items contain text

Select Contents Summary from the View menu - You may have to wait
for a moment or two whilst the entire interpretations file is searched to
determine which items contain interpretations text, and then a summary
will be displayed in the editing window.
W

To revert to editing text

Select Interpretations Text from the View menu.
Sample summary
The summary below has been truncated after some aspects of the moon for
the sake of brevity. The full summary is much longer because its lists all
mapped aspects between every pair of chart points (up to 1296 pairs). In
this example, there are 6 mapped aspects, and those chart point pairs which
have text included are marked with an asterisk (*). Those without text are
left blank.
1 - Conjunction
2 - Square
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3 - Opposition
4 - Trine
5 - Sextile
6 - Quincunx
Aspects of Moon
1

2

3

4

5

6

*

*

*

*

*

*

*

*

*

*

*

Earth
Sun
Vulcan
Mercur

*

The above lines indicate that there is text for the moon in aspect to the sun
and the moon in aspect to mercury for each of the 6 aspects listed, but no
text for the moon in aspect to Earth or Vulcan.
LIST OF INCLUDED TEXT ITEMS
TITLE is fully populated (1 entries)
COPYRIGHT is fully populated (1 entries)
INTRODUCTION is fully populated (1 entries)
DEGREE is fully populated (360 entries)
DECANATE has 0 entries
QUADRANT has 8 entries out of 12
HEMISPHERE has 8 entries out of 12
ELEMENT is fully populated (12 entries)
MODE is fully populated (9 entries)
RAY has 14 entries out of 21
ASPECT has 9 entries out of 26
LUNAR PHASE is fully populated (8 entries)
HOUSE has 24 entries out of 36
SIGN has 24 entries out of 36
POINT has 34 entries out of 36
POINT IN HOUSE has 242 entries out of 432
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POINT IN SIGN has 264 entries out of 432
SIGN ON
entries)

HOUSE

CUSP

is

fully

populated

(144

POINT IN ASPECT TO POINT
1 - Conjunction
2 - Square
3 - Opposition
4 - Trine
5 - Sextile
6 - Quincunx
Aspects of Moon
1

2

3

4

5

6

*

*

*

*

*

*

Mercur

*

*

*

*

*

Venus *

*

*

*

*

*

Mars

*

*

*

*

*

Jupite

*

*

*

*

*

*

Saturn

*

*

*

*

*

*

Uranus

*

*

*

*

*

*

Neptun

*

*

*

*

*

*

Pluto *

*

*

*

*

*

Chiron

*

*

*

*

*

Earth
Sun
Vulcan

*

*

*

Vesta
Pallas
Juno
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Decompiling and Compiling
In earlier versions of Solar Fire, it was necessary to write all interpretations
text into text files, and to run a compilation process in order to create an
interpretations file. In the current version this procedure is no longer
necessary, and it is generally much simpler to edit the text in-place, using
the Interpretations Editor. However, there are two main reasons why you
may wish to use the compilation options:
If you have created text files for earlier version of Solar Fire, you may still
want to compile them.
If you wish to do any work on the entire set of text in bulk, for example, to
make global editing changes, or to spell check the entire text, then you
will need to decompile them first, work on the decompiled file in your
word processor, and then recompile them.
Decompiling
The process of decompiling extracts all the interpretations text from the
interpretations file and inserts it into a single ANSI text file. The ANSI file
is written to conform exactly to Solar Fire’s requirements for a text
interpretations file, so that it may subsequently be recompiled without any
changes being required. The text file may be edited with any text editor or
word processor.
W

To decompile the current interpretations file

1. Select the Decompile... option from the File menu - This will display a
standard “Save File As” dialog
2. Enter a file name - The file name must be a valid file name, and should
have a “.def” extension. Normally it is best to choose the same name as
the current file eg. standard.def or transits.def if you are decompiling
one of Solar Fire’s supplied files.
3. Optionally Select a new directory or folder. If you choose s different
directory, then you will need to remember where you have placed the
file when you wish to recompile it.
4. Select the OK button. You will see a confirmation message showing
you the full path and name of the decompiled file when it has finished.
Note: Remember that after you have decompiled an interpretations file, you
have two versions of the interpretations - the original interpretations file,
and the decompiled text file. If you make changes to the original file
instead of the decompiled file, then when you recompile the decompiled
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file, those changes will be overwritten.
Compiling
Compiling an interpretations file is the process of reading in a text file that
contains interpretations text formatted according to Solar Fire’s
specifications, and writing out an interpretations file which may be used
directly in Solar Fire, and edited with the interpretations editor. The format
of a decompiled text file is somewhat complex, and it is not recommended
that you attempt to make significant alterations to a decompiled file unless
you are technically proficient. For the full specification of the required
format for a decompiled file, see page 391.
W

To compile a text interpretations file

1. Select the Compile... option from the File menu.
2. This will start up the interpretations compiler. See page 391 for further
details.

Compacting the File
When you edit existing interpretations text, if you make the new text
longer than the original text, then the new text will be added to the end of
the file, thus making it larger. The space occupied by the original text is no
longer needed, but still occupies some space in the file. The space that is
wasted due to this process is negligibly small if you only edit a small
number of interpretations, but if you make a large number of alterations,
then you may wish to recover the wasted space. This is possible by
compacting the file.
W

To compact the current interpretations file

Select Compact... from the File menu - You will be asked to confirm
whether you wish to proceed, and if you click OK then the entire
interpretations file will be rewritten to the disk using the minimum space
possible. When the process is finished, you will see a message indicating
how much space was saved.
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Chapter 34: Editing an Aspect Set
This section describes how to edit files that contain definitions of aspect
sets to be used in displaying an aspected chart or aspect grid or in
generating a report type which includes aspects.
W

To edit an aspect file

1. Choose Aspect Set... from the Chart Options menu
2. From the file manager, select the file you wish to edit, and click on the
Edit... button. - This will display the "Edit Aspect Set" screen.

The list box on the left of the screen contains a list of all the aspect names
that are currently available. Those aspect names preceded by a plus mark
are those aspects that are currently switched on, so that it is possible to see
at a glance which aspects are included in this set.
The symbol for the currently selected aspect is displayed in the "Glyph"
box, and the orb angles relating to this aspect are displayed in editable
boxes. The color used to display the aspect line and glyph for the standard
aspects is whatever is defined in the currently selected aspect color set. For
instructions on altering aspect colors, see page 252.
W

To switch on an aspect which is currently switched off

Select the aspect name from the list box, and then select the Restore
button, or double-click on the aspect name in the list box.
W

To switch off an aspect which is currently switched on

Select the aspect name from the list box, and then select the Remove
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button.
W

To switch on or off multiple aspects at once

Select all the desired aspects from the list using the Ctrl key with the
mouse to make multiple selections, and then select either the Restore or
Remove button.
W

To alter aspect orbs

1. Select the aspect name from the list box
2. Use the edit keys to edit the entries in the aspect orb boxes - Aspect
orbs may be entered as degrees, minutes and seconds, or as decimal
degrees (eg. 9 30 or 9.5 for 930'). See page 384 for more information
on entering angles.
There are three types of orbs:
Natal - These orbs are used on all charts and reports other than
progressed charts or dynamic reports.
Progressed - These orbs are used on all progressed charts and reports
relating to progressed charts.
Transits - These orbs are used for entering and leaving events in all
dynamic (transits and progressions) reports.
You may specify different orbs for luminaries and for other chart points.
(Luminaries are the sun and the moon only). Luminary aspect orbs are
used whenever at least one of the chart points in aspect to one another is a
luminary. Also, you may specify a different orb depending on whether the
aspect is approaching exactness (applying) or is moving away from
exactness (separating).
Note: Within an individual chart, Solar Fire calculates whether any aspect
is applying or separating according to the rate of motion of both points
involved in the aspect. An exception to this is when a chart angle is
involved in the aspect. In this case the chart angle is assumed to be
stationary. (Chart angles are the Ascendant, Midheaven, Vertex and
Equatorial Ascendant.) When an aspect is being made between two
separate charts, Solar Fire takes account of the motion of the planet in the
first chart, and holds the planet in the second chart stationary. Therefore,
whether an aspect is found to be applying or separating depends on the
order in which the charts are considered, and swapping the order of the
charts may affect whether a particular aspect is deemed to be applying or
separating. In the case of a biwheel, the inner chart is always held fixed,
whilst in the case of a synastry grid, the chart across the grid is always held
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fixed. In synastry reports, the first chart listed is always held stationary.
W

To change the style or thickness of the aspect line

Click on the Linestyle button to loop through the different line styles and
thicknesses that are available. A sample of the linestyle is displayed below
the symbol in the Glyph window.
Note that it is not possible for the user to alter any standard aspect name,
aspect angle or aspect symbol. However, you can add user-defined aspects
for which any of these items may be altered - see the following section on
advanced options for more information.
W

To edit the description of the aspect set

Click on the Description edit box and type in any text you want. This text
appears in the file manager to assist you in finding the aspect set that you
want, so it is best to type in some meaningful description of what this
aspect file contains.
W

To save any changes when you have finished editing the aspect set

1. Select the Save button
2. If you wish to select the aspect set you have just edited, remember to
click on the Select button when you return to the File Manager dialog
box.

Selecting Advanced Options
You can select a number of options relating to how aspect orbs are
calculated and used in Solar Fire, and you can also add your own userdefined aspects for use in any part of Solar Fire.
W

To display the advanced aspect options

Click on the Advanced button. Clicking this button toggles the advanced
options display area on and off. However, if certain advanced options are
selected, this button will become disabled, and you will not be able to
switch it off unless you switch off the selected advanced options. The
purpose of this limitation is to ensure that you are aware that certain
advanced options have been selected when you select this aspect set for
editing.

248 Solar Fire 5: Customizing Solar Fire

Orb Types
You can select from three different types of orbs
Use Luminary/Other Orbs - This is the standard option that applies if
you do not select the Advanced Options button, and was the only
option available in previous versions of Solar Fire. This allows you to
enter two sets of orbs for each aspect. One set of orbs that apply when a
luminary (i.e. the sun or the moon) is making an aspect, and another set
of orbs when any other planet is making an aspect.
Use Planet Orb Ratios - This option allows for the possibility of each
planet having a different orb for the same aspect. Rather than allowing
orbs to be entered for each planet (which would involve many hundreds
of orbs being entered), the user specifies an orb ratio for each planet,
and specifies just a single set of base orbs for each aspect. The orbs of
any individual planet are then calculated by multiplying the base orb by
that planet’s orb ratio.
Use Aspects by Sign Only - This option precludes the use of orbs, by
determining aspects only according to which signs each planet is placed
in. For example, if one planet is in Aries, and another in Cancer, then
they are in Square aspect, regardless of which degree of their signs they
are in. With this option, only the first nine aspects in the list are active.
An additional option that may be selected in combination with the first two
of the above
•

Use Sign as well as Orb – When this is enabled, any aspect that is
found within its specified orb is also checked to determine if it is also
in the same aspect by sign. If it is not, then the aspect is ignored. For
example, if one planet is at 1 degree of Aries, and another is at 29
degrees of Gemini, then they would be square with an orb of 2
degrees, but the signs are 60 degrees apart (i.e. sextile), so this aspect
would be disregarded.

Special Options
There are three special options that can be used in conjunction with some
of the Orb Types.
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Use 3D Aspects (True Body) - Astrologers usually work with aspects in
ecliptic longitude, which means that the positions of the planets are
projected onto the ecliptic before aspects are calculated between them.
An alternative is to measure the true angle between the two bodies
along the shortest distance between them. These are known variously as
3D, true-body or great circle aspects. Because most of the planets have
orbits close to the ecliptic, there is normally not much difference
between traditional aspects and 3D aspects. However Pluto has an orbit
that is at a significant inclination to the ecliptic, so it is possible that 3D
aspects of Pluto will be significantly different from the traditional
aspects. The other area in which 3D aspects may be especially
interesting is in relation to fixed stars. As most stars are not close to the
ecliptic, there will be a big difference between 3D and traditional
aspects between planets and stars. The fact that stars are not close to the
ecliptic is sometimes given as a criticism of using ecliptical aspects
between stars and planets. Therefore it is well worth trying this 3D
option when generating a fixed star aspects report. This option is
provided as an opportunity to experiment - there is very little written
about this yet.
Use Moieties (Half Planet Orbs) - This option may only be selected in
association with the Planet Orb Ratios option. The principle of moieties
is to determine the orb of an aspect by adding half of the orb of each
planet involved. (This is identical to averaging the orb for each planet
involved in an aspect.) For example, if Pluto has an orb of 6° and The
Sun has an orb of 12°, then the moiety is 9°, so they are in aspect with
each other only when they are within 9° of each other.
Unidirectional Orbs - A unidirectional orb is one that operates in a single
direction, so the orb that is applied between two planets depends on the
order in which the planets are considered. For example, if Pluto has an
orb of 6° and The Sun has an orb of 12°, and they are 9° apart, then the
Sun would be considered to be conjunct Pluto (because it has an orb of
12°), but Pluto would not be considered to be conjunct the Sun
(because it has an orb of 6°).
W

To set planet orb ratios

1. Select the Planet Orb Ratios option button.
2. Specify the required Aspect Orbs - Applying and Separating, for
Natal, Progressed and Transiting planets.
3. Select one (or more) planets from the Planet Ratios list box
4. Enter an orb ratio in the Current Planet’s Ratio edit box - any changes
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you make will immediately be reflected in the orbs displayed under the
Current Planet orbs.
5. Repeat steps 3 to 4 until all the planet’s orbs ratios are set as required.
Typically, the orb ratios that you set will be in the range of 0.1 to 2.0 or
thereabouts. To start with, you might like to specify the Sun’s orb as
having a ratio 1.0, and then specify all the other planet’s orbs in relation to
that, in which case all your other orb ratios will probably be less than 1.0.
W

To add a user defined aspect

1. Click on the Add Aspect button - This will add a user-defined aspect
with the name “New Aspect”, abbreviation “New”, angle 0°, an
alphabetic character as a glyph, and a solid black linestyle.
2. Edit the name, abbreviation and Angle by clicking on the appropriate
edit boxes and typing in the new details. The angle may be entered in
degrees, minutes and seconds (e.g. 22 30) or decimal degrees (eg.
22.5).
3. Choose a glyph by clicking inside the Glyph box, and then typing any
keyboard character that you would like to use to represent this aspect.
4. Select a line style by clicking on the LineStyle buttons.
5. Select a color for the new aspect by clicking on the Color... button and
selecting a color from the standard color selection dialog.
Once you have added a user-defined aspect, you can switch it on or off in
the same manner as for other standard aspects. However, if you wish to
permanently remove a user-defined aspects, then you can remove it from
the list altogether.
W

To delete a user defined aspect

Highlight the desired user-defined aspect
Click on the Del Aspect button.
W

To save any changes and exit from the aspect editor

Click on the Save button.
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Chapter 35: Editing a Color File
This section describes how to edit files that contain definitions of colors to
be used when displaying aspect lines and symbols, chart point glyphs,
zodiac sign glyphs or sign fill colors.
There are four different types of color files.
Point Colors - These colors are used when displaying chart points
(planets, asteroids, etc.) in any chart or grid. To invoke the file manager
for these files
Aspect Colors - These colors are used when displaying aspect symbols or
lines in any chart or grid. To invoke the file manager for these files
Sign Colors - These colors are used when displaying zodiac sign glyphs in
any chart, and also include a color for the retrograde glyph.
Sign Fill Colors - These colors are used as background colors when
drawing zodiac signs in a chart that includes a color-filled zodiac ring.
W

To edit a selection of color

1. Choose the required Colors... option from the Chart Options menu
2. From the file manager, select the required file from the list of file
names
3. Select the Edit... button. This will display the “Edit Colors” Dialog
Box.
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You will see a list of all the items displayed in their currently selected
colors. It is possible to view the items as they will appear with either a light
or dark background.
To view the symbols with a light background
Select the Normal option in the Video Style box.
W

To view the symbol with a dark background

Select the Reverse option in the Video Style box.
W

To select a new color for any item

1. Select the item from the list by clicking on, or by using the cursor keys
2. Select the Color... button. This will display a standard color selection
dialog, from which any color may be selected.
W

To copy a color from one item to another

1. Select the item you wish to copy the color of from the list by clicking
on it.
2. Hold the mouse button down whilst dragging the cursor onto the item
you wish to copy the color to, and then release the mouse. The color of
that item will be immediately updated.
W

To save the current set of color selections

1. Select the Save button.
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2. From the file manager, click on the Select button to make the file which
has just been edited the currently selected file.
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Chapter 36: Editing an Arabic Parts
File
This section describes how to edit files that contain definitions of Arabic
Parts (or other combinations of points which may be expressed as A+B-C)
to be used when displaying Arabic Parts reports for a chart.
Note: If you have selected Arabic Parts as part of an almuten definition in
the Dignity/Almuten editor, and you later use the Arabic Parts Editor to
remove entries from or reorder the Arabic Parts file which you used, then
the almuten calculation will no longer work correctly. You will need to use
the Dignity/Almuten Editor to reselect all the required Arabic Parts before
you can be sure that the calculation will use the correct Arabic Parts. See
page 280 for instructions on using the Dignity/Almuten Editor.
W

To edit an Arabic Parts file

1. Select Arabic Parts... from the Files option of the Chart Options
menu
2. From the file manager, select a file from the list of file names
3. Select the Edit... button
Alternatively, you can also access the editor directly from Windows.
W

To open the Arabic Parts editor from Windows

From the Windows group containing Solar Fire program icons, doubleclick on the Arabic Parts Editor icon. You will be prompted to select a
file to edit, and this will then start up the editor with that Arabic Parts file
displayed.
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The status box at the top of the screen displays the number of parts already
defined, followed by the name of the current Arabic Parts file.
The list box at the top left of the screen contains a list of all the items that
already exist in this file. It is possible to see the details for any of these
items by clicking on that item in the list. It is then possible to edit any of
the following items relating to that entry.
Full Name - This is the name by which the item is identified in any
reports. It is recommended that you limit the length of this name to
about 30 characters, in order to avoid the possibility of formatting
problems in Solar Fire’s Arabic Parts report.
Abbreviation - This is a unique name, limited to 15 characters, by which
this item is identified internally. It is used only when another item in
the list refers to this entry.
Day or Night - Some parts have different formulas, depending on whether
the chart to which they are being applied is a daytime chart or a
nighttime chart. For example the Part of Fortune has a daytime formula
of Ascendant + Sun - Moon, and a nighttime formula of Ascendant +
Moon - Sun, so must have two entries in the list. If the formula that you
enter applies only during the day (when the sun is above the horizon),
or night (sun below the horizon) then select the Day or Night option. If
the formula does not depend on the sun’s diurnal position, then select
the Both option.
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Formula A + B - C - Each of the elements in this formula may be selected
by clicking on the drop-down list boxes for that element. Each element
has two drop-down boxes. The top one is used to indicate what type of
position is being entered, and the bottom one to indicate which position
of that type. The possible types of position are:

Type of Position

Available Positions

Example

Fixed Position

Any Point of Zodiac

15Cn00

Dispositor of

Any Chart Point

Dispositor of The
Moon

Cusp of

Any House

Cusp of 3rd House

Ruler of

Any House Cusp

Ruler of 12th
House Cusp

Other Part

Any other part in this file

FortD

Prenatal

Lunar Phases

New Moon

Once you select a type of position from the top box, the list of positions
that are available for selection in the bottom box is automatically updated.
The only exception to this is if you select the “Fixed Position” option, then
the bottom box does not contain a list - instead you must enter a zodiacal
position into it using the keyboard. See page 384 for information on how to
enter angles.
W

To create a new entry on the list

Select the New button. This will add an item to the bottom of the list, ready
to be edited with the required details.
W

To delete an existing entry from the list

Select the required item from the list.
Select the Delete button.
W

To alter the placement of an item in the list

Select the required item from the list.
Click on the up or down arrow of the spin button.
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W

To obtain a printout of all the items on the list

Optionally select the Printer... button.
This allows you to alter any
printer settings such as page orientation and resolution.
Select the Print button.
W

To save any changes that you have made since the file was last saved

Select the Save button.
W

To exit from the Arabic Parts editor

Select the Quit button.
If you have made changes but not saved them, then you will be asked
whether or not you wish to save them before exiting.
Any changes that you save will take effect immediately in Solar Fire, any
subsequent Arabic Parts reports produced will use the newly saved data.
If you exit from the Arabic Parts Editor without having saved your
changes, then the program will ask you if you wish to save the changes
before it closes.
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Chapter 37: Editing a Fixed Stars File
This section describes how to edit files that contain listings of fixed stars
(or other astronomical points such as black holes or galaxies) to be used
when displaying fixed star reports or page objects or the planetarium.
W

To edit a fixed star file

1. Select Fixed Stars... from the Files option of the Chart Options menu
2. From the file manager, select a file from the list of file names
3. Select the Edit... button
Alternatively, you can also access the editor directly from Windows, as
follows:
W

To open the fixed star editor

From the Windows group containing Solar Fire program icons, doubleclick on the Fixed Star Editor icon.
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Creating a New File
W

To create a new file of fixed stars

Select the New option from the File menu.
If you have made any changes to the current file, then you will be
prompted to save them before a new file is opened. When a new file is
opened, it contains no star information. You must enter this information
yourself, or you can merge information from another star file, or import
information from a Nova star file.

Opening an Existing File
W

To open an existing file of fixed stars

Select the Open option from the File menu.
If you have made any changes to the current file, then you will be
prompted to save them before a new file is opened. When you select this
option, you will be presented with a file open dialog box from which you
must select the required file.
Solar Fire star files have the file extension “.fst”. It is only possible to open
files of this type. If you attempt to open a file of a different type, then a
message will be shown indicating that the file cannot be read.

Saving a File
W

To save the information that you have entered or edited

Select the Save or Save As... option from the File menu.
The Save option will save any changes that you have made using the
existing file name. If there is no file name (i.e. if it is a new file), then this
option will prompt you to enter a name before it is saved. The Save As...
option prompts you for a name to save the file as.

Merging a File
This option allows you to merge the information from another star file into
the current star file.
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W

To add all the entries from another star file, and append them to the end
of the current file

Select the Merge... option from the File menu.
When you select this option, you will be presented with a file open dialog
box from which you must select the required file. You can only select
Solar Fire star files with this option.

Importing a Star File from Nova
This option can only be used if you have Astrolabe’s Nova program
installed on your computer. It allows you to import the information from a
Nova type star file into a new Solar Fire star file.
W

To create a new star file using data from an existing Nova type star file

Select the Import... option from the File menu
If you have made any changes to the current file, then you will be
prompted to save them before a new file is created. When you select this
option, you will be presented with a file open dialog box from which you
must select the required Nova star file. Nova star files have the extension
“.txt”, and normally reside in the Nova directory.

Printing
W

To print a listing of the information in the current star file

Select the Print option from the File menu.
This will list all the information in the file apart from the keywords and
free text user the current printer. You can change your printer settings,
such as page size and orientation with the standard printer setup dialog.
W

To change the printer settings

Select the Printer Setup... option from the File menu.

Editing Star Information
Data for a star may be changed simply by typing the required information
into the display boxes on the main screen. Existing information may be
changed by overtyping it.
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W

To add a new entry

Use the Add button or menu item.
W

To delete an entry

Use the Delete button or menu item.
W

To alter the ordering of entries

Click on the up or down arrow of the spin button.
It is also possible to use the Cut, Copy or Paste menu items to manipulate
all the information relating to a single star entry via the Windows
Clipboard. This is especially useful if you have two copies of the Star
Editor running, in which case you can cut or copy entries in one file and
paste them into another. (In order to run two copies of the Star Editor, you
must start it independently from Solar Fire, using its own icon in the Solar
Fire Group window)
The editable items are as follows.
Traditional Name - The traditional name is the name by which the star (or
astronomical point) is shown in the list of stars. For example, the brightest
star in the constellation Eridanus is commonly known as Achenar.
Nomenclature - This is a standard technical name by which the star is
known. There are several different systems of nomenclature in use, as
listed below. This information is optional, and may be left blank.
Bayer nomenclature - uses a Greek letter name which is unique in a
particular constellation, denoting the relative brightness of the star.
For example, Achenar is known as Alpha Eridanus. This indicates
that it is the brightest star in the constellation Eridanus.
Flamsteed nomenclature - uses a number indicating the position in
order of right ascension within a constellation. For example, Alcor
is known as 80 Ursa Major.
Messier nomenclature - uses letter M plus a number for nebulous
objects in a constellation. For example, Acumen is known as M7
Scorpius.
Greek Alphabet
1. Alpha

7. Eta
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13. Nu

19. Tau

2. Beta

8. Theta

14. Xi

20. Upsilon

3. Gamma

9. Iota

15. Omicron

21. Phi

4. Delta

10. Kappa

16. Pi

22. Chi

5. Epsilon

11. Lambda

17. Rho

23. Psi

6. Zeta

12. Mu

18. Sigma

24. Omega

Constellation - The constellation in which the star (or astronomical point)
resides can be selected from the list of available constellation names in the
drop-down list box. This information is optional, and may be left blank.
GC or NGC Number – GC and NGC stand for General Catalogue and
New General Catalogue, respectively. These catalogues contain lists of
observed celestial objects, and assign a number to each one. For example,
Achenar has GC number 1979. This information is optional, and may be
left blank. Note: Most of the data supplied with Solar Fire contains GC
numbers.
Spectral Class - This indicates the quality of light emitted by the star.
Typically it consists of a letter and a number. The letter indicates the
general class, and the number (0-9) indicates where in that class it resides
eg. A7 indicates white star with a yellowish tinge. The possible letters, in
order of hottest stars to coolest stars are:Class

Color

Temperature

W

Greenish-White

80,000K

O

Greenish-White

36,000K+

B

Bluish-White

12-25,000K

A

White

8-10,000K

F

Yellowish-White

6-7,500K

G

Yellow

5-6,000K

K

Orange

3-5,000K

M

Orange-Red

3,100K

R

Orange-Red

2,500K

N

Red

2,500K

Chapter 37: Editing a Fixed Stars File 263

S

Red

2,600K

Sometimes there are also one or more small letters preceding or following
the letter/number combination, as listed below. For example, gK7 indicates
a giant orange star. This information is optional and may be left blank.

n

Diffuse absorption lines

s

Sharp absorption lines

c

Exceptionally sharp lines

g

A giant star

d

A dwarf star

e

Has emission lines

p

Peculiarities

Magnitude - This is a decimal number indicating the visual magnitude of
the star. The lower the number, the brighter the star. Eg. the brightest star
is Sirius, which has a magnitude of -1.4. The lowest visible magnitude is
about 6. This information is optional and may be left blank.
Right Ascension and Declination - This is the position of the star in
equatorial coordinates on the date specified in the Equator of Yr field.
Right ascension may be entered either in Degrees, Minutes and Seconds, or
in Hours, Minutes and Seconds of arc. However, it is always displayed in
Hours, Minutes and Seconds. Declination is always entered and displayed
in Degrees, Minutes and Seconds. For example, in 1950 Sirius was at a
right ascension of 6h42m56.7s and at a declination of -16°38'46". These
may be entered in any of the following ways.
6h42m56.7s

-16°38'46"

or

6h42 56.7

-16d38 46

or

6 42 56.7

-16 38 46

or

100d44m10.5s

-16d38m46s

Note that the first number entered in the Right Ascension field is assumed
to be an hour number, unless the letter “d” appears somewhere in the entry,
in which case the entry is assumed to be in degrees, minutes and seconds,
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and is automatically converted and displayed in the equivalent hours,
minutes and seconds.
Proper Motion - This is the annual motion of the star in right ascension
and declination. The motion in right ascension must be entered in decimal
seconds of Right Ascension (time). The motion in declination must be
entered in decimal seconds of Declination (arc). For example, the proper
motion of Sirius is -0.037 seconds of right ascension per year and -1.21
seconds of declination arc per year.
Equator of Yr - This is the “epoch” or year for which the entered right
ascension and declination are applicable. Astronomical references usually
contain star information for year 1950, or in more modern references, year
2000.
Keywords and Free Text - For each star, up to 30 characters of keywords
or definition text may be entered, plus unlimited free text. The keyword
text is used in Solar Fire’s star reports. The free text is also used in the
Planetarium whenever star information is shown about any star. This
information is optional and may be left blank.

Changing the Date
The zodiacal positions displayed are calculated for the current date unless
you alter the date setting.
W

To change the date for the calculation of the star’s position

Select the Change Date... option from the Edit menu.
You may, for example, wish to enter your date of birth in order to see the
star’s positions precessed to your birth. The format of the displayed date is
typically “dd mmm yyyy” or “mmm dd yyyy” eg. 31 Dec 1994 or Dec 31
1994. As in the main Solar Fire program, many other formats may also be
entered, but if in doubt, then use one of the above formats.

Sorting the File
You can sort the entries in the current file into a variety of different orders,
as follows.
W

To change the order of the stars in the file

Select the Sort... option from the Edit menu.
You will be presented with a list of possible sort options from which you
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can choose. You may re-sort the file as many times as you wish.

Viewing Stars in the Planetarium
W

To start up the Planetarium and view the current file’s stars

Select the All Stars option from the View menu.
Alternatively, the planetarium may be started from Solar Fire’s View
menu. In this case, you must select the required fixed star file from Solar
Fire’s menu before choosing the Planetarium option.
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Customizing Solar Fire

Chapter 38: Editing a Wheel Design
File
This section describes how to edit files that contain wheel or dial designs
which may be used in Solar Fire’s chart or dial displays and printouts.
W

To edit a particular wheel or dial design

Select one of the Wheel Styles... or Dial Styles... options from the Chart
Options menu, or from a button on the View Chart screen.
From the file manager, select the required file from the list of file names,
and select the Edit... button
W

To start up the wheel designer directly from Windows

From the Windows group containing Solar Fire program icons, doubleclick on the Wheel Designer icon.
Wheel Designer Dialog Box

If you have started the wheel designer via Solar Fire’s file manager, then
when the screen first appears, the current design file will be open. You may
simply wish to examine or edit this file, but you may also use the available
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menu options to open and edit other wheel or dial design files or to create
new ones.
The displayed wheel or dial is not that of a true chart - its planetary
positions are fictitious and fixed, and are shown purely for convenience of
getting a rough idea of how the design will look when used with a real
chart. In order to see the design with a real chart, you will need to use it in
Solar Fire to display a chart.

Creating a New File
W

To create a new wheel or dial design file

Select the New option from the File menu.
If you have made any changes to the current file, then you will be
prompted to save them before a new file is opened. When a new file is
opened, it contains a basic wheel design. You must edit this design and
then save it under a new name.

Opening an Existing File
W

To open an existing wheel or dial design file

Select the Open option from the File menu.
If you have made any changes to the current file, then you will be
prompted to save them before a new file is opened. When you select this
option, you will be presented with a file open dialog box from which you
must select the required file. Solar Fire wheel design files have the file
extension .wh1, .wh2, .wh3, .wh4, and dial design files have the extension
.di1, .di2, .di3, .di4. This final digit in the extension indicates how many
charts are included in the wheel or dial eg. .di3 is dial design with three
concentric charts. It is only possible to open files of one of these types. If
you attempt to open a file of a different type, then a message will be shown
indicating that the file cannot be read.

Saving a File
W

To save the design that you have entered or edited

Select the Save or Save As... option from the File menu.
The Save option will save any changes that you have made using the
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existing file name. If there is no file name (ie. if it is a new file), then this
option will prompt you to enter a name before it is saved. This option will
automatically provide the appropriate file extension for your design eg. if
you are saving a biwheel design, then it will be given the extension .wh2.
The Save As... option prompts you for a name to save the file as.

Editing the Design Properties
Each wheel or dial design consists of a number of objects, each of which
has a number of properties. The objects in a wheel or dial design are:
•

General Properties - items that relate to the whole design

•

Circles - circles defining rings in which other objects are placed (up to
20)

•

Planet Rings - positions of planet and angle text (1 for each chart)

•

Extra Point Rings - positions of additional points and angle text (1
for each chart). These points are those that can be selected in the
“Extra Ring Points” option of the Solar Fire Options menu.

•

House Lines - lines delimiting house cusps (up to 2 per chart)

•

Cusp Annotation - glyphs and text for each house cusp (up to 2 per
chart)

•

House Numbering - identification of house numbers (up to 2 per
chart)

•

Zodiac/Dial - zodiacal annotation or dial annotation (up to 2 per chart)

•

Aspect Lines - lines showing aspects in a chart or between two charts

Each object has a different list of properties that may be edited in order to
change the appearance of the wheel or dial.
The values of the properties for any of these objects may be set by
choosing the required object from the drop-down list box at the top right of
the screen, and then editing the values of the individual properties which
appear in the list below the drop-down box.
The radius of the Circles may also be altered by using drag-and-drop
operations with the mouse directly on the displayed wheel.
W

To alter any property for an object

Select the required object from the drop-down list box
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Click on the required property in the property list
This will cause the value of that property to be displayed and highlighted
in the editing box at the top of the property list. Depending on the type of
property, it is then possible to select a new value by one for the following
methods.
Type a new value into the editing box (any property)
Select an entry from the drop-down list of possible values (only for
properties with a pre-defined list of possible values, eg. True/False,
Solid/Dashed/Dotted, etc.)
Select a color from the palette by clicking on the > button (only for color
properties)

Common Property Types
LineStyle - Possible values are Solid, Dash, Dot, Dash-Dot, Dash-DotDot. However, this property is only applicable if the LineWidth is 1. If
the LineWidth is greater, then the line is always Solid, regardless of the
value of this property.
LineWidth - This must be in the range 1 to 5. Note that if it is greater than
1, then the LineStyle is always displayed as solid, regardless of the
value of the LineStyle property.
Color - This may be any of several million colors, although the exact
color that is used when the wheel is displayed or printed depends on the
color capabilities of your computer display or printer. The drop-down
list of values contains a list of only the 16 main solid colors. If you
wish to use any other color, then you must select the > button, and use
the color selection dialog to find or define the color that you want. Note
that where the color property relates to a line, the nearest solid color to
the selected color is always used.
Inner & Outer Circle - These must have values from 0 to the number of
circles in the wheel or dial design, and they define a ring (ie. the region
between these two circles) in which the object is placed. The circles are
always arranged with circle 1 outermost, and increasing in number to
the innermost circle. If you delete any circles after setting this property,
then these values may be automatically altered to ensure that they refer
to existing circles. Setting one or both of these values to 0 will prevent
that object from being included in the chart. For example, setting the
house numbers inner and outer circles to zero ensures that no house
numbers will be displayed.
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Lengths & Widths - These properties are used to define the length and
width of various items such as tick marks and arrowheads. They must
be between 0 and 1, as they are always relative to the radius of the
outermost circle eg. a value of .1 would produce an arrow head width
or length 1/10th of the radius of the circle, or a value of .02 would
produce a tick mark 2/100ths of the radius of the circle.

General Properties
House Anchor Chart - This must have a value between 1 and the number
of charts in this design. It indicates which chart’s house cusps will be
used for multi-wheel displays. This is usually set to 1, indicating that
the houses of the innermost chart will be used. In a three chart wheel,
setting this to 2 would indicate that the middle chart’s houses would be
used, and setting it to 3 would indicate that the outermost chart’s
houses would be used.
Thin Printer Lines - This must be either True or False. When it is false,
then when the design is printed it will have lines that are approximately
the same thickness as on the screen design. When it is true, then the
printed lines are somewhat thinner than the screen lines. Typically the
printed chart looks better when this is set to True.
Dial Degrees - This must be a number from 10 to 360, indicating the
number of degrees shown in the wheel. If the number is less than 360,
then this design is considered to be a dial. If the number is 360, then
this design is considered to be a wheel, provided that the glyph type in
the zodiac ring is not set to degrees.
Fixed Anchor - This must be either True or False. It indicates whether or
not the wheel or dial is fixed at a particular angle, rather than having
the anchor chart’s ascendant fixed on the left of the chart. Normally it
should be set to false for a wheel display and to true for a dial display.
When set to true, the chart is fixed at the angle specified in the anchor
degrees property.
Anchor Degrees - This must be a number from 0 to 360. It specifies at
what angle the wheel or dial is fixed. For example, setting this to 0
ensures that the 0 degree point on the chart is fixed at the left of the
wheel. Similarly, 90 fixes the 0 degrees point of the chart to the top of
the wheel, 180 to the right of the wheel, and 270 to the bottom of the
wheel. For a dial, this should normally be set to 90, putting the origin at
the top of the dial. This option is ignored if the Fixed Anchor property
is false.
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Circles
Radius - This must have a value between 0 and 1. It indicates the radius of
the circle relative to the outermost circle in the design. If it has a value
of .6, for example, then this circle would have a radius 6/10ths of the
size of the outermost circle. The radius of circle number 1 is always set
to 1, and cannot be changed. If you wish to design a chart that is
smaller than the standard size, then you should make circle 1 invisible,
and ensure that the other wheel design objects are placed between other
smaller circles. Instead of typing in a value here, it is possible to use the
mouse to drag-and-drop the circle radius to its required size.
Visible - This must be either True or False. If this property is false, then it
will not be visible when displayed or printed in Solar Fire. However,
for the sake of clarity, it is always displayed in the wheel designer
regardless of the value of this property.
LineStyle - The line style that is used for this circle. Ignored if circle is not
visible.
LineWidth - The line width that is used for this circle. Ignored if circle is
not visible.
LineColor - The line color that is used for this circle. Ignored if circle is
not visible.
Fill Circle - This must be either True or False. If this property is true, then
the FillColor will be used to fill the entire region from this circle
inwards. If you wish the fill color to end at another circle, then you
must set that circle’s Fill Circle property to True and set its FillColor to
White.
Fill Color - This defines the color that will be used to fill this circle if the
Fill circle property is true. Ignored if circle is not visible.

House Lines
Inner & Outer Circle - These define the circles between which the house
lines will be drawn.
Angular & Other LineStyle - These define the line style used for the
house cusp lines. Angular lines are those of the 1st, 4th, 7th and 10th
house cusps.
Angular & Other LineWidth - These define the line width used for the
house cusp lines.
Angular & Other LineColor - These define the color in which the house
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cusp lines are drawn.
Arrow on 10th & 1st - This must be either True or False. If this property
is true, then an arrowhead is drawn at the outer end of the 10th or 1st
house cusp lines.
Arrow Width & Length - These define the width and length of the
arrowhead, and must be between 0 and 1. Try values .1 for length and
.05 for width as a starting point.

Cusp Annotation
Inner & Outer Circle - These define the circles between which the cusp
annotation will be drawn.
Cusp Style - This must be Normal, Crystal, Teardrop or Lotus. You can
see what these different styles look like by selecting them and
redrawing the wheel. Cusp styles other than normal require a
reasonable width between inner and outer circles to look their best.
Show Interceptions - This must be either True or False. If this property is
true, then sign glyphs for any intercepted signs are displayed as well as
the glyphs on the house cusps. Ignored unless Cusp Style is normal.
Inner & Outer Tick Length - These define the length of tick marks
pointing out from the inner circle and in from the outer circle, and must
be between 0 and 1. Try a value of .02 as a starting point. Set this value
to 0 to prevent ticks appearing.
Glyph Visible – This must be one of Sign Glyphs On, No Sign Glyphs, or
Sign Abbr On. The last option forces the sign to be displayed as a twoletter abbreviation instead of as an astrological glyph.
Degrees, Minutes Visible - This must be either True or False. If this
property is false, then the degree text or minute text on each house cusp
will not be displayed. For example, you might like to display only the
degree number on each cusp, in which case you should set the Minutes
Visible property to false.
Glyphs, Degrees, Minutes FontSize - This allows you to choose in what
fontsize this item should be displayed. Ignored if not visible.
Glyphs, Degrees, Minutes Bold - This must be either True or False. This
allows you to choose whether this item should be displayed in a normal
font if false, or a bold font if true. Ignored if not visible.
Glyphs Italic - This must be either True or False. This allows you to
choose whether the sign glyphs on each house cusp should be displayed
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in a normal font if false, or an italic font if true. Ignored if not visible.

House Numbering
Inner & Outer Circle - These define the circles between which the house
numbers will be drawn.
Position Ratio - This must be a number between 0 and 1, defining where
the number is centered between the inner and outer circles. A value of
.6 would position the numbers 6/10ths of the way from the inner circle
to the outer circle.
Numbers FontSize - This allows you to choose in what fontsize this item
should be displayed.
Numbers Bold - This must be either True or False. This allows you to
choose whether the house numbers should be displayed in a normal
font if false, or a bold font if true.

Zodiac/Dial
Inner & Outer Circle - These define the circles between which the zodiac
or dial ring will be drawn.
Glyph Type - This may be any of the following: None, Vertical, Rotated,
Degrees, Vertical Text Abbr, Rotated Text Abbr, Rotated Degrees. The
vertical options displays zodiac sign glyphs or abbreviations in their
normal upright position. The rotated option displays them rotated
according to their position in the zodiac ring, so that their base is
always pointing inwards. The degrees options prevent signs glyphs or
abbreviations from being displayed, and displays angle text instead.
Note, however, that if the Dial Degrees property is set to anything other
than 360 degrees, then sign glyphs or abbreviations will not be
displayed regardless of the setting of this property.
Fill Signs - This must be either True or False. This allows you to choose
whether the zodiac signs will have their background filled with their
colors (as set in Solar Fire). If false, then the glyphs or abbreviations
will be drawn in their sign colors, but the background will be
unchanged. If true, then the glyphs will be black or white, but the
background of each sign will be filled with its color. Note, however,
that in order for the fill option to work, the individual signs must be
fully enclosed with circles on both sides, and division intervals at either
end. If they are not fully enclosed, then the fill option will not work
correctly. (This means that the division interval must be 30 degrees,
and the division tick ratio must be 1).
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Glyphs Position - This must be a number between 0 and 1, defining where
the number is centered between the inner and outer circles. A value of
.6 would position the numbers 6/10ths of the way from the inner circle
to the outer circle.
Glyphs FontSize - This allows you to choose in what fontsize this item
should be displayed. Ignored if not visible.
Glyphs Bold - This must be either True or False. This allows you to
choose whether this item should be displayed in a normal font if false,
or a bold font if true. Ignored if not visible.
Glyphs Italic - This must be either True or False. This allows you to
choose whether the sign glyphs on each house cusp should be displayed
in a normal font if false, or an italic font if true. Ignored if not visible.
Glyph Widening - This is the ratio between the glyph width and height. A
value of 1 ensures that the glyph has its normal appearance. A value of
2 would stretch the glyph horizontally to be twice its normal width. A
value of .5 would shrink the glyph horizontally to be half its normal
width. This option is mainly useful for widening the glyphs when they
are displayed in rotated format.
Division Interval - This must be a number from 1 to 360, indicating at
what interval division markers are placed. For wheels, this should
normally be 30, to ensure that the divisions fall between the zodiac
signs. For a dial, it should be set to some factor of the dial degrees eg. if
the dial degrees is 90, then setting this interval to 30 will produce 3
equal divisions in the dial, or setting it to 10 will produce 9 equal
divisions in the dial.
Division Tick Ratio - This must be a number from 0 to 1. It indicates how
long the division markers are in relation to the distance between the
inner and outer circles. A value of 1 ensures that the division markers
cover the full distance between the two circles. Use a value of zero to
switch off the division markers.
Tick on Inner - This must be either True or False. If true, then all tick
marks and division markers will start from the inner circle and extend
towards the outer circle. If false, then they will all start from the outer
circle and extend inwards.
Tick Color - The color that is used for all the division and tick marks.
Large & Small & Tiny Tick Ratio - This must be a number from 0 to 1.
It indicates how long the tick marks are in relation to the distance
between the inner and outer circles. A value of .2 ensures that the tick
marks cover 2/10ths of the distance between the two circles. Typically
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the large tick ratio is larger than the small tick ratio, which itself is
larger than the tiny ratio. Use a value of 0 to switch of the tick marks.
Large & Small Tick Interval - Large tick interval must be in the range 1
to 90, and the small tick interval in the range 1 to 30. These indicate at
what intervals the tick marks are displayed.
Tiny Tick Fraction – This indicates how many tick subdivisions per
degree are displayed. This must be in the range 2 to 10. This option is
useful for dials which have a modulus of say 90 degrees or less, when
the interval between degree ticks is quite large.
Zodiac Type – This must be one of the following: Default, Tropical,
Sidereal or Constellations. The Default option ensures that the
displayed zodiac ring uses the zodiac type of the chart being displayed.
The Tropical option ensures that the zodiac ring displays the tropical
zodiac sign positions, regardless of the zodiac type of the chart being
displayed. The Sidereal option ensures that the zodiac ring displays
sidereal zodiac sign positions, regardless of the zodiac type of the chart
being displayed – in this case Solar Fire’s default sidereal zodiac type
used is. The Constellations option makes the zodiac ring display the
astronomical constellation boundaries (giving uneven sign lengths and
including a 13th division for the constellation Ophiuchus). Note: If you
include more than one zodiac ring for a chart, then you can choose
different zodiac types for each, so that you can see both tropical and
sidereal sign positions in the same chart, for example.

Aspect Lines
From & To Circle - These define the circles between which the aspect
lines will be drawn. Usually aspect lines are drawn to different points
on the same circle. In this case both these should be set to the same
circle number.
From & To Chart - These must be in the range 1 to the number of charts
in the current wheel. These define the charts between which the aspect
lines will be drawn. Usually aspect lines are drawn to different points in
the same chart. In this case both these should be set to the same chart
number. If they are set to different chart numbers, then you will see
aspects between those two charts.
From & To Tick Ratio - These must be numbers from 0 to 1. They
indicates how long the tick marks are in relation to the distance
between the inner and outer circles. Use a value of zero to switch off
the tick marks.
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From & To Tick Width - This is the line width used to draw the tick
marks at the planetary positions on the circle. Aspects are drawn to the
end of these tick marks instead of to the circles, unless the tick ratios
are zero.

Planet Rings and Extra Ring Points
Inner & Outer Circle - These define the circles between which the zodiac
or dial ring will be drawn.
Glyph, Degree, Sign, Minute, Retro Position - These must be numbers
from 0 to 1. They indicate where each item is positioned relative to the
inner and outer circles. A value of 0.25 positions it 1/4 of the way from
the inner to the outer circle, and a value of .75 positions it 3/4 of the
way. If this value is set to 0, then this item is not displayed. For
example, if you wish to display only the glyph, degree text and zodiac
sign, then assign them non-zero values, but give zero values to the
minute and retro positions.
Glyphs, Degrees, Minutes FontSize - This allows you to choose in what
fontsize this item should be displayed. Ignored if not displayed.
Glyphs, Degrees Bold - This must be either True or False. This allows you
to choose whether this item should be displayed in a normal font if
false, or a bold font if true. Ignored if not displayed.
Glyphs Italic - This must be either True or False. This allows you to
choose whether the sign glyphs on each house cusp should be displayed
in a normal font if false, or an italic font if true. Ignored if not
displayed.
Inner & Outer Tick Length - These must be numbers from 0 to 1. They
indicate how long the tick marks are in relation to the distance between
the inner and outer circles. Use a value of zero to switch off the either
of these sets of tick marks.
Tick Width - This is the line width used to draw the inner and/or outer tick
marks at the planetary positions on the inner and outer circles. Ignored
if the tick lengths are zero.
Glyphs as Text – This must be either True or False. If false, then planets
are shown as glyphs. If true then planets are shown as three-letter
abbreviations.
Signs as Text - This must be either True or False. If false, then signs are
shown as glyphs. If true then signs are shown as two-letter
abbreviations.
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Adding a New Circle
It is possible to have up to 10 circles in a wheel or dial design.
W

To add a new circle to the design

1. Select the Add Circle... item from the Edit menu
2. Click on the wheel at roughly the required radius for the new circle
You can adjust the radius of the circle after it is added either by drag-anddrop with the mouse, or by setting its radius property in the property list
for the circle.

Deleting a Circle
W

To delete an existing circle in the design

1. Select the required circle by clicking near it, or select the required
circle from the drop-down list of objects
2. Select the Del key or select the Delete Circle... item from the Edit
menu
If the deleted circle was referenced by any objects, then those references
will be automatically updated to refer to other existing circles.

Adding a New Chart
It is possible to have up to four charts in a wheel or dial design.
W

To add a new chart to the design

1. Select the Add Chart... item from the Edit menu
2. Click on the wheel between two circles where you wish that chart’s
planets to be placed
You can adjust the planet positions, the circles used and other properties
after it is added.

Deleting a Chart
You cannot delete the chart that is the single remaining one.
W

To delete another chart in the design, do one of the following
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Select the required chart’s planets from the drop-down list of objects, and
then select the Del key
Select the Delete Chart... item from the Edit menu, and then click on the
wheel between two circles where that chart’s planets are placed

Editing the Wheel Description
A description of a wheel or dial design is displayed at the top left of the
design screen, but is not displayed when the wheel or dial is displayed or
printed in Solar Fire. In Solar Fire, its only purpose is to help you select a
wheel or dial design file from the list of available designs. These
descriptions are listed in Solar Fire’s file manager when you invoke the
Wheel Styles... or Dial Styles... items from the Preferences menu.
W

To edit the description of the current design

1. Select the Wheel Description... item from the Edit menu.
2. Enter or edit up to 80 characters of text.
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Customizing Solar Fire

Chapter 39: Editing a Dignity/Almuten
File
There are several reports and page objects within Solar Fire that use a
dignity scoring system in order to determine which planet is the most
dignified in certain circumstances. These items are as follows.
Essential Dignities Tabulations - These are displayed in the “Horary”
report and also in the “Essential Dignities” page object, and are defined
in the file essdig.alm in Solar Fire’s main directory.
House Almutens - These are displayed in the “Horary” report and also in
the “House Almutens” page object, and are defined in the file
house.alm in Solar Fire’s main directory.
Dignity/Almuten Scores - These are displayed in the “Dignity/Almuten”
page object. By default, they are defined in the file general.alm in Solar
Fire’s main directory, but the user can generate any number of
customized definitions in files of the type *.alm in Solar Fire’s
\USERDATA directory, and opt to use these customized definitions
instead of the default.
In each case, the dignity scoring definitions are stored in files of the type
“*.alm”, and any file of this type may be edited in the Dignity/Almuten
Editor.
W

To start the Dignity/Almuten editor

From the Solar Fire Group folder, double-click on the Dignity/Almuten
Editor icon.
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When the editor first starts up, it will prompt you to select an existing
dignity/almuten file. If you do not select one to open, then it will start with
a new dignity definition set containing a single definition for the scoring of
essential dignities.

Manipulating Files
W

To open an existing dignity definition file for editing

Select Open... from the File menu.
This will display a standard “File Open” dialog from which you may select
any existing file with a “*.alm” extension.
The default directory for user-defined dignity/almuten definition files is
Solar Fire’s \USERDATA directory. However, the system default
definition files reside in Solar Fire’s main directory. Initially, you will have
the following files available.
general.alm - The default file used by the Dignity/Almuten page object.
This is in Solar Fire’s \USERDATA directory. It contains several
definitions.
essdig.alm - The file used for the calculation of essential dignities tables.
This is in Solar Fire’s main directory. It contains a single definition.
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house.alm - The file used for the calculation of house cusp almutens. This
is in Solar Fire’s main directory. It contains a single definition.
hyleg.alm – The file used for certain parts of the calculation of chart
hylegs. This is in Solar Fire’s main directory. It contains a single
definition.
You have the option of editing any of these files, in addition to any further
user-defined dignity/almuten definition files that you have previously
created yourself.
W

To save any changes you have made

Select Save from the File menu. This will save any changes you have
made to the file that is currently being edited.
W

To save the current file as a copy under a new name

Select Save As... from the File menu.
This will display a standard “File Save” dialog in which you may enter a
new name (and optionally location) for the file. The file must have a “.alm”
extension in order to be usable in Solar Fire, and it must be saved to Solar
Fire’s \USERDATA directory. The only exceptions are for the system
default definition files (essdig.alm, house.alm, hyleg.alm) that must always
reside in Solar Fire’s main directory.
W

To create a new dignity/almuten definitions file from scratch

Select New from the File menu. This will create a new file containing a
single definition for essential dignities, which you can edit and save under
any name you like.

Editing a Single Definition
W

To edit any definition on the list

Select the entry you wish to edit by clicking on it. This will update all the
other items on the screen to display what is contained in this definition, and
any of these items may be edited.
The editor allows you to create two different types of dignity/almuten
definitions.
Degree Dignities - This type of definition allows you to specify a
calculation which determines either i) the dignity score of a planet for the
position that it occupies in the chart (also known as “essential dignities”, or
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ii) to determine the dignity scores of all planets at the position of a house
cusp, from which the almuten of the house cusp may be determined.
For example, if Jupiter is at 28°Libra, then the ruler is Venus, exaltation is
Saturn, Triplicity ruler (daytime chart) is Saturn, Term ruler (Ptolemaic) is
Mars, the Face is Jupiter, the Detriment is Mars and the Fall is the Sun. In
this case, Jupiter would be assigned points for being in its own Face. If the
definition was being used to calculate a house cusp, then Saturn would get
the highest dignity score, because it is exalted and in triplicity
Almuten - Sum over Points - This allows you to specify a calculation
which sums the dignities of each planet at each of a variety of specified
positions. The result is a summed score for each planet, and the highest
scoring planet is deemed to be the overall almuten.
For example, Ibn Ezra suggests that the almuten of the chart can be found
by summing the dignity scores that each planet has at the positions of I) the
Moon, ii) the Sun, iii) the Ascendant, iv) the Part of Fortune and v) the
position of the moon at the last syzygy (new moon or full moon) prior to
the time of the chart.
W

To select the Calculation Type

Click on either the Degree Dignities or the Almuten option button in the
Calculation Type frame.
If you select the Almuten option, then the Selected Points button and
Minimum Honors edit boxes will become enabled, otherwise these
options will remain unavailable.
W

To select points for almuten calculations

Click on the Selected Points... button. This will display the “Summation
Point Selection” dialog box from which you can select a large range of
primary chart points, house cusps or other derived positions.
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The points available are as follows.
All Chart Points
Each of the 12 House Cusps
Various Other Points
The Descendant (Dsc)
The Immum Coeli (IC)
The prenatal syzygy Moon
The prenatal syzygy Sun
The prenatal syzygy Sun or Moon (Most Elevated)
The prenatal New Moon
The prenatal Full Moon
The prenatal Sun (at the Full Moon)
Any Arabic Parts in a selected Arabic Parts file
For each point, you can also choose to apply the following modifiers
Own position - no modifier is applied. The position of the selected point is
used in the calculation.
Dispositor - The position of the ruler of the sign in which this point is
placed is used in the calculation. The rulerships used depend of which
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set is chosen using the Options... button.
Triplicity rulers - The position of the 1st (in sect), 2nd (out of sect) or 3rd
(participating) triplicity ruler of the element in which this point is
placed is used in the calculation. The triplicity type used depends on
what is selected using the Options... button.
Term ruler - The position of the term ruler of this point is used in the
calculation. The term type used depends on what is selected using the
Options... button.
Face ruler - The position of the face ruler of this point is used in the
calculation. The rulerships used depend of which set is chosen using
the Options... button.
W

To add a point to the list of selected points

1. Select an option from the Points to Show frame. This will list all the
available points of that type in the Available Points list.
2. Select an option from the Point Type frame.
3. Select the required point from the list of Available Points by
highlighting it and then clicking on the Add button, or by doubleclicking its entry. This will add the selected point to the bottom of the
list of Selected Points.
W

To remove a point from the list of selected points

Select the required point from the list of Selected Points by highlighting it
and then clicking on the Delete button, or by double-clicking its entry. This
will remove that entry from the list.
If you wish to specify any Arabic Parts as selected points, then you must
first ensure that you have an Arabic Parts file containing the required
Arabic Part definitions. See page 255 for instructions on using the Arabic
Parts Editor.
W

To select an Arabic parts file

Click on the Arabic Parts File... button. This will display a standard file
open dialog listing all available Arabic Part files. You must select a file
from this list. You must not attempt to select a file from any other directory
than the one which is first displayed (the Solar Fire \USERDATA
directory), or else the Arabic Parts will not become available for selection.
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Notes:
1. You can select Arabic Parts from a single Arabic Parts file only. Once
you have added Arabic Parts as selected points, and you then select a
different Arabic Parts file, any Arabic Parts selected from a previous
file will be removed from the list.
2. If you wish to use an Arabic part that has a separate day/night formula
(for example the Part of Spirit), then you should ensure that you add
both the day and the night formula versions of that Arabic Part to the
list of selected points (Part of Spirit (Day) and Part of Spirit (Night)).
When Solar Fire calculates the almuten, it will ignore that version of
the Arabic Part which is not applicable to the sect of the chart for which
the almuten is being calculated.
3. Warning: If you later use the Arabic Parts Editor to remove entries
from or reorder the Arabic Parts file which you select here, then the
almuten calculation will no longer work correctly. You will need to use
the Dignity/Almuten Editor to reselect all the required Arabic Parts
before you can be sure that the calculation will use the correct Arabic
Parts.
When you have selected the required points, click on the Save button to
return to the previous screen.
W

To select Minimum Honors

Click inside the Minimum Honors edit box, and type in the minimum
number of honors that a planet must have in order to be deemed the
almuten.
An honor is a dignity by rulership, exaltation, triplicity, term of face. This
option is intended to be used to prevent a planet from being deemed the
almuten if it does not have sufficient dignity. If a planet does not have
minimum honors when this option is set, then it is given a zero dignity
score. It is currently used only in the hyleg.alm system file for the
calculation of chart hylegs.
W

To edit text for the Brief Name, Full Name and Description

Place the cursor in the required edit box, and type in the changes.
Brief Name is what this definition is called on the list, and does not affect
anything else in Solar Fire.
Full Name is used in Solar Fire’s dignity/almuten page object as a title for
the definition, so should be brief but descriptive.
286 Solar Fire 5: Customizing Solar Fire

Description is not used in Solar Fire, but may be used to add a few notes
about the definition, its origin, and how it should be used, for example.
W

To select an item on the Dignity Scoring list for editing

Select the required item by clicking on it.
The Dignity Scoring list items are as follows.
In Rulership - The score for a planet that is a sign which it rules
In Exaltation - The score for a planet that is in a sign in which it is exalted
In Triplicity (In Sect) - The score for a planet that is in its own triplicity
for the sect of the chart (diurnal or nocturnal).
In Triplicity (Out Sect) - The score for a planet that is in its own triplicity
for the opposite sect of the chart (nocturnal or diurnal).
In Triplicity (Extra) - The score for a planet that is in its own triplicity of
the extra (or participatory) triplicity ruler.
In Term - The score for a planet which is in its own term
In Face - The score for a planet which is in its own face
In Detriment - The score for a planet which is in a sign opposite its
rulership
In Fall - The score for a planet which is in a sign opposite its exaltation
In MR (Rulership, Exaltation etc.) - The score for a planet that is in
mutual reception by rulership, exaltation, triplicity (in sect), term or
face.
Planet of Day - The score for the planet that is the planet of the day.
Planet of Hour - The score for the planet which is the planet of the hour
In Peregrine - The score for planet which is in peregrine
In House x - The score for a planet occupying the xth house.
Notes:
1. Any score may be set to 0 (zero) to prevent it being used in the dignity
scoring calculation.
2. Rulerships, exaltations, faces, detriments and falls are deemed
according to whichever set of rulerships has been selected to be used
with this definition.
3. Triplicity rulerships are deemed according to whichever one of the
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available options is selected as described below.
4. Term rulerships are deemed according to whichever one of the
available options is selected as described below.
5. A planet is deemed to be in peregrine if it has no dignity by rulership,
exaltation, triplicity, term or face. Optionally, a further condition for
deeming a planet to be peregrine is that is also has no mutual receptions
by rulership, exaltation, triplicity, term or face. This option may be
selected by the user as described below.
6. The Planet of Day, Hour and House options would normally only be
used for almuten calculations rather then degree dignities.
7. When scoring the In House option, the house placement of each planet
is determined according to user-defined options as described below.
W

To adjust the scoring for the selected dignity item

Click on the > button to increment the score by 1 point, or the < button to
decrement the score by 1 point.
When you select a dignity item that is a Mutual Reception (MR), you can
also select a peregrine option, which affects whether or not a planet can be
deemed to be in peregrine if it is in mutual reception. These options are as
follows.
Ignore MR for peregrine flag - This option ignores the mutual reception
when determining whether a planet is in peregrine, so the planet may be
in peregrine even if it is in a mutual reception of this type.
Cancel flag if MR occurs - This option cancels the peregrine if any
mutual reception of this type occurs for the planet, so the planet is
deemed not to be in peregrine if the mutual reception occurs.
You can prevent a dignity/almuten definition from being used for either
daytime or nighttime charts if you wish. This is useful if you wish to apply
different scoring for day and night charts, in which case you must create
two separate definitions, and apply one to diurnal (daytime) charts only,
and the other to nocturnal (nighttime) charts only.
When Solar Fire
displays dignity/almutens scores, it will ignore the definition that does not
apply to the current chart, and display the scores only for the definition that
does apply.
W

To select diurnal applicability

Click in the Diurnal Charts and Nocturnal Charts check boxes to switch
them on or off. At least one of these must be checked, and both must be
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checked in order to apply the definition to charts of both types.

Selecting Further Options
W

To select further options

Click on the Options... button. This will display the “Dignity/Almutens
Options” dialog box.

Planetary Rulerships
You can select any set of rulerships that are defined in Solar Fire’s
Rulerships and Weightings Editor (see page 388).
Triplicity Type
There are three different sets of triplicity rulers from which you may
choose.
Ptolemy - As defined in his book “Tetrabiblos”
Lilly - As defined in his book “Christian Astrology”
Dorothean - According to Dorotheus of Sidon.
Ptolemy

Lilly

Dorothean
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Triplicity
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Air
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Water



    -

  

D=Day; N=Night; P=Participatory
For a more detailed discussion of the different triplicity rulerships and their
applicability, you might like to refer to Dr. Lee Lehman’s book “Classical
Astrology for Modern Living”, published by Whitford Press.
Term Type
There are two different term definitions from which you may choose.
Ptolemy - As defined in his book “Tetrabiblos”. This set of term rulerships
is also sometimes referred to as “Chaldean”.
Egyptian - As defined in Ptolemy’s “Tetrabiblos”.
The following tables indicates the terms of each sign, giving the planet
ruling each term and the number of degrees into the sign at which its
rulership ends, eg. in the Ptolemaic Terms table, Jupiter rules the first 6
degrees of Aries (ie. from 0°00 to 5°59’59”), and Venus rules the next 8
degrees (ie. from 6°00 to 13°59’59”).
Ptolemaic Terms
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For a more detailed discussion of the different term rulerships and their
applicability, you might like to refer to Dr. Lee Lehman’s book “Classical
Astrology for Modern Living”, published by Whitford Press.
Sign Boundaries
The usual modern practice is to deem that an astrological sign starts at 0°
of the sign. However, it is possible that some ancient astrologers may have
deemed a sign to begin at 1° when defining the term rulerships. In this
case, the first degree of each sign is deemed to be the 30th degree of the
previous sign. No other degrees are affected, and this option only affects
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determination of the terms. For example, in the Ptolemaic Terms table,
Jupiter would rule from 1°00 to 5°59’59” of Aries, and Saturn would rule
from 25°00 of Aries to 0°59’59” of Taurus.
House System
You can opt to allow Solar Fire to use whichever house system is in use
with the chart for which this definition is being used, or you can force it
always to use a selected house system. This is useful if you are trying to
emulate the almuten calculations of medieval astrologers who used a
specific house system, for example.
House Cusps Degree Offsets
When determining which house a planet is placed in, many astrologers
read a planet forward into the next house if it is close to the cusp of the
next house. You can emulate this procedure by specifying a number of
degrees from each house cusp type within which the planet will be
considered to be in the next house. Typically this offset is greatest for
angular houses, and smallest for cadent houses. For example, specifying an
offset of 8 degrees will cause any planets lying up to 8 degrees ahead of an
angular house cusp (1st, 4th, 7th or 10th) is deemed to be in that angular
house. This procedure only affects the dignity/almuten scoring for house
placements of planets, so will have no effect unless you are using non-zero
scores for the “In House” dignity scoring items.
Part of Fortune
If the Part of Fortune (or its dispositor) is selected as a summation point in
the Almuten calculation, then you can specify whether it is calculated
according to the daytime formula only, or whether to apply the different
nighttime formula in any nocturnal chart. A similar option is also available
within the main Solar Fire program, but the setting of the option in this
screen overrides the choice you have made in Solar Fire when almuten
calculations are being performed.

Adding a New Definition to the List
W

To add a new definition to the list

Select Add New Definition from the Edit menu. This will add a new
definition for essential dignities to the bottom of the list. You can edit this
new definition as you wish.
W

To duplicate an existing definition on the list
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1. Select the entry you wish to copy by clicking on it
2. Select the Paste Definition item from the Edit menu. This will add a
copy of the current definition to the bottom of the list. You can edit this
as you wish.

Deleting a Definition
W

To delete a definition from the list of dignity/almuten definitions

1. Select the required entry from the list by clicking on it
2. Select the Delete Definition item from the Edit menu.
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Customizing Solar Fire

Chapter 40: Editing a Page Design File
It is possible to infinitely customize what is seen on Solar Fire’s Chart
Viewing screen - from viewing a single chart, to viewing several charts at
once, or viewing a large variety of tables, grids and graphics in addition to
charts.
Solar Fire is shipped with a range of pre-designed pages from which the
user may choose. However, if you cannot find a page that suits your
requirements, you have the option of editing an existing page design or of
creating an entirely new page design from scratch.
A page design can be optimized for viewing on any screen size, as well as
for printing on any standard paper size, whether in portrait or landscape
orientation.
A single viewable page can contain information on up to 12 individual
charts, displayed in any combination (eg. 12 single wheels, 6 biwheels, 3
quadriwheels, 6 biwheels plus 6 synastry grids etc.)

Opening the Editing Screen
W

To open the page editing screen

From within Solar Fire - From the View menu select Page Topic
Index..., click on the name of a page design file and select the Edit...
button. The page designer will appear, displaying the selected page.
From outside Solar Fire - From the Solar Fire v5 folder, double-click on
the Page Designer icon. The page designer will appear, displaying a
new blank page.
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Selecting Files to Edit
You can either create new page design files or modify existing ones.
Usually it is easier to select the page design that is closest to what you
want and then modify it. To save the new design and also keep the original
design intact, you would then use the Save As... option instead of Save.
W

To select a different file without leaving the editing screen

From the editing screen, select the Open... menu item from the File menu.
A standard file opening dialog box will appear, allowing you to select a
directory and filename of an existing page design file. This will initially
list all the page design files (*.pag) in Solar Fire’s \USERDATA directory.
You should not normally change this directory, as Solar Fire requires its
user-defined pages to remain in this directory.
To select any file that is listed, either highlight the name of the file and
then choose the OK button, or just double-click on the filename. If you
have made any changes to the existing page design, then you will be asked
if you wish to save it. The editing screen will reappear, showing the newly
selected page design.
W

To create an entirely new file

From the File Management dialog box - Select any page design file and
click on the Edit button. Then select the New menu item from the File
Chapter 40: Editing a Page Design File 295

menu.
From the Solar Fire v5 folder - Double-click on the Page Designer icon,
and a new page will be opened automatically.

The Editing Process
A page design file consists of a collection of objects, each of which has
various properties. The page itself is an object, as are any items that appear
on the page, such as a chart wheel, aspect grid, tabulation of aspects, etc.
W

To select an object for editing

Any object can be selected by clicking on it. If the object cannot be
selected by clicking on it (for example if it is behind another object), then
it can be selected from the drop-down list of objects. When an object is
selected, red editing bullets will appear around its perimeter, and its
properties will be listed in the property display list, ready to be selected
and edited. The page object can be selected by clicking on any vacant area
of the page, and in this case editing bullets do not appear.
W

To bring an object to the front or back of the display order

If two objects overlap one another, then you can move one of them to the
front or back by selecting it, and then choosing the Move to Front or
Move to Back menu item from the Edit menu. This will also alter the
order in which the objects are drawn when they are displayed in Solar Fire.
Items at the back are drawn first, and items at the front are drawn last. This
feature can be useful if you want to display a graphic that overlaps another
page object, for example a graphic in the center of a chart wheel. If you
move the graphic to the front of the display order, then it will always be
drawn on top of the chart wheel, thus obscuring any aspect lines that may
appear in the middle of the chart. Reversing the order will cause the
aspects lines to be drawn over the graphic, so they will remain visible.
You can find the current display order of all the objects by browsing
through the list of objects in the drop-down list of objects. The items at the
top of the list are drawn first (at the back), and items at the bottom of the
list are drawn last (at the front).
W

To insert a new object

Choose the New Object menu item from the Insert menu. This will
display the New Object dialog that allows you to select and preview the
shape of any of the available object types. A description of each object
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appears in the text box beneath the list when any object name is selected.
When you have found the required object, highlight it and click on the
Insert button, or simply double-click its entry in the list. The new object
will be placed onto the page as the currently selected object, with its
properties displayed ready for editing.
W

To make a copy an existing object

First select the object that you wish to copy, and then choose the Copy of
Object menu item under the Insert menu. The new object will be placed
onto the page as the currently selected object, with its properties displayed
ready for editing.
W

To move an object

First select the object by clicking on it, and then drag the object with the
mouse button held down. Releasing the mouse button will cause the object
to become fixed at its new location. It is also possible to move an object by
typing in new AnchorX and AnchorY property values.
W

To resize an object

First select the object by clicking on it, and then position the mouse over
one of the red editing bullets, and drag the bullet with the mouse button
held down. Releasing the mouse button will cause the object to become
resized. If the object that you are resizing is text based (ie. if it has a Font
Size property), then the object will be resized to use the largest font size
available which will fit inside the new size that you have specified. This
means that the object will often end up slightly smaller than you specified.
It is also possible to resize these objects precisely by selecting a new Font
Size property value.
W

To edit the properties of a selected object

First select the required object by clicking on it. Its properties will then be
listed in the property display list, ready to be selected and edited. Any
property may be selected by clicking on it, and this property entry will
become highlighted, and the value of this property will appear in the
editing box. Some properties have numerical values, some have text
values, and some can be selected from drop-down lists or file selection
dialogs.
Numerical Values - e.g. AnchorX; This can be typed directly into the
editing box
Text Values - e.g. ListAbbrev; This can be typed directly into the editing
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box
Font Sizes, True/False, Justification values, Rulerships - These can be
selected from the drop down list by clicking on the button to the right
of the editing box
File Names - eg. Points File; This can be selected by clicking on the >
button to the left of the editing box
Whenever a property is selected, some descriptive text appears in the text
box underneath the properties list. This gives a description of what type of
value is expected for this property, and may give additional hints.

General Description of the Properties
ListAbbrev - Text - Up to 5 Chars - This is a property only of the page.
This text is used in Solar Fire’s Chart View page in the list of displayed
images, and helps the user identify which page type it refers to.
Chart* Desc - Text - Up to 20 Chars - There is one entry of this type for
each chart that is used on the page (up to 12). This text is used in Solar
Fire when the user is prompted to select which charts to display on the
page, and helps the user identify where on the page this chart is placed
eg. If there are two charts on the page you might enter “Top Chart” and
“Bottom Chart”. If there is only one chart used on this page, then this
text may be left blank.
MarginLeft, MarginTop, MarginRight, MarginBottom - Numeric - 0.0
to 1.0 - This shows how wide a margin to leave at the edge of the page.
Typically a small margin of 0.01 (i.e. 1%) is desirable to avoid objects
being drawn tight up against the edge of the page.
AnchorX, AnchorY - Numeric - Typically 0.0 to 1.0 - This shows the X
and Y coordinates (across and down the page respectively) at which the
object is placed. For most objects the anchor point is the top, left of the
object’s outline, but for wheels it is the center of the wheel. Objects
may be specified to be placed outside the borders by setting their
Anchor values to less than 0 or greater than 1, but they will still be
forced to appear within the page margins. It may be useful to do this to
force a wheel to always align with the edge of the page even when the
displayed page size is different from the design page size. AnchorX and
AnchorY properties may also be set by dragging the object around the
page (or off the edge of the page to force the alignment for other page
sizes).
Anchor Bottom – True/False – When false, this indicates that the top of
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the object is anchored to its specified AnchorY property. Hence if the
object shrinks due to having less data lines than are specified as its
default, then its base will move upwards. When true, this indicates that
the bottom of the object is anchored at its bottom (ie. the specified
AnchorY property plus the default height). Hence if the object shrinks
due to having less data lines than are specified as its default, then its top
will move downwards, and its base will remain fixed.
Width, Height - Numeric - 0.0 to 1.0 - These properties can only be set for
objects which are not text based (such as a wheel, grid or user graphic).
Text based objects have their width and height determined
automatically from the font size in combination with the number of text
lines and data blocks. Wheels must always be round, so specifying
unequal width and height results in both the width and the height being
set to the smaller value when the page is displayed. However, it may be
useful to specify unequal values in order to allow wheels to expand
when displayed on different page sizes. For example, if a landscape
shaped page has a single wheel with a caption above it, then its width
could be set to 1 (to potentially take up the full page width), and its
height to .8 (to allow a gap of .2 for the chart caption above). In this
case the height is smaller than the width, so it is the constraining value.
If this was then displayed on a portrait page, then the width would
become the constraining factor, so the wheel would expand to take up
the full width of the page, but would still allow a gap at the top for the
caption.
Chart - Numeric - 1 to 12 - This indicates which of the page’s charts is to
be used in the current object. For example, if the page has two
biwheels, then the first biwheel may use charts 1 and 2, and the second
wheel charts 3 and 4.
Justification - Numeric - 0=Left, 1=Right, 2=Center - This indicates how
text displayed in this object is justified.
Reverse - True/False - This indicates the vertical order in which text
appears. When False, the text appears with the first line at the top, and
subsequent lines going down. When True, the first lines appears at the
bottom. and subsequent lines going up.
Font Size - Numeric - 3.75 to 25.5 - This indicates the font size at which
text is displayed. In practice the font size may be varied if the object
contains more text lines than expected or the display page size is
significantly different from the design page size.
Data Lines - Numeric - Limits vary for different objects - This indicates
the maximum lines of data that are expected to be displayed in this
Chapter 40: Editing a Page Design File 299

object. For example, a flexible points list will display a data line for
each displayed point in Solar Fire. If you normally expect to have only
14 displayed points in Solar Fire, then you could set the Data Lines
value to 14, in which case the object would display correctly in the
chosen font size. However, if you increased the displayed points to 20,
then the object would remain the same size, but a smaller font size than
the one you specified will be used so that the 20 lines can all fit into the
same space. Conversely, if you set the Data Lines to 20, resulting in a
larger object, but only have 14 displayed points, then the selected font
size will be used, but the size of the object will shrink back to enclose
the 14 lines of data.
Data Blocks - Numeric - Limits vary for different objects - This indicates
how many side-by-side blocks (or columns) to split the data into. For
example, if you have 12 Data Lines, then setting the Data Blocks value
to 2 will result in two columns of 6 lines of data each. This property
can be used to change the shape of the object - increasing the number of
data blocks makes the object shorter and wider.
Title Line - True/False - If the object has a main title line available, then
this property can be used to switch it on or off. If it is switched off
(False) then the object becomes slightly shorter, but without its title it
may not be obvious to all users what the object is.
Frame Type - Numeric - 0=None, 1=Single, 2=Double - This controls
what type of frame, if any, is drawn around this object. Most objects
that have internal column and row lines look better with at least a single
line frame, but objects such as user graphics may look better without a
frame.
Graphic File - Text - Up to 255 Chars - This property applies only to the
graphic object, and specifies the name of a graphic file (including the
file extension) that is to be displayed. This may be any file of type
*.bmp, *.wmf, *.jpg, *.ico, *.gif, *.emf. (Unlike previous versions of
Solar Fire, it is no longer necessary to copy the graphic file into the
Solar Fire directory – you can select a file from anywhere you like.)
Points File, Aspects File, Star File, Arabic Parts File, Asteroid File Text - Up to 80 Chars - This specifies the name of the Solar Fire file
(without the file extension) which is used to determine which points,
aspects, stars, Arabic Parts or asteroids that are used within this object.
If left blank, then Solar Fire will use whatever default file is currently
selected when this object is displayed. This is useful if you wish to
always display the same items in this object, regardless of the currently
selected files in Solar Fire.

300 Solar Fire 5: Customizing Solar Fire

Dignity File - Text - Up to 80 Chars - This specifies the name of the Solar
Fire dignity/almuten definition file (without the file extension) which is
used to calculate dignity or almuten scores within this object. If left
blank, then Solar Fire will use its default file (“general.alm” for the
Almutens object, “houses.alm” for the house almutens and
“essdig.alm” for other objects).
Rulerships - Text - eg. Modern, Old, Esoteric, Hierarchical - This
specifies which rulerships will be used within this object eg. in a
flexible points list, this influences what is shown in the house rulership
and dispositor columns.
Modulus - Numeric - Angle in Degrees - This specifies the modulus angle
that is used in this object. Angles may be entered in any format
acceptable to Solar Fire (see page 384).
Max Orb - Numeric - Angle in Degrees - This specifies the maximum orb
that is used within the object. Angles may be entered in any format
acceptable to Solar Fire (see page 384).
Weighted Scores - True/False - This specifies whether scoring in this
object will use unweighted scores (i.e. 1 point per item) or scores
weighted according to Solar Fire’s default weightings. The default
weightings may be edited using the Rulerships and Weightings editor
(see page 385).

General Description of The Objects
Captions
Chart Details

This is an unboxed segment of text which shows all the details of the chart
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including its placement, name, type, date, time, timezone, place, latitude
and longitude, coordinate type, zodiac type, house system, node type (and,
if switched on, lunar parallax).
Chart Details - Boxed

This shows all the chart details formatted into a rectangular area, optionally
inside a frame.
Chart Details - Brief

This shows the same main chart details as the full Chart Details object, but
excludes coordinate type, zodiac type, house system, node type etc.
Chart Title

This shows only the chart placement, chart name and type.
Chart Name

This shows the chart name only, optionally inside a frame.
Chart Placement
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This shows the chart placement (eg. Chart 1, Upper Chart, Across Grid
etc..), optionally inside a frame.
Compliments

This displays the current compliments text, provided that the user has not
chosen to hide compliments text in the Preferences dialog. See page 364.
User Caption Line

This displays up to 20 characters of user-supplied text
Page File Name

This shows the name of the currently displayed page file (without path
name).
Page Description

This shows the description that has been saved with the current page file.
Program

This shows the name of the program – Solar Fire
Version

This shows the program name and current version number.
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Date/Time Stamp

This shows the date and time at which the current page was displayed or
printed.
Copyright

This shows a copyright notice.
Chart Comments

This is a sizable box that displays any chart comments that are currently
stored for the selected chart. If there are no comments stored, then the box
remains empty. If there are more comments then can be fitted into this box
at its selected font size, then the text is truncated accordingly.
Superimposition Option

This displays a caption indicating what type of superimposition option the
user has selected. If no superimposition option has been selected, then it
remains blank. It is intended that this object be placed onto pages with
multi-wheels, so that the user can easily see when the charts in the wheel
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have been superimposed in any way other than the normal zodiacal way. If
this page object is absent, then the user has no way of knowing when a
superimposition option has been selected, and may be mislead. For more
information on the superimposition options, see page 338.

Chart Wheels
Uniwheel

This is a single chart wheel or dial, the style of which is user selectable.
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Biwheel

This is a concentric two-chart wheel or dial, the style of which is user
selectable.
TriWheel

This is a concentric three-chart wheel or dial, the style of which is user
selectable.
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Quadriwheel

This is a concentric four-chart wheel or dial, the style of which is user
selectable.
Traditional Chart

This displays a traditional style chart with triangular houses. Various
options such as glyph sizes, line styles and background colors can be
altered by editing the SQUARE1.WH1 wheel design file. (Note that the
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SQUARE1.WH1 wheel design file appears as a round wheel in the wheel
designer.)
Traditional Chart 2

This displays a traditional style chart with square cardinal houses, and
triangular other houses. Various options such as glyph sizes, line styles and
background colors can be altered by editing the SQUARE1.WH1 wheel
design file. (Note that the SQUARE1.WH1 wheel design file appears as a
round wheel in the wheel designer.)

Aspect Grids
Full Grid
This is a single chart aspect grid, half of which shows longitudinal aspects,
and the other half shows aspects of declination.
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Half Grid
This is a single chart aspect grid showing longitudinal aspects only.

Synastry Grid
This grid shows aspects of longitude between planets in any two charts.
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Planets
Points List – Flexible

This object lists data for each displayed point of a chart. Individual
columns may be switched on or off, and their ordering changed by
choosing the Edit / Flexible List Columns menu item when this object is
selected. The columns available are:
Pt - Point’s glyph or symbol
Abbr - Point’s abbreviation
Name - Point’s full name
Long. - Zodiacal longitude and retrograde symbol
Travel - Daily travel in longitude
Lat. - Zodiacal latitude
R.A. - Right ascension
Decl. - Declination
Azi. - Local azimuth (0 Degrees is North, 90 is East)
Alt. - Local altitude (+ve above horizon, -ve below)
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Sg - Sign placement
Hs - House placement
Rules - Houses ruled by this point
Disp - Dispositor of this point
Hs (Disp) - House placement of dispositor
Modulus - Longitude using specified modulus
NNode - Longitude of point’s north node
NNTrav - Daily travel of north node
SNode - Longitude of point’s north node
SNTrav - Daily travel of north node
Antiscia - Longitude of point’s antiscion
ContraAntiscia - Longitude of point’s contra-antiscion
G.S. - Gauquelin sector of this point (36 sectors)
G+ - Is this point in a Gauquelin plus zone (+ = yes, blank = no)
Orb Ratios - If the current aspect set uses planet or ratios, then this shows
the orb ratio in effect for this point (otherwise it shows “n/a”)
Point’s Long Name – An extra wide column for the name (intended for use
with non-standard points which have longer names such as asteroids,
Arabic Parts, stars and extra ring points, for example)
Point’s Long Abbreviation – A column with enough width for a long
abbreviation – also see comments for long name
Point’s Long Symbol – A column with enough width for multiple symbols
characters – also see comments for long name
Time of Rising, Culmination, Setting, Anti-Culm. – the local time,
expressed in 24 hour format, indicating when the point crosses the local
horizon or meridian. If a point does not cross the horizon during the
day, then it will show times for culmination and anti-culmination, but
not for rising and setting. The rising and setting times are true
astronomical times rather than visual times, having no adjustment for
atmospheric refraction. (Note: The rise and set times in the planetarium
are visual times, and therefore differ slightly from the times given
here.)
Point’s Distance – the distance of the point from the earth (for geocentric
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charts) or the sun (for heliocentric charts), expressed in Astronomical
Units (1 AU = average Earth/Sun distance).
Co-Rise, Co-Culmination, Co-Set and Co-Anticulmination - the ecliptical
longitude that crosses the horizon or meridian at the same time as the
point does. Points that co-rise at the same ecliptical longitude are seen
to rise at the same time, even though they may be at different places
along the horizon, and have different zodiacal longitudes. Points that
share rise, culmination, set or anti-culmination ecliptical longitudes are
said to be in “paran” to one another, which is a type of mundane aspect.
Asteroid List – Flexible
Arabic Parts List – Flexible
Star List – Flexible
Extra Bodies List – Flexible
Ring Points List – Flexible
These all have the same column options as the “Points List – Flexible”
object, shown above. It is recommended that the long name, abbreviation
and symbol columns be used for these object rather than the standard Pt,
Abbr, Name columns, in order to allow for the fact that these items have
longer names than the standard chart points. Also note that not all columns
will contain data when used for these types of points. For example, the Star
List does not show any data in the Point’s Distance column, and shows
zero values in the Travel column.
Nearest Eclipses

This shows a list of eclipses from 6 months before to six months after the
date of the chart, showing whether they are solar or lunar, their type
(partial or total), the date and time at which they occur (in the time zone of
the selected chart), and their zodiacal position.
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Lunar Phases

This shows a list of lunar phases (new moon, 1st quarter, full moon, 3rd
quarter) around the date of the chart. It lists their dates and times (in the
time zone of the selected chart), the zodiacal position of the moon, and also
shows an eclipse glyph if one occurs on that lunar phase. This list is
expandable by changing the number of data lines. The list always contains
at least one phase after the time of the chart, and up to four before the time
of the chart. If the number of data lines is increased to eight or more, then
the phases are split evenly between prior and subsequent lunar phases.

Signs
Sign Names

This object lists the name corresponding to each sign glyph.

Houses
House Cusps

This object lists the zodiacal longitude of each house cusp in the chart.
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House Almutens

This object lists the planets which are the almutens of each house cusp in
the chart, calculated according to the default dignity scores stored in the
file house.alm, which resides in Solar Fire’s system directory.

Aspects
Aspects - Flexible

This object lists data for each aspect within the current aspect set.
Individual columns may be switched on or off, and their ordering changed
by choosing the Edit / Flexible List Columns menu item when this object
is selected. The columns available are:
Asp - Aspect’s glyph
Abbr - Aspect’s abbreviation
Name - Aspect’s full name
Angle - Angle of aspect
Lum-A, Lum-S, Oth-A, Oth-S - Orb’s for luminaries and other planets,
both applying (A) and separating (S).
Hits, Actual Hits - The actual number of aspects of this type found in this
chart, and an equivalent graphical display.
Likely, Likely Hits - The likely number of aspects of this type to found in
this chart, and an equivalent graphical display. This calculation is based
on the assumption of a random distribution of planets in a chart, so
should not be treated as a definitive value - rather as an indicative
value.
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Dev, Deviation - The difference between the actual hits and the likely hits,
expressed as a percentage, and an equivalent graphical display.
Synastry Aspects - Flexible
This is similar to the Aspects - Flexible object, but applies to aspects
between two given charts rather than within a single chart.
Nearest Aspects

This object lists aspects within a single chart in order of closeness of orb.
Aspects will not appear in this list unless their orb is within i) the
maximum orb specified for this object, and ii) the maximum orb allowed
for that aspect in the aspect set which is being used. The total number of
aspects shown is limited to the number of data lines specified for this
object.
Nearest Synastry Aspects
This is similar to the Nearest Aspects object, but applies to aspects
between two given charts rather than within a single chart.
Aspects of Moon

This object lists aspects from the moon to other planets, as well as to sign
boundaries. Aspects are sorted from largest separating orb down to largest
applying orb, which gives an indication of the order in which aspects will
be made by the moon as time progresses. A horizontal line separates the
separating aspects (those that have already occurred) from the applying
aspects, (those that will occur in the future). Aspects between the moon
and other planets will not appear in this list unless their orb is within the
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maximum orb allowed for that aspect in the aspect set which is being used.
The total number of aspects shown is limited to the number of data lines
specified for this object.
Fixed Star Aspects

This object lists aspects made between the planets and fixed stars within a
single chart. Aspects are listed in planetary order, and the aspects and
maximum orbs allowed are set according to the specified aspect set. The
stars used are those contained in the specified star file. If too many aspects
are found, then the font-size is reduced to fit all the required lines of data
into the box. If the font becomes too small to be readable, then you should
either reduce the orbs on the specified aspect set, or select a star file with
less stars in it.
Arabic Part Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects
with Arabic Parts contained in the specified Arabic Parts file.
Asteroid Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects
with asteroids contained in the specified asteroid file.
Body Aspects
This object is similar to the Fixed Stars Aspects object, but find aspects
with bodies contained in the specified extra bodies file.

316 Solar Fire 5: Customizing Solar Fire

Dignities & Ancient
Planetary Sects

This object contains information about the sect of the seven traditional
planets for the current chart. The first column shows the planetary glyph
and its inherent nature. The “Cht” column shows whether the chart is
diurnal or nocturnal (ie. whether the sun is above the horizon or not, and is
therefore the same for all rows in the table). The “Plc” column shows
whether that planet is in a diurnal or nocturnal placement (ie. whether it is
in the same hemisphere as the sun). The “Sgn” column shows whether that
planet is in a diurnal (masculine) or nocturnal (feminine) sign. If the
planet’s inherent nature concurs with chart, placement, and sign, then it has
a dignity know as “In Hayz”. If it s nature opposes all of them, then it is
“Ex Conditione”, which is a form of negative dignity.
Essential Dignities

This object lists the traditional essential dignities for each of the displayed
points in the chart. The scores are normally calculated according to the
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default dignity scores stored in the file essdig.alm, which resides in Solar
Fire’s system directory. Optionally you may select the name of another
dignity scoring file to use instead. The columns contained in this table are
as follows:
Pt - Point’s glyph or symbol
Ruler - Planet which is in rulership at this point’s zodiacal position
Exalt - Planet which is in exaltation “
Trip - Planet which is the triplicity ruler “
Term - Planet which is the term ruler “
Face - Planet which has its face “
Detri - Planet which is in detriment “
Fall - Planet which is in fall “
Score - Total dignity score (an a “p” flag denoting whether this point is in
peregrine)
A plus sign (+) in a column indicates that the point is in its own dignity. A
minus sign (-) indicates that the point is in its own fall or detriment. An
“m” indicates that the point is in mutual reception with another point for
that form of dignity.
Dignity/Almuten scores

This object displays planetary scores for various dignity or almuten
calculations. The scores are normally calculated according to the default
dignity and almutens scores stored in the file general.alm, which resides in
Solar Fire’s system directory. Optionally you may select the name of
another dignity or almuten scoring file to use instead. Each dignity or
almuten definition requires 3 data lines (hence if the dignity definition file
318 Solar Fire 5: Customizing Solar Fire

contains 3 definitions, then 9 data lines are required). The first line displays
a description of the scoring method. The second line displays the list of
planets (highest scoring first, lowest scoring last), and the third lines
displays the numerical score values under each planet.
Planetary Hour/Day

This object shows the planet of the day and hour of the current chart, and
which hour of day or night is current. (These hours are not hours of 60
minutes each, but instead are exact divisions of 12 into the length of time
of day or night.) The bottom two rows indicate how long since the last
planetary hour was in effect, and how long until the next planetary hour
takes effect, and what planets are involved.
Mutual Receptions

This object lists planetary mutual receptions and cross-receptions found
within the current chart. Items are listed in the order Rulership, Exaltation,
Triplicity, Term and Face, but are limited to the number of data lines
specified for this object.
Horary Considerations

This object lists certain pre-defined criteria which are used in evaluating
horary charts. These criteria are i) Moon void of course, ii) Moon in via
combusta, iii) Asc in via combusta, iv) Asc near a sign boundary, v) Saturn
in 7th house or conjunct Descendant v) Moon fast or Moon slow. If none of
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these conditions are present in the chart, then the word “None” appears in
the box.
Firdaria

This object lists the starting dates of planetary periods and the ages of the
individual at each of these dates. The number of planetary periods covered
depends on the number of data lines selected for the object. For example,
44 data lines will cover 64 years from birth, and 60 lines will cover 86
years from birth. There are two variants of this object, one using planetary
periods as they were used by Al Biruni and Schoener, and the other is a
variant of this which places the nodes in a different order for night-time
charts. (The variants give identical results for daytime charts.)
Planetary 36Yr Cycle

This object displays the same information as the Planetary Hour/Day
object, but also indicates the current planetary rulers of a 36 year cycle.
Each 36 year period is ruled by one of the 7 planets from Mars to Neptune,
and each year within that 36 year period is sub-ruled by a planet. The
periods of rulership start on the tropical Aries ingress each year. This 36
year cycle is described in American Astrology Magazine - Year 1940, in an
article by David Anrias (although it is referred to in that article as a 35 year
cycle), and is also alluded to in the title of the book “The Initiate in the
Dark Cycle” by Cyril Scott – Publ. Samuel Weiser Inc. This “Dark Cycle”
is the 36 year period from 1909 to 1945 which was ruled by Mars.
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Arabic Lunar Mansions

This lists, for each displayed point, the number of the Arabic mansion it
occupies (1 to 28), the name of the mansion as given in the Picatrix, the
Arabic name, and the English name.
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Direction of Divisions (Term Directions)

This object lists the starting dates of planetary term periods and the ages of
the individual at each of these dates, according to the primary direction of
the Ascendant of the birth chart by oblique ascension. The number of
planetary periods covered depends on the number of data lines selected for
the object. For example, 15 data lines will cover about 90 years from birth.
The type of terms used (either Ptolemaic or Egyptian) can be chosen by
specifying a dignity file that has the required type of term selected in its
first definition.
Chart Hylegs

This object lists the chart hyleg, and its zodiacal longitude, according to
several differing methods. These methods are defined in detail on page
423.
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Balances
Quadrants

This displays the number of planets in each quadrant and hemisphere of the
chart.
Elements

This displays the balance of elements in the current chart, totaling the
number of planets in each element. If the weighting option is selected, then
the scores are weighted according to Solar Fire’s default point weightings,
and an asterisk appears after the tile on the top line.
Modes

This displays the balance of modes in the current chart, totaling the number
of planets in each mode. If the weighting option is selected, then the scores
are weighted according to Solar Fire’s default point weightings, and an
asterisk appears after the tile on the top line.
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Rays

This displays the balance of rays in the current chart, totaling the number
of planets in each ray’s signs. If the weighting option is selected, then the
scores are weighted according to Solar Fire’s default point weightings, and
an asterisk appears after the tile on the top line.

Graphical
Elements Graph

This display the balance of elements in the current chart, totaling the
number of planets in each element. If the weighting option is selected, then
the scores are weighted according to Solar Fire’s default point weightings,
and an asterisk appears after the tile on the top line.
Modes Graph

This display the balance of modes in the current chart, totaling the number
of planets in each mode. If the weighting option is selected, then the scores
are weighted according to Solar Fire’s default point weightings, and an
asterisk appears after the title on the top line.
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Rays Graph

This displays the balance of rays in the current chart, totaling the number
of planets in each ray’s signs. If the weighting option is selected, then the
scores are weighted according to Solar Fire’s default point weightings, and
an asterisk appears after the tile on the top line.
Modulus Sort Strip

This displays the currently displayed points in a modulus sort strip whose
modulus angle is user-specifiable.
Midpoint Trees

This displays midpoint trees for each displayed point in the chart. You
must specify sufficient data lines to allow room for the midpoint lists. For
example, if there are 14 displayed points, and you want to allow 6 lines in
each midpoint tree (including the top line displaying the root planet), then
you must specify at least 84 data lines. This will only fit onto a page if you
also specify multiple data blocks, such as in the example shown where
there are 5 data blocks.
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User Graphic

This displays any graphic file of your choice (of type *.bmp, *.wmf, .jpg).
It may be sized (and stretched) as desired. Note, however, that a
metafile graphic (.wmf) will not appear on the page if the page is copied
to the clipboard as a metafile (ie. you cannot have a metafile within a
metafile).

Vedic
Vedic Chart (S)

This displays a vedic style chart using the South Indian convention of
square shaped whole-sign houses, with a diagonal line through the house
which contains the ascendant. Note that you would normally use this chart
style to display charts which were cast in a sidereal zodiac rather than the
tropical zodiac.
Vedic Chart (N)
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This displays a vedic style chart using the North Indian convention of
diamond shaped whole-sign houses. Note that you would normally use this
chart style to display charts which were cast in a sidereal zodiac rather than
the tropical zodiac.
Vedic Dasas
This displays a list of Dasas (major planetary periods) and Bhuktis (sub
planetary periods) using the current default sidereal zodiac for the selected
chart. The number of planetary periods covered depends on the number of
data lines selected for the object. For example, 60 data lines will cover
about 100 years from birth.

Selecting and Inserting Page Sizes
A single page design file may contain multiple page sizes to suit a whole
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variety of different display sizes, orientations and types. Selectable display
types are:•

Screens

•

Printers

•

Windows metafiles

•

Each of these display types may have different sizes (ie. differing
numbers of pixels or dots per inch across and down the display). For
example, screens will typically be one of the following sizes:-

•

640 x 480 pixels

•

800 x 600 pixels

•

1024 x 768 pixels

•

1152 x 864 pixels

•

1280 x 1024 pixels

Printers have sizes which depend on the physical measurements of the
paper onto which they are printing in combination with the resolution of
the printer (eg. A4 page at 300dpi resolution is approximately 2357 x 3407
pixels when in portrait orientation).
Windows metafiles have only nominal sizes, because they can be resized to
virtually any size once they are pasted into another program. However, the
ratio of horizontal to vertical pixels in the user defined size still determines
the base shape of the page, so adding a user-defined page size of 3000 x
6000 pixels would result in a page shape which is twice as high as it is
wide. Solar Fire always looks for the largest page size available when you
are copying a page to the clipboard as a metafile, so if you want to create a
user-defined page size which will be used for metafiles, then you must
ensure that its pixels dimensions are larger than any other page sizes in
your page design file.
For most users who design a new page, it will be adequate to create just a
single page size ie. the screen page size which matches your current screen
display size. In this case Solar Fire will still be able to display the page on
any display type and size, but will have to make automatic adjustments to
match different page types and sizes as best it can. These adjustments may
involve resizing objects to fit the new page dimensions, and altering
displayed fonts and font sizes in order to fit the text inside the resized
objects. In many cases these automatic adjustments will work well enough
to avoid the need for you to create designs for each page size that you use.
However, cases in which the automatic adjustments may not give the best
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possible appearance might be:If you design a page for one screen or printer page size and then display it
on a screen or printer page with a significantly different aspect ratio
(height to width ratio).
If you design an object which uses a small font size and then display it on a
smaller page size.
You will also need to add extra page sizes to the design in the following
circumstances:If you wish to make what appears on the printer different from what
appears on the screen (for example to add compliments text which
doesn’t appear on the screen display, or to increase the size of
tabulations which are too limited on the screen display)
If you wish to make what appears in a metafile (copied to the clipboard)
different from what appears on the screen or printer (for example to
remove chart text captions when you intend to add your own captions
in another program)
Also, you may wish to add extra page sizes to the design in order to
improve the display quality in the following circumstances:If you intend your page design to be used by other users who may have
different display resolutions
If you want your printed output to be laid out differently from the screen
If you intend to print your page on a variety of different page sizes or
orientations
Note:- If you do decide to add new page sizes, then it is strongly
recommended that you only do so after inserting all the required objects
onto the original page size. The reason for this is that when you add a new
page size, all the objects on the currently displayed page size are copied
into the new page size. If you have not inserted all the required objects
beforehand, then you will have to insert the same new objects onto each
new page separately afterwards.
W

To select a page size to edit

Click on the required page size in the list of existing page sizes. The new
page size will be displayed immediately, and you may edit objects on the
page.
When you start up the page designer, it will automatically select the page
size which corresponds to your current screen size (if there is a page of this
Chapter 40: Editing a Page Design File 329

size in the current page design file - otherwise it will select the first page
size on the list).
W

To add a new page size

1. Before adding a new page size, make sure that you have first selected
the existing page size that you wish to base the new page size on. All
objects on the currently displayed page will be copied onto the new
page.
2. Choose the New Page Size... menu item under the Insert menu of the
Page Designer. This will bring up the “Select Page Size” dialog, from
which you can select or create any required page size. If you are adding
a new screen size, then click on one of the Screen page sizes at the top
of the list. If you want to add a new Printer page, then click on the
Printer option, and then on the Printer Setup... button. This will allow
you to choose the paper type, orientation and resolution of the new
page size. If you want to add a page for copying to metafile, or for any
other screen or printer size which is not otherwise selectable, then click
on the User Defined option and enter the required Width and Height in
pixels.
Note: that you cannot add another page with the same size as an existing
page. If you attempt to do this, then the Page Designer will simply revert to
displaying the existing page of that size.

Editing the Page Description
The page description consists of up to 80 characters of text, the purpose of
which is to describe the page design. Each page design file contains a
single description which is displayed in Solar Fire’s file manager when it
displays list of page design files. Therefore, if you ensure that your page
design has a clear description, it is much easier to find the page design file
that you want, when you wish to select it for display.
W

To edit the page description

Choose the Page Description... menu item under the Edit menu of the
Page designer. This will highlight the text at the top of the page ready for
editing. Any changes that you make are automatically saved when you next
save the page design.
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Saving Files and Exiting
W

To save changes to a page design

Choose the Save menu item under the File menu. This will save any changes that
you have made since the file was last saved.
W

To save the page design to a new file name

Choose the Save As... menu item under the File menu. This will display a
standard Save File dialog into which you may enter a new name. Note that page
design files must be saved under a name with the file extension .pag, and must
reside in Solar Fire’s USERDATA directory in order to be accessed from within
Solar Fire.
W

Exiting from the page designer

Choose the Exit option from the File menu. If you have made any changes to the
current page design, then you will be prompted whether or not to save the
changes before the page designer closes down.
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Customizing Solar Fire

Chapter 41: Changing Chart Options
It is possible to alter any of the following items that relate to the manner in
which charts and reports are calculated and displayed.
•

Chart points displayed

•

Current chart’s displayed points

•

Points included in an extra wheel ring

•

Aspects used and their orbs

•

Chart points which have aspects drawn to them

•

Fixed Star file, Arabic Parts file, Asteroids file and Extra Ring Points
file

•

Style of displayed chart wheels

•

Style of displayed chart dials

•

Selection of whether to display houses proportionally

•

Application of house cusps adjustment when houses are over-full

•

Selection of whether aspect lines appear in displayed charts

•

Selection of whether aspect glyphs appear in displayed charts

•

Colors used for chart points, aspects, zodiac signs and as backgrounds

•

Special chart superimposition options when displaying multi-wheels

•

Fonts used for screen displays and printouts

The selection of each of these is described in detail in the following
sections. It is possible to save any of these selections so that they will be
used automatically when the program is next started up. See page 348 for
instructions on how to do this.

Displayed Points
Displayed points are the planets, asteroids and other points which appear
on a displayed chart or synastry grid or in any report.
A set of displayed points is a named file containing a list of which points
are switched on and which are switched off.
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The name of the currently selected set of displayed points is shown in the
information box on the main screen of the program.
When the program is first installed, there are a variety of named displayed
point sets which may be selected. It is possible to alter which points are
displayed by selecting an alternative set of displayed points, or by editing
an existing one or creating a new one.
W

To alter the displayed point set, from the main screen

1. Choose the Displayed Points... option from the Chart Options menu
2. Then follow the instruction relating to displayed points on page 211.

Current Chart’s Displayed Points
It is possible to select a set of displayed points which will be used only
with the currently selected chart. This is useful, for example, when you
wish to display a chart of the current transits in a biwheel with a natal
chart. In this case, you might prefer the transits chart to display only the
outer planets, because the inner planets and chart angles move so quickly
as to be of much lesser importance.
W

To alter the current chart’s displayed point set, from the main screen

1. Select the chart that you wish to use from the list of Calculated Charts
2. Choose the Current Chart’s Displayed Points... option from the
Chart Options menu
3. Then follow the instruction relating to displayed points on page 211.
Whenever this chart is subsequently displayed, it will always contain the
newly selected displayed points instead of the current set of displayed
points which are used in all other cases.
If you wish to reset the displayed points for this chart to be the current set
of displayed points again, then you must re-use this option to select
whichever set of displayed points is the current set.

Extra Ring Points
Extra Ring Points is a selection of points or bodies of various types that
can be displayed in a special chart wheel which includes an extra ring in
addition to the normal ring which displays the standard chart points.
The types of extra points that can be selected are standard chart points,
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midpoints, fixed zodiacal positions, fixed stars and astronomical objects,
Arabic parts, asteroids, bodies calculated from orbital elements, prior lunar
phase and eclipse points.
When the program is first installed, there are a variety of named extra ring
point sets which may be selected. It is possible to alter these selections by
editing an existing set or creating a new one.
W

To alter the extra ring points set, from the main screen

1. Choose the Extra Ring Points... option from the Chart Options menu
2. Then follow the instruction relating to extra ring points on page 230.

Aspect Set
Aspect sets are named files containing a list of which aspects are switched
on and off and what orbs each aspect has. The aspect set controls which
aspects are displayed on charts or synastry grids and in any reports. It is
also used when any dynamic transits or progressions report is created.
The name of the currently selected aspect set is shown in the information
box on the main screen of the program.
When the program is first installed, there are a variety of named aspect sets
which may be selected. It is possible to alter which aspects are displayed
and their orbs by selecting an alternative aspect set, or by editing an
existing one or creating a new one.
W

To alter the aspect set, from the main screen

3. Choose the Aspect Set... option from the Chart Options menu
4. Then follow the instruction relating to aspect sets on page 211.

Aspected Points
Aspected points are the planets, asteroids and other points to which aspects
are drawn on a displayed chart.
A set of aspected points is a named file containing a list of which points
are switched on and which are switched off.
It is possible for an aspected point set to be different from a displayed point
set. In this case the displayed chart will not have aspects drawn between
every chart point. This is useful in order to switch off aspects to the
Ascendant and Midheaven, for example, when they are still required to be
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displayed in the chart.
The name of the currently selected set of aspected points is shown in the
information box on the main screen of the program.
When the program is first installed, there are a variety of named aspected
point sets which may be selected. It is possible to alter which points are
aspected by selecting an alternative set of aspected points, or by editing an
existing one or creating a new one.
W

To alter the aspected point set, from the main screen

1. Choose the Aspected Points... option from the Chart Options menu
2. Then follow the instructions relating to aspected points on page 211.

Files
This menu option allows you to select any of four different types of files to
use as the default, or to edit or browse their contents. These file types are
as follows.
•

Fixed Stars – files containing selections of fixed stars or other
astronomical objects

•

Arabic Parts – files containing lists of Arabic part definitions

•

Asteroids – files containing lists of asteroids

•

Extra Bodies – files containing orbital elements for various bodies

See page 211 for more details on how to select, edit and use these file
types.

Wheel Styles and Dial Styles
It is possible to select from a range of available chart and dial styles to be
used whenever Solar Fire displays or prints charts. Solar Fire comes
supplied with several different pre-defined chart styles, and it is also
possible to create your own designs with the separate Wheel Designer
program. The most common types of wheel styles which you might like to
use are the Anglo/American style, European Style and French style.
You can select any available pre-defined style for use with single chart
displays, bi-chart displays, tri-chart displays, quadri-chart displays, and
small wheel displays (which includes dual wheels on a page and wheel and
grid on the same page).
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W

To select a particular style of display for all subsequent wheel or dial
display and printing

1. Click on the Wheel Styles or Dial Styles button, or choose the required
chart combination option from the Wheel Styles or Dial Styles option
of the Chart Options menu
2. Then follow the instruction relating to wheel and dial styles on page
211.
Once a particular style is selected, all subsequent displays of that chart
combination type will use that selected style. For example, if you select a
“French” style for biwheel chart combinations, then all subsequent biwheel
displays will use the “French” style.

Proportional Houses
Most house systems, apart from equal house systems, have houses which
vary in size. In some cases, especially at high latitudes, there can be a
considerable "distortion" so that a couple of house are very narrow, whilst
others are very wide. It is possible to display Solar Fire charts either with
equal-sized (non-proportional) houses, or with proportional houses.
However, when displaying a chart using a wheel style which contains a
zodiac ring (such as a French or European style), then this option is
automatically overridden, as in this case the house cusps must always
maintain their positions in relation to the zodiac ring. When a chart is
displayed with non-proportional houses, the planets will not be drawn in
their correct geometrical positions. Instead they will be moved, wherever
possible, to fall within the correct house cusps. Also, in this case, the tick
marks on the inside rim of any single wheel display will also be moved to
correspond to the displayed position of the planet. Therefore, when
displaying non-proportional charts, it is advisable to either switch on the
House Expansion option, or to carefully check whether planets are in their
correct houses by looking at their angles, as this will not necessarily be
obvious from their plotted positions. Generally, this problem does not
occur if the chart is drawn with proportional houses, as the tick marks will
clearly show exactly where each planet is in relation to the house cusps,
even if the planet symbol is not in its correct house.
W

To alter the current Proportional Houses setting, from the main screen

Choose the Proportional Houses option from the Display Options
submenu of Chart Options menu. This will switch on the option if it is
currently off, or switch it off if it is currently on. When this option is
switched on, a tick appears to the left of this item on the menu.
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Once this setting is altered, any chart or grid subsequently displayed on the
screen will be affected. To alter the house display on a chart which has
already been displayed previously, the ReDraw button must be selected
from the "Chart View" screen before the change will come into effect.

House Expansion
A chart may sometimes have many planets or other chart points in a single
house. In this case, when you view the chart you may find that some of
these points spill over into adjacent houses. If this happens, you can switch
this option on to prevent this from happening. When switched on, this
option will cause any over-full houses to be expanded to accommodate all
the required points, so that it is clear in which house they reside.
W

To change the current house expansion setting, from the main screen

Choose the House Expansion option from the Display Options submenu
of the Chart Options menu
This will switch on the option if it is currently off, or switch it off if it is
currently on. When the house expansion option is switched on, a tick
appears to the left of this item on the menu.
Once this setting is altered, any chart subsequently displayed on the screen
or printed will be affected. To alter this option on a chart which has already
been displayed on the screen previously, the ReDraw button must be
selected from the "Chart View" screen before the change will come into
effect.

Aspect Lines
Any single-wheel chart which you view on the screen or print may
optionally display aspect lines inside the central ring of the chart.
W

To alter the Aspect Lines setting, from the main screen

Choose the Aspect Lines option from the Display Options submenu of the
Chart Options menu
This will switch on the option if it is currently off, or switch it off if it is
currently on.
Once this setting is altered, any single-wheel chart subsequently displayed
on the screen or printed will be affected. To alter this option on a chart
which has already been displayed on the screen previously, the ReDraw
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button must be selected from the "Chart View" screen before the change
will come into effect.

Aspect Glyphs
Any single-wheel chart which you view on the screen or print may
optionally display aspect lines inside the central ring of the chart. When
they are displayed (ie. when the Aspect Lines option is on), it is also
possible to choose whether or not to show the aspect glyphs in the middle
of each aspect line.
W

To alter the Aspect Glyphs setting, from the main screen

Choose the Aspect Glyphs option from the Display Options submenu of
the Chart Options menu. This will switch on the option if it is currently
off, or switch it off if it is currently on.
Once this setting is altered, any single-wheel chart subsequently displayed
on the screen or printed will be affected. To alter this option on a chart
which has already been displayed on the screen previously, the ReDraw
button must be selected from the "Chart View" screen before the change
will come into effect.

Multiwheel Superimposition
This is a special option that determines the manner in which charts are
aligned with one another (ie. superimposed). The usual manner of
superimposition is “zodiacal”, meaning that when charts are displayed in a
biwheel, for example, 0 Aries in one chart is aligned with 0 Aries in the
other chart. This method is the one used in almost all astrological books
and publications.
However, it is also possible to align charts by other methods, for example
according to their house cusps, or according to the position of points within
the charts. Some further information can be found at
http://www.astronova.nu/.
The options available are
•

Zodiacal (Normal) – This is the default option when the program is
first installed, and should always be selected unless you specifically
wish to use non-standard superimposition methods.

•

By Sign of Selected Point – This will align 0 degrees of the sign of
the selected point in one chart with 0 degrees of the sign of the same
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point in the base chart. In this case the superimposition adjustment
will always be an exact factor of 30 degrees.
•

By Exact Position of Selected Point – This will align the exact
zodiacal position of a point with its exact position in the base chart.
In this case the superimposition adjustment can be any angle.

The last two options require a specific chart point to be selected. For
example, if the “Exact Position of Selected Point” option is selected, then
the selected superimposition point might be set to Ascendant. In this case,
when a biwheel is displayed, the outer chart will have its ascendant aligned
exactly to the ascendant of the inner chart, so that the houses of each chart
coincide with one another.
This option never affects a single chart on its own – it only affects
multiwheels, reports or page objects that show chart inter-relationships.
Specifically, the items affected are:
Biwheels – The outer chart is adjusted. The inner chart remains fixed.
Triwheels - The two outer charts are adjusted. The inner chart remains
fixed.
Quadriwheels - The three outer charts are adjusted. The inner chart remains
fixed.
Synastry aspects – Chart B is adjusted. Chart A remains fixed.
Further options are as follows.
Use Radix Point in Subsidiary Charts – This option only affects
subsidiary charts (such as progressed charts) that are superimposed onto
other base charts. In this case it is possible to superimpose the charts by
aligning the subsidiary (progressed) point with the base chart, or
alternatively by aligning the radix position of the selected point of the
progressed chart. For example, if we view John’s progressed chart in a
biwheel around Susan’s natal chart, and we have selected to superimpose
by exact position of ascendant, then, when this option is switched off,
John’s progressed ascendant will be aligned to Susan’s natal ascendant.
However, when this option is switched on, John’s natal (radix) ascendant
will be aligned to Susan’s natal ascendant, instead.
Display Superimposed Positions – This option determines whether the
planets and zodiac of the superimposed chart retained their original
zodiacal positions in the wheel or reports, as opposed to the entire chart
being shifted in the zodiac to appear as if it was aligned with the zodiac of
the base chart. For example, if we view John’s natal chart in a biwheel
around Susan’s natal chart, and we have selected to superimpose by exact
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position of ascendant, then, when this option is switched off, John’s
ascendant will be notated with its original (un-superimposed) zodiacal
position, and the zodiac of the outer chart will be shown as offset from that
of the inner chart. However, when this option is switched on, John’s
ascendant will be notated with its superimposed position (i.e. identical to
Susan’s ascendant position), and the zodiac of the outer chart will appear
to align exactly with the zodiac on the inner chart. The purpose of this
option is to allow inter-chart aspects to be seen much more readily than
would otherwise be the case.
Note: Using these options can cause much confusion if you are not familiar
with the concept of superimposition. After use, please remember to switch
this option back to Zodiacal (Normal) in order to avoid the likelihood of
mistaking a superimposed zodiac with an erroneously calculated chart!

Color Schemes
A “color scheme” is a set of color selections for aspects, chart points, sign
glyphs, sign fills as well as a background color or graphic which is
displayed on the chart viewing screen.
You can select existing color schemes or create and save your own
schemes. The name of the currently selected color scheme for both screen
and printer is shown in the information box on the main screen of the
program.
W

To select, edit or create a color scheme

Choose Color Scheme… from the Chart Options menu
This will display the color scheme selection dialog.
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The elements in this dialog are as follows.
•

Screen Colors / Printer Colors – You can assign different color
selections to be used for the screen and the printer. This is useful, for
example, if you wish to print in monochrome even though you have a
color printer, or if you want the colors on the printer to be darker
than the colors on the screen to make them more legible on a white
page. This is especially useful if you have selected a dark
background color for the screen, but still wish to print onto white
paper. In this case you can choose light colors to contrast well with
the screen background, and dark colors to contrast well with the
printed white page. Note that any colors you select apply only to
either the Screen or the Printer, depending on which option is
selected. Thus, when you change screen colors, the colors that appear
on the printer will remain unchanged unless you also change the
printer colors.

•

Scheme Name – When this program is first installed, there are a
number of predefined color schemes that can be selected from this
drop-down list box. Selecting a named scheme from this list will
result in the subsequent items on this dialog being updated to reflect
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all the color selections stored in that selection. If you have made
changes to any color selections, then you can save the new color
scheme by clicking on the Save As… button and specifying a name
for the scheme. If you specify an existing scheme name, then that
scheme will simply be replaced with your new scheme. You can also
delete any named scheme by first selecting it from the list, and then
clicking on the Delete button. Note that the list of scheme names is
different for screen and printers.
•

Aspect Colors - Aspect colors are the colors in which aspect
symbols and aspect lines will appear in any displayed chart or grid. A
set of aspect colors is a named file containing a list of which color is
assigned to each aspect. When the program is first installed, there are
a variety of named aspect colors sets which may be selected. It is
possible to alter the colors in which aspects are displayed by
selecting an alternative set of aspect colors, or by editing an existing
one or creating a new one. To alter the aspect colors set, click on the
box containing the name of the current aspect colors, and then follow
the instruction relating to aspect colors on page 211.

•

Point Colors - Point colors are the colors in which planets, asteroids
and other points will appear in any displayed chart or grid. A set of
point colors is a named file containing a list of which color is
assigned to each point. When the program is first installed, there are
a variety of named point colors sets which may be selected. It is
possible to alter the colors in which points are displayed by selecting
an alternative set of point colors, or by editing an existing one or
creating a new one. To alter the point colors selection, click on the
box containing the name of the current point colors, and then follow
the instruction relating to point colors on page 211.

•

Sign Text Colors - Sign text colors are the colors in which zodiac
sign glyphs will appear in any displayed chart. A set of sign colors is
a named file containing a list of which color is assigned to each sign.
When the program is first installed, there are a variety of named sign
colors sets which may be selected. It is possible to alter the colors in
which signs are displayed by selecting an alternative set of sign
colors, or by editing an existing one or creating a new one. To alter
the sign colors set, click on the box containing the name of the
current sign text colors, and then follow the instruction relating to
sign colors on page 211. Usually you will want to choose colors
which contrast well with the background color or graphic eg. if the
background is white, then dark sign colors will be most legible.

•

Sign Fill Colors - Sign fill colors are the colors in which zodiac
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signs in chart zodiac rings will appear in any displayed chart. A set
of sign colors is a named file containing a list of which color is
assigned to each sign. When the program is first installed, there are a
variety of named sign colors sets which may be selected. It is
possible to alter the colors in which signs are displayed by selecting
an alternative set of sign colors, or by editing an existing one or
creating a new one. To alter the sign colors set, click on the box
containing the name of the current sign text colors, and then follow
the instruction relating to sign colors on page 211. Usually you will
want to choose colors which blend well with the background color or
graphic eg. if the background is white, then light sign text colors will
be most appealing.
•

Background Color – The background color of the Chart View
screen may be set with this option. You can select any color, but
usually it is best to choose either a fairly light color or a fairly dark
color. If you choose a moderately light or dark color, then you may
have difficulty viewing aspects, points and wheels on the page. This
option determines whether charts and page objects are drawn with
dark (black) outlines or light (white) outlines. When you choose a
light color, charts are drawn with dark lines, and when you choose a
dark color, charts are drawn with light lines, in order to maximize the
visibility of the displayed items. Note that if you choose a dark
background graphic, then it will be necessary also to choose a dark
background color to ensure that the chart is drawn with light lines.

•

Background Graphic – You can select any graphic of type *.jpg,
*.wmf, *.gif, from any location, to display as the background to the
Chart View screen. Ideally you should choose a graphic which does
not have large contrasts in color, to avoid the possibility of making
the charts or page objects difficult to see. If you choose a dark
graphic then you will also need to select a dark (eg. black)
background color to ensure that the page objects are drawn with light
colored lines. Similarly, if you choose a light graphic then you will
also need to select a light (eg. white) background color to ensure that
the page objects are drawn with dark colored lines. You have the
option to stretch the graphic to fit the size of the display, or to tile it,
in which case the graphic is repeated as many times as needed to fit
the full display area. You can clear any graphic selection by clicking
on the Clear button.

Note: If you use a background graphic, then you may notice that some
chart wheels are displayed transparently, so that the graphic shows
through them, and some are opaque, so that the background graphic is not
visible inside them. This behavior depends on whether the rings within
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the wheel have been designed to be transparent or to have a fill color.
You can alter any wheel design to make it transparent or opaque by
setting the its ring fill color option in the wheel designer. See page 267
for further information.

Color Depth
Solar Fire can be used on any computer which is capable of displaying at
least 16 colors or grayscales on the screen. However, it can also take
advantage of displays with 256 colors or greater color depths known as
“HiColor” and “TrueColor”, and in this case you will be able to generate
more attractive displays. In most cases, whenever you select a color from
one of Solar Fire’s color selection options (eg. sign colors, aspect colors,
planet colors etc.), the color which is actually displayed on the screen will
be whichever of the available colors matches your selected color most
closely. If your display supports only 16 colors, then you may find that
some of the displayed colors are very different from your original
selections. With 256 color, the discrepancies are normally less noticeable,
but may still be quite significant in some cases. If you are using HiColor or
TrueColor, then you will find that the displayed colors match your original
selections very well.
If you have a 16 color display, then those 16 colors are preset by Windows,
and cannot be altered. However, if you have a 256 color display, then Solar
Fire allows you to choose from three different palettes (color ranges) in
order to help you most closely match the colors that you have chosen. This
option is unavailable for 16 color displays, and unnecessary for display
with greater color depths, so the associated option is grayed out unless you
are currently using a 256 color display. The color palettes which are
available for displays with 256 colors are as follows.
Bright Colors - A selection of colors which are at the brighter end of the
scale
Pastel Color - A selection of colors which are softer in tone
Rainbow Colors - A selection of colors which covers a wide range of
tones
If you are viewing a chart, you will need to click on the ReDraw button to
see the effect of the new palette.
Note: Changing the color palette does not change your original color
selection, it only affects how your color selection is currently displayed.
For example, if you choose the color orange for a planet, then displaying it
with the Pastel Colors palette shows it as a browny color, because that is
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the closest match to orange in that palette. However, if you then switch to
the Bright Colors palette and redraw the chart, it is displayed as orange,
because an orange color is included in that palette.

Changing the number of colors your monitor can
display
Most modern computer displays allow you to select how many colors they
will display, so if you are currently displaying only 16 or 256 colors, then
you can probably alter your display settings to allow more colors to be
displayed.
Warning: It is not recommended that you try the following unless you are
proficient in the use of Windows, and able to deal with potential problems
caused by changing the display driver. For further assistance, you should
contact your computer dealer, or a qualified Windows instructor.
W

To select a greater color depth for your display

Exit from Solar Fire
From the Control Panel, select the Display icon
Click on the Settings Tab
Select a color setting from the Color Palette drop-down box
Note: If you do not exit from Solar Fire before changing color depth, then
some colors may be displayed incorrectly. If so, you should exit from Solar
Fire and then start it up again. This will clear the problem.

Fonts
It is possible to choose which text font style you wish to use on chart
captions displayed on the screen, as well as another text font style for any
charts and reports which are printed on your printer. You can also select a
base font size for printed reports and tabulations.
When the Solar Fire program is first installed on you computer, it sets your
screen font as "ET Sans Serif" and your printer font as "ET Astro".
However, you are free to select alternative fonts if you so wish. If you
select any other fonts, then Solar Fire will use your selected font for
displaying any normal text, but will continue to use the astrological fonts
when displaying any astrological symbols.
These two fonts contain all the astrological symbols which are needed by
the program, without which you will not be able to display charts and
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reports with astrological symbols. Therefore you must not delete them
from your computer. If, for any reason, these fonts are removed, then Solar
Fire will display spurious symbols instead of the correct astrological
symbols.
It is sometimes possible, after you have changed your display driver
resolution or color depth, that Windows will have unloaded all the
available fonts. If Windows does not have any fonts loaded then the
program will display an error dialog box upon startup, asking you to load
some fonts. In this case you will need to use the Windows Control Panel to
reload the fonts in your WINDOWS\SYSTEM directory. Please refer to
your Windows manual for further instructions on how to load fonts.
W

To examine or alter the existing font selections

Choose the Fonts... option from the Chart Options menu. This will
display the "Font Selection" screen, which allows the selection of any
available font for your printer or screen.
Font Selection Dialog Box

When this screen is first displayed, the current font selections will be
highlighted in each of the list boxes.
W

To change a font selection

Select a font name from either list box.
An example of text in the selected font is shown in the display boxes below
each list. Some printer fonts cannot be displayed on the screen, in which
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case the display box will contain a message to this effect.
W

To alter the base font size used for printing reports, time maps and
graphic ephemerides

Select a font size from the drop-down list.
Note: This base font size does not affect printed charts or user defined
pages, as these use font sizes which vary according to user-defined font
size selections in the wheel and page designs, and also on the size of the
displayed page.
W

To activate the new font selections

Click on the Select button.
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Chapter 42: Changing Preferences
It is possible to perform any of the following actions from the Preferences
menu
Editing current settings
Save all the current settings
Restore the previously saved settings
Switch on or off an option to save settings automatically upon exit
Edit the toolbar buttons
Switch on or off various panels on the main screen
The selection of each of these is described in detail in the following
sections. It is possible to save any of the switchable preferences so that
they take effect automatically when the program is next started up by using
the Save Settings option.

Saving and Restoring Settings
Whenever the program is started up, all current settings are read in from
the SOLFIRE5.INI file, which resides in the Windows directory of your
computer. The program's settings may be saved or restored at any time.
Whenever the settings are saved, the SOLFIRE5.INI file is updated, so that
these will be retained for use next time the program is started up.
These settings include such things as chart calculation options,
compliments text, date entry and display options, atlas type selection,
email options etc.
Some additional items are also stored in the SOLFIRE5.INI file, but these
are stored automatically whenever they are changed, and do not depend on
the user selecting a save option. These include things like the default place,
report screen’s modulus and orb, the dynamic report entry screen’s
selection, the dynamic report sort order etc.
W

To save all the current settings in the program

Choose the Save Settings... option from the Preferences menu. This will
display a dialog box asking you to confirm whether or not you wish to
overwrite the previously stored selections. Selecting the Cancel button will
prevent any action from being taken. Selecting the OK button will save the
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current settings.
W

To restore all the previously saved settings in the program

Choose the Restore Settings... option from the Preferences menu. This
will display a dialog box asking you to confirm whether or not you wish to
overwrite the current selections. Selecting the Cancel button will prevent
any action from being taken. Selecting the OK button will restore the
previously saved settings and make them the current settings.
Note that it is not possible to save or restore settings individually - all
settings are saved or restored together.

Save Settings on Exit
It is possible to ensure that any alteration made to settings and defaults
(described above) are saved automatically whenever the user exits from the
program.
W

To switch the Save Settings on Exit option on or off

Choose the Save Settings on Exit option from the Preferences menu. This
will switch on the option if it is currently off, or switch it off if it is
currently on. When the save on exit option is switched on, a tick appears to
the left of this item on the menu. If there is no tick then it is currently
switched off.

Editing Settings
Choose the Edit Settings… option from the Preferences menu. This will
display the Preferences dialog with various tabbed panels grouping the
available options into various topics.

Calculations
Lunar Node Type
The lunar node is one of the chart points which may be displayed
in any chart or grid. It is possible to select the lunar node as either the true
node or the mean node.
•

True Node - is the real position of the moon's node at any time.

•

Mean Node - is the position of the moon's node according to a
mathematical formula which ignores many of the minor
perturbations in its orbit.
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Any chart display or report indicates which type of lunar node has been
used during its calculation. The lunar node type is not saved with a chart it is only applied when a chart is being calculated.
Part of Fortune Type
The way in which the Part of Fortune, as displayed in charts, is calculated
may be selected by the user. The options are as follows.
Different Day/Night - According to researchers of ancient astrological
texts, the correct method of calculating the Part of Fortune is to use
Asc+Moon-Sun for daytime charts, and Asc+Sun-Moon for nighttime
charts.
Fixed Formula – (Daytime Only) Many astrological programs in the past
(including earlier versions of Solar Fire) have used a calculation for the
Part of Fortune which is based on a single formula for both day and
night charts ie. Asc+Moon-Sun. Although this is now thought to be
incorrect, many astrologers have become accustomed to using it in this
way, so this option is included for their convenience.
Any charts subsequently opened or calculated will use the newly selected
calculation type.
Note that this option affects the position of the Part of Fortune as shown in
charts and all reports with the exception of the Arabic Parts report of Solar
Fire. If you wish to alter the calculation of the Part of Fortune in the Arabic
Parts report, then you must use the Arabic Parts Editor.
Optional Correction Factors
Apply Geocentric Correction to Latitude
It is possible to calculate charts based either on geographic (also known as
geodetic) latitude or geocentric latitude.
Atlases such as the ACS International Atlas, the ACS American Atlas and
Solar Fire’s own place databases, contain geographic latitudes. Geographic
latitudes are based on the measurement of the angle of the local horizon
(also known as the geodetic horizon) onto the celestial sphere. It is
assumed that all latitudes entered into Solar Fire are geographic latitudes,
and all displayed latitudes, such as in chart details text, are geographic
latitudes.
However, because the earth is not perfectly spherical it is also possible to
define a latitude based on where the horizon would be if the earth was a
perfect sphere, which also corresponds to the angle of a line from that
location to the center of the earth. This is known as a geocentric latitude.
The geocentric latitude is never more than 12 minutes of a degree different
from the geographic latitude.
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There are arguments for and against using each of these types of latitude.
Astrologers are divided about which is the most appropriate to use.
Solar Fire always displays latitudes as a geographic latitudes. However,
when this option is on, any chart calculations performed will have a
correction applied to the latitude to convert it from geographic to
geocentric. Any chart that has had this correction applied will have a “G”
appended to its latitude. For example, a geographic latitude of 34°S55’ is
displayed as 34°S55’G when this option is on.
In order to determine exactly what the geocentric correction is, you must
view a “Chart Analysis” report for the chart. If the geocentric correction
has been applied, then this will be specified in the report, and the corrected
geocentric latitude will shown as well as the originally entered geographic
latitude.
Any charts opened or calculated, or dynamic reports generated are
calculated according to the current setting of this option.
Apply Parallax Correction to Moon
Traditionally, the planet’s positions are calculated as if they were observed
from the center of earth (hence “geocentric”). However, as the moon is
much closer to the earth than the other planets, certain geometrical effects
come into play that are negligible for the other planets. In particular, due to
the moon’s proximity to the earth, it appears to be in a slightly different
zodiacal position depending on where on earth it is observed from. This
effect is known as lunar parallax (or also as a “topocentric” coordinate
system).
Typically, this can make a difference to the moon’s longitude of the order
of 1 degree. Thus, if the moon is near the end of a sign, applying this
correction can actually put the moon into the next sign in same cases.
Any charts opened or calculated, or dynamic reports generated are
calculated according to the current setting of this option. When this option
is switched on for a particular chart, the chart details text has an additional
line indicating that the parallax correction has been made.
Note that, although the altitude of the observer also makes a small
difference to the parallax calculation, it is negligible in comparison with
the observer’s location, so is ignored by Solar Fire. For example, an
altitude of 3000 meters makes a maximum difference of only 2 to 3
seconds of arc in the moon’s position, and it is usually less than this.
Vulcan Calculation
As Vulcan is a hypothetical planet, there is no officially accepted
ephemeris for the calculation of its position. However, two of the more
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widely used methods of calculating its position have been included in Solar
Fire, and it is possible to choose which of these methods you would like to
be used whenever Vulcan’s position is calculated. The possible methods
are
L.H.Weston - Professor Weston produced a set of orbital parameters for
Vulcan based on a number of supposed sightings during last century
and early this century. This proposed orbit has Vulcan orbiting the Sun
once every 19.5 days, and having a maximum orb of about 8° from the
Sun, as observed from the earth. The complete theory is published in
the booklet “The Planet Vulcan”, published by the American
Federation of Astrologers, Inc. Some doubt has been cast on the
correspondence of this proposed orbit with the observations on which it
is based, but no alternative has yet been proposed.
D.Baker - Dr. Baker has documented a theory for Vulcan based on a
quantum mechanical type of behavior. Vulcan is positioned 3° from
Mercury in the direction of the Sun. If Mercury is within 3° of the Sun,
then Vulcan is conjunct the Sun. It is always on the same side of the
Sun as Mercury. The full rationale behind this concept is explained in
his Dictionary of Astrology.
When this option is changed, any charts that are subsequently opened or
calculated will use the newly selected calculation method, but charts that
have already been calculated retain the option that was in effect when they
were calculated.
Ray Weightings
The Rays are the seven primary energetic influences proposed and
described in various works relating to esoteric astrology and philosophy.
Each sign is considered to be influenced by a subset of rays, and possibly
in varying proportions. Two of the most commonly used schemes for
assigning weightings to the rays influencing each sign are provided as
options.
•

Equal – This scheme is based directly on tabulations in the book
“Esoteric Astrology” by Alice A. Bailey, and assumes that each
ray influencing a sign does so in equal proportion.

•

D.Baker – This scheme is based on the works of Dr. Douglas
Baker, and assumes that the rays influence each sign
disproportionately.
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Sign

Equal

D.Baker

Aries

1 = 50%; 7 = 50%

1 = 40%; 7 = 40%; 6 = 20%

Taurus

4 = 100%

4 = 70%; 1 = 20%; 5 = 10%

Gemini

2 = 100%

2 = 80%; 4 = 10%; 3 = 10%

Cancer

3 = 50%; 7 = 50%

3 = 40%; 7 = 40%; 6 = 20%

Leo

1 = 50%, 5 = 50%

1 = 40%; 5 = 30%; 2 = 30%

Virgo

2 = 50%; 6 = 50%

6 = 60%; 2 = 30%; 5 = 10%

Libra

3 = 100%

3 = 80%; 1 = 10%; 5 = 10%

Scorpio

4 = 100%

4 = 80%; 6 = 20%

Sagittarius

4 = 33.3%; 5 = 33.3%; 6 =
33.3%

4 = 40%; 5 = 30%; 6 = 30%

Capricorn

1 = 33.3%; 3 = 33.3%; 7 =
33.3%

3 = 40%; 1 = 40%; 5 = 20%

Aquarius

5 = 100%

5 = 40%; 7 = 40%, 4 = 20%

Pisces

2 = 50%; 6 = 50%

2 = 50%; 6 = 40%; 1 = 10%

Whichever option is selected here will affect any Ray tabulation page
objects and interpretation reports that include a balance of Rays section,
when they are subsequently produced.
MC in Polar Regions
Historically, astrology has been developed mainly in temperate latitudes,
and therefore the mathematical problems that occur in polar regions have
not received much attention in astrological texts. As a result, many modern
astrology programs have failed to deal with these issues in a consistent
manner.
The crux of the problem is that the normal (temperate latitude) way of
defining chart angles and houses breaks down in polar regions. In these
latitudes, it becomes possible for the Ascendant to retrograde, and for
certain portions of the zodiac never to rise at all.
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Generally, except in some very specific polar locations, it is always
possible to identify the Ascendant as that part of the zodiac that is rising
across the horizon (even though it may in fact be retrograding), and this
happens to occur always in the Eastern horizon.
However, there are two different ways of determining the Midheaven
(MC), which sometimes give diametrically opposed answers for its
position in the zodiac.
•

Always towards equator – In this case the MC is defined as the
intersection of the prime meridian with the ecliptic, towards the
equator (or more precisely the ecliptic). This means that the MC
is always due south in northern polar regions (and conversely is
due north in southern polar regions), even though, on those days
when the Sun does not rise, the MC also remains below the
horizon. Another consequence of this definition is that the MC is
the same for any location along a line of longitude, right from
one pole to the other.

•

Always above horizon – In this case the MC is defined as the
intersection of the prime meridian with the ecliptic, above the
horizon. This means that the MC is always above the horizon
(even when the Sun does not rise during the day), but as a
consequence, the position of the MC in the zodiac jumps by 180
degrees (ie. has a discontinuity) as you move along a line of
longitude from the equator to the winter pole.

When this option is changed, any charts that are subsequently opened or
calculated will use the newly selected calculation method, but charts that
have already been calculated retain the option that was in effect when they
were calculated.

Progs/Dirns
Chart Angle Progression Type
When charts are progressed, it is normal to progress all the planets
according to the prescribed progression rate, but to apply a separate
calculation to determine the position of the Midheaven (MC), and then to
derive the other chart angles (Ascendant, Vertex, Equatorial Ascendant)
from that newly calculated MC. Solar Fire includes 5 different methods by
which the MC’s progressed position may be calculated. These methods are
as follows.
True Solar Arc in Longitude - The MC’s longitude is progressed by the
same longitude arc as the Sun. This method is possible the most
commonly used method today.
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True Solar Arc in Right Ascension - The MC’s right ascension is
progressed by the same right ascension arc as the Sun
Naibod in Longitude - The MC’s longitude is progressed at the rate of the
mean motion of the Sun in longitude (this is 0°59’08’’ per day). This
method is also widely used.
Naibod in Right Ascension - The MC’s right ascension is progressed at
the rate of the mean motion of the Sun in right ascension (this is
3m56.5s of arc per day).
Mean Quotidian - The MC is progressed by the same method as the
planets, thus moving about 361° per day, as opposed to the Sun’s
movement of about 1° per day. This method is also known as “Daily
Houses”.
You can select your desired method from the drop-down list. Any
progressed charts or dynamic reports involving progressions that are
subsequently calculated will use the newly selected angle progressions
method. It is possible to determine which angle progression method has
been used in a progressed chart by checking the chart type in the chart
details text - the chart type description includes the angle progressions
method that was used. Similarly, it is possible to determine which rate was
used in a dynamic report by looking at the list of selected events in the
report header. This contains a description of the progression type, method
and rate.
Rate for User Defined Progs
In addition to the secondary, tertiary and minor rates of progression, it is
possible for the user to specify their own rate. The existing rates that are
pre-defined are as follows.
Secondary Rate - one day per solar year = 1 / 365.24219907 =
.00273790926
Mean Tertiary Rate - one day per lunar cycle = 1 / 27.32158648 =
.03660109676
Minor Rate - one lunar cycle per solar year = 27.32158648 /
365.24219907 = .07480402242
You can define your own rate by simply working out the required ratio eg.
if you wish to use a lunar progression rate
Lunar Progression Rate = 1 day per lunation cycle = 1 / 29.53059027778 =
.033863190359
You can select a previously entered rate from the drop-down list or simply
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enter a new progression arc rate as a decimal number. The last ten rates
that you enter here are stored in the list for easy reselection later.
The progression rate selected here will be used whenever you select to use
the User Progressed chart method when creating a progressed chart from
the Progressed... option of the Charts menu. This rate is also used in
dynamic reports whenever you select User Rate from the Progression
Type option of the “Dynamic Report Selection” screen.
Rate for Primary Directions
When primary directions are calculated in a dynamic report or in a page
object, there are several different methods of determining the exact rate of
direction. The primary direction rate is always about one year of life per
degree of directed arc, but any of the following options may be selected.
1 Year per Degree (Ptolemy) - The progression rate is exactly one degree
of arc for each year of life.
Naibod (1 Year for 59’08’’) - The progression rate is 59’08’’ of arc for
each year of life.
Natal Solar Rate - The progression rate is the natal Sun’s rate of motion in
R.A. for each year of life.
Any dynamic reports or page objects which use primary directions that are
subsequently calculated or displayed will use the newly selected
calculation method.
Progression Day Type
When charts are progressed by secondary or tertiary rate, it is possible to
base the progression rate on either a solar day or a sidereal cycle. (Minor
progressions are not based on days, so are not affected by this option). The
solar day is the time taken for the sun to move from the Midheaven on one
day to the Midheaven on the next day - that is 24hrs. This is the standard
rate, also known as Q2. This is the rate that is in most common use by
western astrologers. The sidereal cycle is the time taken for a fixed star to
move through 24hrs of arc, which is slightly more than 24hrs of clock
time. This is the Bija rate, also known as Q1. Astrologers who use the
sidereal zodiac sometimes use this rate. The ratio of the standard rate to the
Bija rate is 0.997269566.
When you change this option, any progressed charts or dynamic reports
involving progressions that are subsequently calculated will use the newly
selected progression day type. It is possible to determine which
progression day type has been used in a progressed chart by checking
whether the chart type in the chart details text - this includes either Q1 or
Q2 in its name. Similarly, it is possible to determine which rate was used in
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a dynamic report by looking at the list of selected events in the report
header. This contains a description of the progression type, method and
rate.
Rate for User Defined Directions
In addition to the solar arc, ascendant arc and vertex arc rates of direction,
it is possible for the user to specify their own annual direction rate, for use
in casting directed charts or in dynamic reports. The existing arc rates that
are pre-defined are as follows.
Solar Arc - the arc of the secondary progressed Sun. This has an average
rate of motion of about 1 degree per year.
Ascendant Arc - the arc of the ascendant, as derived from the Midheaven
when it is progressed by the secondary progressed solar arc. This has an
average rate of motion of about 1 degree per year, but varies somewhat.
Vertex Arc - the arc of the vertex, as derived from the Midheaven when it
is progressed by the secondary progressed solar arc. This has an
average rate of motion of about 1 degree per year, but varies somewhat.
You can define your own fixed rate in terms of annual longitudinal motion
in degrees. You can select a previously entered rate from the drop-down
list or simply enter an annual arc rate in degrees and minutes, or in decimal
degrees. See page 384 for a more detailed descriptive of acceptable formats
for entering angles. The last ten angles that you enter here are stored in the
list for easy reselection later.
The direction rate selected here will be used whenever you select to use the
User Arc Directed chart method when creating a directed chart from the
Progressed... option of the Charts menu. This rate is also used in dynamic
reports whenever you select User Arc from the Direction Type option of
the “Dynamic Report Selection” screen.
Prog/Drn Relocation Option
This is a special option that relates to relocating progressed and directed
charts. In normal operation, when calculating progressed or directed charts,
if a new location is entered by the user, then the resulting chart is
calculated as if the natal chart had been relocated to that new location
before the progressions or directions are applied. However, when this new
option is enabled, the resulting chart is calculated as if the natal chart was
relocated only to the latitude of the new location before the progressions or
directions are applied (the longitude remains unchanged). This applies to
the calculation of progressed and directed charts as well as to the
calculation of progressions and directions in the dynamic reports.
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Zodiac
Default Zodiac
It is possible to specify which zodiac is used for any chart calculations.
Typically, western astrologers use the Tropical zodiac, which has its
starting point where the Sun is when it crosses the equator northwards.
However, many eastern astrologers use a Sidereal zodiac that has a
starting point that is fixed against the constellations, and is currently
roughly 25-30 degrees earlier than the tropical zodiac’s starting point. The
exact difference depends upon which ayanamsa that is used.
An ayanamsa is the longitudinal difference between the Tropical zodiac
and a Sidereal Zodiac. This difference changes with time, due to the
precession of the equinoxes, but may be defined as a fixed difference at a
specific date, such as 1st Jan 1900. There are certain standard ayanamsas
that are used by astrologers, and the most common of these are available
for selection from the menu. Any that are not on the menu may be selected
by choosing the User Defined zodiac type, and selecting or entering a
value into the Sidereal Vernal Point.
Tropical

Precessing vernal point - Normally used in western
astrology

Fagan-Bradley

Standard western astrologers' sidereal ayanamsa

Lahiri

Official Indian government ayanamsa

DeLuce

According to
Astrology"

Raman

According to B.V.Raman of India

Usha-Shashi

According to Usha-Shashi in "Hindu Astrological
Calculations"

Krishnamurti

According to K.S.Krishnamurti

Djwhal Khul

Based on the assumption that the age of Aquarius starts in
the year 2117, as proposed by some students of the
Ageless Wisdom.

Draconic

Based on position of the moon’s north node

User Defined

Allows you to enter your own ayanamsa in terms of the
position of the Sidereal Vernal Point at 1st January 1900
for that ayanamsa. Angles may be entered in degrees,
minutes and seconds (eg. "334 27 32") or using zodiacal
sign (eg. "4 Pi 27 32"). See page 384 for more
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Robert

DeLuce

in

"Constellational

information on entering angles.

Any charts subsequently cast will use the newly selected zodiac. It is
possible to see which zodiac has been used in any chart, as it appears as
part of the chart details that are displayed in the "Current Chart" box of the
main screen.
Note that a few page objects (such as Vedic Dasa tabulations) always use a
sidereal zodiac, even when the selected default zodiac is tropical. The
sidereal zodiac that is used for these objects is whichever sidereal zodiac
was last selected before the tropical zodiac was selected. To change this
selection, choose the Sidereal option, select the required zodiac type from
the list, and then re-select the Tropical option.
Zodiac Application
• Use default zodiac only when casting new charts – When this
option is selected, any charts that are opened from chart files
will be calculated using the zodiac type with which they were
stored. New charts are calculated using the selected default
zodiac. This is how previous versions of Solar Fire worked.
•

Use default zodiac for both new and opened charts - When
this option is selected, any charts that are opened from chart files
will be calculated using the selected default zodiac type, instead
of the zodiac with which they were stored. This effectively
overrides the zodiac type stored with charts.

Houses
Default House System
You can select a house system which is the one used by default for all new
charts in Solar Fire, and optionally also for all re-opened charts as well.
The available house systems are as follows.
Campanus - Uses the prime vertical as the fundamental circle, divided
into 12 equal lunes. Derived in the 13th century by mathematician
Johannes Campanus.
Koch - One of the most commonly used systems. Similar to Alcabitius,
except that the degree of the Midheaven is moved back to the ascendant
before the ascendant is moved towards the Midheaven. Recently
derived (1940s).
Meridian - Also known as the Axial system.
Morinus - Uses the equator as the fundamental circle, divided into 12
Chapter 42: Changing Preferences 359

equal arcs starting from the projection of the ascendant onto the
equator. Attributed to Jean Baptiste Morin in the 17th century.
Placidus - One of the most commonly used systems. Derived by
determining the points on the ecliptic whose semi-diurnal arcs exactly
trisect their quadrant. Derived by Placidus de Tito in the 17th century.
Porphyry - Each quadrant is dissected by longitude into three equal
houses. Originated in the 3rd century AD.
Regiomontanus - Similar to Campanus, but uses the celestial equator as
the fundamental circle. Derived by Johannes Muller.
Topocentric - Based on the rotation of the horizon line, cutting the ecliptic
at equal spaces in equal time. Recently derived (c 1961) by Vendal
Polich and Anthony Page.
Equal - Equal system with the 1st house cusp set to the Ascendant. First
described by Ptolemy in his book Tetrabiblos.
Aries - Equal system with 1st house cusp set to 0° Aries
Solar Sign - Equal system with 1st house cusp set to 0° of the Sun’s sign
“Planet” on 1st - Equal systems with 1st house cusp set to that planet’s
longitude
Vertex on 7th - Equal system with 1st house cusp set opposite to the
Vertex
MC on 10th - Equal system with 10th house cusp set to the Midheaven’s
longitude
Whole Signs - Equal system with 1st house cusp set to 0° of the
Ascendant’s sign
Hindu Bhava - Based on the Porphyry system, but with the cusps shifted
to the midpoints of the Porphyry houses, so that the Ascendant falls in
the middle of the first house.
Alcabitius - Time based system, based on the trisection of the diurnal arc
of the ascendant traveling towards the Midheaven.
Asc in 1st - Equal system with center of 1st house set to the Ascendant
Whichever house system you highlight in the list will become the new
default house system.
Asc/MC Display Option
Normally, even if the Ascendant and Midheaven are selected as displayed
points, they are not shown as chart points inside the chart wheel. The only
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exceptions to this rule are when these points are not identical to the 1st and
10th house cusps respectively. The reason for this behavior is to avoid
putting superfluous information into the chart, thus avoiding clutter.
However, there are two options which you may switch on the alter this
behavior.
•

Show Asc even when 1st House Cusp – When switched on, this
option ensures that the Ascendant is always displayed in a wheel
as a chart point, even when it is also the 1st house cusp.

•

Show MC even when 10th House Cusp – When switched on,
this option ensures that the Midheaven is always displayed in a
wheel as a chart point, even when it is also the 10th house cusp.

Composite Chart Houses
This option applies only to the calculation of Composite – Midpoints
charts. In most cases the calculation of these charts is straightforward, and
the house cusps of the chart are simply the midpoints of the same house
cusps in the two base charts. However, if the house cusps of the two base
charts are almost diametrically opposed, then it is possible that a chart
made up of the short-arc midpoints of the base charts’ house cusps will
have its cusps out of zodiacal order. When this happens, Solar Fire will
adjust some of the house cusps to be long-arc midpoints instead of shortarc in order to preserve the correct zodiacal ordering of the houses. This
adjustment can be made in any of the three following ways.
•

Auto Anchor – The 1st and 10th house cusps of the base charts
are tested to see which one has the “strongest” composite
midpoint, and then that cusp is taken as a short-arc midpoint,
and other house cusps adjusted as required to maintain correct
zodiacal order of the cusps. The “strongest” midpoint is the one
in which the short-arc difference in angle between the cusps on
the two base charts is a minimum.

•

Anchor on 1st House – The 1st house cusp is always taken as the
short-arc midpoint, and other house cusps adjusted as required to
maintain correct zodiacal order of the cusps.

•

Anchor on 10th House - The 10th house cusp is always taken as
the short-arc midpoint, and other house cusps adjusted as
required to maintain correct zodiacal order of the cusps.

House System Application
• Use this house system only when casting new charts – When
this option is selected, any charts that are opened from chart files
will be calculated using the house system with which they were
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stored. New charts are calculated using the selected default
house system. This is how previous versions of Solar Fire
worked.
•

Use this house system for both new and opened charts When this option is selected, any charts that are opened from
chart files will be calculated using the selected default house
system, instead of the house system with which they were
stored. This effectively overrides the house system stored with
charts.

View Menu
You can customise the type of astrological data that is displayed from each
of the following View menu items.
•

Current Chart

•

Current Chart+Grid

•

Current Grid

•

Dual Wheels

•

BiWheel

•

TriWheel

•

QuadriWheel

•

Synastry Grid

The listbox shows which page style is currently selected for each of these
menu items.
The purpose of this option is to allow you view your preferred page type
for any chart without having to go through extra steps of selecting the page
type each time you display a chart. For example, if you usually want to
display esoteric astrological information, then you might select “Rays and
Rulerships [esot2.pag]” as your selected page style for “Current Chart”.
Note that whichever page style you select for “Current Chart” also takes
effect whenever you double-click on the list of calculated charts.
W

To select an alternative page style

Select the required menu item from the list
1.

Click on the Select… button
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2.

Choose a page type from the Page Topic Index dialog, and click
on the OK button

You can reset all the page styles to their original defaults by clicking on the
Reset to Defaults button.

Misc
Pluto Glyph
You may select any of three available styles for the Pluto glyph. This style
is used in all chart wheels and reports in Solar Fire.
Uranus Glyph
You may select either of two available styles for the Uranus glyph. This
style is used in all chart wheels and reports in Solar Fire.
Capricorn Glyph
You may select either of two available styles for the Capricorn glyph. This
style is used in all chart wheels and reports in Solar Fire.
Midpoint Trees
There are two options that affect how all midpoint trees are calculated,
both in the reports and in the midpoint tree page objects.
•

Allow trees to contain midpoints which include the root
planet – Normally, when midpoint trees are constructed, the
root planet for each tree is excluded from calculations of the
midpoints which fall under that tree. This can only occur when
the root planet is conjunct the other point, and as this can
normally be seen easily in the chart itself, it is of less interest
than other items in the midpoint trees. However, if you prefer,
you can ensure that these entries will appear in the trees by
switching this option on.

•

When sorting trees, take into account the sign of the orb –
The entries in midpoint trees can be sorted in two ways: a)
according the absolute orb of the contact (disregarding which
side it is on), in which case the closest orbs appear at the top of
the list, or b) according to the orb and sign, in which case the
closest orbs appear in the middle of the list. If you prefer option
b), then switch this option on.

Sound for Events
The program issues appropriate beeps when any error or information
dialog box is displayed, when the "Print" dialog box is displayed and when
printing or copying has finished. It is possible to prevent any beeps from
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being sounded by switching off the sound option.
Angle Rounding
It is possible to display zodiac angles in either of two ways. If the angle
rounding option is off, then when angles are displayed they will simply be
truncated from their full precision. If the angle rounding option is on, then
the displayed angle will be rounded to the nearest displayed unit (ie. to the
nearest minute if the angle is displayed in degrees and minutes, or to the
nearest second if the angle is displayed in degrees minutes and seconds).
Some examples follow.
Angle

Angle Rounding On

Angle Rounding Off

12° 34' 56.7"

12° 35' or 12° 34' 57"

12° 34' or 12° 34' 56"

23° 59' 59.5"

24° 00' or 24° 00' 00"

23° 59' or 23° 59' 59"

Any charts or reports that are generated display any angles according to the
current setting of this option. Note that this option does not affect the way
in which angles are calculated or stored internally (they are always stored
to a high precision, regardless of this option) - it only affects the manner in
which angles are displayed.

Compliments
It is possible to edit the compliments text that appears when most charts
and pages are printed. Typically you might want to enter you name,
address and telephone number, for the sake of any clients who receive your
printed charts. On a single-wheel chart, this text appears on the top right
corner of the page; on a biwheel chart it appears at the bottom right; and on
a triwheel chart it appears at the bottom left. Compliments text is not
normally printed on quadriwheel charts, but can be added to or removed
from any page if required, using the Page Editor.
The topmost line of text will always be printed with a bold font (unless it is
left blank), and the subsequent lines will be printed in a normal font. Each
line of text is justified to the right or the left depending on which part of
the chart the text is being printed. This alignment can be changed used the
Page Editor.
In some situations you may want to prevent compliments text from
appearing eg. if you are producing a large number of charts and pages for
publication. In this case, you can check the “Hide compliments text” box.
This will prevent the compliments text from appearing on any displayed or
364 Solar Fire 5: Customizing Solar Fire

printed page. It is not necessary to remove the text itself. Unchecking the
box will allow the specified compliments text to be displayed on any
subsequently drawn or printed page that includes a compliments text
object.

Dates
Window for 2 Digit Year Entry
When you are entering dates into Solar Fire, you can facilitate input by
excluding the century number from the year and entering just one or two
digits for the year, and allowing the century number to be automatically
inserted. For example, entering 3/12/98 might result in the date “3 Dec
1998” being assumed, or 3/12/0 might result in “3 Dec 2000”.
This option allows you to specify the 100 year window in which the
century number is correctly assumed.
For example, if you enter the window range 1905 (to 2004), then one or
two digit year numbers are assumed to be within this year range i.e. 0 to 4
are converted to 2000 to 2004, and 5 to 99 are converted to 1905 to 1999.
Note: If you wish to enter a date with any year number which is outside the
specified window, then you must enter at least 3 year digits (or a BC date
qualifier), including leading zeroes for dates in the first century AD eg. 003
for year 3 AD.
Calendar Style Display Options
• Never show OS/NS flags – Always use default – When this
option is selected, Solar Fire never displays OS (old style,
Julian) or NS (new style, Gregorian) suffixes on its dates. When
this option is in effect, any date on or prior to 14 Oct 1582 is an
OS date, and any later date is a NS date. This is how earlier
versions of Solar Fire always worked.
•

Always show OS/NS flags between years – When this option
is selected, Solar Fire will always display the OS or NS suffix on
any chart whose year falls within the specified range.

•

Retain all user entered OS/NS flags – When this option is
selected, Solar Fire remembers whether the date you entered had
an OS or NS suffix, and if so, always displays the date with that
suffix, and according to that calendar style. For example, if you
entered “17 Aug 1753 OS”, then that date would always be
displayed that way too. However, if you entered “17 Aug 1753
OS” when this option was not selected, then it would be
converted into the NS calendar, and displayed as “28 Aug 1753”
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or “28 Aug 1753 NS”.

Interps
The following options apply to textual interpretation reports that Solar Fire
generates. You can select which word processor you wish to use when
viewing and printing interpretation reports. If you do not select one
yourself, then Solar Fire will use the default word processor for your
computer system.
•

Use default word processor – When this option is selected, the
report file that Solar Fire generates is launched using whatever
word processor has the RTF file type association (for RTF files),
or TXT file type association (for TXT files). However, if your
computer does not have a file type association, then you will
need to use the following option instead.

•

Use specified word processor – Selecting this option requires
you to click on the Browse… button to locate your desired word
processor program file. You must select a word processor that is
capable of opening TXT and RTF files.

•

Apply rich text formatting to report - Rich Text Format (RTF)
is a method of producing formatted reports (ie. with centered
text, bold and italics, for example). Without RTF, a report file
will contain only plain text in a single font, without any special
formatting, and this is much less attractive and harder to read.
Solar Fire can produce its interpretations reports either with or
without RTF. However, if you use the RTF option, then you
must be using a word processor that is capable of understanding
the RTF format. MS Word for Windows, WordPerfect and the
Windows WordPad can all understand the RTF format. If you
have the RTF option switched on, but are using a word processor
that does not understand RTF, then you will see a lot of spurious
items in the report file that interfere with its normal layout.

Places
This dialog allows you to select a list of “favorite” places, set one of them
as your current location, and select which Atlas type to use for place
lookups.
Favorite Places
This list can contain the details of up to five places. One of these places
must always be your current location, and the other four may be places to
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which you travel frequently, or places for which you frequently cast charts,
for example.
W

To add a favorite place

Click on the Add… button.
The will open the Atlas dialog for your currently selected atlas type, from
where you can find the required place, or add new place details if you are
using the Solar Fire Atlas. See page 40 for more details on selecting a
place from the Atlas. When you have selected a place, it is automatically
added to the list of favorite places. If your list already has five places on it,
then the one at the bottom of the list (the least recently used one) is
removed to make way for the new place.
W

To delete a favorite place

Highlight the required place and then click on the Delete button.
Current Default Place
The current default place should usually be set to your current location.
This is what determines the location details that are displayed on the front
screen of Solar Fire.
W

To select a new current default place

Ensure that the place you want is on the list of favourite places (if it is not
there then add it).
Highlight the required place
1.

Click on the Set as Default button.

The name of the new default place will be updated immediately.
Lookup timezone on each startup
The default place details also contain the current timezone for that location.
If you don’t want to have to remember to adjust that timezone for daylight
savings yourself, then you can switch on this option, so that every time that
Solar Fire starts up, it will check the current timezone according to the
Atlas timezone tables, and set it accordingly for the current date.
However, if for any reason the place you have selected as your current
default place is not linked to a timezone table, then using this option might
result in a warning message each time that Solar Fire starts up, and the
timezone will not be updated. In this case you have the option of either
switching this option off, or of re-selecting your current location using an
Atlas that does has a timezone table link.
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Atlas to Use
Solar Fire contains its own atlas, but also has the capability of linking
transparently with the ACS PC Atlas. You can elect to use either Atlas if
you own both. Otherwise you will only be able to select the Solar Fire atlas
option.
If this is the first time that you have attempted to use the ACS Atlas from
Windows, then Solar Fire will search for the directory of the ACS Atlas,
and when it is found a dialog box will appear, into which you will be
prompted to confirm or edit the directory or folder into which the Atlas
was installed. Typically this will be C:\ATLAS\ATLAS, but you may need
to edit this if you have installed it into a different drive or directory. (You
will not need to do this on subsequent occasions, as Solar Fire writes an
entry into the ACSATLAS.INI file for future reference.)
If you do not have the ACS PC Atlas installed, or if you enter the wrong
DOS path, then Solar Fire will automatically revert to using the Solar Fire
place databases.
After you set this option, whenever the atlas is accessed either directly (by
clicking on a Place… button) or indirectly (by using the Autolookup
feature), the chosen atlas is accessed.
Refresh Index
This button is only accessible when the Solar Fire atlas is selected. The
Solar Fire atlas contains an index of country and places that greatly speeds
up lookups.
If you only ever add, edit or delete places to this atlas via Solar Fire, then
the index will be maintained automatically.
However, if you were to add or install new atlas files, or make other
changes to atlas files via the operating system, then these index files might
no longer be up-to-date, and you might fail to find new information. In this
case you can select this button to invoke a re-indexing of the files, thus
ensuring that the atlas has access to all new information in it.

Charts
Chart Conversion to SFv5 Format
This version of Solar Fire uses a chart file format that is different from that
of previous versions. This new file format has advantages over the old
format, but it is not compatible with earlier versions. However, this version
of Solar Fire is able to read all older version chart files, and is also able to
save chart files to the SFv3/4 file format if required.
However, when saving to a SFv3/4 chart file, any chart rating and source
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notes that you have entered, along with the chart event type or gender are
not saved, and it is not possible to save any charts other than natal types
charts.
•

Always automatically convert older charts – When this option
is selected, any time that you select an old version chart file
(SFv1/2/3/4) to open, it will automatically be converted into a
new version chart file, and a backup copy of the old version file
will be stored into the OLDCHART sub directory of the main
Solar Fire directory. This option is recommended if you do not
need to maintain compatibility with other software that is unable
to read the new Solar Fire chart file format.

•

Prompt me whether or not to convert each older chart file When this option is selected, any time that you select an old
version chart file (SFv1/2/3/4) to open, you will be prompted
whether or not allow it to be converted into a new version chart
file. If you consent, then it is converted and a backup copy of the
old version file will be stored into the OLDCHART sub
directory of the main Solar Fire directory. If you do not consent,
then it is left unchanged.

•

Never convert – use SFv3/4 chart format only – When this
option is selected, any old version chart file that you open
remains unchanged. However, this means that you will not have
the advantage of the new chart file format features.

Auto Chart Save
Any new charts that are created by the program, plus any charts which are
edited instead of being opened, must be saved to a chart database if you
wish to use them again in later sessions with the program.
It is possible to save a chart by manually selecting Save options within the
program, or alternatively any new charts can be saved automatically
whenever they are created by switching this option on.
For more information on saving charts see page 86.
Chart Data Email Options
Solar Fire allows you to create emails that automatically include details of
any charts that you have selected, either as attached chart files and
comment files, or within the body of the message itself. You can also
automatically create emails that include chart page graphics as attached
files. This should greatly facilitate the exchange of astrological data.
In order to use these email options, you must have a MAPI compliant
email program. See page 97 for more information.
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These are the options that apply to the sending of chart data:
•

Include text chart details when sending chart files – When
this option is selected, any time that you choose to send chart
files as an email attachment, the details of those chart files will
also be listed, either in the body of the message or as an attached
text file according to the options below.

•

Send text chart details in body of message – When this option
is selected, any text chart details are added into the body of the
message.

•

Send text chart details as attached file - When this option is
selected, any text chart details are included in an attached text
file.

•

Include chart comments – When this option is selected, chart
comments files are included along with any chart files, and when
the chart details are included in text format, then the chart
comments are written out in text immediately after each chart’s
details.

See page 97 for further details on sending charts by email.

AutoRun
Solar Fire can automatically run a set of Astrologer’s Assistant tasks every
time that it starts up. For example, you may want Solar Fire to generate a
chart of current transits whenever it starts up, or to open your own chart,
and then view it in a triwheel with the current progressions and transits
around it.
If a task file has already been selected for AutoRun, then the file name and
its title and description will be displayed in the text boxes.
If you wish to create a new task file, then see page 373 for further
instructions.
W

To select a task file to run on startup

Click on the Select… button and choose an existing task file from the list
of available task files.
W

To prevent a task file from running on startup

Click on the Clear button.

370 Solar Fire 5: Customizing Solar Fire

Ephemerides
Solar Fire installs a copy of the Swiss Ephemeris into its own
subdirectories. However, it is possible that you already have a copy of the
Swiss Ephemeris in another location on your computer. In this case you
can avoid keeping multiple copies of the Swiss Ephemeris files by
directing Solar Fire to use the copy in the other location.
W

To select an alternative location of the Swiss Ephemeris

Click on the Browse… button and choose the folder in which the Swiss
Ephemeris resides.
Once you have chosen a new directory, Solar Fire attempts to connect to
the ephemeris files at the new location. If you specified a folder that does
not contain the correct Swiss Ephemeris files, then you will see an error
message, and the location will revert to its original value.
After you have successfully specified an alternative location, you may
delete the ephemeris files from Solar Fire’s SWISSEPH subdirectory, in
order to free up disk space, if you wish.
Note: Swiss Ephemeris asteroid ephemerides must always reside in
subdirectories of the main Swiss Ephemeris directory. If you use this
option to change locations, then you must ensure that any extra asteroid
ephemerides you have are also present in the new location, or you will lose
access to them. See page 227.

Editing the Toolbar Buttons
The toolbar contains a range of graphical buttons that provide shortcuts to
various items within Solar Fire. It may be customized by changing the
selection or ordering of the buttons it contains.
W

To customise the toolbar

Select the Edit Toolbar… item from the Preferences menu, or doubleclick the mouse on any blank area of the toolbar.
This will display the toolbar customization dialog, which display a list of
available toolbar buttons on the left, and current toolbar buttons on the
right. You can manipulate buttons and separators (ie. blank spaces) as
follows.
W

To add a button
1.

In the current toolbar buttons list, select the button above which
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you wish to insert the new button.

W

W

W

2.

In the available toolbar buttons list, select the required new
button.

3.

Click on the Add button.

To remove a button
1.

In the current toolbar buttons list, select the button you wish to
remove.

2.

Click on the Remove button.

To change the order of buttons
1.

In the current toolbar buttons list, select the button you wish to
move.

2.

Click on the Move Up or Move Down buttons as required.

To restore your previous button selection

Click on the Reset button.
This will restore the order of buttons to the way it was when you opened
this dialog box.

Viewing Panels on the Main Screen
The panels on the main screen which may be turned on or off from the
Preferences menu are as follows.
•

Toolbar

•

Date and place

•

Current Settings

•

Planet Bar

See page 11 for a detailed description of what each of these items contains.
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Chapter 43: Using the Astrologer’s
Assistant
The Astrologer’s Assistant is a powerful task automation feature that
allows you to record a list of tasks and then save them for replay at any
time. This functionality is also sometimes known elsewhere by names such
as Macros or AutoJobs.
Once it is set into record mode, it keeps a record of the tasks that you carry
out (this window stays on top whilst you work). When you click the Stop
button, you can review and edit certain elements of the task list, and save
this list to file for future reuse.
When you click the Play button, it will run through the list of tasks using
whatever charts you have currently selected in your calculated charts list.
Some tasks do not require a base chart to run, and others require one or
more base charts to be selected. If you have not already selected the
required number of charts, then you will be prompted to select them before
the task list runs.
For example, you could record a task to print a chart, calculate a
progressed chart and transits chart for the current date, display them
together in a triwheel and print them, run a dynamic report with one years
transits and progressions and then print that out. This set of tasks can then
be replayed for any other starting chart at the click of a button.
Tasks which can be recorded and replayed are:
•

opening charts from a file

•

casting new charts

•

generating any types of subsidiary charts

•

viewing or printing or copying a page or report

•

viewing, generating or printing or copying to clipboard dynamic
reports, time maps and graphic ephemerides

•

deleting and saving charts

•

selecting files of all types (eg. Displayed Points, Colors, Aspects,
Fixed Stars, etc..)

•

saving settings and restoring settings
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W

To open the Astrologers Assistant ready to record or play task lists

Select the Astrologers Assistant item from the Utilities menu.
This will display the Astrologer’s Assistant dialog, which is a small dialog
with a range of buttons. This dialog remains on top of any other windows
until it is closed.

The buttons are as follows:
Open task list from file – This displays a file open dialog, allowing you to
select any pre-existing task lists. When you open a task list, its title (and
the number of tasks it contains) appears in the box at the bottom of this
dialog.
Save task list to file – This displays a file save dialog, allowing you to
save a task list that you have just recorded or edited. Once saved, it can be
re-opened and re-used at any time.
Start recording tasks – This will put the Astrologer’s Assistant into
recording mode. Any tasks that you subsequently perform (which are on
the list above) will be added to the list.
•

Pause recording – This stops the recording, but leaves the list of
tasks ready for additions as soon as the Start button is activated
again.

•

Stop recording – This stops recording and closes the task list. It is
not possible to add any extra tasks to the list after this is done.

•

Run tasks – This will execute whatever task list is already open,
using whatever chart or charts are currently selected in the list of
calculated charts. If the task list requires more than one base charts to
be selected, and you have not already highlighted enough charts, then
you will be prompted to select the additional charts.

•

Edit task list – This displays the editing dialog. Editing of the task
list is limited to deleting tasks, and selecting date options to apply
(such as using a date based on an offset from the current date for a
transits report start date, or using the current date for a new transits
chart etc.).

•

Ellipsis (…) – This will show a popup menu listing up to a
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maximum of about 30 pre-defined task lists. Selecting an item from
this list will open it for running or editing in the same manner as if it
was opened from the file open dialog. This is a quicker way of
selecting task files than using the file open dialog.

Browsing or Editing a Task List
W

To open the task list editor

After opening a task list, or stopping recording of a task list, click on the
Edit task list button on the Astrologer’s Assistant dialog.
This will display the Task List dialog, showing the title and description of
the current task list, as well as a list of the individual tasks.

The title and description may be freely edited, but the editing of the
individual tasks in the list is limited to deleting tasks, and selecting save
options or date options to apply (such as using a date based on an offset
from the current date for a transits report start date, or using the current
date for a new transits chart etc.).
The date and time options are as follows:
•

Use specified date and time – When this option is selected, the date
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and time fields are enabled, and may be edited by the user. In this
case the specified date and time is always used, regardless of the
current date and time at which the task is run. This option is useful in
order to cast a fixed natal chart, or to run dynamic reports from a
fixed date.
•

Use current date and time as base – When this option is selected,
the date field is disabled, and only the time may be edited. If neither
of the following two sub-options is enabled, then the task will always
adopt the date and time which are current when the task list is run.

•

Go to – When selected, this allows the user to select a specific
date/time to move to, starting from the current date and time when
the task list is run. The “Adjust date by” option may also be used as a
further date modifier if required.
o

Start of Day – 0:00am of current date

o

Start of Month –0:00am on 1st day of the current month

o

Start of Quarter – 0:00am on 1st day of the current quarter
(ie. 1st Jan, Apr, Jul or Oct)

o

Start of Half Year – 0:00am on 1st day of the current half
(ie. 1st Jan, or Jul)

o

Start of Year – 0:00am on 1st day of current year (ie. 1st Jan)

Specified Time – User entered time on current date
•

Adjust date by - When selected, adjusts the specified date (or “Go
to” date, if selected), by the specified multiple of days, months or
years. The multiple may be any integer, either positive or negative. A
positive integer moves the date forward in time, whereas a negative
integer moves it back in time.

For example, if the selection is to use the current date and time as base, to
go to the beginning of the month, and then adjust the date by –1 months,
then the task will always use 0:00am of the 1st day of the preceding month.
The save options are only available for a recorded task which involved
saving a chart to file.
The options are as follows:
•

Save to default chart file – The chart file will be saved to the
currently selected (default) chart file, without prompting the user
first.

•

Prompt user for chart file – The replay of the task list will be
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halted temporarily whilst the user is prompted to select a chart file
into which the chart will be saved. This option is useful if, at the time
of recording, you are unsure which chart file you might want to save
any calculated charts into.

Examples of Recording Task Lists
Progressed Composite
Progress two different base charts to the same date, then make a composite
chart and print it, delete the progressed charts, and then view the composite
1.

Click on the Astrologer’s Assistant button to open the floating
dialog box

2.

Click on the Record button

3.

Select any natal type base chart (it doesn’t matter which) from the
list of calculated charts and then select Chart / Progressed and
progress it to the current date.

4.

Select a different natal chart and then select Chart / Progressed
and progress it to the current date.

5.

Select Chart / Combined and select both of the newly calculated
progressed charts as the base charts, and select the required
composite method.

6.

Once calculated, select View / Current Chart.

7.

Click on the Stop button to stop recording.

8.

Click on the Edit Task List button to see the dialog below.

9.

Fill in the title and description as required.

10. Click on the two “Calculate: Sec.Prog.” tasks one by one, and
select the “Use current date and time as base” option for each one.
(These ensure that the charts are always progressed to the current
date, instead of the date on which you created this task list.)
11. Click on the OK button
12. Click on the Save button and supply a file name to save this set of
tasks under.
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Viewing a TriWheel with current progressions and
transits
Cast a transits chart, apply outer planets displayed points to this chart,
progress a base chart to current date and view a tri-wheel.
1.

Click on the Astrologer’s Assistant button to open the floating
dialog box

2.

Click on the Record button

3.

Select any natal type base chart (it doesn’t matter which) from the
list of calculated charts and then select Chart / Progressed and
progress it to the current date.

4.

Cast a new natal and click on the Now button to set it to transits
for the current date.

5.

Highlight the transits chart, and select Chart Options / Current
Chart’s Points, then select the “outers.pts” file. (This ensures that
only the outer planets are displayed in the transits chart.)

6.

Select View / TriWheel, and select the natal, progressed and
transits chart in required order, and view the wheel.

7.

Click on the Stop button to stop recording.

8.

Click on the Edit Task List button.

9.

Fill in the title and description as required.

10. Click on the “Calculate: Sec.Prog.” and “Cast Chart: Transits”
tasks one by one, and select the “Use current date and time as
base” option for each one. (These ensure that the charts are
always calculated to the current date, instead of the date on which
you created this task list.)
11. Click on the OK button
12. Click on the Save button and supply a file name to save this set of
tasks under.

Jayne’s Directions
This is a task list for producing a dynamic report using a typical technique
used by Charles Jayne. He mixed together into the same report solar arc,
ascendant arc, vertex arc directions, both direct and converse. Solar Fire
can do each of these in an individual report, and once merged together
result in a single report containing all of these directions.
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To record this task list you would do as follows.
1.

Click on the Astrologer’s Assistant button to open the floating
dialog box

2.

Click on the Record button

3.

Select any natal type base chart (it doesn’t matter which) from the
list of calculated charts, and then select the Dynamic Transits and
Progressions menu item.

4.

Select the first required events, directions type and converse
options (SolArc/ Direct) and ensure that the Merge option is not
checked.

5.

Click on View to run the report, and when it has finished, click on
New Report

6.

Repeat steps 4 and 5 for each of the remaining report types
(AscArc/Direct;
VtxArc/Direct;
SolArc/Converse;
AscArc/Converse; VtxArc/Converse) but this time ensuring that
the Merge option is checked

7.

Click on the Stop button to stop recording.

8.

Click on the Edit Task List button to see the dialog below.

9.

Fill in the title and description

10. Click on the tasks one by one, and select the date and time options
as shown below. (These ensure that the reports always start at the
beginning of the current month, instead of the date on which you
created this task list.)
11. Click on the OK button
12. Click on the Save button and supply a file name to save this set of
tasks under.
Now, when you select any natal type base chart from your list of calculated
charts, you can click on the Play button on the Astrologer’s assistant, and
the dynamic reports will be run and merged for you as you watch.
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Chapter 44: Backing Up Chart Files
Most files in Solar Fire can be easily re-installed or fairly readily
reconstructed if should you experience serious problems with your
computer’s hard disk or operating system. However, chart files cannot be
reconstructed unless you keep some sort of copy of all the charts that you
cast or import. Therefore, it is wise to make backups of your chart data on
a regular basis.
W

To backup your chart data onto diskettes or any other location

Select the Backup Chart Files… item from the Utilities menu.
You will be prompted to select a drive or location to save the backup files
to.
If you want to create a backup copy that you can keep separately from your
computer, then you should choose your floppy disk drive (usually this will
be your A:\ drive), but you can also save copies to another directory or disk
on your computer, or to another computer linked to yours on a network.
If a diskette becomes full during the backup process, then you will be
prompted to insert a new diskette to continue the process.
Note: This procedure simply copies all the files of type .cht (Charts) and
*.chm (Comments) from your current Solar Fire chart directory to the
specified destination location. The current Solar Fire chart directory is the
location from which you last opened a chart file.
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Chapter 45: Using the Utilities Menu
Solar Fire has a Utilities menu which is completely customizable by the
user. When you first install Solar Fire, the Utilities menu will already
contain a list of options, including options which start up most of the
separate programs that are supplied with Solar Fire, such as the Chart
Export utility and the Rulerships and Weightings Editor. However, you
may add items to, delete items from, or rearrange this list as you wish.
W

To start up the utilities menu editor

Select the Assign to Menu... option from the Utilities menu. This will
display the Solar Fire Menu Editor screen.
Solar Fire Menu Editor Screen

The list box on the left of the screen displays a list of all the items which
will appear in Solar Fire’s Utilities menu. The text boxes on the right
display the details associated with the currently selected item.

Editing Menu Items
W

To edit an item which is already on the list

Select the required item from the list. You can then edit any of the details,
as follows.
Menu Text - This allows you to enter the text which will be displayed in
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Solar Fire’s menu. Note that entering a single & before any letter will
cause that letter to be underscored in the menu, and allow it to be used
as a short-cut letter for accessing that menu item from the keyboard eg.
&Import Charts... is displayed as Import Charts..., and the Alt+I
keys may be used as a short-cut to accessing this menu item in Solar
Fire. It is recommended that you limit to length of your entries to about
20 characters, so that the menu will not become overcrowded.
Executable File - This allows you to specify which program will be started
whenever this menu item is selected from Solar Fire. You can either
enter a file name directly into this text box, or you can use the Find
File... button to search for the file you want and automatically enter its
path and name into this text box. If you enter a file name yourself,
without entering any path, then Solar Fire will assume that the file
resides in its own directory (normally called SOLFIRE), or in the
WINDOWS directory. If you want to call up a program from any other
directory than either of these, then you must enter its full path as well
as its name eg. to call the chart import utility, which resides in the Solar
Fire directory, enter “fileconv.exe”. To call the Nova program, for
which a PIF file exists in the Windows directory, enter “nova.pif”. To
call a program mygame.exe which exists in the directory GAMES on
the C drive, enter “c:\games\mygame.exe”. If you are use the Find
File... button to select the file, then the full path will be entered
automatically.
Help Text - This allows you to specify what help text will be displayed on
Solar Fire’s status bar at the bottom of the main screen when this menu
item is being browsed. This may be left blank if you wish.
Note that if you have incorrectly entered the Executable File name or path,
or if the program referred to is later deleted or moved to a different
directory, then Solar Fire will issue an error message whenever you
attempt to access that menu item. In this case, you can use the Assign to
Menu... option to edit or delete the problematic entry.

Deleting Menu Items
W

To delete any item on the list

1. Select the required item from the list
2. Click on the Delete button
This will delete the item immediately, without asking for confirmation.
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Reordering the Menu
W

To alter the position of any item on the list

1. Select the required item from the list
2. Click on the up or down arrow of the spin button
This will move the selected item up or down the list relative to the other
entries.

Saving Changes to the Menu
W

To save your changes

Click on the Save button. This will save any changes that you have made.
Next time that Solar Fire starts up, your changes will be read in, and the
Solar Fire Utilities menu will reflect these changes. Note that if you are
editing the menu whilst Solar Fire is running, any changes that you make
will not take effect until you exit from Solar Fire and restart it.
If you select the Quit button, and there are outstanding changes that have
not yet been saved, then you will be asked whether or not you wish any
changes that you have made to be saved.

Suggestions for the Utilities Menu
In addition to Solar Fire’s utility programs, you might consider adding
some of the following items into the Utilities menu.
•

Other astrology programs - You might find it useful to have some of
your other astrology programs accessible directly from Solar Fire.

•

Windows utilities - eg. Calculator (CALC.EXE), Clipboard
(CLIPBRD.EXE),
Notepad
(NOTEPAD.EXE),
Paintbrush
(PBRUSH.EXE). Note: These all reside in the WINDOWS directory,
so you do not need to enter a path for them.

•

Other programs that you use often - eg. your word-processor
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Chapter 46: Entering Angles
Angles are required to be entered in several different places in the program,
eg. when editing aspect orbs, editing report modulus and orb, specifying a
chart angle when rectifying a chart, entering a user-specified ayanamsa and
when specifying a return angle in the Advanced Return Options screen.
Angles may be entered in degrees, minutes and seconds or as decimal
degrees or in degrees, zodiac sign, minutes and seconds. Whenever an
angle is entered, Solar Fire will convert it into a standard format, unless it
cannot understand the entry, in which case an error message will be
displayed, and you can try entering an angle again.
Normal angles (non-zodiacal)
The angle must have at least a degree number. It may also have a minutes
number and a seconds number. The minutes and seconds number must be
between 0 and 59 only. Some examples of valid angle entries are as
follows.
23

23 59

23 59 59

Zodiacal Angles
The angle must have at least a zodiacal abbreviation or a degree number. It
may also have a minutes number and a seconds number. The minutes and
seconds number must be between 0 and 59 only. If you enter a zodiacal
abbreviation of 2 letters, then it must be one of the following - Ar, Ta, Ge,
Cn, Le, Vi, Li, Sc, Sg, Cp, Aq, Pi. If you enter more than 2 characters of a
sign name, then it must be an exact part of the full name of the zodiac sign
eg. "Sag" for Sagittarius. Some examples of valid zodiacal angle entries are
as follows.
23Aries
Aries 59 59

23Ar
133 23
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23Ar59 59
12 Cn 23

23
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Chapter 47: Changing Rulerships and
Weightings
This chapter describes how to use Solar Fire's Rulerships & Weightings
Editor to browse, add, edit, rename or delete sets of rulerships, and
weightings which are ascribed to chart points in various reports within
Solar Fire.

Rulerships
Adding or deleting sets of rulerships will affect how many different
rulership reports are available in the list of available reports as described
on page 155, and in the list of rulerships available in the menu of the
interpretations screen. When Solar Fire is first installed, there are four sets
of rulerships: Modern, Old, Esoteric and Hierarchical. Each set of
rulerships defines, for each sign, its ruler, what is exalted and what is the
ruler of each of the decanates.
The Modern set of rulerships uses rulerships as used by most modern
astrologers.
The Old set of rulerships uses Mars as ruler of Scorpio, Saturn as ruler of
Aquarius, and Jupiter as ruler of Pisces.
The Esoteric and Hierarchical rulerships use a completely different set of
associations, as defined in the book "Esoteric Astrology" by Alice A.
Bailey.

Weightings
Altering weightings of the chart point will affect the way in which scores
are calculated in the balance of the modes and elements in basic Chart
Analysis report of Solar Fire. It also affects the way in which Solar Fire
determines the balance of Modes, Elements and Rays in the Interpretation
reports.
When Solar Fire is first installed, the following weightings are in effect.
•

Multiplier 3 - Sun, Moon, Ascendant, MC

•

Multiplier 2 - Mercury, Venus, Mars

•

Multiplier 1 - Jupiter, Saturn, Uranus, Neptune, Pluto
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•

Multiplier 0 - All other chart points

This means that the Sun and the Moon count three times more than Jupiter
or Saturn in assessing which element is strongest, for example. Asteroids,
which have a weighting of zero, are ignored in this assessment.

Starting the Rulerships & Weightings Editor
W

To start the editor

From the Solar Fire Group, double click the Rulerships & Weightings
Editor program icon. After the utility loads, Solar Fire displays the
following screen.
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Rulerships & Weightings Editor Screen

Adding a Set of Rulerships
W

To add a new set (or level) of rulerships

1. Select the Add Level... option from the Edit menu. - You will be
prompted to verify that you wish to add a level.
2. Select the Yes button in order to delete it, or the Cancel button to
return to the editing screen without deleting it.
Note that the new level will initially contain an exact copy of the names
and all the rulerships of the currently displayed level, and will appear in the
list immediately after the currently displayed set, then. You are then free to
change the names and edit the rulerships as you wish.
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Deleting a Set of Rulerships
W

To delete (remove) the set of rulerships currently displayed

1. Select the Delete Level... option from the Edit menu. You will be
prompted to verify that you wish to delete the current level.
2. Select the Yes button in order to delete it, or the Cancel button to
return to the editing screen without deleting it.

Editing Rulerships
W

To edit the rulerships for any level

1. Select the desired Level Number from the drop-down list box. The
name of the level appears in the Name of Set box, and the text by
which this level will be known in Solar Fire menus appears in the
Menu Name box. Either of these names may be edited, eg. you could
rename the "Old" rulers to be "Traditional", and the menu name to be
"Ancient".
2. Select a Zodiac Sign from the list of signs. The remaining boxes will
then be automatically filled in with the rulers relating to the selected
sign. It is possible to alter any of these rulerships (or exaltations).
3. Select any of the available items from each drop-down list box. Note
that although it is possible to select any planet, asteroid or chart angle
from the drop-down list boxes, traditionally only the planets should be
selected.

Editing Weightings
W

To change the weighting of any chart point

1.

On the lower part of the screen, click on the desired chart point in the
list box

2.

Click on the Increase Weighting or the Decrease Weighting button
as many times as you wish - Each time that you click on one of these
buttons, the weighting number for that chart point will be updated on
the list. Note that a weighting cannot be set to less than zero or greater
than one hundred.
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Exiting from the Editor
W

To save your changes

Select the Save option from the File menu
W

To exit from the editor

Select the Exit option from the File menu. You may be shown a dialog box
asking you if you wish to save any changes that you have made. If you
wish to exit without making any alterations to the rulerships or weightings,
then select the No button. If you wish any changes that you made to be
saved then select the Yes button. Selecting the Cancel button will return
you to the editor, without exiting. Once you have exited, you can double
click on the Solar Fire icon to launch the main program.
Note: Any changes that you make to the rulerships or weightings will not
take effect until the next time that Solar Fire is launched. If Solar Fire is
running whilst you make changes, you will need to exit from Solar Fire
and launch it again in order for the changes to take effect.
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Chapter 48: Compiling Interpretations
You can edit any interpretations in Solar Fire by using the supplied
Interpretations Editor program (see page 234). However, on occasion you
may wish to decompile the interpretations into a text file so that you can
work on it in a word processor or text editing program. In this case you
will eventually need to recompile the text file so that the interpretations can
be used in Solar Fire. Also, if you own a previous version of Solar Fire,
then you may still have old text files that need to be compiled.
The Interpretation Compiler allows you to edit interpretations text files,
and assembles and compiles all the input text into a single, compact
"direct-access" file, from which Solar Fire is able to access any text item
almost instantaneously.
Once you have successfully run the Interpretations Compiler, you will be
able to access your interpretations by selecting the name of the file you
have created to be the current Interpretations File in Solar Fire, via the File
Manager.

Requirements
In order to edit your interpretations text files and compile your
interpretations, you will need to be familiar with a text editor or wordprocessor which can create ASCII text files. The Interpretations Compiler
allows you to access directly the Windows Notepad and the Windows
Write word-processor in order to edit the text in the interpretations files.
However, you may also use any other word processor or text editor of your
choice, if you prefer.

Procedure
1. From the Interpretations Editor, choose the Compile... option from the
File menu.
2. Select the definition file for the set of interpretations which you wish to
edit.
3. Optionally edit any of the displayed files which contain the
interpretations text for this project.
4. Compile the project.
5. If the Compiler finds any errors, then repeat steps 3 and 4 until all the
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errors are eliminated.
You can exit from the interpretations compiler without creating an
interpretation file, at any time, by clicking on the Quit button.

Editing Interpretations Text
To edit interpretations text files for any Solar Fire interpretation set, you
must first find the definition (*.def) file for that set of interpretations. If
wish to work with an interpretation set other than that already shown in the
Definition File text box, then you must select another file.
W

To select a definition file

Do one of the following
Enter a full file path and name into the Definition File text box
Click on the file button the right Definition File text box. You will be
shown a file selection dialog box from which you may select directories
and files.
When you select a definition file in the Interpretations Compiler, all the
text files that are related to this project will be listed in a list box. You are
then able to edit or browse them using any of several different editing
programs.
W

To select a text editor to work with

Do one of the following
Choose the required editor from the drop down Editor box - In
most
cases the easiest editor to use is the Notepad, which is supplied with
Windows, as this is a simple text editor. Any changes that you make
with Notepad are automatically saved in the correct (text file) format.
However, Notepad is unable to edit files which exceed a certain size. If
you attempt to do so, then it will display an error message to this effect.
If this happens then you should close Notepad and use another editor
instead. The Write word-processor is also quite easy to use, but you
will need to remember always to save any changes using the Save As
menu option and selecting to save as “Text Files (*.txt)” from the dropdown list of File Types. Also, when you open the Write program, it will
ask you whether or not to convert the file to its own internal format.
The best option is to select “No Conversion”.
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If you prefer to use another editor or word-processor of your own
choosing, then you may do so by entering its full path and filename into
the drop-down list box. For example, to use MS Word for Windows,
you might enter “c:\msoffice\winword\winword.exe”. (Whatever you
enter here will be remembered for future sessions with the compiler.)
W

To edit a text file

Select the required file from the list and click on the Edit Text button, or
double-click on the required file in the list. This will start up the selected
editor with the selected file. Note that you must remember to close the
editor after you are finished with it. Each time that you edit a file in the
compiler, a new instance of the editor is started up. If you do not close the
editor after editing each file, then you will end up with many copies of the
editor running simultaneously.
Note: If you are adept with your computer, then you may prefer to edit the
text files externally, without using the Interpretations Compiler at all. This
is quite acceptable, in which case you need to run the Interpretations
Compiler only to run the compilation after you have finished editing all
your text files.

Running the Compiler
When you have finished creating or editing any text input files, then you
can start the Compiler after specifying the output file. The output file is the
file which Solar Fire will use to read interpretation from.
W

To specify an output file

Do one of the following
Enter the full file path and name into the Output File text box
Click on the File Selection button to the right of the text box - This will
display a standard windows dialog box allowing you to specify the
directory and name of the output file.
Note: For Solar Fire to be able to use the output file, it must be in the
INTERPS subdirectory of Solar Fire, and it MUST have a ".INT" file
extension. If you specify different locations or extensions then you will
have to copy the resulting output file to the correct location and give it the
correct extension before Solar Fire will recognize it as a valid
interpretations file.
W

To start the compilation
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Click on the Compile button.
The compiler makes two passes of the input file/s. On the first pass the
syntax of each entered line of text is checked. If there are no errors, then a
second pass is performed during which the output file is created. You can
see which pass is currently being performed by looking at the Pass No. text
box, and which keyword lines are currently being read by looking at the
Keyword text box. The compilation is complete when the Pass No. text
box contains the word “Finished”.
If the output file that you have selected already exists, then you will be
asked whether or not you wish to overwrite it. If you choose to do so, then
the original copy of the output file will only be deleted after the compiler
has checked the syntax of your input files, and starts its second pass.
Therefore, if the compiler finds any syntax errors, the original file will
remain unchanged.
The compilation may take several minutes or more, depending on how
much text has been entered. You can stop the compilation at any time by
clicking on the Stop button. You can safely do this at any time during the
first pass. If you do this during the second pass of the compiler, then the
output file will probably be useable by Solar Fire, but will not contain all
of the required text.
If there are syntax errors encountered, then an error message will be sent to
the list box for each line which contains a syntax error. When the compiler
finishes, you can browse through these messages in order to pinpoint
where amendments must be made. You may need to refer to the File
Layout specification in order to determine how to correct the error. You
can access the editing options of the compiler by clicking on the Edit Text
Files button.
If no errors are encountered, then the first line of the list box will say
"Errors Encountered: 0", and following this will be a list of the information
types for which valid input text was found. In this case, you will be able to
use the output file in Solar Fire successfully.
W

To exit from the interpretations compiler

Click on the Quit button.
For information on how to select the interpretations file you have just
compiled for use in Solar Fire, see page 213.

Chapter 48: Compiling Interpretations 393

File Locations
The interpretations text files which are supplied with Solar Fire are all
installed into a single directory, which is the INTERPS subdirectory of the
main Solar Fire directory. If you chose to install Solar Fire to the default
directory, then the interpretations file will be in directory
C:\SOLFIRE\INTERPS

Input File Layout
The easiest way to learn how to lay out an input text file is to browse
through a text files which has been decompiled from an interpretations file
supplied with Solar Fire. These are in the INTERPS subdirectory of Solar
Fire.
Input files must be sequential ASCII text files. If you are editing your file
from WordPerfect, for example, then you must choose to save your files as
"ASCII Text (DOS)".
In any input file there are four types of lines which may legally appear.
These are comment lines, directive lines, keyword lines and text lines.

Comment lines
These are blank lines on which the first character is a semicolon (;) or a
formfeed. These are ignored during compilation. You can use them to
annotate your file with comments which you do not want to be included as
interpretations text. For example
; The following section was written by John Smith on 17th Sept 1995

Directive lines
These are lines on which the first character is "#". These allow you to tell
the compiler to include a separate text file at this point in the current file.
You can "nest" these directives in up to five levels of files. The syntax is
#include <filename>
where <filename> is either a full path plus a filename, or just a filename
without a path. If no path is given, then the compiler assumes that the file
is in the same directory as the top level input file. Examples:
#include c:\solfire\interps\aspects.txt
#include decans.txt
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Keyword lines
These are lines on which the first character is an asterisk (*). These allow
definition types to be specified. Any text lines following a keyword line
will be used as text relating to whatever item was defined on the keyword
line. The keyword line must be one of the following types:
* TITLE
e.g. *Title
* COPYRIGHT
eg. * Copyright
* INTRODUCTION
eg. *Introduction
* DEGREE degreenumber (1-360)
eg. *Degree 37
* DECANATE decanatenumber (1-30)
eg. * Decanate 13
* QUADRANT quadrantnumber (1-4) [WEAK/STRONG]
eg. *Quadrant 3
* HEMISPHERE hemispherename [WEAK/STRONG]
e.g. *Hemisphere Eastern Strong
* ELEMENT elementname [WEAK/STRONG]
e.g. *Element Fire Strong
* MODE modename [WEAK/STRONG]
e.g. * Mode Cardinal
* RAY raynumber (1-7) [WEAK/STRONG]
e.g. *Ray 7
* ASPECT aspectname [mappedname]
e.g. *Aspect Square Hard
* PHASE phasename
e.g. *Phase Balsamic
* housenumber [st,nd,rd,th] [house] [WEAK/STRONG]
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e.g. *11th House
* signname [WEAK/STRONG]
e.g. * Aries
* pointname
e.g. *Moon
* pointname IN housenumber [st,nd,rd,th] [house]
e.g. *Sun in 1st House
* pointname IN signname
e.g. * Juno in Sagittarius
* signname ON housenumber [st,nd,rd,th] [house] [cusp]
e.g. *Aries on 3rd House Cusp
* pointname mappedaspectname pointname
(mappedaspectname must have previously appeared as a
non-mapped aspect name or as a mapped aspect name in a
"*Aspect" keyword line. See below for more details.)
eg. *Jupiter Hard Moon
* DYNAMICASPECTS
This is an optional keyword which need appear only once in the
file, and should not followed by any text lines. If it is present,
then any keyword entries of the previous type (point aspecting
point) are assumed to relate to dynamic points aspecting radix
points, and the points are therefore not interchangeable. In this
case a definition for the aspect Pluto Trine Venus, for example,
is stored separately from the aspect Venus Trine Pluto. If the
DYNAMICASPECTS keyword is not present, then keywords of
the previous type are assumed to relate to either a single chart,
or to synastry between charts, in which case, for example, Pluto
Trine Venus is treated as being identical to Venus Trine Pluto.
(This means that if both of these were present in your file, the
text for the first one would be overwritten with the text for the
second one.) See below for more details.
* SCORING type WEIGHTED/UNWEIGHTED ratioweak
ratiostrong
(type

must

be

one
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of

QUADRANT,

HEMISPHERE,

ELEMENT, MODE, RAY, HOUSE, SIGN. The items
ratioweak and ratiostrong must be positive real numbers.)
eg. *Scoring Element Weighted 0.5 1.5
Items in square brackets are optional, and uppercase keywords which are
not in square brackets are obligatory. Blanks between "*" and the next
non-blank character are ignored. Text is case insensitive (ie. text can be
entered in lower, upper or mixed case). Names of chart points must not
include blanks ie. Part of Fortune becomes PartofFortune, North Node
becomes NorthNode, South Node becomes SouthNode, East Point
becomes EastPoint. See the name lists below.
Aspect Definitions
Aspect definitions relate aspects to their mapped aspect names. (Any
aspects which do not have a mapped aspect name in a "*Aspect" definition
cannot be used in this set of interpretations. If no *Aspect definitions
appear then no "*Point aspect Point" definitions can be entered later.) Note
that *Aspect definitions must appear before any "*Point aspect Point"
definitions appear in the input file/s. For example:
*Aspect Conjunction Soft
This aspect combines the effects of the planets involved...
*Aspect Opposition Hard
This aspect indicates a conflict between the planets involved...
*Aspect Trine Soft
This aspect indicates an easy flow of energy...
*Aspect Square Hard
This aspect gives motivation...
*Aspect Semisquare
This aspect can result in frustration...
*Sun Hard Uranus
You are rebellious and unconventional...
*Sun Soft Uranus
You have a strong social conscience...
This would have the effect of creating two aspect types (Hard and Soft)
which must then appear with identical spelling in any "*Point aspecting
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Point" keyword lines. When the application runs, when an interpretation is
requested for a conjunction or trine between the Sun and Uranus, then the
interpretation text for the Soft aspect between those two points is returned.
Similarly the text for the Hard aspect is returned for the opposition and
square between those two points. No text is returned for any semisquare or
other type of aspect between those points (although text is returned for the
definition of a semisquare).
Note that if you are creating an interpretations file for transits, progressions
or directions to a radix chart, then you must include the
*DYNAMICASPECTS keyword somewhere in your file, in which case the
first point of a “*Point aspecting Point” keyword entry will always be
assumed to be the dynamic point, and the second point will be assumed to
be the radix point. For example text entered after the “*Saturn Square Sun”
keyword entry will be used by Solar Fire only for dynamic Saturn squaring
the Sun in the radix chart, but will not be used for dynamic Sun squaring
Saturn in the radix chart. If you want Solar Fire to return text for dynamic
Sun squaring Saturn, then you would have to create a “*Sun Square
Saturn” keyword entry.
You should NOT include the *DYNAMICASPECTS keyword if you are
creating interpretations for a single chart or for synastry between two like
charts, in which case the order of points in a “*Point aspecting Point” is
irrelevant. You need therefore create only one entry for each pair of points.
For example text entered after the “*Saturn Square Sun” keyword entry
will be used by Solar Fire for both Saturn squaring Sun and for Sun
squaring Saturn aspects.
Scoring for Balances
The "*Scoring" keyword allows you to specify how the balance of
quadrants, hemispheres, elements, modes and rays is calculated. If the
"Weighted" keyword is specified, then Solar Fire will apply a weighting
factor to each chart point placement in the chart. The weighting factor
applied in each case may be modified by using the Rulerships &
Weightings Editor supplied with Solar Fire. If the "Unweighted" keyword
is used (or any other word than "Weighted"), then no weightings will be
used. The ratios to be specified are used to determine what score is WEAK
and what is STRONG. Solar Fire does this in the following way.
1. The score for each category (eg. quadrant, element etc.) is calculated by
finding the number of chart points in each category, and multiplying each
one by its weighting if appropriate. (Note that the chart angles are always
excluded in the calculation for quadrants and hemispheres.)
2. The average score is found by summing the scores for each category and
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dividing by the total number of categories (ie. by 4 for quadrants,
hemispheres and elements, by 3 for modes, by 7 for rays)
3. If the score for any category is less than the average score times the
"weakratio" number, then it is considered to be WEAK in the chart. If the
score is equal to or greater than the average score times the "strongratio"
number, then it is considered to be STRONG in the chart.
Note that it is possible to prevent WEAK interpretations from appearing in
the compiler by specifying a "weakratio" of 0 (zero). Similarly it is
possible to prevent STRONG interpretations from appearing by specifying
a large "strongratio" (eg. 99.9).
Spelling of Keywords
The following lists indicate the exact spelling that must be used in the *
header lines for each interpretation. Abbreviations may be used only as
truncations of these words, and must be unambiguous eg. "Ca" will cause
an error if used as a sign abbreviation, but "Can" or "Cap" will be accepted
correctly as Cancer and Capricorn respectively.
SIGNS: Aries, Taurus, Gemini, Cancer, Leo, Virgo, Libra, Scorpio,
Sagittarius, Capricorn, Aquarius, Pisces
HOUSES: 1 to 12
ELEMENTS: Fire, Earth, Air, Water
MODES: Cardinal, Fixed, Mutable
HEMISPHERES: Eastern, Northern, Western, Southern
POINTS: Sun, Vulcan, Mercury, Venus, Earth, Moon, Mars, Jupiter,
Saturn, Uranus, Neptune, Pluto, Chiron, Vesta, Pallas, Juno, Ceres,
Hygeia, Astraea, NorthNode, SouthNode, Ascendant, Midheaven, Vertex,
EastPoint, PartofFortune, Cupido, Hades, Zeus, Kronos, Apollon,
Admetos, Vulcanus, Poseidon, TransPluto, BlackMoon
ASPECTS: Conjunction, Opposition, Trine, Square, Quintile, Sextile,
Septile, SemiSquare, Novile, Decile, UnDecagon, SemiSextile, BiQuintile,
BiSeptile,
TriSeptile,
SesquiSquare,
BiNovile,
QuadriNovile,
SesquiQuintile,
BiUndecagon,
TriUndecagon,
QuadriUndecagon,
QuinqueUndecagon, Quincunx, Parallel, ContraParallel
PHASES:
NewMoon, Crescent, FirstQuarter, Gibbous, FullMoon,
Disseminating, ThirdQuarter, Balsamic
RAYS:

1, 2, 3, 4, 5, 6 7
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Text lines
Any other line than those shown above is considered to be a text line. Text
lines are always assumed by the compiler to relate to the last keyword line
that was read in by the compiler.
Note that any carriage returns or line feeds within the body of the text are
ignored by the compiler. In order to force text onto a new line, a "|"
(vertical bar) character must be used. Eg.
The quick brown fox jumped over these items:|A box|A tree|A hen
This will ensure that, when displayed in Solar Fire's interpretations
window, the last three items each appear on a new line, as follows
The quick brown fox jumped over these items:
A box
A tree
A hen
Because the compiler ignores carriage returns, it does not matter how many
words are contained in each text line. You can put as many or as few words
on a line as you wish. When you run Solar Fire, the interpretation text lines
are automatically formatted to fit within the interpretations window,
whatever its size.
The limit to the amount of text that can be entered in relation to any one
keyword is that it cannot exceed about 40,000 characters (ie. roughly 650
lines of 60 characters width). There is no specific limit on how much text
may be entered into any one interpretations file. In practice you will be
limited by the amount of available disk space on your computer.
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Appendix A: Symbols & Abbreviations
Zodiac Signs
Symbol

Sign

Abbr

Symbol

Sign

Abbr

²

Aries

Ar

f

Libra

Li

³

Taurus

Ta

g

Scorpio

Sc

b

Gemini

Ge

h

Sagittariu
s

Sg

c

Cancer

Cn

ior »

Capricorn

Cp

d

Leo

Le

j

Aquarius

Aq

e

Virgo

Vi

k

Pisces

Pi

Chart Points
Symbol

Name

Abbr

Symbol

Name

Abbr



Moon

Mon



Ceres

Cer



Earth

Ear



Hygeia

Hyg



Sun

Sun

Astraea

Ast



Vulcan

Vul

£

Ascendant

Asc



Mercury

Mer

¤

Midheaven

MC



Venus

Ven

¥

Vertex

Vx
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Mars

Mar

¦

East Point

Ep



Jupiter

Jup

§

Part of Fortune

PF



Saturn

Sat

¨

Cupido

Cup

RU¼

Uranus

Ura

©

Hades

Had



Neptune

Nep

ª

Zeus

Zeu

RU¿

Pluto

Plu

«

Kronos

Kro

¡

North
Node

Nod

¬

Apollon

Apo

¢

South
Node

Sno



Admetos

Adm



Chiron

Chi

®

Vulcanus

Vus



Vesta

Ves

¯

Poseidon

Pos



Pallas

Pal

°

TransPluto

TPl



Juno

Jun

±

Black Moon

BMo
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Aspects
All the aspects of longitude from the 1st to the 12th harmonic are shown in
the following table, with angles in decimal degrees, and fractions relating
to a full circle.
Symbol

Name

Abbr

Angle

Fraction

µ

Conjunction

Cnj

0

0

¶

Opposition

Opp

180

1/2

·

Trine

Tri

120

1/3

m

Square

Squ

90

1/4

s

Quintile

Qnt

72

1/5

n

Sextile

Sxt

60

1/6

w

Septile

Spt

51.43

1/7

o

SemiSquare

SSq

45

1/8

¹

Novile

Nov

40

1/9

u

Decile

Dec

36

1/10

z

Undecagon

Und

32.73

1/11

q

SemiSextile

Ssx

30

1/12
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Symbol

Name

Abbr

Angle

Fraction

t

BiQuintile

BQn

144

2/5

x

BiSeptile

BSpt

102.86

2/7

¸

TriSeptile

TSpt

154.29

3/7

p

SesquiSquare

Sqq

135

3/8

y

BiNovile

BNv

80

2/9

º

QuadriNovile

QNv

160

4/9

v

SesquiQuintile

SqQn

108

3/10

{

BiUndecagon

BiUn

65.45

2/11

|

TriUndecagon

TrUn

98.18

3/11

}

Quadri-Undecagon

QaUn

130.91

4/11

~

Quinque-Undecagon

QiUn

163.64

5/11

r

Quincunx

Qnx

150

5/12

The aspects of declination are:-

Parallels - denote equality of declination
 ContraParallels - denote equal but opposite declination angle (eg. +3
and -3).
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Appendix

Appendix B: Rulerships &
Associations
The following table shows the relationships between the planets and signs
as they are initially specified in the Solar Fire program. It should be noted,
however, that there are a varying opinions in the astrological community
about some of these relationships. Some of these are noted below. It is
possible to alter any rulership in Solar Fire by using the supplied
Rulerships and Weightings Editor.
Zodiac
Sign

Modern
Ruler

Old
Ruler

Esoteric
Ruler

Hierarchical
Ruler

Exalted
Planet

Planet
in Fall

Aries

Mars

Mars

Mercury

Uranus

Sun

Saturn

Taurus

Venus

Venus

Vulcan

Vulcan

Moon

Uranus

Gemini

Mercury

Mercury

Venus

Earth

-

-

Cancer

Moon

Moon

Neptune

Neptune

Jupiter

Mars

Leo

Sun

Sun

Sun

Sun

-

-

Virgo

Mercury

Mercury

Moon

Jupiter

Mercury

Venus

Libra

Venus

Venus

Uranus

Saturn

Saturn

Sun

Scorpio

Pluto

Mars

Mars

Mercury

Uranus

Moon

Sagittarius

Jupiter

Jupiter

Earth

Mars

-

-

Capricorn

Saturn

Saturn

Saturn

Venus

Mars

Jupiter

Aquarius

Uranus

Saturn

Jupiter

Moon

-

-

Pisces

Neptune

Jupiter

Pluto

Pluto

Venus

Mercury

Planets are in detriment when they are in the sign opposite to their
rulership. For example, Uranus is in detriment in Leo traditionally, Aries
esoterically, and Libra hierarchically.
Neptune may also be considered to be exalted in Cancer or Pisces, and in
fall in Capricorn.
Vulcan may also be considered to be in fall in Pisces.
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Appendix

Appendix C: Calculation Methods
Planets and Chart Points
All planetary positions are calculated using the Swiss Ephemeris™, which
“is at least as accurate as the Astronomical Almanac, the standard
planetary and lunar tables astronomers refer to.”
The core part of Swiss Ephemeris is a compression of the JPL-Ephemeris
DE406, plus an extension of the time range to 10,800 years, from 2 Jan
5401 BC to 31 Dec 5399. As a guide, the accuracy of the standard planets
around the current era is estimated to be as shown in the following table.
Dates

Planets

Accuracy

1980 – 2000

all planets

< 0.01”

1600 – 1980

Sun – Jupiter

a few 0.1”

1600 – 1900

Saturn – Neptune

a few ”

1900 – 1980

Saturn – Neptune

a few 0.1”

1910 – 1980

Pluto

< 1”

Moon

a few ”

2000 – 2160

2000 – 2010
1750 – 2169

For a more detailed explanation of how the accuracy is estimated, see the
Swiss Ephemeris website at www.astroch.com/swisseph.
When Solar Fire calculates heliocentric positions, they are true dynamic
positions, and have no corrections applied. Their geocentric positions are
corrected for nutation and light time delay, and therefore correspond
closely to the positions published in the "The American Ephemeris"
(ACS), for example.

Asteroids
The asteroid positions in Solar Fire are calculated from ephemeris files.
The main asteroids (Ceres, Pallas, Juno, Vesta) are available for the full
range of the Swiss Ephemeris (2 Jan 5401 BC to 31 Dec 5399). The likely
accuracy is a few arc seconds in 1600 AD and a few arc minutes in 3000
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BC.
The supplied supplementary asteroids are also calculated from
ephemerides supplied by Mark Pottenger, and cover the period 1900 to
2100 approximately.

Chiron
As a result of close encounters with Saturn in Sept. 720 AD and in 4606
AD, Chiron’s orbit beyond this time range is uncertain. Chiron’s position
is therefore reliable only for the time between 700 AD and 4650 AD.

Hypothetical and Experimental Planets
The planet Vulcan, the Transneptunian planets and TransPluto are not
officially discovered planets, but are important in esoteric and Uranian
astrology. They should be treated as experimental. Their true accuracy is
therefore unascertainable at this time. However, efforts have been made to
ensure that their calculated positions agree with the orbits that have been
proposed and are in general use for these bodies.
The Lilith used in Solar Fire is the one popular in Europe, and it is also
called the Black Moon. This is not actually a hypothetical planet, but rather
the geocentric position of the empty focus of the moon’s orbital ellipse (the
earth being at the other focus). Solar Fire gives the Black Moon’s mean
position.

House Cusps and Chart Angles
The house cusps, and chart angles (Ascendant, Midheaven, Equatorial
Ascendant and Vertex) are accurate for all dates limited only by the
uncertainty of changes in the earth’s rotation rate (sometimes called
DeltaT). Solar Fire uses the best available Swiss Ephemeris calculations to
determine these changes. However, there is still an inherent uncertainty of
about 15 minutes of time around 1500 BC, and possibly several hours
around 3000 BC.

Progressed Charts
Mean Progressions
A progressed chart for a particular date is calculated by determining the
time elapsed since the birth or event chart, and applying a progression rate
to the elapsed time to get a progressed elapsed time, and then adding that
progressed elapsed time to the birth or event chart date. For example,
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secondary progressions are based on a correspondence of one year to one
day. Therefore a progressed chart for a time and date 32.745 years after the
birth time and date is calculated as a natal chart would be for a time and
date 32.745 days after the birth time and date.
Once the planetary positions are determined in this manner, the progressed
Midheaven is calculated according to the currently selected method of
angles progression, and then the other chart angles are derived from the
Midheaven according to the chart’s location.
True Progressions
Instead of using a progression rate determined from mean periods, it is
possible to base the progression calculation upon true (fluctuating) periods.
This is of practical use with progression rates which are based on the
moon’s cycles, because the moon’s cycles do fluctuate significantly with
time. Solar Fire offers this option in relation to the tertiary progressions of
fixed charts (but not in the dynamic module). In this case one is assuming
that each true lunar cycle corresponds to one day in the progressed chart,
so the calculation involves finding the exact times of the lunar returns
before and after the target date, and interpolating between these to find the
exact fractional lunar cycle to add to the number of completed lunar cycles
at the target date. The resulting number of lunar cycles is the number of
days by which to progress the chart.

Directed Charts
Zodiacal Directions
A chart is directed by adding a fixed arc to every point in the chart,
including the chart angles. Therefore a directed chart maintains the same
aspects as the chart upon which it is based, but different zodiacal positions.
In Solar Fire, the fixed arc that is applied is determined by the arc of the
secondary progressed Sun’s longitude, or by the arc of the derived
Ascendant or Vertex once the Midheaven has been progressed by the same
longitude as the secondary progressed Sun. Which of these methods is used
depends on which method of directions is currently selected for the chart or
dynamic report.
Primary Mundane Directions
Primary directions are created by the diurnal rotation of the earth about its
own polar axis. Hence each planet or chart angle is directed along its own
diurnal arc, starting from its natal position. Each degree of rotation is
deemed to correspond to 1 year in the life of the individual. Aspects are
deemed to be formed between directed and natal planets when their relative
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positions in their diurnal arcs are in angular relationship. (Note that this is
quite different from aspects of zodiacal longitude.). For example, if the Sun
is natally situated in the 10th house at 90% along its arc from its rise to its
culmination, then Saturn will be in natal mundane square to it when it is
directed to a position in the 1st house which is at 90% along its arc from its
nadir to its rise across the horizon. If this occurs after Saturn has been
directed by 24.5 degrees along its diurnal arc, then it is deemed that
directed Saturn makes a mundane square to the Sun when the individual is
24 and a half years old.

Return Charts
Chart Point Returns
A return chart is calculated for the exact date and time that a chart point
returns to its longitude in the base chart. If the base chart uses the tropical
zodiac, then the return is to the same point in the tropical zodiac (unless it
is precessed). If it is sidereal then the return is to the same point in the
sidereal zodiac. The program iterates in time to find the correct date and
time of the return. For planets other than the Sun, Moon and Earth, an
approximation to the time of the return is found initially by doing a
heliocentric return. (For Mercury, Venus and Vulcan, an Earth return is
used.) A search is then made for geocentric returns on either side of the
heliocentric return date, until the date or angle exceeds the possible limits
for finding further geocentric returns.
In the calculation of returns, the accuracy of the return time is calculated
by dividing the accuracy of the planet's position by the speed of the planet
at the time of the return, both for the natal chart and for the return chart,
and these are added together. This method gives a reasonable assessment
of accuracy in most cases. However, the accuracy of Pluto returns outside
the range 1890-2099 is likely to be much worse than is indicated by this
method.
Wynn-Key Return
This chart is calculated with the planetary positions for the date for which
the Wynn-Key chart is required, but the chart angles are based on the
preceding and following Solar return chart angles. The R.A. of the
midheaven is determined by interpolating between the R.A.s of the two
Solar Returns (which are typically about 6 hours apart), based on the
proportion of time that has elapsed between them at the required date.
Progressed Solar Return
This chart uses planetary positions determined by a performing a
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secondary progression of the planets in the preceding Solar Return, to the
date of the required return chart. However the chart angles are determined
by interpolating between the R.A.s of the midheavens of the preceding and
following solar returns. The progressed R.A. of the midheaven is deemed
to move through an entire rotation in addition to the exact difference
between the two R.A.s of the returns (ie. about 30 hours altogether). The
R.A. of the resulting chart is based on the proportion of time that has
elapsed between the two returns at the required date. This return type is
also known as a Progressed Solar-Sidereal Return (or PSSR) chart.

Harmonic Charts
An harmonic chart is calculated by multiplying the longitude of each base
chart point and angle by the harmonic number, and then reducing the
resultant numbers to the range 0 to 360. The house system in the resulting
chart is based on the position of the harmonic ascendant.

Antiscia and Contra-Antiscia Charts
These charts are calculated by taking the "mirror image" of each planet and
asteroid about an axis of longitude. There are two methods of calculating
such charts in this program.
Antiscia - 0 Degrees Capricorn
The axis about which the mirror image is taken is 0 degrees of Capricorn
and Cancer.
Points in a natal chart which are tightly conjunct or opposite points in its
antiscia chart are thought to be points of personal self-fulfillment (ie.
indicators of in what areas the individual is self sufficient and does not
require a relationship in order to be fulfilled.)
Contra-Antiscia - 0 Degrees Aries
The axis about which the mirror image is taken is 0 degrees of Aries and
Libra.
Points in a natal chart which are tightly conjunct or opposite points in its
contrascia chart are thought to be points of public self-fulfillment (ie.
indicators of fame).

Arc Transform Charts
The arc transform chart is simply an harmonic chart whose harmonic
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number is determined by the arc between the two selected planets or chart
points, as follows.
1. Arc = Longitude of 2nd Planet - Longitude of 1st Planet
2. If Arc is -ve then change it’s sign to +ve
3. Harmonic = 360 / Arc
Note: If the Arc is less than about 1 second of arc, then the harmonic would
be unacceptably high, resulting in an UN-meaningful chart. Hence, to
avoid problems in this case, the harmonic is set to 1.

Combined Charts
A combined chart is calculated by taking an "average" of two or more base
charts, to produce a single representative chart. There are five methods for
calculating combined charts in this program.
Composite - Midpoints
The midpoint of the shortest arc joining each chart point, angle and house
cusp within the two base charts becomes the position of that point in the
new chart. Note that it is sometimes possible for the house cusps to be out
of expected order after this method is applied. See page 361.
When calculating any type of composite charts, Solar Fire first determines
the composite longitudes, and then determines the composite right
ascensions separately. Thus any right ascensions for a composite chart in
Solar Fire are true composite right ascensions rather than right ascensions
of composite longitudes.
Composite - Derived Ascendant
The midpoint of the shortest arc joining each planet, asteroid and the
Midheaven within the two base charts becomes the position of that point in
the new chart. The chart angles and house cusps are then derived from the
Midheaven according the new chart's latitude.
Composite Group - Derived Ascendant
The average position of each planet, asteroid and the Midheaven along the
shortest arc joining them within each of the base charts becomes the
position of that point in the new chart. The chart angles and house cusps
are then derived from the Midheaven according the new chart's latitude.
Robert Hand describes this method in detail in his book "Planets in
Composite".
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Relationship - Davison
The new chart is calculated as if it was a natal chart for the midpoint in
time, latitude and longitude of the two base charts.
Coalescent
This is a method which was developed fairly recently by Lawrence
Grinnell and David Dukelow, and is published in a booklet “Coalescent
Horoscopes - A New Method of Synastry” published by ACS Publications
in 1992. To determine each planet’s coalescent position, first find the
shortest arc between the pair of planets in the two base charts and divide
this by 360 degrees to get the harmonic factor. Next, multiply the position
of the planet which has the earliest zodiacal position by the harmonic
factor. This must be repeated for each pair of planets and for the
Midheavens. The authors of this technique recommend using the Meridian
house system to derive the coalescent house cusps from the coalescent
Midheaven.

Locality Charts
Geodetic
The planetary positions are calculated as for an ordinary natal chart.
However, the angles of the chart are determined solely by the location of
the chart, and are not influenced by its date or time.
Using the Longitude method, the longitude of the Midheaven is determined
as the longitude of the Sun minus the longitude of the chart. (East is -ve.)
Using the R.A. method, the R.A. of the Midheaven is determined as the
R.A. of the Sun minus the longitude of the chart.
The ascendant and other chart angles are then derived according to the
chart’s latitude.
If a user-defined geodetic offset is being used, then this offset is added to
the position of the Sun (either it’s longitude or its R.A., as appropriate).
Johndro
This chart type is very similar in principle to the Geodetic chart type,
except that a precessionary factor is added to the position of the Sun. This
factor was 29°10’ of R.A. in 1930, and increases with time at the rate of
precession of the equinoxes (about 46.1 seconds of arc per year). Using the
longitude method, the precession in R.A. is converted to an equivalent
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precession in longitude before it is added to the longitude of the Sun.

Prenatal Charts
Although most astrologers place much emphasis upon the chart of the time
of physical birth of an individual, there is also a school of thought which
says that the physical birth is not the only time for which a useful chart can
be cast.
In esoteric thinking it is suggested that the incarnation of a human being
starts on the spiritual plane, descends to the mental plane, then the
astral/emotional plane, and finally to the physical plane when birth takes
place. If charts can be determined for the times at which incarnation onto
the mental and astral/emotional planes occurred, then they would provide
astrologers with insight into the mental and emotional aspects of the
individual, and thus provide a fuller picture of how the individual functions
at different levels, and how interactions between these levels occur.
The earliest known reference to prenatal charts is in the “Tritune
Hermitas”, which states that the chart of conception (which is usually
about nine months prior to birth) has positions of the Moon and Ascendant
which are interchanged from those of the natal chart.
The concept of prenatal charts has been adopted and developed by several
astrologers in more recent times, such as Sepharial, Johndro, Charles
Jayne, E.H. Bailey and Gustav Schwickert and as a result there are now a
number of other prenatal chart types which have been proposed. For
example, in addition to the time of conception (fertilization of the egg),
the time of quickening or animation (first independent movement by the
fetus) is also thought to be especially important. Two of the
aforementioned eminent astrologers (Charles Jayne and E.H. Bailey) who
undertook a lifetime study of prenatal charts, seem to concur from their
independent research that these charts reflect mental (thinking) and
emotional (feeling) aspects of an individual, respectively, as distinct from
the birth chart itself which reflects outer physical events and sensations.

Bailey’s Prenatal Charts
E.H. Bailey worked mainly with just these two types of prenatal charts, as
well as with charts of descent, which are charts of monthly lunar returns
during the gestation period. Solar Fire includes four types of charts based
on his methods, listed below.

Bailey’s Prenatal Charts
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Prenatal
Epoch of

Abb
.

Prenatal
Interval

Chart InterRelationship

Lunar
Phase

Luminary
/Angle

Conception

C

10 lunar
months

 Syz B Asc

-

Asc Syz B


Quickening

Q

5 lunar
months

 Cnj B 

-

-

Asc Cnj B Asc

Birth (C)

B

0

 Syz C Asc

-

Asc Syz C


Birth (Q)

B

0

 Cnj Q 

-

-

Asc Cnj Q Asc
Syz=Syzygy (ie. Conjunct or Opposite); Cnj=Conjunct; Opp=Opposite; Asc=Ascendant

Bailey’s conception chart is based closely on the simple method described
in ancient times of swapping the birth Moon and Ascendant positions,
although he allows syzygies as well as direct swapping. (Thus the
conception Moon may be on either the birth Ascendant or Descendant, and
the conception Ascendant can be on either the birth Moon or its opposite
point.) He also uses a method of sex determination based on a Hindu
division of the zodiac into male and female divisions. This method is based
on the assumption that the conception chart must confirm the sex of the
individual. Therefore, Solar Fire allows you to specify whether the
individual for whom you are casting a conception chart is male or female,
and Solar Fire then automatically eliminates those possible conception
times which would give the wrong sex. Solar Fire also allows you to alter
the prenatal interval used. For example, if you know that the individual
was born a few weeks premature, then you could choose to base the
calculation on 9 lunar cycles instead of the usual 10. As with many of the
other types of prenatal charts, Solar Fire offers you a choice of all the
prenatal charts that fit the given criteria. In the case of conception charts,
there are potentially up to 4 possible charts per month, so you may find
that Solar Fire offers up to 8 different possibilities. Solar Fire makes a
recommendation of which chart to use by highlighting that chart on the list.
However, it is up to you to choose which one best fits the requirements.
Solar Fire makes its recommendation based on Bailey’s method, which
involves looking at i) the order of the natal chart, and ii) the rectified birth
time.
The natal lunar phase and position indicate the order of the natal chart. If
the moon is above the horizon and waxing then it is a first order chart, or if
waning then it is a second order chart. If the moon is below the horizon and
waxing then it is a third order chart, or if waning then it is a fourth order
chart. Bailey recommends that if the natal chart is of the first or fourth
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order, then you should look for a shorter gestation than average, and if it is
of the second or third order, then you should look for a longer gestation
than usual.
Bailey recommends that you use a chart which confirms the birth time as
closely as possible by his rectification method, which involves determining
what the birth time would be if the proposed conception chart were used to
re-derive the natal chart. To this end, Solar Fire indicates this “rectified”
birth time for each possible conception chart.
Solar Fire finds the chart which most closely matches these criteria. If you
have any knowledge of the actual term of gestation, ten you may wish to
alter the choice of chart to one which more closely matches the known
period of gestation.
After generating any prenatal chart, use rectification and predictive
techniques to confirm whether or not the chart you have is valid.
Bailey’s quickening chart is based on the 5th converse lunar return from
the birth chart. The time at which the Ascendant returns exactly to its natal
position on this day is the time for the quickening chart. Thus, the Moon’s
position is usually a few degrees away from its natal position in this chart.
Solar Fire also allows you to experiment with the number of lunar cycles
used in this chart. This calculation offers only one possible chart for the
required number of lunar cycles, so no further choice needs to be made.
The Bailey Birth charts (C) and (Q) are included to allow you to reverse
the calculation, and derive a birth chart from a conception (C) or
quickening (Q) chart. For example, if you have a possible conception date
and time, then you can use this to create a normal natal type chart by
entering this date and time in Solar Fire’s New... option in the Charts
menu, and then use this as your base chart for the calculation of a Bailey
Birth (C) chart. The resulting chart is then a predicted birth chart, based on
the given conception time. In this case Solar Fire also indicates whether the
base chart shows that a male of female would be born, before calculating
the chart. A similar procedure can be used if you have a possible time for
the quickening of a pregnancy. You can create a normal natal type chart by
entering this date and time in Solar Fire’s New... option in the Charts
menu, and then use this as your base chart for the calculation of a Bailey
Birth (Q) chart. The resulting chart is then a predicted birth chart, based on
the given quickening time.

Jayne’s Prenatal Charts
According to Charles Jayne, there are 16 significant times (or prenatal
epochs) prior to birth for which charts may be cast. There are 16 epochs
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because there is one prenatal epoch for each planet (10 known and 6
hypothetical). Jayne has developed an extensive and comprehensive
philosophical basis for these charts, and discusses them in depth in several
of his papers and books.
Jayne’s Hypothetical Planets
Vulcan

period 25 days

Rex

period 40 months (focused in the asteroid belt)

Sigma

period 13.93 yrs

Isis

period 384 yrs sidereal

Morya

period 640 yrs sidereal

Lion

period 1610 yrs sidereal

Jayne also postulated that, following the birth chart, there are another 32
charts which may be cast for an individual (2 for each planet), and these
are known as post-natal epochs. Thus the total number of charts for an
individual is 49 in total. These charts are somewhat more complex to
calculate than the prenatal charts, and have not been included in Solar Fire.
However, all 16 prenatal epoch charts have been included. These are listed
below.

Jayne’s Prenatal Charts
Prenatal
Epoch of

Abbr

Prenatal
Interval

Chart InterRelationship

Lunar Phase

Luminary
/Angle

Chiron

Y

13.2 yrs

Independent

Trine 
(in 5th)

Sunrise

Sigma

S

9 yrs

Cnj C Asc

NM applying

Sunset

Jupiter

Z

8 yrs

Opp F MC

NM or FM
separating

 Cnj MC

Rex

H

7 yrs

Opp C MC

NM applying

Noon

Venus

R

6 yrs

Opp T Asc

NM or FM
separating

Moonset

Mercury

W

5 yrs

Opp B MC

NM or FM
separating

Noon

Vulcan

G

4 yrs

 Syz B Asc

NM or FM
separating

Sunset

Sun

O

22.3 mths

Independent

FM

Noon
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applying/sepa
rating
Moon

Q

15.7 mths

Independent

FM
applying/sepa
rating

Moonrise

Lion

U

11 mths

 Syz B Vtx

-

Sunrise

Uranus

C

9 mths

 Syz B Asc

-

Asc Syz B 

Isis

I

7.5 mths

 Syz B MC

-

Midnight

Pluto

T

6.5 mths

Independent

QM applying

 Syz MC

Neptune

A

5 mths

 Syz C MC

-

Midnight

Morya

F

3 mths

Independent

QM applying

 Syz Asc

Mars

E

2 mths

 Syz C Vtx

-

Sunrise

Saturn

B

0

 Syz C Asc

-

Asc Syz C 

NM=New Moon; FM=Full Moon; QM=Quarter Moon; Syz=Syzygy (ie. Conjunct or
Opposite); Cnj=Conjunct; Opp=Opposite; Asc=Ascendant; MC=Midheaven; Vtx=Vertex

Calculation Procedure for Jayne’s Prenatal Charts
1. A starting date is derived by applying the Prenatal Interval, as tabulated
above.
2. If the Chart Inter-relationship involves the sun, then two times are
derived by moving forward and backward from the starting date to
satisfy the inter-relationship. This results in two starting times which
will be one year apart.
3. If there is a Lunar Phase to be satisfied, then further times are derived
by moving forward and backward from the starting times produced in
previous steps, in order to satisfy these phase requirements. This will
produce times which are one lunar month (27.3 days) apart if there is a
single lunar phase (such as QM applying), or half a lunar month if there
are two possible phases (such as NM or FM separating). This results in
twice as many starting times as there were before this step.
4. Each starting time is moved forward and backward until the
luminary/angle relationship is satisfied. This results in twice as many
starting times as there were before this step.
As a result of these steps, Solar Fire may offer the user up to 8 possible
time/date combinations for prenatal chart. It is up to you to choose which
one best fits the requirements. Solar Fire indicates how far the charts had to
be adjusted to match their starting date and times. The following example
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shows the choices that Solar Fire offers when calculating a Jayne Mercury
prenatal chart. The first number on each line is the deviation from the
given prenatal interval. Because this prenatal chart involves matching the
position of the Sun with the natal IC, we end up with two groups of
possible charts - one between 193 and 178 days later, and one between 172
and 187 days earlier than the given prenatal interval (Step 2). Within each
of these groups we have 4 further possibilities, based on the Moon being
either new or full, and the time moving either forwards or backwards to be
conjunct the Midheaven (ie. local noon). The second item on each line is
how many degrees the moon is away from exactly satisfying the required
phase.

For example, the first suggested chart above occurs 193.2 days later than
the average prenatal chart of this type, and has a lunar position which is
12.4 degrees away from being either a full or new Moon. Of the visible
options, the fourth item (-178.2 Days / -0.8 Degs) would appear to give the
overall closest match. However, Jayne suggests that the chart which most
closely matches the given prenatal interval or lunar phase is not necessarily
the correct chart. Therefore, he recommends that you calculate ALL of the
possible charts, and then use your own judgment, as well as rectification
and predictive techniques to confirm whether or not each individual
possible chart is the valid one. In particular Jayne used directions of
longitude of Solar Arc, Ascendant Arc and Vertex Arc, both direct and
converse to confirm timing of events. He also directed the declination by
each of these arc methods, and used parallels and contra-parallels of
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declination in timing of events.
Jayne’s conception chart, Uranus (C), is similar to Bailey’s except that the
sex of the individual is ignored. The possible conception charts offered by
this option are the same as those offered by Bailey’s conception chart if the
male and female options were combined. Another difference, however, is
that Jayne’s method does not lend itself to allowing a different term of
pregnancy to be specified. Instead, Jayne hypothesized that short term
births occurred at other prenatal epochs, such as the Morya F or Mars E
epochs.
Jayne’s quickening chart, Neptune A, differs more markedly from
Bailey’s. Whereas Bailey’s method involves replicating the position of the
natal Moon and Ascendant as closely as possible, Jayne’s method involves
finding a syzygy between the Moon and the conception Midheaven, and
then adjusting the time to give a midnight (Sun on the IC) chart.
Jayne’s birth chart (C) may be used to predict possible birth dates and
times based on a natal type chart which has been calculated for the
proposed time of conception. However, unlike Bailey, Jayne believes 1)
that the true conception chart does not necessarily occur at the time of
physical conception, and 2) that the luminary/angle relationship of the
chart does not need to be exact. Therefore this method would not be able to
predict an accurate birth time. However, this chart calculation method is
included in Solar Fire for completeness and to allow experimentation.
A number of other charts in this list require another prenatal chart to have
been calculated before they can be used. The list below summarizes which
prenatal charts are based on other prenatal charts.

Epoch

Based on

Sigma S

Uranus C

Jupiter Z

Morya F

Rex H

Uranus C

Venus R

Pluto T

Neptune A

Uranus C

Mars E

Uranus C

Saturn B

Uranus C
or Natal
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For example, to calculate a Neptune chart, you must first calculate a
Uranus chart, and then use that as the base chart for the calculation of the
Neptune chart.
Jayne’s Law of Sex
Solar Fire does not apply any adjustments to account for the sex of the
individual whose prenatal charts are being cast. However, Jayne does
suggest applying small adjustments to the position of the Moon or Sun in
relation to the chart’s angles, depending on which of these two is used in
the Luminary/Angle calculation of the chart in question.
“Lunar charts taking place at moonrise or moonset have the Moon about
half a degree below the Ascendant or about half a degree above the
Ascendant for women, whereas for men the Moons are slightly cadent
instead of slightly angular, ie. are about half a degree on the other side of
the horizon. Of course this is before rectification. In lunar charts with the
Moon on the MC or IC there is no known law as to which side of the
meridian they must fall. In solar charts for men, occurring at noon or
sunrise, the Sun is slightly angular, ie. is in the 10th or 1st houses, but is
slightly cadent for women. If a solar chart occurs at midnight or sunset for
men the Sun is slightly cadent, but for women is somewhat angular.
Specifically in female midnight charts (such as A and I) the Sun is 3
degrees inside the fourth house. It is not known how the law of sex works in
the charts of homosexuals.”
For example, when casting a Jayne Mercury prenatal chart, the
luminary/angle calculation is “noon”, meaning that the Sun is on the
Midheaven. Therefore this is a solar chart, so the time of the chart should
be adjusted slightly to cause the Sun to move into the 10th house for a
man, or into the 9th house for a woman. Adjusting the time by about 2
minutes will effect a change of about half a degree in the Midheaven. This
can be done most easily by viewing the chart and then using Solar Fire’s
Rectify... button which allows the chart time and angles to be easily
changed.

Interpreting Prenatal Charts
As prenatal charts have only been used by few western astrologers until
now, there is a lack of published material explaining how to use them in a
practical way. This situation may change in the future, but for the time
being the reader is referred initially to the original authors of the
techniques used for an explanation of how to interpret and use them. In
particular, refer to E.H. Bailey for directions on how to use Bailey
Conception and Bailey Quickening charts, and to Charles Jayne for
directions on how to use the various Jayne prenatal charts.
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The conception and quickening charts of Bailey and Jayne have also
received some coverage in astrological journals and publications, but
Malvin Artley, an American astrologer and esotericist, is currently (early
1995) writing a manuscript which will give a comprehensive explanation
of the meaning and use of conception and quickening charts in relation to
their esoteric associations with the mental and astral/emotional aspects of
man. He has already published an article in the FAA journal (see
references) which gives examples of the ways in which these charts work.
It is as a result of his work and inspiration that these prenatal charts have
been included in Solar Fire.
Artley suggests several ways in which the conception, quickening and birth
charts can be interpreted, using the correspondence of conception chart to a
mental chart, and of quickening chart to an astral/emotional chart. He
recommends working with the these two charts in addition to the birth
chart in order to get a complete picture of an individual’s physical,
emotional and mental make-up.
Firstly one can look at the sign placements of the Suns in each of these
three charts, for example the birth chart may have a Capricorn Sun, the
astral chart a Leo Sun, and the mental chart an Aries Sun. Whilst this
person would displays the traditional Capricornian traits, they are also
likely to be somewhat generous and attention-seeking emotionally, and
rather impetuous and quick-thinking mentally.
Further, one can look at each of the three charts to find which one has the
most difficult aspects, and this would indicate the level (physical,
emotional or mental) on which that individual had the most work to do in
their lifetime. For example, individuals with relatively “easy” aspects in
their mental chart may have much more stressful aspects in their emotional
chart, indicating that whilst they may be intellectually talented, they have
greater difficulty in coping with emotions.
Artley also suggests a technique of interpretation based on displaying the
conception, quickening and birth charts in a triwheel, with the conception
chart innermost and the birth chart outermost. In this way one can examine
the positions of the key planets, such as the Sun, in each chart in relation to
the houses of the conception chart. Using the correspondence of conception
to mental and of quickening to astral, this defines the flow of energy from
the mental, to the astral, to the physical plane. For example if the mental
Sun is in the 6th house, the astral Sun is in the 11th house, and the physical
Sun is in the 3rd house, then that is the major path for descent of psychic
energy - from the 6th to the 11th to the 3rd, and thus the major house of
outer life expression is the 3rd.
Finally, Artley has investigated methods of determining which of the 7
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rays (as defined in esoteric teachings, such as those of A.A. Bailey) are
most strongly represented in each of the charts, thus arriving at a ray
profile for the individual. This may be of particular interest to esoteric
astrologers.
The table below is a summary of keywords that have been used to describe
some of the charts and what they signify, by their authors. These are brief,
but never-the-less will probably give sufficient hints for an experienced
astrologer to begin experimenting with them.

Chart Type

Keywords / Meaning

Bailey Birth (C)

Birth - Physical events, sensation, outer security

Bailey Birth (Q)
Jayne Birth (C)
Bailey Conception

(Mental) Thinking, conceiving

Bailey Quickening

(Astral/Emotional) Feeling & emotion

Jayne Vulcan

Isolation, will & persistence

Jayne Uranus (C)

(Mental) Thinking, conceiving, individuality

Jayne Sigma

Endings & accomplishments, karma

Jayne Isis

Inspiration - Fiery feeling of the Heart, yearning,
aspiration

Jayne Mercury

-

Jayne Neptune (A)

(Astral/Emotional) Feeling & emotion, sentimentality

Jayne Rex

Intuitiveness, elusiveness, nurture

Jayne Lion

Understanding - Education & civilization, synthesis
and integration

Jayne Mars

Ego - Instinct & Intuition

Jayne Morya

Fate - What one has to endure, accept and transmute in
life

Jayne Pluto

Ties - What binds one and holds one back

Jayne Moon

Mother, the body

Jayne Sun

-

Jayne Chiron

-
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Jayne Venus

-

Jayne Jupiter

-

Note that although no specific meaning was given by Jayne to the Sun,
Mercury, Venus, Jupiter and Chiron epoch charts in the references below,
he named his charts to reflect the energy of the planet that they are named
after. Hence one could interpret the Sun chart as relating to identity and
vitality, and the Venus chart as relating to relationships with women and
acquisitions, for example.
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Chart Hylegs
Solar Fire calculates chart hylegs in one of its reports as well as in a page
object. The hyleg is a planet, or a position in the chart, which is
representative of the life and vitality of the native. Unfortunately there is
currently no universal consensus on precisely how the hyleg should be
determined, even though the general principles are not disputed. Various
astrological authors have written on the matter, and we have attempted to
incorporate our best understanding of some of these by creating a set of
algorithms for their calculation. These are as follows.
•

Bonatti/Lehman - Based on J. Lee Lehman (et al)’s derivation of
Bonatti, as described in “Medieval Methods of Longevity
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Measurement: A Pilot Study” The Astrological Journal Volume 42,
No. 1, Jan/Feb 2000, p60.
•

Omar/Bonatti - Based on Omar's method as described in "Three
Books on Nativities" by Omar of Tiberius, Translated by Robert
Hand, Project Hindsight, Latin Track, Volume XIV. This method
was also described by Bonatti as translated in “Tools & Techniques
of the Medieval Astrologers” by Robert Zoller.

•

Ptolemy - Based on Ptolemy's method as described in p39-41 "Night
& Day - Planetary Sect in Astrology" by Robert S. Hand - ARHAT
Monograph #1

These methods use data settings stored in two required files –
HYLEG.ALM and HYLEG.ASP. Certain details of these calculations may
be altered by the user by editing HYLEG.ALM in Solar Fire’s main
directory with the Dignity/Almuten editor, or by editing HYLEG.ASP in
Solar Fire’s aspect set editor.

Bonatti/Lehman
This calculation uses rulerships and all other options specified in the 1st
definition in the HYLEG.ALM file - these may be edited by the user, but
by default these are as follows:
* Traditional rulerships
* Dorothean Triplicities
* Egyptian Terms
* Signs start at 0 degs
* Default houses
* 8,5,3 degree house cusp offsets (for ang, suc, cad houses)
* Different Day/Night Part of Fortune
* 5 points for rulerships
* 4 points for exaltations
* 3 points for (each of the three) triplicity rulers
* 2 points for term ruler
* 0 point for face ruler (ie. face will not be used in this calculation)
* No points for any other items
* Degree Dignities
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* Applies to both Diurnal and Nocturnal charts
1. Check if Sun is in 1st, 10th or 11th houses (apply house cusp offsets
specified in HYLEG.ALM). If so, then the Sun is the hyleg. If not, then go
to the next step.
2. Check if Sun is in 7th, 8th or 9th house, and is also in a masculine sign.
If so, then the Sun is the hyleg. If not, then go to the next step.
3. Check if Moon is in a feminine sign and not in a cadent house. If so,
then the Moon is the hyleg. If not, then go to the next step.
4. Check if chart is conjunctional (i.e. Moon is waxing). If so, then check if
any of the 5 rulers of the Ascendant's position are forming an aspect to the
Ascendant. Check each of the following rulers which have a non-zero
score in HYLEG.ALM: Domicile ruler, Exaltation, Triplicity in Sect,
Triplicity out of Sect, Triplicity participating, Term, Face. If any one or
more make an aspect (according to aspects and orbs specified within
HYLEG.ASP), then the Ascendant is the Hyleg. If not, go to next step.
5. Check if chart is conjunctional (i.e. Moon is waxing). If so, then check
for aspecting rulers of the Part of Fortune's position as described in step 4.
If any make an aspect, then the Part of Fortune is the Hyleg. If not go to
the next step.
6. Check if chart is conjunctional (i.e. Moon is waxing), and find the
position of the Conjunctional Moon (ie. preceding NEW Moon's position =
NM). If so, then check for aspecting rulers of the NM's position as
described in step 4. If any make an aspect, then the NM's position is the
Hyleg. If not go to the next step.
7. Check if chart is preventional (i.e. Moon is waning). If so, then check
for aspecting rulers of the Part of Fortune's position as described in step 4.
If any make an aspect, then the Part of Fortune is the Hyleg. If not go to
the next step.
8. Check if chart is preventional (i.e. Moon is waning). If so, then check
for aspecting rulers of the Ascendant's position as described in step 4. If
any make an aspect, then the Ascendant is the Hyleg. If not go to the next
step.
9. Check if chart is preventional (i.e. Moon is waning), and find the
position of the Preventional Moon (ie. preceding Full Moon's position =
FM). If so, then check for aspecting rulers of the FM's position as
described in step 4. If any make an aspect, then the FM's position is the
Hyleg. If not go to the next step.
10. If the Hyleg has not been found in any of the previous steps, then the
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chart is deemed to have no hyleg.

Omar/Bonatti
Differences from the Bonatti/Lehman method - the Sun and Moon can be
Hyleg only if they have a ruler (domicile, exaltation, triplicity or term)
making an aspect to them. In the Bonatti/Lehman method (above), they can
still be hyleg even without any such aspect existing.
This calculation uses rulerships and all other options specified in the 2nd
definition in the HYLEG.ALM file - these may be edited by the user, but
by default they are the same as above.
1. Check if Sun is in 1st, 10th or 11th houses (apply house cusp offsets
specified in HYLEG.ALM). If so, then check if any of the 5 rulers of the
Sun's position are forming an aspect to the Sun. Check each of the
following rulers which have a non-zero score in HYLEG.ALM: Domicile
ruler, Exaltation, Triplicity in Sect, Triplicity out of Sect, Triplicity
participating, Term, Face. (By default, face is not included because it has a
zero score. The user may include it by assigning face a non-zero score). If
any one or more make an aspect (according to aspects and orbs specified
within HYLEG.ASP), then the Sun is the Hyleg. If not, go to next step.
2. Check if Sun is in 7th, 8th or 9th house, and is also in a masculine sign.
If so, then check for aspecting rulers of the Sun's position as described in
step 1. If any make an aspect, then the Sun is the Hyleg. If not go to the
next step.
3. Check if Moon is in a feminine sign and not in a cadent house. If so,
then check for aspecting rulers of the Moon's position as described in step
1. If any make an aspect, then the Moon is the Hyleg. If not go to the next
step.
All remaining steps from 4 to 10 are identical to the previous definition.

Ptolemy
Note that Ptolemy’s method always results in a hyleg being found, whereas
Omar’s and Bonatti’s may not.
This calculation uses rulerships and all other options specified in the 3rd
and 4th definitions in the HYLEG.ALM file - these may be edited by the
user, but by default they are the same as follows.
* Traditional rulerships
* Ptolemy Triplicities
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* Ptolemy Terms
* Signs start at 0 degs
* Default houses
* 5,5,5 degree house cusp offsets (for ang, suc, cad houses)
* Different Day/Night Part of Fortune
* 5 points for rulerships
* 4 points for exaltations
* 3 points for (all three) triplicity rulers
* 2 points for term ruler
* 1 point for face ruler
* No points for any other items
3rd definition
* Summation Points: Sun, Ascendant, Pre-natal NM
* Minimum Honors: 3
* Applies to Diurnal charts
4th definition
* Summation Points: Moon, Part of Fortune, Pre-natal FM
* Minimum Honors: 3
* Applies to Nocturnal charts
"Prorogative" houses are the 1st, 7th, 9th, 10th, 11th
1. If a daytime chart then check if Sun is in a prorogative house (apply
house cusp offsets specified in HYLEG.ALM). If so, then the Sun is the
Hyleg. If not then check if Moon is in a prorogative house. If so, then the
Moon is the Hyleg. If the Hyleg was not found, then go to next the step.
2. If a nighttime chart then check if Moon is in a prorogative house. If so,
then the Moon is the Hyleg. If not then check if Sun is in a prorogative
house. If so, then the Sun is the Hyleg. If the Hyleg was not found, then go
to next the step.
3. If a daytime chart then find the almuten according to the 3rd definition,
and if a nighttime chart, then us the 4th definition instead. If this results in
Appendix C: Calculation Methods 427

a point being found with a non-zero score, then that is the Hyleg. If the
Hyleg was not found, then go to next the step.
4. If the Moon is waxing, then the Ascendant is the Hyleg. If the Moon is
waning, then the Part of Fortune is the Hyleg.
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Appendix

Appendix D: Format of the Orbital
Elements File
Solar Fire’s “Other Bodies” report lists the positions of various astronomical
bodies for the time of any chart. The list of bodies that appear in this report
may be edited by the user, so that it is possible to add new bodies to the
report, or to remove existing ones.
W

To see the “Other Bodies” report

1. Select the Current Chart option from the Reports menu
2. Scroll down the list of report types to last report on the list, and select
it.
When Solar Fire is first installed, the bodies included are The Dark Moon
(elements according to Waltemath), and all of Charles Jayne’s hypothetical
planets (Sigma, Pan, Isis etc.)
The orbital elements for these bodies are contained in editable text files
called “extras.dat” and “jayne.dat”, in Solar Fire’s USERDATA directory
(usually called C:\SOLFIRE\USERDATA or similar). You can create any
number of similar files and select them from within Solar Fire, provided
that you put them in this same subdirectory.
It is possible for the user to add orbital elements for any other
geocentrically or heliocentrically elliptically orbiting bodies. For example,
you could add the elements of recently discovered body QB1992. However
it is not possible to add elements for parabolic orbits, so you cannot add the
Hale-Bopp comet, for example.
These files are comma-quote delimited (CQD), which means that they are
text files in which character strings are enclosed in quotes, and each item
on a line is separated by a comma from the next entry.
The data for a each body takes 8 lines of text, and must follow the
prescribed format exactly. Following is an example of how the data must
be entered for a single body (Sigma).
Example of Format
"***Name Abbr Symbol",

"Sigma", "Sig", "S"

"BaseYr/Epoch/Geo/Prec.", 19350107.0, 0, 0, 1
"Semimajor Axis",

5.789593, 0, 0, 0
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"Eccentricity",

0.26, 0, 0, 0

"Inclination (Degs)",

5.0, 0, 0, 0

"Perihelion (Degs)",

2.0, 0, 0, 0

"Node (Degs)",

161.0, 0, 0, 0

"Mean Anomaly (Degs)",

137.5489, 2584.1766225,
0, 0

A description of each of the 8 lines follows.
Line 1 - Comment, Name, Abbr, Symbol
Comment - (Text) This is for reference only, and contains a reminder of
the items on this line.
Name - (Text) This is the name of the body which will appear in reports in
Solar Fire, containing up to 20 characters.
Abbr - (Text) This is a 3 or 4 letter abbreviation of the name of the body.
Symbol - (Text) This is a single character representing the body.
Line 2 - Comment, BaseYr, EpochYr, Geo/Helio Flag, Precession Flag
Comment - (Text) This is for reference only, and contains a reminder of
the items on this line.
BaseYr - (Numeric) The date (expressed either as a decimal year number
YYYY.yyyyyyyy or as a decimal year date YYYYMMDD.ddddd) for
which the following orbital elements were calculated..
EpochYr - (Numeric) The date (expressed either as a decimal year number
YYYY.yyyyyyyy or as a decimal year date YYYYMMDD.ddddd) of the
standard ecliptic for which these orbital elements were calculated. If this is
set to 0 (zero), then the EpochYr is taken to be the same as the BaseYr.
Geo/Helio Flag - (Numeric) Set to 0 (zero) if the orbit is a heliocentric one,
or to 1 (one) if it is a geocentric one.
Precession Flag - (Numeric) Set to 0 (zero) if the orbital elements apply to
the Tropical (precessing) zodiac, or to 1 (one) if the elements apply to the
fixed zodiac of the EpochYr date. When set to 1, the orbital elements are
precessed to the date of the calculation, whereas when set to 0, no
precession is performed.
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Lines 3 to 8 - Comment, Orbital Elements
Comment - (Text) This is for reference only, and contains a reminder of
the items on this line.
Elements - Each line has 4 numeric items. These items are used to
calculate the elements for a specific date in the following manner.
X = Item1 + Item2 * t + Item3 * t² + Item4 * t³
where t is time since the BaseYr date, expressed in decimal centuries (if
the EpochYr date is prior to yr 2000) or in decimal millennia (if the
EpochYr date is yr 2000 or later).
In many cases where the elements are approximate, items 2, 3 and 4 may
be zero. However, they must still appear on the line as zeros, in this case.
Line 3 – Semi-Major Axis
This must be in astronomical units (1 = average earth/sun distance). This
item is ignored for bodies which have a geocentric orbit.
Line 4 - Eccentricity
This must be in units of eccentricity (0 = circular orbit).
Line 5 - Inclination
This must be the inclination of the orbit to the ecliptic, in degrees.
Line 6 - Perigee/Perihelion
This must be the position of perigee or perihelion in degrees. (Note that
this is not the same as the “argument of the perihelion”, which is equal to
the position of the perihelion minus the position of the north node.).
Line 7 - Node
This must be the position of the north node in degrees.
Line 8 - Mean Anomaly
This must be the mean anomaly in degrees. If the second item on this line
is set to 0 (zero), then the rate of change of mean anomaly is automatically
calculated from the semi-major axis instead, according to the formula:
Daily Motion = 0.9856076686 / (Semi-Major Axis)1.5
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Appendix

Appendix E: Text and Data Supplied
with Solar Fire
Solar Fire includes data and interpretations from a variety of sources. This
data is immediately available to the user once Solar Fire is installed.

Chart Data
Solar Fire includes two chart databases - The Clifford Data Compendium
and the Australian Data Collection.

The Clifford Data Compendium
The Clifford Data Compendium presents the birth data of 500 famous
individuals in a number of areas from entertainment to sport, politics to
religion. It incorporates some of the most accurate data of leading figures
found in other collections whilst including many data collected by the
author, and some never before published.
The charts are contained in the file clifford.cht (and their biographies are in
the file clifford.chm).
Each data entry has notes presented in the following format:
Source - Details of where the data originated from (if not from the author’s
archives) and the classification of the data is in brackets (see Data
Accuracy below)
Real Name - If available and differing from name given
Profession - The various vocations for which the individual is primarily
known
Biography - A short biography, including a few dates for further study
Some entries incorporate birth details of related individuals.
Data Accuracy
It is vital any data collections presented to the astrological community be
as accurate and fully sourced as possible. There may, however, be the
occasional update to this collection, and the author welcomes any
corrections or additions.
All data are classified using the simple Rodden Rating system.
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AA - Data from Birth Certificates (BC), hospital or governmental birth
records (BR), notes from Vital Statistics/Registries, family bibles, baby
books, family written records. This is the best evidence of data
accuracy available.
A - Data from the person, family member, friend or associate. Also
included are newspaper birth announcements. Times given within a
‘window of time’ of thirty minutes (eg. “between 3.30pm and 4.00pm”)
are presented here.
B - Data from biographies and autobiographies where no other source is
given.
C - Caution, data not validated. No source, vague, rectified/speculative
data, “personal” ambiguous sources, approximate birth times (eg.
“early morning”, “around lunchtime”).
DD - Dirty Data. Two or more unsubstantiated quotes of time, place or
data (perhaps rectified without designation). Any unverified data that
are contradicted by another source.
All data presented in this collection are of AA, A or B standard.
Unverified data have not been included.
Abbreviations found in the Notes section:
FCC - Author Frank C. Clifford
RR - Rodden Rating - a data classification system (see above)
GBAC - The Gauquelin Book of American Charts
CAH - Contemporary American Horoscopes
Data Bibliography
Most of the data presented have been personally checked by the author
himself, and in most cases the actual Birth Certificate or Birth Record/Note
is in hand. Many thanks to my international colleagues for sharing data
and collected BCs and BRs over the last few years, including Thelma &
Tom Wilson, Dana Holliday, Edwin Steinbrecher, David Fisher, Sally
Davis, Francoise Gauquelin, Tashi Grady, Linda Clark, Caroline Gerard,
Lois Rodden, Marion March, and Grazia Bordoni.
The Gauquelin Book of American Charts (ACS, 1982). Accurate BC data
by Michel & Francoise Gauquelin
The House of Commons (1992-7) by Caroline Gerard. Available from: 6
Belford Mews, Dean Village, Edinburgh EH4 3BT, Scotland (£8).
The Astro-Data series. Five volumes and Data News by Lois Rodden,
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covering a variety of data.
Contemporary American Horoscopes. BC data from Janice Mackey and
Jessica Saunders, 1990. Available on computer disk from Astrolabe.
A special thank you to Edwin Steinbrecher for providing access to his
database and BRs. The Steinbrecher Data Collection is a comprehensive
database of 20,000 timed data (+ 6000 noon charts). See the website:
http://www.dome-igm.com/dome/
About the author
Frank C. Clifford is an astrologer, palmist and data collector. His data
interests include running the Data Exchange Network to swap data with
international collectors, working with the Astrological Association’s Data
Section, and checking data/biography for many magazines and books. His
non-astrological work includes script-writing, broadcasting and
researching. Frank lives in London and can be contacted via Flare
Publications. His first data book “British Entertainers: The Astrological
Profiles” is available from Flare Publications (SF), P.O. Box 10126,
London NW3 7WD, England, UK. UK orders - checks or postal orders for
£11.50; International orders - an International Money Order for £17. All
prices include S&H.
Please do not send cash, unless by
guaranteed/registered delivery.

The Australian Data Collection
This is a collection of more than 250 charts of famous Australians (and
immigrants) and Australian events, all sourced, and some with
biographical notes and important dates. This data was compiled by
Australian astrologer Stephanie Johnson, with contributions from other
astrologers around the world.
The charts are contained in the file aussie.cht (and their biographies are in
the file aussie.chm).

Interpretations Text
The interpretations text in Solar Fire was written by Stephanie Johnson PC
(FAA) of Esoteric Technologies Pty Ltd. Text Copyright © 1994-2000
Esoteric Technologies Pty Ltd.
The interpretations in the file STANDARD.INT relate to natal geocentric
charts. It can also be used fairly effectively with various other types of
charts, such as return charts or progressed charts, provided that the reader
bears in mind the original purpose of the text, and adapts it to the new
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context. For example, the interpretation of the Sun in the 5th house in a
return chart will only apply for a period of 1 year, whereas the text was
written to refer to enduring traits that would result from this placement in a
natal chart.
The interpretations in the file TRANSITS.INT relate to transits to a natal
charts.
The interpretations file SYNASTRY.INT relates to synastry between two
natal charts.
Not all possible categories of interpretations are covered in these files
given the vast number of possible combinations that need to be potentially
catered for. For example there is no text relating to aspects between the
TransNeptunians and planets.
You are, however, free to add you own text to either of these files, or to
create your own interpretations files from scratch, by using the
Interpretations Compiler supplied with Solar Fire.
Copyright Restrictions
All text included with Solar Fire is copyrighted, but the licensed owner of
Solar Fire is granted permission to use any output printed or exported from
Solar Fire for the purpose of providing astrological charts and reports
generated by Solar Fire to friends or clients. This text must not otherwise
be reproduced or copied without the express permission of the copyright
holder. This text may also be edited before distribution, provided that the
copyright of any portions of original text is respected and acknowledged
where appropriate.
If you print reports using text supplied with Solar Fire, then you should
ensure that Esoteric Technologies’ copyright notice appears on the report.
If you have added some of your own text, then you might like to add a
copyright notice which applies to the text you have written yourself, for
example
Main Text (c) 1993-97 Esoteric Technologies Pty Ltd
Portions of Text (c) 1998 Mary Smith
If you are printing reports which use your own text exclusively, then there
is no need to include any copyright notice relating to Esoteric
Technologies.
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Fixed Stars Data and Text
The fixed star file BRADY.FST contains data and interpretations for 50
fixed stars. This file was compiled by Bernadette Brady Dip. (FAA) from
her work in progress “Fixed Stars and Stained Glass”. Bernadette has done
all her research on fixed stars working with parans, so she suggests that the
best results can be achieved with this star file by using the Star Parans
report rather than the Star Aspects report in Solar Fire. She recommends
using an orb of 15 to 20 minutes of arc when using the Star Paran report.
She has included coding of + and - signs with some star names to indicate
stars which are especially positive (+++) and those that may prove very
difficult (---). Text Copyright © 1995 Bernadette Brady.
The fixed star file PTOLEMY.FST contains a number of stars that were
commonly used in the era of Ptolemy. This file was also compiled by
Bernadette Brady. The keyword text for each star in this file identifies its
nature in terms of planetary symbolism (eg. Jupiter for a star which has a
Jupiterian nature), and its long text identifies which position in its zodiacal
symbol this star takes. Text Copyright © 1995 Bernadette Brady.
The fixed star file ALLSTARS.FST contains data on about 290 of the most
commonly used stars, but has no interpretations text. It was generated by
importing the fixed star file that is supplied with the NOVA program, and
is included by kind permission of Astrolabe, Inc.

Arabic Parts
The Arabic Parts file supplied with Solar Fire contains all the Arabic Parts
which are supplied with the NOVA program, and is included by kind
permission of Astrolabe, Inc.

Asteroids
Solar Fire is supplied with ephemerides for 38 additional asteroids which
have been supplied under license from Mark Pottenger. The ephemerides
cover the period 1900 to 2100.
It is possible to obtain additional asteroid ephemerides either from Mark
Pottenger or from the Astrodienst web site at www.astroch.com/swisseph.

Eclipses
Solar Fire’s eclipse data has been extracted from Fred Espenak’s
(NASA/GSFC) web pages at sunearth.gsfc.nasa.gov/eclipse/eclipse.html
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which include comprehensive and accurate astronomical eclipse data
covering many millennia.
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Appendix F: Bibliography
Those who are interested in reading further may wish to refer to some of
the following publications. There are, of course, many other high quality
astrological publications available, and this list is simply intended to be a
starting point for those wishing to know more.

General Astrology
Alan Oken's Complete Astrology - Alan Oken - Publ. Bantam Books
Choice Centered Astrology - Gail Fairfield - Publ. Ramp Creek Publishing,
Inc.
Synastry - Penny Thornton - Publ. The Aquarian Press
The Astrologer's Companion - John Filbey & Peter Filbey - The Aquarian
Press
The Twelve Houses - Howard Sasportas - Publ. The Aquarian Press

Predictive Astrology
Planets in Transit - Robert Hand - Publ. Whitford Press
Solar and Lunar Returns - John Filbey - Publ. Aquarian Press
The Eagle and the Lark - Bernadette Brady - Publ. Samuel Weiser, Inc.
The Progressed Horoscope - Alan Leo - Publ. Destiny Books

Locational Astrology
Planets in Locality - Steve Cozzi - Publ. Llewellyn
Planets on the Move - Maritha Pottenger and Zipporah Dobyns - Publ.
ACS Publications
The Geodetic World Map - I. I. Chris McRae - Publ. American federation
of Astrologers Inc.

Medieval & Classical Astrology
Carmen Astrologicum - Dortheus of Sidon - Translated D.Pingree - Publ.
Ascella Publications
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Christian Astrology - William Lilly - Publ. Regulus Publishing Company
Ltd
Classical Astrology for Modern Living - Dr. J. Lee Lehman - Publ.
Whitford Press
Essential Dignities - J. Lee Lehman Ph.D. - Publ. Whitford Press
Night and Day: Planetary Sect in Astrology - Robert S. Hand - Publ.
ARHAT and Golden Hind Press
Tetrabiblos - Ptolemy - Translated F.E. Robbins - Publ. Harvard Uni. Press
Three Books on Nativities – Omar of Tiberias – Translated R. Hand – Publ.
Project Hindsight (Latin Track Volume XIV)

Esoteric Astrology
Esoteric Astrology - Alice A. Bailey - Publ. Lucis Publishing Company
Soul-Centered Astrology - Alan Oken - Publ. Bantam Books
The Best of Charles Jayne - Charles Jayne - Publ. American Federation of
Astrologers Inc.
The Labors of Hercules - Alice A. Bailey - Publ. Lucis Publishing
Company
The Sabian Symbols as an Oracle - Lynda Hill & Richard Hill - Publ.
White Horse Books
The Prenatal Epoch - E.H. Bailey - Publ. Samuel Weiser Inc.
The Sabian Symbols in Astrology - Marc Edmund Jones - Publ. Aurora
Press
Transpersonal Astrology - Errol Weiner - Publ. Element, Inc.

Other Specialized Topics
Asteroid Goddesses - Demetra George - Publ. ACS Publications, Inc.
A Handbook of Medical Astrology - Jane Ridder-Patrick - Publ. The
Penguin Group
Finding Our Way Through the Dark: The Astrology of the Dark Goddess
Mysteries - Demetra George - Publ. ACS Publications Inc.
Natural Fertility - Francesca Naish - Publ. Sally Milner Publishing
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Planets in Composite - Robert Hand - Publ. Whitford Press
The Black Moon Book - F. Santoni & Demetra George - Publ. Sum Press.
The Combination of Stellar Influences - Reinhold Ebertin - Publ. American
Federation of Astrologers Inc.
The Lunation Cycle - Dane Rudhyar - Publ. Aurora Press
Interpreting the Eclipses – Robert Carl Jansky – Publ. Astro Computing
Services

Astronomical Calculations and Computing
Astronomical Algorithms - Jean Meeus - Publ. Willman-Bell, Inc.
Astronomical Formulae for Calculators - Jean Meeus - Publ. WillmanBell, Inc.
Mathematical Astronomy Morsels – Jean Meeus – Publ. Willman-Bell, Inc.
Horoscope Calculation - J.A. Eshelman - Publ. American Federation of
Astrologers, Inc.
Planetary Programs and Tables from -4000 to +2800 - P. Bretagnon & JL. Simon - Publ. Willman-Bell, Inc.
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Appendix G: Changes from Version to
Version of Solar Fire
Changes from Version 4.x to Version 5
Following is a list of the major and most notable changes that have been
made for v5 of Solar Fire. A large number of smaller changes have also
been made, but have been excluded from this list for the sake of clarity and
brevity.
32 Bit - Solar Fire v5 is now a fully compiled 32bit Windows program,
running on Windows 32 bit platforms such as Windows 95, 98, NT4 and
later releases. It is now able to access the full power of the 32 bit computer
chips (such as Pentium processors), and take advantage of powerful
operating system features, such as long file names.
State of the Art Calculation Accuracy – Planetary calculations now use
the Swiss Ephemeris™, based on JPL (Jet Propulsion Laboratory) data,
providing state of the art accuracy across more than 10,000 years. The full
set of Swiss Ephemeris asteroid files may now also be used with Solar Fire
(available for free via web download or at low cost on CD).
Astro-Locality Mapping – A new mapping module is included to allow
planetary, eclipse path and local space lines to be viewed on a selection of
world maps. This module is compatible with (and may be upgraded to)
Solar Maps as a fully comprehensive mapping package.
Astrologer’s Assistant – a new and very powerful task automation feature
which allows you to record various tasks and then save them for replay at
any time. For example, you could record a task to print a chart, calculate a
progressed chart and transits chart for the current date, display them
together in a triwheel and print them, run a dynamic report with a years
transits and progressions and then print that out. This set of tasks can then
be replayed for any other starting chart at the click of a button.
Animated Charts and Pages – any chart or viewable page can now be run
as a real-time astrological clock, or animated backwards or forwards in
time using customizable time steps.
New Chart File Structure – a new chart file storage structure allows users
to save almost all kind of charts generated within Solar Fire, including
progressed, directed and composite charts, for example. Solar Fire v5 is
backwards compatible with all earlier version chart files, and can
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optionally save to earlier chart file formats if required. Comments may
now also be saved with subsidiary charts, and enhanced chart comment
editing features make it possible to access and edit chart comments whilst
casting a chart, as well as at any stage prior to saving it. Chart files may
now be accessed from (or saved to) any location on your computer or
network.
Toolbar Buttons – a fully customizable toolbar contains graphical buttons
for all frequently used option in Solar Fire, allowing quicker access to
commonly used features.
Screen Customization – the user may now easily select background colors
and graphics for the main screen and all data viewing screens (such as
chart viewing pages), and save these preferences along with other color
selections in named Color Schemes. These allow different colors to be
selected for use with a printer, thus obviating the need to change color
selections when printing.
Synastry Reports – full text for synastry reports has been included as part
of the standard interpretations text base, and is easily accessible via a new
menu item.
Eclipse Data – 5000 years of accurate solar and lunar eclipse data has been
included, plus a module to allow flexible searching based on chart
contacts, eclipse types, Saros numbers etc…
Page topic index – displayed chart pages may now be selected via a
customizable topic index, where pages can be grouped into categories such
as Beginner, Classical, Cosmobiology, Esoteric, Vedic etc. Many new page
object have been added such as square (traditional and vedic) charts, dasas
and bhuktis, flexible listings of asteroids, arabic parts, fixed stars and other
bodies, etc.…
Email Support – Chart data and graphical data (such as chart page
displays) may now be saved into JPG file format for easy attachment to
emails, and (for MAPI compliant email programs like MS Outlook and
Eudora) the email program is automatically launched with the data file/s
already attached or listed in the body of the message.
ASCII Data Export – a powerful and highly flexible method of exporting
chart details and or positions of planets, midpoints, asteroids, stars, Arabic
parts etc., which can be read in by other programs such as spreadsheets or
other astrology programs.
Enhanced Dynamic Reports – it is now possible to view dynamic events
of one person’s chart in relation to another person’s radix planets, to merge
multiple reports into a single listing, and to include a greater range of extra
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dynamic points, such as fixed stars and asteroids.
Enhanced Graphic Ephemeris – you can now see an ephemeris of
declination or latitude, and also include extra dynamic points such as
planetary midpoints.
Enhanced Atlas – greatly expanded with more time zone information, and
more forgiving automatic lookup facilities. Default place may now have an
automatic timezone lookup on startup, thus allowing automatic adjustment
for daylight savings periods. Also the user may select a list of favorite
places for quick and easy default location changes.
Enhanced Wheel Designs – Chart wheels may now have multiple house
and zodiac rings, so that both the tropical and sidereal zodiac can be
displayed on the same chart, for example. Different chart rings in a wheel
may retain their own house cusps instead of always anchoring on the inner
chart’s house cusps. A ring of user-defined additional points may also be
displayed with a planets ring, including points such as asteroids, stars,
arabic parts etc.
Enhanced Reports – new Planetary Differences report, new Midpoint
Weighting Analysis (MWA) report, Adjusted Calculation Date (ACD),
Chart Hylegs, star parans displayed in local times, etc.

Changes from Version 3.x to Version 4
Following are the main changes that have been made for v4 of Solar Fire.
A number of smaller changes have also been made, but have been excluded
from this list for the sake of brevity.
New Chart Types: True Tertiary Progressed, Arc Transform, Relocated,
Johndro, Geodetic, Progressed Solar Return, Wynn-Key Return, Lunar
Phase Return
Page Designer: The user may design page layouts including items such as
wheels, grids, points lists, house cusp lists, dignity tabulations, midpoint
trees, modulus sort strips, balance of element and mode. There are about
50 different types of object which may be placed onto a page design,
moved and resized at will. A variety of useful pre-designed pages are also
supplied.
Graphic Ephemeris: A flexible and elegant graphic ephemeris may be
viewed and printed, either with or without radix planetary positions. A
novel features is the ability to display aspect symbols wherever dynamic
points cross radix positions.
User Definable Aspects: There are a variety of new aspecting options,
Appendix G: Changes from Version to Version of Solar Fire 443

including moieties, unidirectional aspects, and the ability to add any
number of user-defined aspects.
Dial Pointers: Dials now have moveable pointers, showing midpoints and
aspects as the dial is rotated.
Enhanced Rectify Assist: The ascendant may now be adjusted directly,
and the user has a choice of step increments when adjusting times or
angles.
Dignity/Almuten Editor: The manner in which essential dignities are
calculated may be specified by the user. Also, it is possible to define
complex almuten calculations whose results are displayed in a tabulation.
Extra House Systems: Several extra house systems have been added,
including Alcabitius.
Interpretations In-place editor: Interpretations may now be edited inplace, without the need to compile them, which greatly simplifies the
editing process.
256, Hi-color and True-color screen support: Colors of signs, planets
and aspects may now be chosen from the full range of possible colors.
Additional Asteroids: 38 additional asteroids are now available in reports
and certain page objects. It is also possible to install further asteroids.
Dynamic report - extra points: Dynamic reports may now include
transiting, progressing or directed midpoints for any combination of chart
points. Also, the radix chart may also include midpoints, fixed stars,
Arabic Parts and asteroids.
Dynamic report - primary directions: Dynamic reports may now use a
method of Primary Mundane directions.
Planet Search facility: It is possible to search any chart file for planets in
signs, houses, or in aspect to other planets or positions, and to combine
search criteria to perform a complex search.
Chart Details Comments May Be Printed: It is possible to print
summaries of chats or chart files, including chart details and optionally
also any chart comments included with the charts.
TimeZone Tables for Solar Fire Place Database: The Solar Fire place
database now allows the use of user editable timezone tables. These tables
have been populated for several countries.
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Changes from Version 2.x to Version 3
Following are the main changes which have been made for v3 of Solar
Fire. A number of smaller changes have also been made, but have been
excluded from this list for the sake of brevity.
Context Sensitive Help: Help may be invoked by using the F1 key
anywhere in Solar Fire.
New Chart Points: 8 TransNeptunians, TransPluto, Black Moon Lilith
(mean)
New Chart Types: Tertiary, Minor and User Rate Progressed; Ascendant
Arc and Vertex Arc and User Arc Directed; Coalescent; Prenatal (18 types,
including conception and quickening); Rising/Setting using either visual or
true altitude; Transiting and Progressed Lunar Phases.
Savable Charts: Return, Ingress, Prenatal and Relationship charts may
also now be saved to a chart file.
Retainable Charts: Any selection of calculated charts may be retained for
an indefinite number of future Solar Fire sessions. Retained charts appear
immediately in the list of calculated charts when Solar Fire starts up. Any
type of chart may be retained, including composite and progressed charts,
for example.
Opening Charts: It is possible to search for a chart through all your chart
files at once. Chart names may be displayed in a variety of orders to help
find the charts you want. Charts may be opened from Nova type chart files
transparently.
Chart Comments: Virtually unlimited comments or text may be added to
any saved chart, and this text may be easily browsed or edited whilst
opening the chart.
Deleting Charts: Any number of calculated charts may be selected for
deletion all at once.
Rectifying Charts: The date of a chart may now be altered in addition to
the time and the midheaven. This makes it possible to cross date
boundaries when attempting to rectify charts whose times are close to
midnight.
Displayed Points: It is now possible to select a set of displayed points to
apply to a single chart instead of to all charts. This makes it possible, for
example, to view only the outer planets in a transits chart outside all the
planets in a natal chart.

Appendix G: Changes from Version to Version of Solar Fire 445

DTP: Any chart or grid displayed in Solar Fire may now optionally be
copied to the clipboard or to a file in Windows Metafile format. This
allows scaleable Desk-Top-Publishing quality charts to be viewed and
printed in many other programs.
Draconic Zodiac: The Draconic zodiac may be selected for the calculation
of any new chart, in addition to the existing zodiac types. Draconic charts
may be mixed with other types of charts in biwheels and reports, for
example.
Angle Progression Methods: Solar arc in longitude and right ascension;
Naibod in longitude and right ascension, mean quotidian (also known as
daily houses). These may be used both in progressed charts and in dynamic
progressions.
Progressions Day Type: May be either Standard or Bija
Lunar Parallax: The moon’s position may optionally be adjusted to take
account of the location on the earth’s surface. This correction may be used
in any chart or dynamic report.
Vulcan Calculation: The position of Vulcan may be calculated using
either the orbital parameters proposed by L.H. Weston, or the theory of
D.Baker.
Dials: Any displayed wheel may easily be viewed as a 90 degree dial. The
wheel designer may be used to design dials of any modulus for viewing in
Solar Fire.
Wheel Designer: All of the supplied wheel and dial display styles are
editable with a supplied utility program. You can also create your own
designs from scratch if you prefer. Editable features include zodiac glyph
style, house cusp style and arrows, color fills, planet and degree positions,
and much more.
New Dynamic Reports Features: Dynamic reports may use any
progression or direction method. From a dynamic report you can: View
interpretations of a dynamic event (eg. Transiting Uranus Square Natal Sun);
Export all the interpretations for the report to a file for editing or printing in a
word-processor; View a list of similar events, including the number of exact
hits before and after the report; View a list of aspects made to the radix chart
by an eclipse or stationary point; View a chart for the time of the dynamic
event; View a graphical Time Map for all the items in the report.
New Reports: Horary - planetary day and hour, almutens of houses,
ancient dignities, point count per planet; Sensitive points - zodiacal
positions at which aspects are made to chart’s planets; Midpoint Modal
Sort - zodiacal midpoints sorted by mode; Arabic Parts - zodiacal positions
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and aspects to chart’s planets; Star Aspects - zodiacal positions and aspects
to chart’s planets plus keywords for each star; Star Parans - list of stars in
paran to chart’s planets plus keywords for each star; Planetary Nodes zodiacal positions of each planet’s nodes and aspects to chart’s planets
Planetarium: Any chart may be displayed on the celestial sphere with
fixed stars in the background. Special features are: Click on a planet to find
the nearest star; Double click on any star to get full information, including
an interpretations (where available); View the sphere in equatorial,
ecliptical or local coordinates, from the side or towards either pole; Rotate
the celestial sphere by clicking on a scroll-bar; Highlight any constellation
by selecting it from a list
Time Map: Any dynamic report may be displayed graphically with bar
lines indicating entering and leaving orbs along a time scale. This is
scrollable and printable to allow all events in the report to be viewed.
Interpretations: Solar Fire is supplied with 2 sets of interpretations - one
for natal charts and one for transits to a natal chart. It is also possible to
specify a different default interpretations file for up to 7 different types of
charts or dynamic events, if you create or acquire other interpretations sets.
For example, you can use one set of interpretations for a natal chart, and
another set for a solar return chart.
Interpretations Compiler: This now keeps track of all the text files
related to a set of interpretations, and allows them to be edited directly
from the compiler using Windows Notepad, Windows Write or any other
word-processor of your choice.
Fixed Star Editor: Technical data and interpretations text my be entered
for any fixed stars or other astronomical objects for use in the planetarium
and fixed star reports.
Arabic Parts Editor: Any combinations of A+B-C may be entered for use
in the Arabic Parts report.
Ephemeris Generator: It is possible to browse or print an ephemeris for
any combination of planets and asteroids for virtually any time period and
using any time interval.
Utilities Menu Editor: Any program may be added to the utilities menu so
that it may be called up directly from Solar Fire.

Changes from Version 1.x to Version 2
Windows 3.1: Due to use of Truetype fonts, v2 requires Windows 3.1 - it
will no longer run on Windows 3.0.
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Improved Accuracy: Planets are now accurate to within several seconds
of arc in most cases, with the Sun accurate to one second of arc.
Use of Glyphs: Through the use of specially created fonts, all reports may
now be viewed on the screen or printed with either word abbreviations or
the graphical glyphs of signs, planets and aspects, according to your
choice.
Status Bars: Status bars have been added to the top and bottom of the
main menu screen. These shows the current date, time, location and a
continually updated ascendant, midheaven and planetary positions.
Retrograde planets are shown in red.
Additional Menu Help: Whilst the menu is being browsed the bottom
status bar gives a fuller description of whichever menu item is being
browsed.
Chart Edit: Any calculated natal chart may now be copied and edited (for
example to alter the house system) by a simple menu selection.
Chart Delete: Any calculated chart may be deleted from the list of
calculated charts by a simple menu selection.
Coordinate Systems: It is possible to create charts in heliocentric
coordinates. Heliocentric charts may be used alongside geocentric charts in
synastry grids and reports, biwheels, triwheels etc.
Zodiacs: It is possible to select either Tropical or any of 7 different
Sidereal zodiacs, plus the ability to define your own sidereal ayanamsa.
House Systems: There are two new house systems - Whole Signs and
Hindu Bhava.
Precession and Converse Charts: It is now possible to use precession or
converse timing with any progressed or return charts.
Return Charts: Planetary and asteroid return charts have been included.
Improved Place Database: It is now possible to easily edit, copy or delete
places on and between place database files (without having to "mark"
records first). It is also possible to type in a place name (or part of a place
name) on any screen requiring a place, and the details of that place will be
retrieved automatically from the current place database file, if a match is
found.
Dual Wheel Display: It is possible to view or print two separate wheels on
a single page.
Rectify Assist: It is possible to alter the time, or Midheaven angle of a
natal chart via a simple dialog screen, after which the chart is automatically
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redrawn.
Faster Chart Display: Due to use of special Truetype fonts, chart displays
are faster than in version 1.2x.
LMT Support: Typing "LMT" in any timezone box will cause the LMT to
be calculated automatically from the longitude.
Chart Compliments: Up to six lines of text may be entered to appear on
printed charts as compliments text (ie. your name and address).
Pop-Up Menu: Clicking the right hand mouse button in the Chart View
screen causes a pop-up menu with all the display option to appear. It is
therefore possible to alter colors, displayed points, aspects etc., all without
leaving the chart viewing screen.
Charts without Aspects: It is possible to select options to prevent aspect
lines being printed in the center of any single wheels, or to prevent aspect
symbols being printed in the center of each aspect line.
Enhanced Copy Ability: It is possible to copy any report (including
dynamic reports) to the clipboard, with an option of either clearing the
clipboard first, or simply appending the report to the current contents of the
clipboard. In this manner, almost any number of reports can be "stacked
up" in the clipboard for later pasting into a word processor document, for
example.
3-D Aspects: (Also known as True Body Aspects) It is possible to select
an option so that all reported aspects will be 3-D aspects instead of aspects
of longitude and latitude or declination. (This option does not apply in
dynamic reports).
Applying/Separating Aspects: All reports and grids giving aspects have
been modified to show applying/separating. The calculation of these is
based on the actual rate of movement of each point involved in the aspect.
A separate orb angle may now be specified for applying and separating
aspects.
Editable Rulerships and Weightings: Modern, Old, Esoteric and
Hierarchical rulerships are supplied with the program. It is possible to edit
and alter these, or to add your own definitions of rulerships of signs and
decanates, exaltations and falls. You may also alter the weightings applied
to planets, asteroids and other chart points for reports containing
assessments of the balance of modes, elements and rays.
Midpoint Reports: Four new reports have been added - 1) Chart point
sort (any modulus), for one or two charts combined; 2) Midpoint listing in
planetary order or by zodiacal position (any modulus), for one chart, or for
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one chart combined with the primary positions of a second chart. This may
be used to examine transiting positions relative to the midpoints of a natal
chart, for example; 3) Midpoint axes (any modulus or orb); 4) Midpoint
trees (any modulus or orb). Also the existing Aspect Analysis report has
been amended to include a list of aspect patterns found in the chart
(Unaspected planets, stelliums, Grand Crosses, T-Squares, Kites, Grand
Trines, Mystic Rectangles, Yods, Focused Yods).
Dynamic Reports: It is possible to define a set of "radix points" to be used
in any dynamic reports, instead of the use of the "displayed points". All
dynamic options have been incorporated into a single comprehensive
module with the following capabilities:Transits to Radix, Transits to Transits, Transits to Progressions, Transits
to Solar Arc Directed, Progressions to Radix, Progressions to
Progressions, Solar Arc to Radix, House Ingress, Sign Ingress, Parallels of
Declination or Latitude, Stationary Points, Solar and Lunar Eclipses,
Entering and Leaving Orb, Precessed, Converse
It is possible to view reports using either graphical glyphs or name
abbreviations, both on the screen and printer. It is also possible to view or
print reports using the user-defined colors for each glyph.
On-line Interpretations: A major new feature is the ability to browse
through natal chart interpretations, plus basic definitions of a large variety
of items in a charts. By simply clicking on a particular part of any natal
chart which you have displayed in the chart viewing screen, you can
instantly browse through an interpretation. For example, if you click on a
planet, you will see an interpretation of that planet in its house and sign. If
you click on a house cusp, you will see an interpretation what the sign on
the cusp of that house means. If you click on the degree of a planet or
house cusp, you will see information about that degree of the zodiac. If you
click on a second planet (within 3 seconds of clicking on a first planet) you
will see an interpretation of the aspect between those two planets. The
following types of information are available in relation to a natal chart:
Balance of modes, elements, quadrants, hemispheres, rays, lunar phase,
chart point in house and sign, chart points rulerships and dispositor, list of
aspects to a point, interpretation of an aspect between two chart points.
The following general types of information are available (without referring
to a natal chart): Degrees, decanates, signs, modes, elements, houses,
quadrants, hemispheres, rays, aspects, chart points, houses, signs on cusps,
chart points in signs, chart points in houses, chart point aspecting another
chart point.
The information supplied with the program contains interpretations of
450 Solar Fire 5: Appendix

every planet in aspect to every other planet with a major aspect
(conjunction, opposition, trine, square, sextile, quincunx), every planet and
asteroid in each house and sign, and every sign on each house cusp, in
addition to information relating to individual degrees, signs, houses,
modes, elements etc.
Although the interpretations module has been designed specifically for use
whilst viewing charts, it is also possible to save all text relating to a chart
into a file, which may subsequently be edited or printed using a wordprocessing program, for example.
Interpretations Compiler: It is possible to edit/alter the interpretations
supplied with the program, or to add your own entirely new text with the
use of the supplied compiler. This reads through the source text files and
compiles them all into a single indexed file which Solar Fire can then use
to access any required paragraph of text almost instantly. It is possible to
include any of a huge variety of information types, as described above.
ACS PC Atlas: It is possible to use the ACS PC Atlas instead of the Solar
Fire place databases, if you have this installed on your computer.
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Appendix

Appendix H: Technical Details
Backing Up
In case of computer hardware failure, or other accidents, it is wise to have
made backup copies of certain key files on your computer.
The Solar Fire program can normally be reloaded from its original
installation diskettes should you ever experience a major problem. If your
original diskettes have become corrupt or unusable for any other reason,
then you can get a replacement copy by contacting you astrological
software dealer, usually at a nominal cost.
However, to avoid losing any data files that you may have created or saved
during the course of your usage of the Solar Fire program, (which therefore
cannot be reloaded from the installation diskettes), you should create your
own backup of the data files associated with the program.
Solar Fire has a built-in utility that helps you backup your chart files (see
page 380), but there are also other file types that you may want to backup.
There are a variety of methods that can be used for backing up files,
including simply copying them to diskettes, or using the DOS BACKUP
command, or using the Windows Backup utility, for example.
Whichever method you use, you should always backup all the files that are
in the following directory.
Solar Fire’s \USERDATA directory
If you have edited interpretations of any kind, then you should also back up
file in the following directory.
Solar Fire’s \INTERPS directory
If you have modified any of Solar Fire’s standard system page files (not
user-defined pages), almuten definition files (general.alm, essdig.alm,
house.alm), timezone file (timezone.fil) or any other files which reside in
Solar Fire’s main directory, then you may also want to ensure that those
files are backed up.
If you are accessing chart files from any location other than Solar Fire’s
USERDATA directory, then you should also back them up.
If you backup these files, and keep you original installation diskettes, then
you can recover from a disaster as follows.
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Re-install Solar Fire using the installation diskettes
Restore the backup files for the Solar Fire USERDATA directory
Restore the backup files for the Solar Fire INTERPS directory
It is recommended that you perform backups on a regular basis, or at least
after those occasions when you have created large numbers of new charts
or maps etc.

Uninstalling Solar Fire
W

To uninstall Solar Fire
1.

Select Settings / Control Panel from the Start Menu

2.

Select Add/Remove programs

3.

Find Solar Fire v5 on the list, and highlight it

4.

Click on the Add/Remove button

If you have installed Solar Maps or Solar Spark into the same directory as
Solar Fire, then you will need to re-install them after you have uninstalled
Solar Fire.

Files Types
The files on the Solar Fire installation disks have been compressed and are
automatically expanded to their normal size during the installation
procedure.
The following table describes some of the file types that are included in
Solar Fire’s directories.
Type

Description

*.adp

Aspected points

*.alm

Dignity/Almuten definitions

*.arp

Arabic Parts

*.asp

Aspect set

*.cas

Aspect colors

*.cht

Chart database

*.chm

Chart comments
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*.cpt

Chart point colors

*.csg

Sign colors

*.dat

Orbital elements file

*.di*

Dial design file

*.doc

Documentation text file

*.elm

Ephemeris element files

*.eph

Ephemeris files

*.fil

Data file

*.fst

Fixed stars

*.lst

List of files to install

*.mnu

Menu definition

*.pag

Page layout file

*.prp

Dynamic progressing points

*.pte

Extra ring points

*.pts

Displayed points

*.sta

Stationary points

*.trp

Dynamic transiting points

*.usr

User name file

*.wh*

Wheel design file
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Appendix

Appendix I: Technical Support
If you have a problem running your software, please first look for its
solution in the appropriate section in the manual, the on-screen help, and
the README.DOC file (in your Solar Fire directory; readable through
Windows Write, NotePad, WordPad or any other word processor). If you
cannot find the answer to your questions there, your call is welcome. We
understand that we provide software for astrologers, not computer
experts. If something mystifies you, we want to help.
It is useful to have your hardware information handy. For future
reference, you can write it here:
Computer brand, model and processor chip:
Amount of RAM memory:
Video Adapter (VGA? SVGA?):
Printer brand and model:
It’s also useful to have information shown in the Solar Fire Help menu’s
“About” selection:
Your Solar Fire serial number:
Your Solar Fire version number:
Your Windows version and version number:
System resources currently being used:
If you have received an error message, write it down and have it ready.
This can tell us exactly what the problem is. Also,
What job were you working on? Have you used that part of the program
before? Were you entering data for a new chart, importing data from
another program, or retrieving data from a file? Were you trying to make
something happen on the screen, or trying to print something out?
With this information at hand, contact Astrolabe techincal support by
phone at 508/896-5081 between 10am and 4pm ET, by fax at 508/8965289, in writing at PO Box 1750, Brewster MA 02631 or by email at
support@alabe.com.
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Index
A
Abbreviations
for aspects · 402
for signs · 400
Alcabitius Houses · 359
Almuten · See Dignity/Almuten
of house cusps · 312
Angle
format for entering · 383
Angle progressions · 353
Angle Rounding · 362
Animation · 193
controlling · 198
selecting alternative chart types ·
196
Antiscia
calculation method · 409
casting chart · 73
Arabic Parts
adding new · 256
editing · 254
page object · 311
part of fortune · 349
selecting · 212
selecting as almuten points · 284
selecting as extra radix points ·
222
Arc
user-defined · 355
Arc Transform
calculation method · 409
casting chart · 73
ASCII Definitions
editing · 102
Aspectarian · See Grid
Aspected Points · 333
Aspects · 333
3D (true body) · 248
adding user-defined · 250
advanced options · 247
changing · 24
changing line style · 247
changing orbs · 246
456 Solar Fire 5

colors · 210
colors · 341
copying · 214
creating a new set · 213
deleting · 214
displaying glyphs · 337
displaying lines · 336
dynamic report · 170
editing · 245
moieties · 249
page object · 313
renaming · 214
search · 57
selecting · 212
selecting for interpretations · 237
unidirectional · 249
Asteroids
accessing additional files · 226
accuracy · 405
editing · 224
page object · 311
selecting · 212, 224
selecting as extra radix points ·
222
supplier · 434
Swiss Ephemeris · 227
Astro_Locality Maps · 142
Astrologer’s Assistant · 372
Astrologer's Assistant
editing task list · 374
running on startup · 369
Atlas
refreshing index · 367
selecting · 366
Atlas, ACS · 39
connecting to · 6
radius search · 50
similar names · 49
using · 48
zone changes · 51
Atlas, Solar Fire · 39
timezone tables · 43
Australian Data Collection · 432
Auto Chart Save · 85, 368
AutoRun · 369

Ayanamsa · 357

B
Backing Up · 379, 449
Bhuktis · 326
Bibliography · 435
Biwheel
viewing · 23
Black Moon · 406
Brady, B.N. · 433

C
Calendar
display options · 364
Campanus Houses · 358
CCRS Program · 226
Chart
adding comments · 62
adjusting angles · 120
adjusting date · 120
adjusting time · 120
animation · 193
antiscia · 409
antiscia · 73
arc transform · 73
calculated · 13
calculation · 19
calculation methods · 406
casting · 26
coalescent · 75, 411
combined · 75, 410
comments · 13, 303
composite · 75
composite · 410
contrascia · 409
contrascia · 73
copy to clipboard · 119
copying · 61
current · 13
deleting · 61, 88
directed · 66, 407
displaying with eclipse · 147
editing · 60, 87
emailing · 96
exporting to other programs · 89

finding · 54
Geodetic · 83
harmonic · 409
harmonic · 73
here and now · 26
importing · 89
ingress · 69
ingress · 73
interpreting prenatal · 419
Jayne prenatal · 414
Johndro · 83
locality · 83
lunar phase · 81
lunar phase return · 81
moving · 62
new · 22
new · 25, 26
open · 53, 59
operations · 19
prenatal · 77, 411
presetting options · 25
printing · 204
printing summary · 63
progressed · 66, 406
radix · 164
rectifying · 119
relationship · 75
relationship · 410
relocating · 87
relocating · 83
retaining · 88
retrieving from file · 53
return · 23, 69, 408
rising or setting · 79
saving · 85, 368
selecting · 58
sending via email · 96
shortcuts for viewing · 115
stepping in time · 194
storage · 19
subsidiary · 65
traditional · 306
transit · 69
Vedic · 325
viewing · 110
viewing in Solar Maps · 144
Chart Comments
adding · 62
Index 457

entering · 38
page object · 303
Chart Data
Australian data collection · 432
Clifford Data Compendium ·
430
exporting · 100, 102
Chart File
changing description · 63
changing directory · 213
copying · 214
creating · 213
creating · 93
deleting · 214
finding charts · 54
finding planetary aspects · 56
finding planetary placements ·
56
importing from other programs ·
89
limitations · 64
printing summary · 63
renaming · 214
selecting · 212
selecting · 54
Chart Options · 331
Chart Points
colors · 210
copying · 214
creating a new set · 213
deleting · 214
editing · 216
progressing · 210
renaming · 214
selecting · 212
transiting · 210
Charts
composite · 360
conversion options · 367
email options · 368
Chiron
range of ephemeris · 406
Cities
retrieving from ACS PC Atlas ·
145
Clear Images · 118
Clifford Data Compendium · 430
Clock
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real time · 193
setting · 6
Coalescent
casting chart · 75
Color Schemes · 339
Colors
aspects · 341
background · 342
changing color depth · 344
copying · 214
creating a new set · 213
deleting · 214
editing · 251
points · 341
printer · 339
renaming · 214
scheme · 339
selecting · 212
signs · 341
Combined
calculation methods · 410
casting chart · 75
Compiling
interpretations · 242
Compliments · 363
Composite
casting chart · 75
Coordinate System
charts · 36
planetarium · 150
topocentric · 350
Copy
as bitmap · 126
as metafile · 126
chart or page to clipboard · 119
dynamic report to clipboard ·
179
graphic ephemeris as graphic ·
188
graphics · 125
Time Map to clipboard · 181
Copyright
of interpretations text · 433
Current Settings
viewing · 371

D
Dasas · 326
Date
chart · See Rectify Assist
entering · 27
format · 28
selecting format · 7
system · 12
Dates
options · 364
Davison Chart · See Relationship
Decompiling
interpretations · 242
Defaults · 347
Deleting Charts
calculated charts · 88
from files · 61
DeltaT · 406
Detriment · 404
Dial
options · 122
pointer · 121
rotating pointer · 122
using · 121
Dial Style · 334
design options · 268
editing · 266
selecting · 212
Dignity/Almuten
almuten · 282
creating · 281, 291
degree dignities · 281
diurnal applicability · 287
editing files · 279
page object · 317
point types · 283
saving changes · 281
scoring · 286
selecting house system · 291
selecting part of fortune · 291
selecting points · 282
selecting rulerships · 288
term type · 289
triplicity type · 288
Directions
calculation method · 407
casting chart · 66

dynamic report · 168
graphic ephemeris · 185
of midpoints · 169
of term · 321
page object, primary · 321
primary mundane · 169, 407
primary rate · 355
relocation · 356
to midpoints · 169
user-defined · 355
Displayed Points · 331
colors · 341
current chart · 332
graphic ephemeris · 187
Dynamic reports
colors · 173
Dynamic Reports · 164. See also
Time Map
bold text · 173
colors · 173
copying · 179
direction arc · 355
direction types · 168
editing · 176
glyphs · 173, 176
headers · 164
layout · 174
limit · 172
midpoints · 169
options · 164
point types · 176
print queue · 170
printing · 179
progression types · 168
saving selections · 171
selecting aspects · 170
selecting events · 167
selecting points · 169
sort order · 172
transit times · 164
viewing · 172
viewing chart · 178
viewing interpretations · 177,
178

E
Eclipses
Index 459

as extra ring points · 231
data source · 434
displaying with a chart · 147
page object · 311
Saros number · 189
searching for · 189
types · 190
Email
graphics · 125
options · 368
Emailing Charts
emailing · 96
Ephemeris
dumping to file · 203
generator · 200
graphic · See Graphic Ephemeris
viewing · 202
Esoteric
further reading · 436
Esoteric Rulerships · 404
Essential Dignities
page object · 316
Event Type · 35
Exaltation · 404
Exiting · 15
Exporting Charts · 89
Exporting Data · 100
Extra Bodies
selecting as extra radix points ·
222
Extra Points
editing · 219
types · 219
Extra Ring Points · 332
editing · 229
selecting · 212

F
Fall · 404
Features
new · 438, 440, 441, 444
selected · 2
File Manager · 210
Files
description · 450
Firdaria · 319
Fixed Positions
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selecting as extra radix points ·
223
Fixed Stars
classification of · 261
creating new file · 259
description of files · 433
editing · 258
editing information · 260
importing · 260
merging file · 259
nomenclature · 261
page object · 311
printing list · 260
selecting · 212
selecting as extra radix points ·
222
viewing in planetarium · 149,
265
Fonts
changing size · 346
screen vs printer · 344
selecting for display · 344
Full Transit Header · 164

G
Geocentric Correction · 349
Geodetic
casting chart · 83
Glyphs
alternative · 362
for aspects · 402
for signs · 400
Graphic Ephemeris · 183
coordinate type · 185
copying · 188
display options · 186
generating · 183
modulus angle · 186
printing · 187
saving selections · 187
selecting dynamic type · 185
selecting options · 183
selecting points · 187
viewing · 187
Grid
viewing · 110
viewing synastry · 24

Group Composite
casting chart · 75

H
Harmonic
calculation methods · 409
casting chart · 73
Help
on-line · 15
Horary Considerations
page object · 318
House System
selecting · 35, 36
types of · 35
Houses · 358
description · 358
expansion · 336
proportional · 335
Hylegs
defined · 422
page object · 321

I
Importing Charts · 89
Ingress
casting chart · 69, 73
Installation · 4
Installing
problems · 6
Interpretations
author · 432
browsing · 131
compacting · 244
compiling · 242, 389, 391
copyright restrictions · 433
creating new file · 233
current chart mode · 129
decompiling · 242
dynamic aspects · 239
editing · 233
exiting · 140
exporting · 138
file · 139
file layout · 393
file locations · 392

mapped aspect names · 238
modes · 132
producing report · 136
rulerships · 135
selecting aspects · 237
selecting report categories · 137
text categories · 234
types · 133
viewing · 128
viewing contents summary · 240
viewing dynamic · 177
viewing dynamic report · 178
viewing from Time Map · 181
weightings · 236
word processor · 137, 364
Interpretations File
selecting · 212
Interpretations Window
opening · 131

J
Jayne, C. · 414
Johndro
casting chart · 83
Johnson, S.M. · 432

K
Keyboard · 16
Keys
short-cut · 17
Koch Houses · 358

L
Latitudes
entering · 34
geocentric correction · 349
Lilith · 406
Lines
description of types · 146
LMT · 33
Locality
calculation methods · 411
casting chart · 83
Index 461

Longitudes
entering · 34
Lunar Mansions
page object · 320
Lunar Node · 348
Lunar Parallax · 350
Lunar Phase
as extra ring points · 231
casting chart · 81
families · 81
page object · 311
Lunar Phase Return
casting chart · 81

M
Macros · 372
Main Screen · 11
MAPI · 96
Margins · 206
MC
calculation · 352
Midpoint Trees
options · 362
Midpoint Weighting Analysis · 160
Midpoints
dynamic · 169
page object · 324
selecting · 221
Moieties · 249
Moon
black moon · 406
node type · 348
Mutual Reception
page object · 318
MWA · 160

N
Naibod · See Angle Progressions
Node
lunar type · 348

O
Orbital Elements · 427
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Orbs
changing for aspects · 246

P
Page Designer · See Page, Userdefined
Page Topic Index · 113
Page, User-defined
description of objects · 300
description of properties · 297
designing · 293
editing · 293
graphic file · 299
inserting new object · 295
saving changes · 330
selecting · 113, 212
selecting page sizes · 326
shortcuts for viewing · 115
viewing · 112
Parallax · 350
Parans · 154
Part of Fortune
selecting formula · 349
Place · See also Atlas
adding · 41
automatic lookup · 31
changing on main screen · 7
copying · 42
databases · 39
deleting · 43
editing · 41
entering details · 31
finding · 40
manual lookup · 32
restoring default · 31
selecting · 40
selecting for copy/delete · 42
setting default · 7
Solar Fire database · 39
Solar Fire timezone tables · 43
Places
favourites · 365
setting default · 366
Places File
copying · 214
creating · 213
deleting · 214

renaming · 214
selecting · 212
Placidus Houses · 359
Planet bar · 14
Planet Bar
viewing · 371
Planet Search · 56
Planetarium · 149
animating · 153
coordinate system · 150
printing · 153
selecting a star · 151
view direction · 151
viewing a constellation · 152
viewing star information · 152
Planetary Hour
page object · 318
Planetary Periods
page object · 319
Planets
hypothetical · 406
Jayne's hypothetical · 414
search · 56
user-defined orbits · 427
Vulcan · 406
Pointer · See Dial
options · 122
Polar
MC calculation · 352
Pottenger, M. · 226, 434
Preferences · 347
pre-setting · 8
Prenatal
calculation methods · 411
casting chart · 77
description of · 411
interpreting charts · 419
Jayne's law of sex · 418
Primary Directions · See Directions
Printer
batch queue · 208
orientation · 208
setting margins · 206
settings · 207
Printing · 204
fixed stars list · 260
planetarium · 153
summary of charts · 63

Progressions
angles · 353
calculation method · 406
casting chart · 66
day type · 355
dynamic report · 168
graphic ephemeris · 185
lunar phase chart · 81
of midpoints · 169
relocation · 356
to midpoints · 169
user rate · 354
Proportional Houses · 335
Publish
graphics · 125

Q
Queue · See Printer

R
Radix File
copying · 214
creating · 213
deleting · 214
renaming · 214
selecting · 212
Rays
page object · 323
weightings · 351
Real Time Clock · 193
Rectify Assist · 119
Relationship
casting chart · 75
Relocating
chart · 87
combined chart · 77
composite chart · 77
directions · 68
dynamic reports · 167
graphic ephemeris · 185
lunar phase chart · 83
natal chart · 83
prenatal chart · 78
progressions · 68
returns · 70
Index 463

rise/set chart · 80
Relocation
progs/dirns · 356
Reports · See also Dynamic
Reports. See also Interpretations
bold text · 162
colors · 162
copying · 162
description · 155
generating · 154
glyphs · 162
headers · 162
modulus angle · 161
orbs · 162
parans · 154
printing · 163, 204
rich text format · 365
single chart · 160
synastry · 163
vernal point · 154
Requirements
disk space · 4
RAM · 4
system · 4
Retaining Charts · 88
clearing · 89
Return
asteroids · 72
calculation methods · 408
casting chart · 69
demi, quarti etc. · 72
multiple · 71
planetary · 72
progressed solar, defined · 408
to user-defined point · 73
Rich Text Format · See Reports
Rise/Set
casting chart · 79
Rulerships · See also
Dignity/Almuten
changing · 384
esoteric · 404
hierarchical · 404
tabulation of · 404
Rulerships and Weightings Editor ·
385
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S
Saros Number · 189, 191
Saving Charts · 85
auto chart save · 85
Saving Settings · 348
Search
aspects · 57
planetary placements · 56
Sect
page object · 316
Sending Chart Data · 96
Settings · 347
editing · 348
restoring · 348
saving · 347
saving on exit · 348
Solar Maps · 142
display options · 147
eclipses · 146
line types · 146
Sound · 362
Source Rating · 36
Stars · See Fixed Stars
Starting · 10
Superimposition · 337
options · 338
types · 337
Swiss Ephemeris
accuracy · 405
asteroids · 227, 369
location · 369
Symbols · See Glyphs
Synastry
viewing grid · 24, 110

T
Term
types defined · 289
Term Directions
page object · 321
Time
chart · See Rectify Assist
entering · 29
format · 31
selecting format · 7

setting clock · 6
system · 12
Time Map · 164, 179
copying to clipboard · 181
dates · 180
deleting lines · 181
hit numbers · 180
moving lines · 181
viewing interpretations · 181
Timezone
editing a table · 45
entering · 32
LMT · 33
startup · 366
tables · 43
Toolbar · 12
editing · 370
viewing · 371
Topocentric
Moon · 350
Transit Times · 164
Transits
casting chart · 69
dynamic report · 167
graphic ephemeris · 185
of midpoints · 169
to midpoints · 169
Transneptunians · 406
Triplicity
types defined · 288

U
Uninstalling · 450
User Direction Rate · 355
User Progression Rate · 354
Utilities · 380
editing · 380
suggestions · 382

V
Vedic Charts · 325
Vernal Point · 154
View Chart
buttons described · 118
changing options · 117
using · 117
View Menu
customizing · 361
Vulcan
calculation · 350

W
Weightings
changing · 384
dynamic reports · 173
interpretation balances · 236
Wheel Style · 334
design options · 268
editing · 266
selecting · 212
Wheels
shortcuts for viewing · 115
Whole Sign Houses · 359
Word processor
selecting · 137, 364
Wynn-Key
defined · 408

Z
Zodiac · 357
selecting · 36
Zodiac Sign
colors · 210
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